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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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Chapter 1
About This Guide

1  About This Guide

Audience and Scope  
If you're looking for information about performing day-to-day tasks in your sales applications, then this guide is for you.
The information is primarily aimed at salespeople, sales managers, and other sales users who form part of your sales
organization.

This guide describes how to:

• Improve and speed up your searches

• Use a single, unified work area with direct access to common actions

• Manage customers and contacts.

• Log sales calls.

• Manage calendars and activities.

• Create and update sales campaigns and sales leads.

• Create, monitor, and update opportunities.

• View and perform actions from within actionable and Workspace infolets.

• Create and update territories and quotas.

• Use mobile applications with your sales application and use sales assistant.

• View key metrics, such as pipeline revenue, quota performance, and in-context audit to view transaction
change history at a glance.

Related Guides  
You can refer to the following related guides to understand more about the user tasks covered in this guide. All of these
guides are on Oracle Help Center.

Title Description

Oracle Fusion Cloud Applications: Using
Common Features
 

Describes user tasks and features that are common across Oracle Applications Cloud.
 

Oracle Fusion Cloud Sales Automation:
Using Incentive Compensation
 

Describes the user tasks for the incentive compensation business process, from creating and
managing compensation plans to reviewing and monitoring incentive plans and performance data.
 

Oracle Fusion Cloud Sales Automation:
Using Customer Data Management for
Sales and Fusion Service
 

Describes user tasks to manage customer information and customer data quality.
 

1

http://docs.oracle.com
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACPR
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=OACPR
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACMI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACMI
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAEIM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAEIM
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAEIM
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Title Description

Oracle Fusion Cloud Sales Automation:
Using Customer Contracts
 

Describes user tasks for customer contracts including creating customer contracts, authoring of
contract terms, and maintenance and configuration of contracts.
 

Oracle Fusion Cloud Customer Experience:
Creating and Administering Analytics for
Sales and Fusion Service
 

Provides advanced instruction on creating and modifying analytics and reports.
 

Oracle Fusion Cloud Sales Automation:
Using Partner Relationship Management
for Channel Managers
 

Describes user tasks to help channel sales managers, channel account managers, and channel
operations managers perform day-to-day business tasks.
 

Oracle Fusion Cloud Sales Automation:
Using Partner Relationship Management
for Partners
 

Describes user tasks to help partner sales managers, partner salespeople, and partner administrators
perform day-to-day business tasks.
 

Oracle Fusion Cloud Fusion Service: Using
Fusion Service
 

Contains information to help service managers, service personnel, and other service end users to
perform day-to-day business tasks using Oracle CX Service.
 

Oracle Fusion Cloud Fusion Service: Using
Knowledge
 

Describes how administrators, agents, authors, and other knowledge base contributors can implement
and use Knowledge in CX Service.
 

Oracle Fusion Cloud Sales Automation:
Using Digital Sales (Next Gen Sales)

Provides an introduction to the new Oracle Digital Sales application. It explains the principles of using
the new interface and provides instructions on basic tasks. The guide doesn't explain the underlying
CX Sales functionality. It focuses on what's new in Digital Sales.

Oracle Fusion Cloud Sales Automation:
Using Sales
 

(This guide) Aimed at salespeople, sales managers, and other sales users. Contains information about
performing day-to-day tasks in the sales applications.
 

2

https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACAA
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACAA
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FACAA
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASCO
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAFFP
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAFFP
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAFFP
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAUEC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAUEC
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAEUK
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FAEUK
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSU
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FADSU
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASTG
https://docs.oracle.com/pls/topic/lookup?ctx=fa-latest&id=FASTG
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2  Get Started

Overview of the Sales Application  
Your sales application from Oracle gives you a single interface to perform a variety of key sales tasks. The easy-to-use
design means less time training, so you get up-to-speed quickly.

In addition to presenting core tasks in a simple UI, the application features analytics that provide information when and
where you need it. Here's a summary of the key tasks you can accomplish with the applications:

• Manage accounts, households, and contacts.

• Create business plans and manage customer assets.

• Log sales calls and follow up on tasks.

• Manage calendars and appointments.

• Send out sales campaigns.

• Create and update leads and convert them to opportunities.

• Create, monitor, and update opportunities.

• View competitor information.

• Create and manage service requests.

• Create and update territories and quotas.

• Manage sales forecasts.

• Use and share documents in the Lightbox content library.

• Manage partner information.

• Use the mobile application to manage customer information, leads, and opportunities.

• View sales metrics, such as pipeline revenue and quota performance, at a glance.

Get to Know the UI and Features
Understanding the main areas of the UI and core features helps you as you work within the sales applications. UI and
features include:

• Home page:

◦ The home page is your central location to navigate where you need to go to complete important tasks,
like updating contact, account, lead, or opportunity information.

◦ You can quickly create sales records from just one page. From the Sales tab on the home page, access
quick actions to create opportunities, leads, contacts, and activities, including tasks, appointments, and
call reports, from a single location.

◦ The home page contains a springboard and a panel that shows different useful items, depending on
setup. For example, it can show you company announcements or a news feed.

• Springboard:

◦ The springboard shows a set of functional area icons.

3
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◦ Use springboard icons to open pages and applications.

• Accounts and contacts:

◦ Create and manage accounts, contacts, and households for selling.

◦ View and manage associated items, such as interactions, leads, opportunities, and appointments.

• Calendars, Tasks, and Call Reports:

◦ Use calendars and tasks in Activities area.

◦ Create and manage appointments and tasks, and associate them with the contacts, leads, and
opportunities you're working on.

◦ Manage team calendars and respond to autogenerated tasks.

◦ Enter and submit call reports.

• Leads:

◦ View and edit lead information, including products, budget, and deal size.

◦ Create, qualify, and convert leads.

• Sales campaigns:

◦ Create sales campaigns to target contacts from multiple sources including the contact repository and
previous campaigns.

◦ Manage all the information related to your sales campaign such as monitoring responses.

• Opportunities:

◦ Create and manage opportunity information, such as owner, product revenue, win probability, sales
stage, and more.

◦ Manage all the information related to your opportunities like relationships, contacts, appointments, and
sales team members from one, convenient portal.

• Sales forecasting:

◦ View forecast, pipeline, and won amounts for current, past, and upcoming quarters.

◦ See forecast trends over time.

• Partner management:

◦ Manage partners, including their leads and opportunities.

◦ Review notification requests and manage activities and notes related to partners.

◦ Manage partner enrollments.

• Sales analytics:

◦ Predefined infolets contain key metrics, such as Top Open Deals or Stalled Deals. You navigate to the
infolets using the pagination controls (clickable dots).

◦ Gain insight into your performance against your quota.

◦ View your pipeline, including total opportunity revenue, revenue per sales stage, and opportunity count
in the pipeline.

• Additional configuration (administrators only):

4
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◦ Set any one of several different themes to change look and feel.

◦ Change icon style, button shape, and logo to personalize the user experience.

◦ Configure news and announcements on the home page.

A Personalized UI
As you work in the sales application, the application saves certain changes you make. This personalization applies only
to you, and it remains as you sign out of the application and sign back in.

Here are a couple of ways to improve your own personal application experience:

• Save searches: Save your personalized searches in work areas so you don't have to recreate them each time you
sign in.

• Home page: Show what you want to see or not see on the home page, such as work area icons.

Keep in mind that some changes remain only while you're working on a page, for example, changes to the column
widths of a table. When you next refresh the page, even in the same session, table column widths are restored to their
original sizes.

Related Topics
• Sign In and Get Started

• Personalize Infolets

• How can I show or hide work area icons on my home page?

• How can I change the criteria in saved searches for the global search?

• Save Searches with Multiple Criteria

Overview of Work Areas  
A work area is a set of pages that provides everything you need to accomplish a business goal.

Watch video
 

You can use work area icons on your home page or the Navigator to open work areas. When you open any work area,
you see a landing page. Landing pages typically summarize data and let you drill down to more details. Often you can
change the records that you view by running different searches or filters, or by clicking an infotile, if any on the landing
page. Let's explore a couple of work areas.

Landing Pages with Searches and Filters
Some landing pages have filters you can use to view specific set of records that you're looking for. For example, you can
remove some values to exclude records that you don't want to see, and then hide the filters. You can also use the search
to find what you need. You can select the Actions menu to get going with a few tasks on the specific records, or open
the record to see or edit details on another page.

5
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Here's a landing page of a work area, where you use searches (1) and filters (2) to view specific records, and the Actions
menu (3) to do your tasks.

Sometimes, you might find this record in the form of a grid or list. You can use the Grid icon and the List icon to switch
between these two views of the same records.

Landing Pages with Quick Access to Key Tasks
Now let's see another work area where you get quick access to a set of related tasks. On these landing pages, you easily
see the key tasks you can do in the work area.

Here's a landing page of a work area, where you can quickly access the key tasks (1).

Landing Pages with Infotiles
Other than filters and searches, there are other ways for you to get to what you need to work on.

Some landing pages show the work areas with infotiles, which display key information about a set of records. You can
click links in the infotile to filter the records. For example, you can see the list of items you need to act on.
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This table shows the available UI elements on the landing page and explains what you use them for.

Callout Number UI Element What You Use It For

1
 

Row of infotiles
 

Display key information about a set of records,
 such as expense items and expense reports.
 

2
 

Summary table
 

• View records for the infotile you select.

• Drill down from the landing page to a
specific record.

3
 

Panel tab
 

Do additional tasks, such as use the links to go
to related tasks or view reports.
 

Some landing pages have tabs on the left you can use to go to another page in the same work area.

Here's a landing page of a work area with tabs on the left (1).

Landing Pages with Infolets
Some landing pages consist of only infolets. This is what a landing page with infolets looks like.

This is what a landing page with infolets looks like.
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From an infolet, you can usually open other pages in the same work area or another work area.

There are many other types of work areas, which you can explore!

Related Topics
• Sign In and Get Started

• How You Use Tables

• Overview of Infolets

About Recent Items  
Whenever you view records or make changes to records, that event gets added to your recent items list. Recent items
help you when you search or enter information, because they automatically populate items you've recently viewed or
accessed.

Recent items are available in:

• Find search boxes on landing pages

• Favorites and Recent Items list (accessible from the global header)

• In search boxes in application page, such as when adding an opportunity to an account

Scenarios for When Recent Item Relationships Occur
These simple scenarios illustrate when the application establishes a recent items relationship:

• You create a record, such as a lead, an opportunity, or an activity like a task or appointment.

• You drill into the edit page of a record that's not among the recent items, for example, you open a task.

• You sign out of the application.

This scenario is a little more complex and illustrates how recent items can appear in other objects:

• An appointment has Opportunity 1 associated with it.

• You edit Opportunity 2 and save the opportunity.
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• You go into the same appointment and remove Opportunity 1, and then click on the drop-down list for
opportunities, to associate a different opportunity with the appointment.

• In the appointment's drop-down list for opportunities, the application shows the last opportunity (Opportunity
2) first in the list.

Your administrator can configure how long to keep recent items in the database. The default is 30 days.

Mark Favorite Records  
Mark your favorite records so that you can find them more easily. To mark a favorite record, you:

• Click the favorite icon in the edit page of a record.

• In Workspace, click the favorite icon for the record in the list page.

Note:  Your administrator must enable the favorites functionality in Workspace. See the related topic, Enable
the Favorite Field for Quick Access to Records.

You can mark favorites in these areas:

• Accounts and contacts

• Assets

• Activities

• Campaigns

• Deal registrations

• Leads

• Opportunities

• Partners and partner contacts

• Territories

• Custom objects

You can also mark favorites in the CX Sales Mobile app and in Sales for Microsoft 365.

Related Topics
• How can I mark favorite records in Workspace?

• Enable the Favorite Field for Quick Access to Records

View and Act On Notifications  
Notifications alert you that something requires your attention or action. Click the Notifications icon in the global
header to open your notifications list. The number on the icon indicates how many pending notifications you haven't
acted on or dismissed yet.
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Most notifications are for workflow tasks, but not all. So it's possible that what you see in the list isn't the same as what
you see assigned to you in the Worklist: Notifications and Approvals work area. Also, for one task you see in that work
area, you might get more than one notification. For example, one notification that someone requests information from
you about the task, and later another notification that the task is approved.

Here's an example of the notifications list in the global header. The Notifications icon says there are 25 pending
notifications. The first three are new ones you have never seen before and require some action on your end. The third
one you can approve or reject without even opening the notification. The next two are just FYI.

On your home page, you can also find notifications in the Things to Finish section, which looks like this.

The first card in the Things to Finish section has two numbers:

• Assigned to Me: The number of notifications assigned to you either to act on or just FYI, in this case 10. The
rest of the cards in the Things to Finish section are the notifications assigned to you, the exact same as the
pending notifications you see in the global header.

• Created by Me: The number of workflow tasks you submitted that are still pending final approval, in this case 2.
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Here are some things to know about both the Things to Finish section and the notifications list in the global header:

• From either place, you can open the Notifications page. That's where you can view and manage all your
notifications in one place, not just the ones that are pending and assigned to you.

• Updates you make to workflow tasks in the global header, for example approving them, are automatically
reflected in the Things to Finish section. Same goes the other way around, too. But changes you make
elsewhere and changes that someone else makes aren't reflected in either place until the Synchronize
Notifications in Global Header process runs, for example every two hours. The scheduled process updates
workflow notifications with the latest task status and removes notifications older than 30 days no matter
the status. For example, you approved one task from email, and someone else in the approval group that
you're part of rejected another task from their notifications list. After synchronization, the notifications asking
approval for these two tasks are removed from your list in the global header and your Things to Finish section.
Because these tasks are no longer pending for you, based on the latest task status.

No matter where you see the notification, the language of the notification title might not be the same as the language
that you selected when you signed in to the application. The title is always displayed in the language that was used
when the notification was generated.

How You Address Your Notifications
To view and act on notifications in the Things to Finish section, the global header, or the Notifications page:

1. Click the Notifications icon in the global header, or go to the Things to Finish section on the home page.

◦ Here are a couple of things to know about the list that opens up in the global header:

- The New icon (a blue dot) identifies any new notifications. Even if you close the list now without
doing anything else, the same notifications are no longer new the next time you open the list.

- You can search based on the text of the notification titles in the list. For example, if you search by
the term reports, search results include all notifications with reports in the title, but not the ones
with report.

◦ In the Things to Finish section, you can click the Close icon just to remove the card. The notification is
still assigned to you, so you can still find it, for example, in the global header or the Assigned to Me tab
on the Notifications page.

2. Go on to the next step, or click one of these links to open the Notifications page:

◦ Show All from the notifications list in the global header

◦ A number on the first Things to Finish card to open the corresponding tab on the Notifications page,
Assigned to Me or Created by Me

◦ Show More in the Things to Finish section

3. For a notification that requires action, you have a few options:

◦ Click the Approve or Reject button, where available.

◦ Open the Actions menu and select an action, where available.

◦ Click the notification title to see the details and select from all available actions. Depending on what the
notification is about, some actions might not apply. For workflow tasks, you get the same task details that
you do from your worklist, using the Worklist: Notifications and Approvals work area or region.

4. For a notification that doesn't require action, you also have a few options:

◦ Click the Dismiss button to acknowledge the notification. For workflow tasks, this option is available only
for FYI tasks. The FYI task itself isn't marked as acknowledged, so it's still pending to be either manually
or automatically completed.
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◦ On the Assigned to Me tab on the Notifications page, click the Dismiss All button.

- For workflow tasks, this option is available only for tasks where action is already taken and there's
no more action pending with assignees. For example, the task is approved or withdrawn. This
option doesn't apply to FYI workflow tasks.

- If you still see some notifications after you click Dismiss All, those are notifications for FYI
workflow tasks, notifications that still require action, or notifications that you have to first open up
to see details before dismissing.

◦ Click the notification title to open the details.

◦ Just read the notification title, if the title is text-only and not a link because there aren't any details to
display.

5. On the Created by Me tab on the Notifications page, you can see the workflow tasks you submitted that are
pending final approval or already completed. Where available, you can take action on the pending items, for
example to withdraw your request.

No matter which option you choose to address notifications that require action or not, the notification is taken off the
list in the global header and is no longer assigned to you in the Things to Finish section or the Notifications page. You
can still find the notification on the All tab on the Notifications page.

Use Alternate Notifications UI
If your administrator has selected the panel or banner home page layout, then you get an alternate UI when you click
the Notifications icon in the global header. Also, the Things to Finish section and Notifications page aren't available.

Let's take a look at the alternate notifications list. In this example, you have two pending notifications, the first one you
have never seen before. You can approve or reject both notifications without even opening them.

Here's how you use the alternate notifications list in the global header:

1. Click the Notifications icon in the global header.

In the list that opens up, the New icon (a blue dot) identifies any new notifications. Even if you close the list now
without doing anything else, the same notifications are no longer new the next time you open the list.

2. Take any of these steps to get another view of notifications:

◦ Click the drop-down button to switch between pending notifications and all notifications.

◦ Search based on the text of the notification titles in the list. For example, if you search by the term
reports, search results include all notifications with reports in the title, but not the ones with report.

◦ Click the More Details button to view and manage workflow tasks in your worklist.
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3. For a notification requiring action, you have a few options:

◦ Click the Approve or Reject link, where available.

◦ Open the Actions menu and select an action, where available.

◦ Click the notification title to see the details and select from all possible actions you can take. For workflow
tasks, you get the same task details that you do from your worklist, using the Worklist: Notifications and
Approvals work area or region.

The notification goes off the pending list now that you have acted on it.
4. For a notification that doesn't require action, you also have a few options:

◦ Click the Clear icon that appears when you hover over the notification, to dismiss the notification.

◦ Click the notification title to open the details.

◦ Just read the notification title, if the title is text-only and not a link because there aren't any details to
display.

In all cases, the notification is considered read and taken off the pending list. To keep a notification as pending,
you can click the Undo link that temporarily shows up near the notification title after you click the title or Clear
icon.

Related Topics
• Use Your Worklist to Manage Workflow Tasks

• Actions and Statuses for Workflow Tasks

• Synchronize Notifications in the Global Header and Home Page with Workflow Tasks

• How do I remove notifications from the global header and home page?

• Why are workflow notifications that I acted on still in the global header and home page?

Get Help in the Application  
To get help for what you're working on, use help icons that are on many of the pages. The icons open help windows that
can have informational text, links to help content, and maybe even help that your company added.

Watch video
 

Use Help Windows
Here's what you do:

1. Click a help icon. The help window gives you information specific to the page or part of the page that the icon is
on.

2. In the help window, click any of the links available.

◦ You see help links in your preferred language only if there's content in that language. If not, you see links
in English.

◦ Help content opens in a new browser tab so you can keep that open while you work.
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◦ You can do more with the help than just read it. Options can include printing, downloading, or emailing
the help.

3. Most of the links open guides in the Oracle Help Center. You can use the Table of Contents tab to move around
in the guide for other information. Or, to search within the guide, open the Search tab and run a search with the
Search this book option selected, as we see here.

What to Do If You Don't See Help Icons
If you don't see any help icons on the page, click your user image or name in the global header and select Show Help
Icons. You reveal any icons on your current page, and any other page you might use, but not all pages have help icons.
In that case, click your user image or name in the global header and select Applications Help to open the Oracle Help
Center.

Related Topics
• Find Guides, Readiness Material, and Other Resources

• Oracle Help Center

Find Guides, Readiness Material, and Other Resources  
The Oracle Help Center (https://docs.oracle.com) has guides, videos, readiness material, and other resources for Oracle
Fusion Cloud Applications.

Watch video
 

Here are a couple examples of what you'll find in the Help Center:

• Guides give you cumulative information about all features in each cloud service, for example how to use, set up,
and extend them.

• Readiness documents tell you what's new or changed in a particular release update. This material is published
before the update happens, to help you prepare for it.

In the application, when you click links in help windows, most of the time you open a specific guide in the Help Center.
From there, you can search or browse to find other content. Or, if you're on the oracle.com site, open the Resources
menu and select Oracle Help Center to get to the Help Center. It's a good idea to bookmark the Help Center.
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Let's take a look at how you can move around and find what you're looking for in the Help Center.

Browse for Cumulative Content About a Cloud Service
Here's how you find guides, videos, and other resources:

1. From anywhere in the Oracle Help Center, open the main menu and select Fusion Applications Suite under
Cloud Applications. Or, click Fusion Applications Suite on the Help Center home page.

2. On the Oracle Fusion Cloud Applications Suite page, browse the cloud services which are organized in
categories.

3. Click the name of your cloud service.
4. On the main page for the cloud service, select a release update if you don't want to see the latest content.
5. Use the navigation pane to get to a specific guide, video, or other resource. Here are some examples of where

you might go:

◦ All Books or Videos: Get all the videos or guides for the cloud service.

- On the Videos or All Books page, you can use the View list to filter by category.
- Most guides are available in multiple formats, for example HTML and PDF.

◦ Top Tasks: Click a task category and then a specific, common task to go straight to information that will
help you with that task.

◦ APIs & Schema: Get reference information about APIs and schema details.

Tip:  Use the breadcrumbs to get to other parts of the Help Center.

Search Within or Across Guides
The scope of the search in the global header of the Oracle Help Center depends on the page you're on. For example, on
the Oracle Fusion Cloud Applications Suite page, you search across all guides for Fusion Applications. On the pages for
a specific cloud service, you search only within that service, which gives you more targeted results. If you want to search
within one guide, use the Search tab in the guide.

Let's take a look what we can do with the search results. In this case, the first result is a guide, but you might also see
other types of resources, such as videos, reference architecture and solution playbooks, or readiness material. And
they might come from places other than the Help Center, for example My Oracle Support (https://support.oracle.com),
oracle.com, or YouTube.
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Callout Number What You Can Do

1
 

Remove a filter from the search to get more results.
 

2
 

Apply more filters to narrow down your choices, for example based on publication date.
 

3
 

Open the main page page for a product that has many results that match your search.
 

4
 

See search results from this product.
 

5
 

Open the title page for a guide with content that matches your search terms.
 

6
 

See when this guide was published.
 

7
 

Open a specific chapter in this guide.
 

8
 

See more chapters in this guide.
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Review Readiness Documents
Let's find the readiness material that can help you prepare for your next quarterly update:

1. On a page in the Oracle Help Center for your cloud service, click Cloud Readiness / What's New in the
navigation pane.

2. On the main page in Oracle Cloud Readiness for your service, find the What's New subsection in the Essential
Content section.

3. Click HTML to open a What's New document in a new browser tab.
4. Click the release update you want to review.
5. In the table of contents, click Feature Summary to see which features are enabled or disabled by default. You

need to take action to make disabled features available to your users.
6. If you see an Opt In Expiration tab, click it to see when disabled features will become enabled by default.
7. Click the tab for your release update to go back and see the details about specific features.
8. Return to the browser tab with the main page for your cloud service to explore other readiness content. From

there you can also jump over to other cloud services.

Related Topics
• Get Help in the Application

Why can't I see all the items in my browser window?  
If you're using the application primarily on a tablet or other small screen and can't see all the items on the screen in the
browser, ask your administrator to check the value of the profile option, Advanced Responsive UI features.

This profile option, when set to Yes, means the application better displays content on smaller screens.

Related Topics
• Optimize Browser Space in Work Area and Detail Pages

17

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20078628


Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 2
Get Started

18



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 3
Sales Resources, Roles, and Organizations

3  Sales Resources, Roles, and Organizations

Overview of Managing Resources  
Managing resources involves viewing and modifying a resource's profile, organization membership, role assignment,
skills, additional contact information, and salesperson information.

All the resources within the deploying company can view any resource's profile. However, only the administrator can
modify a resource's profile, organization and team membership, and role assignment. Managers can modify the skill
information of their direct and indirect reports. However, resources can only modify their own profiles, skills, and
additional contact information.

Manage Resource Profiles
Resource profile management involves managing a user's profile, including the resource's core skills, photo, time zone,
additional contact information, and so on. As part of managing a resource's profile, the administrator specifies the dates
between which the resource is available to the organization. The administrator also ensures that role assigned to the
resource is within the period mentioned in the profile.

Manage Organization Membership
At any point in time, a resource belongs to an organization, and the administrator can assign this resource to any other
organization within the deploying company.

Manage Resource Role Assignment
An administrator or an organization manager can assign or modify resource roles within an organization, with one
role assigned to a resource at a time. However, administrators can also assign multiple roles to resources outside an
organization.

Note:

• The dates of the resource role assignment must be within the date range during which the resource is active in
the deploying organization.

• An organization can have only one manager.

Configure Extensible Resource Pickers
Administrators can configure extensible resource pickers that let sales users search and associate users with business
objects relevant to their business flows. For more information about configuring the resource search, see the related
topics.
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Related Topics
• Overview of Configuring Resource Search

• Configure Resource Search

• Frequently Asked Questions (FAQs) for Resources

Resource Directory  
You can use the Resource Directory to view all the resources within your organization. You can also use the Resource
Directory to find and communicate with other resources, and to network and collaborate with them.

You can access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform
some of the functions of the resource directory using the Manage Resources setup task.

You use the Resource Directory to perform the following tasks:

• View and modify your profile

• View your organization information

• View information related to other organizations

• View the profiles of other resources

• Communicate with other resources

Note:  You can set the profile option HZ_RESOURCE_ALLOW_CUSTOMIZATION to Yes to enable desktop pages for
Resource Directory in Application Composer. The default value of this profile option is No.

Related Topics
• Frequently Asked Questions (FAQs) for Resources

Make an Employee a Sales Resource  
An employee must be a sales resource before they can be assigned to any role or be added to any organization.

After making an employee as a sales resource, you can manage the resource's organization membership, add or remove
skills of the resource, provide contact information, and so on. If you have an employee who needs to be a sales resource,
perform these steps:

1. Navigate to the Resource Directory.
2. Click Identify Resources in the Tasks region.
3. On the Identify Resources page, fill in the Person Name or Registry ID. You don't need to enter the complete

name. The application automatically searches for any characters entered, even if it's only a single character.
4. Select Employee as the Usage and click Search.
5. Select the employee and click Add as Resource.
6. Click OK on the confirmation message.

The employee is now also a sales resource.
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7. On the Add Resource Information page, in the Resource Details section, specify dates for the resource.
8. Select the Organization and the Role that you want to assign to the resource.
9. Optionally, in the Sales Person Information section, specify additional information about the resource.

10. Click Save and Close.

Related Topics
• Designate Proxies

• Impersonation Audit

• Configure Impersonation Auditing

• About Transferring Records Between Users

Examples of Updating Resource Skills and Qualifications 

This example illustrates the various contexts in which you can update your skills and qualifications in Oracle Resource
Management.

You can add a wide range of skills and qualifications into Oracle Resource Management. For the sake of convenience,
let's categorize these into core skills, achievements, and mandatory requirements.

Each of these skills must be used in specific contexts as described in the following scenarios.

Update Core Skills
Skills that reflect your key abilities are categorized under the Core Skills head, such as competencies, degrees,
languages, licenses and certifications, skills, and problem codes.

• Use the Competencies option to record your key abilities as a resource. For instance, if you have the ability to
quickly internalize and analyze complex information, list it here.

• Use the Degrees option to record your educational degrees.

• Use the Languages option to record your proficiency with the various languages you know.

• Use the Licenses and Certifications option to record any educational licenses and certifications you may have
received. For instance, if you have a Six Sigma certification, list it here.

• Use the Skills option to list out any specific software or engineering skills you may have. You can search for
these skills by category, product, platform, or component.

• Use the Problem Codes option to record your ability to manage and remedy specific service-related problems
that may arise within your company. For instance, if you're skilled at troubleshooting hardware issues, list it
here.
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Update Achievements
Skills that reflect your key achievements and uncommon abilities are categorized under the achievements head, such as
accomplishments, honors, awards.

• Use the Accomplishments option to record any major task you completed that reflects your abilities as an
individual. For instance, if you completed a rather difficult task in a short deadline, list it here.

• Use the Honors and Awards option to record any special honors or awards you may have received. For instance,
if you were the recipient of a certificate of merit award, list it here.

Update Mandatory Requirements
Skills that capture the mandatory requirements, which you have met for your employment, are categorized under the
mandatory requirements head. Thus, job requirements and work requirements are part of mandatory requirements.

• Use the Job Requirements option to update all job requirements you have met. For instance, many companies
require you to take a medical test before you join. If you took such a test before you joined the company, list it
here.

• Many roles have specific requirements that employees must fulfill before these roles can be assigned to them.
Such requirements can be listed out under the Work Requirements head. For instance, if you're willing to travel
overseas on duty, list it here.

Resource Roles  

About Resource Role Assignment  
Resource role assignment is the task of assigning roles to active resources within the deploying company.

These roles are previously set up, and have associated security privileges. Thus, when you assign a specific role to
resources, they automatically receive access to specific business functions within the company. A resource can only
have one role associated to organization membership and additionally can be assigned more individual resource roles.
A resource can be part of any one organization at any given point of time during active resource assignment range
(start date and end date).

Define Resource Roles  
A resource role, such as salesperson, denotes the function of a resource in an enterprise.

Oracle Applications Cloud comes with some predefined resource roles. You may either use these predefined, out of the
box resource roles, or you may use the Manage Resource Roles task in the Setup and Maintenance work area to create
additional resource roles or to modify predefined resource roles. Note that you must map these newly created resource
roles to one or more job roles and abstract roles before you can use them. Access to business data and privileges to run
business flows comes through job roles and abstract roles.
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Use Role Tags While Defining Resource Roles
You can set several tags while defining resource roles. Use these tags along with the organization hierarchy information
to define the reporting hierarchy of resources.

• Use the Manager tag to define a role as a supervisor role. You must assign a resource organization to a
manager resource, who will have visibility into all opportunities assigned to the members of that resource
organization.

• Use the Member tag to make a role a subordinate role in the resource hierarchy.

• Use the Administrator or Lead tag to indicate the nature of the tasks that resources who are assigned these
roles perform within the hierarchy.

Additionally, you can use these tags along with the resource organization hierarchy information to maintain
manager-to-manager relationships within the organization. For example, Resource A is a manager who heads a sales
organization and Resource B heads his own sales organization. Then, both Resource A and Resource B report into
Resource C, the Sales Vice President. Similarly, you can create resource organizations and manager resources, and relate
managers to higher-level managers, building the resource organization and reporting hierarchies of the company.

Assign Resource Role Types
Resource role types organize roles into logical groups. This simplifies role assignment and assignment tracking. For
example, the Partner resource role type defines a set of partner-specific roles, such as partner sales representative
and partner sales manager. Use the Sales resource role type and the Marketing resource role type to categorize the
appropriate sales and marketing roles for internal employees or contingent worker resources.

About Provisioning Roles  
This topic explains role provisioning, and the difference between resource roles and job roles.

Role provisioning automates the provisioning and deprovisioning of roles, based on resource role assignment. You use
job roles to provide access privileges. You can use Setup and Maintenance, Manage HCM Role Provisioning Rules task
to map the job roles to the resource roles. Associating a resource role to a user enables the user to access the tasks and
data based on the job roles assigned to the resource role.

Difference between Resource Roles and Job Roles
Resource roles are used to filter resources, generate reporting hierarchies, and define security policies. A resource role
may be assigned to a resource without a user account, while a job role can only be provisioned to a resource who has a
user account. Job roles are used to define the security privileges for a user account.

About Resource Members and Dates  
Every resource in the deploying company has start and end dates for a specific activity. When you assign resources to
organizations, you must ensure that their date of assignment is within the employment date range.
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Resource Active Dates and Resource Assignment
When you identify internal or partner employees as resources, you can specify the time for which they're active within
the organization. By default, the date you identify a resource becomes the start date, but there is no end date listed.
Thus, an identified resource is active from the day of activation and you can assign the resource to any organization
for an infinite period. A resource can be part of any one organization at any given point of time during active resource
assignment range (start date and end date).

Resource Skills and Resource Assignment
To get the best out of resources, you may define their skills relevant to the organization within which you deployed
them. Determine whether a resource's skill set matches the requirements of an organization. Then, deploy the resource
as appropriate for a period of time that falls within the active dates specified for the concerned resource.

Overview of Resource Roles, Job Roles, and Abstract Roles  
A resource role, such as salesperson, denotes the function of a resource in a resource organization. Job roles and
abstract roles provide users access to business data and privileges to run business flows.

Oracle follows the industry standard Role Based Access Control approach to security. In Oracle Applications, the
privileges are bundled in:

• Job roles, such as Sales Representative, which correspond to the jobs that the person is doing in your
organization.

• Abstract roles, such as Employee or Contingent Worker, which permit users to carry on tasks that are common
to all employees or resources.

For example, the Sales Manager job role makes it possible for a user to perform all of the sales manager duties, such
as reviewing sales team performance and approving forecasts. The Employee abstract role adds the ability to access
reports and manage personal profile information. The Resource abstract role makes it possible for a user to be assigned
as a sales resource to accounts and opportunities.

When you create a user as an employee with the Sales Manager resource role provided by Oracle, as shown in the
following figure, the application automatically provisions the Sales Manager job role and the Resource abstract
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role. Because you're creating the user as an employee, the application also provisions the Employee abstract role.

Resource Organizations  

Overview of Resource Organizations and Organization Usages  
You can assign organization usage information to resource organizations to classify them based on how you want to use
them. For instance, you can assign the Sales Organization usage to resource organizations engaged in sales activities.

This enables you to sort organizations based on their usage, simplifying your task of working with them.

How Resource Roles and Resource Organizations Work Together  
This topic explains how resource roles and resource organizations work together.

A single resource can belong to only one resource organization and be associated with only a single resource role,
during a given period. The organizations and organization hierarchies that a resource belongs to determine the
reporting relationships for that resource.

Resource Roles
A resource role, such as salesperson or sales manager, denotes the function of a resource in an enterprise from the
perspective of the deploying company. A resource role not only describes who a resource is in the enterprise, but also
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specifies the role a resource performs within the context of an organization or team. A resource can have only one role
in a resource organization during a given period.

Note:  You can assign only one role to a resource at a time.

Resource Organizations
A resource organization represents the internal organization and structure of the deploying company. Resource
organizations are hierarchically structured, and the organization hierarchy helps to derive the reporting relationships. A
resource can be a part of different organizations within the deploying company, and can have separate roles in each.

About Primary Resource Organization by Usage  
A resource can belong to only a single resource organization during a given period.

For each organization, you can assign different resource roles to a resource. When you assign a resource to one
resource organization, the organization becomes the primary organization for the resource for a specific usage.

A resource organization becomes a primary resource organization by usage for a resource, if it meets the following
criteria:

• Resource must be a member of the concerned organization.

• Resource organization must be classified as an organization with the specific usage.

For example, if you classify the resource organization as a marketing organization by usage, then the resource
organization becomes the primary resource organization for the resource for marketing.

Overview of Organization Memberships and Role Assignments  
When you assign a resource to an organization, you must also specify the role the resource is required to play in the
organization.

This helps ensure clarity on the tasks that you can assign to a resource and helps define where the resource is situated
within the organization's hierarchy.

Note:  An organization can have only one manager. A resource can have only one role in a resource organization
during a given period.

Associate Business Units with Resource Organizations  
You can associate resource organizations with multiple business units.

The first business unit that you associate with a resource organization is automatically listed as the primary unit.

26



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 3
Sales Resources, Roles, and Organizations

Associating resource organizations with business units helps you to view the relevant transactional details associated
with the resource, such as opportunities, leads, and so on. By associating resource organizations with business units,
you can also control access to contracts that are based on business units.

Users are associated with a business unit through their resource organization membership. Resource organizations are
mapped to one or more business units. When a sales user is created, the user is assigned to a resource organization,
and gains access to each business unit that's mapped to the resource organization. For example, users can access
relevant transactional data associated with their primary business unit, but might also have access to relevant
transactional data in other business units through their resource organization.

For more information about data access and business units, see the topics in the Securing CX Sales and Fusion Service
guide.

You can associate a resource organization with multiple business units from the Resource Directory. For more
information, see the Associate Resource Organizations with Multiple Business Units topic.

Related Topics
• Multiple Business Units High-Level Setup Steps

• Associate Resource Organizations with Multiple Business Units

Example of Adding or Removing an Organization From an
Organization Hierarchy  
This example describes how you can add or remove a sales organization to or from a sales organization hierarchy.

As new sales organizations are created within your company, you need to add these organizations to your company's
sales organization hierarchy.

Similarly, you may want to remove organizations that no longer exist.

Creating a New Version
1. Navigate to the View Organization Hierarchies UI page as follows: Navigator > Resource Directory > Tasks >

View Organization Hierarchies.
2. Search and select the sales organization hierarchy you want to edit.
3. Click the Action menu. If you want to add the new organization to the sales organization hierarchy with

immediate effect, select the Edit This Hierarchy Version option. If you want the new organization to display
in the organization hierarchy only after a specific date, then select the Create Hierarchy Version option. If you
choose the latter option, then you must specify the date from which the new version of the sales organization
hierarchy must be active.

Adding or Removing an Organization From the Sales Organization Hierarchy
1. Navigate to the View Organization Hierarchies UI page as follows: Navigator > Resource Directory > Tasks >

View Organization Hierarchies.
2. Search and select the sales organization hierarchy to which you want to add a new organization.
3. On the Action menu, click either Edit This Hierarchy Version option or Create Hierarchy Version option.
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4. In the Create or Edit Organization Hierarchy Version page, select the node in the sales organization hierarchy
where you want to add the new sales organization and click the Add button.

Note:  To delete an organization, select the required node and click the Remove button on the Edit
Organization Hierarchy Version page. Click to confirm. If you don’t plan to add any organization, skip to step 7.

5. Search and select the new sales organization in the Add Tree Node screen. This adds the new organization to
the sales organization hierarchy.

6. Select the new organization in the hierarchy, and drag and drop it to the node where you want to place it. The
organization appears in the location you specified within the selected sales organization hierarchy.

7. Click Save and Close.

Example of Creating an Organization with Sales Usage  
This example demonstrates how to create a resource organization with sales usage.

There are two options to create resource organizations with sales usage:

• Create an organization from an existing department

• Create a new organization

Creating an Organization from an Existing Department
You must create an organization with sales usage from an existing department if the concerned department must be
reused as a sales organization. Use the following steps:

1. Navigate to the Manage Internal Resource Organizations UI page as follows: Navigator >  My Enterprise > 
Setup and Maintenance >  Tasks >  Search >  Search for Manage Internal Resource Organizations.

2. You can either search for the organization whose usage you want to modify or click the Create button,
select the Create from Existing Department option and specify the name of the organization in the Create
Organization: Select Creation Method screen and click Next.

3. Click Actions >  Add Row.
4. Specify Sales Organization as the Usage under the Organization Usages section of the screen.
5. Click Finish.

Creating a New Organization with Sales Usage
1. Navigate to the Manage Internal Resource Organizations UI page as follows: Navigator >  Setup and

Maintenance >  My Enterprise >  Tasks >  Search >  Search for Manage Internal Resource Organizations.
2. Click Actions >  Create.
3. Select the Create New Organization option on the Create Organization: Select Creation Method screen and

click Next.
4. Specify the name of the new organization and select Sales Organization as its usage.
5. Click Finish to save the new organization with sales usage.

Assign a Resource to an Organization  
Once you have identified a resource, you can assign the resource to organizations within the deploying company. This
example explains how you can assign resources to organizations.
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Scenario
You must assign a resource to an organization. A resource can belong to only one organization and can have only one
role in an organization during a given period.

To assign a resource to an organization, perform the following tasks.

1. Navigate to the View Resources UI page as follows: Navigator > Resource Directory > Tasks > View
Resources.

2. Search for a resource and select it.
3. Click the Organizations tab. This displays the list of organizations to which the resource belongs.
4. In the Actions drop-down list, click Create.
5. In the Create Organization Membership pop-up, search and select the organization you want from the

Organization drop-down list.
6. In the Actions drop-down list, click Add Row and select the role the resource must play in the organization.
7. Enter the From Date and To Date, and click OK.
8. Click Save and Close.

You can also assign resources to organizations by searching for organizations and adding members to the organization.
To assign resources to organizations by searching for organizations:

1. Navigate to the View Organizations UI page as follows: Navigator > Resource Directory > Tasks > View
Organizations.

2. Search for an organization and select it.
3. Click the organization's name to display its details.
4. Click the Members tab to edit the list of members assigned to the organization.
5. In the Actions drop-down list, click Create to assign a new resource to the organization.
6. In the Add Resource Member window, select a resource from the Resource drop-down list.
7. Click the Add Row button to add a role to the newly-added resource.
8. Click the Role drop-down list and select the role the resource is required to play in the organization.
9. Enter the From Date and To Date, and click OK.

10. Click Save and Close.

Note:
1. The date from which a resource is a member of an organization must be on or after the date which the resource

was hired.
2. You can't reassign the resource to the same organization, if a resource was already a member of the selected

organization with an end date later than the current date. You also can't reassign the resource to the same
organization, if the resource was removed from the organization before the end date.

View Resource Information  
You can use the Resource Directory to view the detailed information about the resources in an organization. Sales
representatives and sales managers are examples of resources.

As a sales representative, you can view the profile details of the resources within your organization. You can also
modify part of your own profile, skills, and additional contact information. As a sales manager, you can modify the skill
information of your direct and indirect reports.
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Here's how you view the details of a resource:

1. Click Navigator >  Resource Directory.
The page displays the organizational structure between you and your manager.

2. View your details or another resource's details using the following steps:

◦ Click Tasks >  View Resource Details to view your details.
The Resource page with your details appears.

◦ Click Tasks >  View Resources to view the profile information of another resource.
The View Resources page appears. You can search for the required resource and click on the resource
name in the search results to view the details of the resource. Note that the Effective As-of Date defaults
to the system date for predefined resources. If a resource has been end dated earlier, the resource won't
appear in the search results. Therefore change the Effective As-of Date so that it falls between the
resource's start date and end date, that's when the resource was active.

The Resource page displays the details about the resource, such as usages, registry ID, manager, job title,
department, roles, mail stop, phone, email, address, and time zone.

3. In the Resource page, you can see the details about a resource, such as usages, registry ID, manager, job title,
department, roles, mail stop, phone, email, address, and time zone.

◦ Organizations: Displays the organization membership details of the resource such as role, organization,
usage, and manager.

◦ Teams: Displays the team information of the resource, such as role, team, team usage, and team
manager.

◦ Roles: Displays the role information of the resource, such as role name, member, manager, administrator,
and lead.

◦ Skills: Displays the skills of the resource, such as accomplishments, skills, competencies, degrees, honors
and awards, languages, licenses and certifications, problem codes, and work requirements.

◦ Additional Contact Information: Displays additional contact point information such as phone, email,
web, and contact preferences.

4. Click Save if you made any updates, or else click Cancel.

Related Topics
• Frequently Asked Questions (FAQs) for Resources

Designate Proxies  
Here's how you can designate a proxy to work on your behalf.

1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set
Preferences.

2. Click Proxies.
3. Click Actions  > Create.
4. Search for the person you want to designate as your proxy.

Note:  If you can't find the person you want to designate as a proxy, ask your administrator to check if the
person has the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege.
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5. Verify the user details and click Apply.
6. Click OK.
7. Select the start and end dates.
8. Click Save and Close.

Related Topics
• Work as a Proxy

Work as a Proxy  
You must have the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege to work as a proxy, which means on
behalf of another user.

1. Click your user image or name in the global header to open the Settings and Actions menu.
2. Click Switch To and select the user you want to work on behalf of.
3. Enter your password.
4. Click Confirm. You're ready to work as a proxy.

As a proxy, you can access all the data and tasks of the actual user. All the tasks you do are logged as though the actual
user worked on them. After you're done working as that user, switch to another assigned account, or sign out and sign
back in to your own account.
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4  Workspace and Work Areas Search

Get Started with Search in Workspace and Work Areas  
Both Workspace and the work areas targeted at individual business objects now provide the same superior search
experience enabled by the high-performance Adaptive Search engine.

Workspace makes it possible for you to work on all the business objects within a single, unified work area. The work
areas handle one at a time. You automatically get the same improved Workspace functionality in the Accounts,
Contacts, Leads, Opportunities, and other work areas if you're a new customer. If you're an existing customer, your sales
administrator must opt in to the new feature Default Navigation to Workspace.

Saved searches are saved search criteria that generate the list of results as soon as you select them. When you open
Workspace or one of the new work areas, you see a list or records generated from the saved search specified as your
default saved search. Your administrator assigns the default for your role, but you can choose your own personal default
as well.

To list all the records you can view, select the saved search with "All" in the name, such as "All Accounts" and "All
Opportunities". If you don't see the item you're looking for or the list is too long for you to scroll through, you can search
for the item in the list using the Search box. All search terms returned are highlighted in bold font in the search results.

Enter complete words as search terms or use the star (*) to indicate missing characters. Searches in Workspace and the
new work areas search across multiple fields, including fields from different business objects. So, searching on the word
main, may return Main Plumbing and Oracle on Main Street.

In the Search box, you can also:

• Take advantage of the enhanced autocomplete feature in the search box to help you add and apply filters to the
results. Autocomplete reduces the number of clicks and let you filter results without opening the Show Filters
pane.

• Narrow down searches by using quotes on multiple words.

Searching on "main plumbing" instead of main narrows down your search.

• Use the preferred operators + (this term must be present) and - (this term must not be present). All other terms
are optional. For example, entering + Oracle -"Redwood" returns Oracle locations not in Redwood city.

• Use AND, OR, and NOT operators.

The familiar boolean operators AND, OR and NOT (also written &&, || and !) are also supported but note that
they don't honor the usual precedence rules, so parentheses should be used whenever multiple operators are
used together.

For example, entering (Oracle NOT "Redwood")  returns Oracle locations not in Redwood city.

• Use the Between operator for a date field. You are prompted to enter a specific date range for the search, such
as between 1/3/2021 and 1/5/2021. Workspace search returns all records for January 03 2021 to January 04
2021, but it doesn't return records for 05 January 2021. This is because Workspace considers the given filter
values between 03-01-2021 12 AM and 05-01-2021 12 AM.

Remember that your search is restricted to the records within the saved search you selected.
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Business Objects Covered by Workspace and the New Work Areas
Here are the objects covered by Workspace and the new work areas powered by Adaptive Search. Which work areas and
objects you use in your application is determined at setup.

Where Adaptive Search is Available

Business Object Workspace Work Areas Powered by Adaptive Search

Accounts
 

Yes Yes

Activities
 

Yes Yes

Assets
 

Yes Yes

Campaigns
 

Yes Yes

Competitor Yes

Note:  This unique object doesn't have a list
page of its own in Workspace.

No

Contacts
 

Yes Yes

Deal Registrations
 

Yes Yes

Leads
 

Yes Yes

Opportunities
 

Yes Yes

Partners
 

Yes Yes

Partner Contacts
 

Yes No

Quotes and Orders
 

Yes Yes

Quote and Order Lines
 

Yes No

Revenue Lines
 

Yes No

Service Requests
 

Yes No

Territories
 

Yes Yes
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Note:  Not all the objects are sales objects. Partners and Partner Contacts are only pertinent for Partner Relationship
Management. HR Help Desk Request, Installed Base Asset, Internal Service Request, and Service Request are specific
to Fusion Service. You can also access and manage any custom objects or child objects that your administrator
created in Application Composer.

Note:  Many customers run their applications and Oracle Databases in their own data centers on Oracle
Cloud@Customer. Currently, Cloud@Customer pods don't support Adaptive search.

Improve Sales Productivity with Workspace  
Workspace improves and speeds up searches and makes different types of sales information available all within a single,
unified work area.

Watch video
 

No more navigation to the Opportunity work area to see your key opportunities and then to the Lead work area to work
on your leads. Not only do you minimize navigation, but you also eliminate search. Workspace makes it possible to keep
multiple records open as tabs and to take common actions on records without having to drill down into them.

Note:  Service users can keep multiple records open at the same time in nested tabs, a Workspace feature not
available to the sales job roles provided by Oracle. If you want to use the nested dynamic tab capability, get your
administrator to create custom job roles with the appropriate additional privileges. If you choose to use dynamic tabs,
then record-level navigation won't be possible. That means that the Previous and Next buttons on the record details
page won't be available for navigating lists of records for Account, Contact, Lead, Opportunity, Activity, Territory,
Campaign, and custom objects through the Workspace UI.

How Salespeople Search in the UI
The same create and edit pages and most other features are available in Workspace as in the individual work areas. Here
are some key things you can do when searching in either the Wotkspace UI or in the work areas powered by Adaptive
Search. For details about configuring adaptive search behavior, see the Implementing Sales guide for setup details.

When you open Workspace, select the business object and saved search you want to display. The saved search
determines the scope of any search you perform on the page. You can enter one or more search terms in the Search
field or you can search using multiple attributes, both from the business object you're searching and from related
objects. For example, when searching an account in the Account work area, you can search by company name, the city
where the account is located, or the primary contact at the company. You can even search for an account by the name of
the salesperson on the sales team.

The saved search you select determines the scope of your search. For example, if you select All Accounts, you're
searching all accounts you can view. If you select My Accounts, then you're searching only the accounts that you own.
You can save any search criteria you enter as your own personal saved search by clicking Save As. The search results
match whole terms, but you can use the (*) wildcard for partial words. For searches with multiple terms, you can use the
OR and NOT operators. For example, searching for "Oracle NOT Portland" returns Oracle locations not in Portland.

You can view the filters used in the saved search by clicking the Show Filters link. You can also add filters of your own.
Filters show the most common values and the number of records in each. For example, a search of accounts with the
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primary industry as a filter, automatically displays the most frequent industries and the number of records for each. A
search of opportunities using win probability as a filter, displays different ranges of win probabilities and the number of
records in each range. Your filter selections are additive, if you select Health Care as the primary industry and then Lisa
Jones as the owner, the search displays only those Health Care accounts Lisa owns.

Here's a screenshot of Workspace highlighting some of the key features.

Callout Number Feature Description

1
 

Here's where you select the object and saved search you want to display in Workspace.
 

2
 

The Search field makes it possible to search within the constraints of the existing search. If you select,
 Accounts, My Accounts, you get to view and search only the accounts where you're on the territory
or in the sales team. Selecting Accounts, All Accounts, lists all accounts you can view and makes it
possible for you to search them.
 

3
 

You control the display of filters by clicking Display Filters and Hide Filters links. Filters automatically
display top values in your data. For example, the Industry filter lists the number of accounts in each of
the top five industries, so you can quickly see the list of accounts in each.
 
For more details, see the Refine Search Results Using Filter Values topic.
 

4
 

Workspace displays the list of records matching the saved search criteria and provides you with a
record count. For more details, see the Display a List of Items Using a Saved Search topic.
 

5
 

Filters display the items with the highest number of records. You can select filters to narrow down the
list.
 

6
 

You can log calls, take notes, create tasks, and take other actions on items on the page without having
to drill down into them. For accounts, you can even create an opportunity. For more details, see the
Create Records and Take Actions on Items Displayed in Workspace topic.
 

7
 

From time to time, you may want to export data from Workspace for offline viewing and verification.
For example, a sales manager might want to export a list of accounts to perform a more in-depth
analysis of their sales team or for reporting purposes. Only sales manager and sales administrator
roles are granted the predefined security privilege ZCA_WORKSPACE_EXPORT to access the export
data feature in Workspace.
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Search and Filter  

Search for the Information You Need  
Here's how to search for the information you need.

1. Select a saved search as your starting point. For example, the All Accounts saved search provided by Oracle lets
you search all the accounts you can see. The My Accounts saved search restricts your search to the accounts
you own.

2. Explore you data and refine your search by adding filters and selecting filter values.
3. Find an item in the list by entering keywords in the search box.

Related Topics
• Refine Search Results Using Filter Values

• Find an Item in the List of Search Results

Refine Search Results Using Filter Values  
Use filters to narrow down the list of search results, focus your search, and explore your data. Just click Show Filters to
display the predefined filters for the saved search you selected. Now you can do any of these tasks:
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• Add fields as filters.

• Select one or more filter values on the page to narrow down the list.

• Add filter values not displayed on the page.

• Filter records based on fiscal quarters.

• Use operators and multiple search terms. For example, you can search for items that are missing information.

• Change the scope of your search.

• Find an item in the list of search results.

Note:  You can set up to a maximum of six filters. If you try to add more than six filters, you're prompted to remove
filters to meet the maximum threshold of six.

Add Fields as Filters
Add a filter by clicking Edit Filters (the pencil icon highlighted in the screenshot). If you add the Name field and
reenter your search term, the search results are narrowed down to those items with your search term in the Name field.
Specifying multiple filters for a query is treated as an implicit AND.

You can change the order of the filters in the Edit Filters window using the move controls, the up and down arrow icons
highlighted in the next screenshot.

The effect of the filters is additive, so always add the broadest filters first. For example, selecting the primary industry
first and the owner of the record second will display more results than selecting the owner first and the industry second.
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Select One or More Filter Values on the Page
You can narrow down your search by selecting one or more filter values. Each filter shows up to five of the most
frequent values (or ranges of values) in your data and displays the number of records for each value. For example, if
your accounts are classified by industry, you can select the High Technology and Financial Services values from the
Primary Industry filter to display only the accounts in those two industries.

Here's a screenshot of the Filters panel with callouts highlighting the different filter features. The screenshot shows
Workspace, but the different work areas work the same.

Callout Number Description

1
 

Show Filters and Hide Filters control.
 

2
 

Number of records for each filter value.
 

3
 

Search link you click to add more filter values.
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Add Filter Values
If you don't see the filter value that you need among the top five, you can select more values by clicking Search at the
bottom of the filter values.

Placing your cursor in the field displays a partial list of unused values sorted alphabetically. You can also search for other
filter values using the Select field. For example, you can enter "Media" to search for "Media and Entertainment".

Filter Records Based on a Fiscal Quarter
You can filter records based on a fiscal quarter or fiscal year rather than the default calendar quarter and year. For
example, the filter This Fiscal Quarter on the opportunity Close Date attribute is based on the fiscal quarter calendar.
This can be really useful to have views such as Opportunities closing in current and next fiscal quarters or Leads
generated in a previous fiscal quarter.

Follow these steps to add the fiscal quarter or fiscal year filters for the opportunity close date:

1. Click Show Filters.
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2. Click the ellipsis icon (More) icon next to Close Date as shown.

3. Click Edit to display the Search and Select dialog.
4. Select the fiscal quarter or fiscal year fields on the left pane and move them to the right pane.
5. Click OK.

You can now apply fiscal quarter or fiscal year filters for the Close Date field.

Use Operators and Multiple Search Terms
You can refine your search filtering even further by clicking the ellipsis icon (More) at the top of the filter and selecting
Advanced.

Here's a screenshot of the ellipsis icon (More) (callout 1) and its menu with the Advanced option (callout 2).

The Advanced mode lets you select an operator for your search and to compose complex queries. Operators let you
specify if you're looking for exact or approximate match, for example, and even permit you to search for missing and
blank values. Which operators are available depends on what you're searching for and decisions your application
administrator makes during setup.

Text fields, such as the account name or the name of the account owner, can include search operators listed in this
table:

Text Search Operators Function

All of the Words
 

All of the search terms must be present.
 

Any of the Words Any of the search terms must be present.
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Text Search Operators Function

  

Contains
 

The results include entries that contain the search term you enter.
 

Ends with
 

The results include entries that ends with the search term you enter.
 

Equals
 

The results must include the search terms in the exact case of the search term because searching on
Equals is case-sensitive.
 

Exists
 

Finds the records with any value in the field.
 

Fuzzy Match
 

Finds records with similar spellings.
 

Is Missing
 

Finds all the records missing values.
 

None of the Words
 

The results exclude entries with the words you enter.
 

Not Equal to
 

Finds all records that don't match the search terms in their order.
 

Starts with
 

Finds all records that start with the search term you enter.
 

Numeric fields, such as opportunity Win Probability, can contain these search operators:

Numeric Search Operators Function

Between
 

The results fall between two entries.
 

Note:
Workspace search doesn't include the To Date field value in the Date filter if using this operator.
 

For example, let's say you perform a search for Opportunity records with the filter Close Date between
1/3/2021 and 1/5/2021. Workspace search returns all opportunity records having Close Date value as
03 January 2021 to 04 January 2021, but it doesn't return records having a close date of 05 January
2021. This is because Workspace considers the given filter values between 01-03-2021 12 AM and
01-05-2021 12 AM. Any records that have a value for 5 January 2021 won't be displayed in the results.
 

Equals
 

The number must equal the search term.
 

Exists
 

Finds the records with any value in the field.
 

Greater Than
 

Finds records with values greater than the entry.
 

Greater Than or Equal to
 

Finds records with values greater than or equal to the entry.
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Numeric Search Operators Function

Is Missing
 

Finds all the records missing values.
 

Less Than
 

Finds records with values less than the entry.
 

Less Than or Equal to
 

Finds records with values less than or equal to the entry.
 

Not Equal to
 

Finds all records not equal to the entry.
 

You can add search terms by clicking Add. Specifying multiple search terms for a filter is treated as an implicit OR. For
example, to search for all the accounts with primary addresses in the Chinese cities of Yiwu and Hefei, you enter these
operators and search terms in the Primary Address filter:

Operator Search Term

All of the Words
 

Yiwu
 

All of the Words
 

Hefei
 

Change the Scope of Your Search
Each search is conducted within a set of records specified in the saved search. For example, the All Accounts saved
search lets you search within all of the records you can view, but the My Accounts saved search lets you search within
the set of records you own.

You can change the scope of your search by showing filters and selecting a different record set from the Record Set list.

Selecting a record set can broaden or restrict the set of records you're searching. Not all record sets are available for
every object or to every user. For example, sales territory record sets only apply to business objects that use sales
territories and only managers can view records of their subordinates.
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Here's a table that lists some of the more common record sets.

Record Set Description

All records I can see
 

Provides the broadest search. Which records you can view is determined by your job role and your
position in the resource hierarchy.
 

I am on the team
 

Records where you're on the team.
 

I own
 

Records where you're listed as the owner.
 

My subordinates are on the team
 

Records where any of your reports are on the team.
 

My subordinates own
 

Records where any of your reports are listed as owners.
 

My territory
 

Records within sales territories you own or are listed as a member.
 

My territory hierarchy
 

Records within your sales territories and any child territories.
 

Related Topics
• What happens when I search for Activities owned by my subordinates?

Find an Item in the List of Search Results  
If you don't see what you're looking for on the page and the list generated by the selected saved search is too long, then
you can enter one or more search terms in the Search box and press Enter on your keyboard.

You can enter a combination of search terms. For example, if you're searching for an account, you may want to search
on the account name, the street address, and the name of the primary contact, and so on. What attributes you can
search is determined by the application administrator. All search terms returned are highlighted in bold font in the
search results. Your results display records matching the search terms in any of the fields enabled for search. For
example, searching accounts using the term Pinnacle, returns both accounts with Pinnacle in the name as well as
accounts on Pinnacle Street, unless the application administrator disables the address search.

Tips for Using the Search Box
Here are some tips and guidelines for how best to us the search in Workspace.

• Use the enhanced autocomplete feature in the Workspace search box to help you add and apply filters to the
results. Autocomplete reduces the number of clicks and let you filter results without opening the Show Filters
pane. For example, as you begin to type "Prim" you will see "Primary Industry" as one of the suggestions
(Primary Industry is an attribute of accounts). Select an attribute to show possible values in a drop-down list.
You can choose one of the possible values to filter the accounts based on that primary industry.
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• If you're searching for an item with multiple words in the name, you can enter any of the words. For example,
a search for Angel retrieves matches for the account names "Vitamin Angels", "Los Angeles Rubber", and
"Angeles Warehouse".

• Workspace search also matches your entry with similarly spelled words. Search results based on such fuzzy
matches are rendered below exact matches. The most relevant items are always displayed first. The fuzzy
match settings can be changed during setup. By default, the application displays spellings that are one letter
off provided that the first three letters of the word match exactly. A keyword search on the term Cernar, for
example, may return "Cerner" or "Cernas" in the search results. It won't return "Cesner", "Carner", or "Kerner".

• Searching is case insensitive for the keyword Search box. Let's say you enter the words Pinnacle or pinnacle,
then Workspace returns the same results.

Note:  However, if you enter a search term with all capitalized letters, that search term is changed to Camel
Case in the search results returned. For example, if you enter RED WOOD, then Workspace returns records
containing RedwoodShores.

• Enter entire words or numbers you're searching for.

For example, entering the word Pin when searching for accounts, returns Pin Point Needlework Inc. and Oracle
on 100 Pin Road.

• You can enter multiple search terms separated by spaces.

Spaces between words act as implicit AND operators. For example, entering Pinnacle Corporation finds all of
the accounts with those two words in the name, including Pinnacle Savings Corporation, Pinnacle Distribution
Corporation, and Pinnacle Corporation.

• Put multiple search terms in quotes to narrow down your search.

For example, entering "Pinnacle Corporation" returns only Pinnacle Corporation, and any other records with
those two terms in that specific order.

• Use the OR operator to search on multiple terms.

For example, entering Chicago OR Pittsburgh, finds accounts in both of these cities as well as accounts with
those terms in the name.

• Use the NOT operator to narrow down your search.

For example, entering Oracle NOT Sunnyvale when searching for accounts, returns Oracle locations excluding
those in Sunnyvale.

When you use NOT followed by two or more words you must enclose the words in double quotes (" " ). For
example, entering Oracle NOT "San Francisco" when searching for accounts, returns Oracle locations excluding
those in San Francisco. If you exclude the double quotes, then searches would return Oracle locations in areas
beginning with San such as San Jose, San Diego and so on.

• Capitalization doesn't matter on search terms, but the operators OR and NOT must be in uppercase letters.

• Use the star (*) symbol to indicate missing characters or partial words. This symbol can be used at the
beginning, end or middle of a word to be searched.

For example, entering *tion as your search term returns Presentation. If you enter Present*, records with
Present, Presentation, and Presents are returned. Finally, if you enter the star symbol in the middle of a word
such as Pr*tion, records with the terms Presentation and Production are returned.

• Use the question mark (?) to match exactly one character. This wildcard can be used at the beginning, end or
middle of a word to be searched.
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For example, entering Pri?e returns the following results: - Price - Prize.

View Search Results Grouped By Fields  
You can display search results in groups based on the specific fields on the object or related objects. View an overview of
the number of records in each Grouped By grouping and search and filter records within these groupings.

You can also view aggregates such as count, average, minimum, maximum, and sum of values on the records of each
group. Count aggregations are available on each group by default.

For example, you can view opportunities arranged into groups for various stages of the pipeline. In addition, you can
view data aggregates for each group, such as grouping opportunities by month and viewing the total revenue for each
month. You can sort the groups alphabetically or by the results count for each group based on text fields. You can also
have one custom aggregation based on numeric fields on the object and can save your Group By lists as a saved search.

Your administrator must set the Enable Group By in Workspace parameter from the Parameters tab in the Configure
Adaptive Search page so that you can avail of this feature. Once the parameter is enabled, you can view data with
common characteristics in a more understandable and relevant way.

Access the Manage Group By Feature
Here's how to access the group by feature to manage your records.

Click Manage Group By (the pencil icon on the right of the Workspace UI page highlighted in the screenshot. You can
also change which columns are displayed on the page by selecting the Edit Column item.

Use Group By to Manage Your Object Records
Here's how to use the group by feature to manage your records from the Workspace UI.

1. Click the pencil icon on the top right and select Manage Group By.
2. Enter the following details in the Manage Group By page:

◦ Group By: Select from the list of fields that you can use to Group the results. This list is defined by your
administrator.

◦ Groups: Select from the list which groups should be used for Group By.

Note:  If you select a numeric field for Group By, then, there's no choice and the groupings are based
on the filter groups defined in the Configure Adaptive Search setup.
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◦ In the Define Aggregation section, from the list in the Aggregate Field, select the field for which the
aggregation will be applied. Only numeric data types fields are shown here.

◦ Aggregate Function: Select from a list of operators such as Sum, Average, Minimum and Maximum.
When you click Apply, the field displays a concatenated label with operator and field name.

3. Click Apply or Apply and Close  when you're finished updating your groups and aggregations.

Note:  When you create a Group By view of your search records, you can save as a private saved search.

When you first perform a record search using Group By, the initial search displays a maximum of 6 groups. You can use
the Show More link (callout 3) to display the next 6 groups as in this sample screenshot. Also shown is an example of
the aggregation of the sum of the number of emails sent to your contacts callout 2 in a specific city group (callout 1).

You can group date fields by:

• Filter Groups - Those groups defined for filters in the Configure Adaptive Search setup

• By Month
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For example, if you filter search records using Group By on a date field such as Creation Date, you can select By Month
to group your data into monthly intervals. You can view data beyond 6 months by simply clicking Show More. This
provides a more complete view of data divided by months.

If you choose to group your object records by a date type field such as Close Date, then the following filters are available:

• This Quarter

• Next Quarter

• This Year

• Last Quarter

• Last Year

Filter Records by Date and Time in Workspace and Work Areas
Powered by Adaptive Search  
You can now select both date and time filters on specific date and time fields to narrow down your list of search results.
This saves you time because you can conduct more focused searches.

Previously, you could only specify a date while filtering records from a date field. For example, if you added the Creation
Date field as a search filter, all records within the specific From and To date pickers were returned. You can now specify a
specific time filter as part of your date search filter which helps to further refine your list of returned records.

Here's an example of how to filter account records by date and time in Workspace or work areas powered by Adaptive
Search.

1. From Workspace or a work area powered by Adaptive Search , select the object you want to search such as Accounts.
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2. Click Show Filters and select Creation Date from the list of available filters and move it to the selected pane as shown.

3. Edit the Creation Date filter and enter the date and time on the Select Date and Time panel as shown.
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4. Click Search to narrow your search results of accounts based on the creation date and time filter you specified.

Use Dynamic Dates in Workspace Date Filters  
You can add date filters using dynamic dates in Workspace. For example, you can add a filter on opportunities where the
close date is due in the next 7 days. This helps in creating more useful saved searches based on rolling dates.

Here's an example of how to filter opportunity records by close date using dynamic dates in Workspace or work areas
powered by Adaptive Search.

1. From Workspace or a work area powered by Adaptive Search, select the object you want to search such as My
Open Opportunities.

2. Click Show Filters and select Close Date from the list of available filters.
3. Click Advanced from the More button (three horizontal dots).
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4. Select Dynamic Dates as shown in the sample screenshot and select the dates
to search where the close date for the opportunity is due in the next 7 days.

Note:  If you want to search using a date and time field, such as Last Update Date, then you can also select hours as a
filter along with days, weeks, and months.

Saved Searches  

Saved Searches  
When you open Workspace or navigate to a work area, the page displays the list of items generated by the default saved
search. They contain predefined search criteria that display useful lists for you as soon as you select them.

Selecting My Appointments, for example, shows you a list of your current appointments, selecting My Overdue Tasks
lists all of your overdue tasks, and so on. Saved searches are provided by Oracle, by your administrator, and you can
create them yourself by saving any search in Workspace.
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The predefined saved searches provided by Oracle follow a naming convention:

• To view a list of items you own, select saved searches starting with the word "My". For example, My
Appointments displays the list of the appointments you created. My Accounts displays a list of accounts
where you're listed as the owner. You're an owner of the account if you created the account record or if you're
assigned ownership by an administrator.

• To view a list of the broadest range of items, select the saved search that starts with the word "All". For example,
selecting All Accounts searches all the accounts you can view.

When you select a saved search, the search results display on the page. You can see the approximate number of items in
each saved search, and you can control how the items are sorted.

Save Your Search to Create a New Saved Search  
Saving your current search criteria and your preferred way displaying the results is as simple as clicking Save As on the
landing page. Your saved search saves whatever you added to your search, including keywords, filters, columns, and
sort order of the results.

1. Click Save As on the landing page.
2. In the Create Saved Search dialog box, enter the name for your saved search. Your saved searches are listed in

alphabetic order.
3. If you're an administartor, you can share the saved search you're creating. There are three options:

◦ Only Me

◦ Everyone

◦ Specific Roles

If you select Specific Roles, click Search (the people icon) and select the job roles.
4. Click Create.
5. Your saved search appears on the page.

Create Saved Searches in Workspace  
You can save any search you perform in Workspace as a new saved search and you can manage the saved searches
available to you.

Your application administrator determines which saved search you see by default when you open Workspace and which
saved searches are available for each business object, but you can override these settings with your own personal
preferences. A saved search includes all of the search terms you enter and all of your preferences, including the columns
that display for your search results.

Oracle delivers predefined default saved searches for some user roles and the search results returned depends on what
role is assigned. For example, ready-to-use partner roles include Partner Sales Representative, Partner Sales Manager,
and Partner Administrator.

Users of Actionable Infolets can include saved searches created in Workspace as filters to quickly access relevant
records. To access a different set of data, they can create a new saved search in Workspace and then expose the relevant
saved search in the Actionable Infolets UI. This gives them a more targeted view of the records that they want to update
and take immediate action on.
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Note:  By entering precise search criteria for your saved search, you can greatly decrease the number of records
returned and decrease the load time.

Create Saved Searches
Here's how to create a saved search:

1. Select a saved search as your starting point. For example, the All Accounts saved search provided by Oracle
lets you create your saved search for all the accounts you can see. The My Accounts saved search restricts your
saved search to the accounts you own.

2. Enter your search terms. You can enter search terms in the Search box, use filters, or both.
3. You can add or change the columns displayed in the search results. See the Change Columns Displayed in

Search Results  topic for details.
4. Click Save As.

Here's a screenshot of Workspace highlighting the location of the Save icon (callout 1).

The Create Saved Search window appears.

5. Enter the name of your saved search.
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6. Optionally, select Set as my default saved search to make the saved search your personal default whenever
you navigate to Workspace.

7. Click Create.

Maintain Your Personal List of Saved Searches  
While each business object has its own list of saved searches, you can designate only one saved search as your personal
default.

This is the saved search that you see each time you open Workspace or the appropriate work area. Each business object
comes with its own saved searches, which you can manage as described in the following steps.

The next section is for non-administrative users only. Only administrators can assign saved searches to different roles
and assign default saved searches to different user roles. For more information, see the Saved Search Setup section in
the Implementation Reference guide

Manage Your Personal List of Saved Searches
From the Workspace UI selector:

1. Select the business object.
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2. From the same menu select Manage Saved Searches.

Here's a screenshot of the list of business objects that appears when you click the selector. The image
highlights the Manage Saved Searches task, the last selection on the list.

The following screenshot shows an example of the Manage Saved Searches window as seen by users. Here's a
table that describes the columns highlighted in the screenshot by callouts.

Callout Number Column Name Description

1
 

My Default Saved Search
 

This is your personal default saved
search. You can keep the default saved
search assigned by the administrator, or
change the saved search to a different one
contained in the drop-down list.
 

2
 

Manage List
 

The business object containing the saved
searches you're managing. For example, be
selecting Accounts for Manage List, saved
searches based on the Account business
object are displayed. You can quickly
switch between saved searches across
objects. Once a new object is selected,
 saved searches related to that object are
immediately displayed.

55



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 4
Workspace and Work Areas Search

Callout Number Column Name Description

 

3
 

Show in List
 

The saved search appears in the list of
saved searches only when this option
is selected. While you can't delete lists
provided by Oracle, you can hide them by
deselecting the Show in List option.
 

4
 

Default
 

The Default check box for saved search
appears in the list of saved searches and
is selected where user level defaults are
used. While you can't delete lists provided
by Oracle, you can hide them by deselecting
the Default check box option.
 

5
 

Name
 

You can rename your own personal saved
searches here. However you can't rename
other saved searches, such as those created
or assigned by an administrator.
 

6
 

Shared With
 

You can view but can't change the values
here.
 

7
 

Delete
 

You can only delete your own personal
saved searches. You can't delete saved
searched provided by Oracle or an
administrator.
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Callout Number Column Name Description

 

3. Update the saved searches. You can:

◦ Rename personal saved searches you created

◦ Hide save searches from your personal list, by deselecting Show in List.

4. Click Save and Close when you're done.

How to Display the Most Relevant Records for My Mobile App  
Saved searches are predefined for Workspace users. Now, in addition, administrators can set the default saved search
per object for mobile app users for either specific roles or for the whole site. Mobile users can override these and set
their own default searches, too.

This feature helps to display the most relevant records in their mobile app with a single tap on the menu. Sales
administrators can create saved searches for the whole sales organization and for specific sales roles for mobile app
users. A default saved search is the saved search that's automatically displayed when you first accesses Workspace from
your mobile app. Oracle delivers predefined default saved searches for some user roles and the search results returned
depends on what role is assigned. For example, ready-to-use partner roles include Partner Sales Representative, Partner
Sales Manager, and Partner Administrator.

From the My List tab, you can manage your own personal saved searches exclusively, separate from the saved searches
that are shared with the broader organization.

Note:  Mobile app users can select the save searches they want from the Default for Mobile column.
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Display a List of Your Most Recent and Frequently-Accessed Items
 
You can display a list of the most relevant items by selecting a My List search.

The application automatically tracks your user context and activities and generates a list for each object, My List for
Accounts, My List for Leads, and so on. When you click on one of these saved searches, you see the most relevant
results based on your object activity and context.

Use Workspace and Work Areas Search  

Change Columns Displayed in Search Results  
You can change which columns are displayed on the page and in what order by clicking Edit Column (the pencil icon).
You can also change the width of the columns by dragging their sides.

Your preferences can be saved as part of a saved search. This screenshot highlights the location of the Edit Column
icon.
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You can add the Snippet field to display keyword information of the search results displayed in Workspace. For example,
when you do a keyword search, the Snippet field highlights the part of the record that matches the keyword as shown in
this example.

Find the Most Recent Items You Worked On  
The application remembers the last ten items you worked on for each of your work categories and displays a list as soon
as you put your cursor in the Search box.

For example, to get to the last account you worked on, simply select Accounts, place your cursor in the search box, and
click the account name in the list.
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Update Multiple Records at the Same Time  
You can update multiple fields in multiple records at the same time in Workspace and in individual work areas that use
the same Workspace features.

Watch video
 

For example, you can update the sales stage on multiple opportunities at the same time with just a few clicks. Or update
rank and deal size on several leads at once.

Note:  Your administrator must enable both the mass update and the mass actions Adaptive Search parameters for
this feature to work. In addition, they must also use the Configure UI tab from the Configure Adaptive Search page to
specify which fields to enable for mass update. They must select the Mass Update  check box and have at least four
fields selected for both standard and custom objects.

You can also mass update additional fields on multiple records. These additional fields include choice list fields based on
objects that aren't available in Adaptive Search. This makes the mass update feature more usable and complete.

1. Highlight the records that you want to update.

Use the standard ways of selecting items: press the CTRL key to select individual records. Press and hold the
Shift key to select a range.

2. Right-click on the mouse and select Update from the list.
3. On the Update page, select the fields you want to update and enter the new values.
4. Click Update.
5. Confirm your action in the dialog box.

Take Actions on Search Results  
You can create records and take actions on one or more items on the page.

• Create records in Workspace and work areas powered by Adaptive Search by clicking Create.

• Drill down and edit the records on the page.

• Drill directly down into a record, such as an opportunity or account using a deep link. Since deep links are
also exposed in other applications, such as Business Intelligence, you get quick access to open and view such
records.

• Take different actions on the records without drilling down on them, by clicking Actions (represented by the
three dot icon in the Actions column).

The available actions vary by business object. For example, for accounts you can create an appointment, create
an opportunity, create a note, create a task, and log a call.

Note:  Not all objects allow for the creation of records or actions in Workspace. For example, Territories can
only be created in the context of a parent territory so it isn't possible to create a territory from within the
Workspace UI. You must first edit a territory and then create a child territory.
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Note:  Any changes or actions you take are processed as part of near real time and are reflected in a couple of
seconds. If an action is performed on a set of records, you may have a longer time lag before you see the updated
records in Workspace or in your work areas powered by Adaptive Search.

List of Predefined Actions and Saved Searches
Most of the objects come with predefined actions. For example, you can easily complete or defer tasks without having
to drill down to view the record, or you can accept or reject new leads at the click of a button.

You can select contacts or leads from your Workspace saved searches and add them as campaign members to
Oracle Eloqua marketing campaigns through the Add to Campaign action. After the added contacts and leads are
synchronized to Oracle Eloqua, they get added to the specified Oracle Eloqua marketing campaigns.

Here are the predefined actions that you can take for each of the objects

Business Object Predefined Saved Search Actions Multi-record Actions

Account
 

• All Accounts

• My Accounts

• My Favorite Accounts

• My List for Accounts

• My Teams Account

Specific for Sales Manager
and Sales VP roles.

• Create Appointment

• Create Service Request

• Create Opportunity

• Create Note

• Create Task

• Delete Account

• Log a Call

• Update

• Update

• Merge

Activity
 

• My Appointments

• My Call Reports

• My Calls to Log

• My Open Tasks

• My Overdue Tasks

• My Team's Task

Specific for Sales Manager,
 Sales VP, and Partner Sales
Manager roles.

• Mark Complete

• Delete Appointment

• Create Follow-Up Task

• Decline Call Report Creation

• Create Follow-Up
Appointment

• Delete Task

• Create Note

• Create Call Report

• Update

• Delete Appointment

• Decline Call Report Creation

• Delete Task

• Mark Complete

• Create Follow-Up Task

• Create Follow-Up
Appointment

• Create Note

• Create Call Report

• Update

Asset
 

• All Active Assets

• My Customers' Active Assets

• My Customers' Potential
Renewal Assets

Specific for Sales, Channel,
 and Partner roles.

• Log a Call

• Create Appointment

• Create Task

• Update

Update
 

Campaign
 

• Active Campaigns

• All Campaigns

• Add Contacts

• Add Leads

Update
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Business Object Predefined Saved Search Actions Multi-record Actions

• Planned Campaigns • Update

Contact
 

• All Contacts

• My Business Contacts

• My Contacts

• My Favorite Contacts

• My List for Contacts

• Create Note

• Create Task

• Add to Campaign

• Create Opportunity

• Log a Call

• Create Appointment

• Create Service Request

• Delete Contact

• Update

• Update

• Merge

Deal Registration
 

• All Deal Registrations

• All Deal Registrations Expiring
Soon

• All Deal Registrations Where I
am on the Team

• All Pending Deal Registrations

• All Returned Deal
Registrations

• Deal Registrations Owned By
Me

 

• Create Appointment

• Create Note

• Create Task

• Log a Call

• Update

Update
 

Lead
 

• My Favorite Leads

• My Open Leads

• My List for Leads

• Open Leads Where I am on
the Team

• My Team's Open Leads

Specific for Sales Manager
and Sales VP roles.

• Accept

• Assign Partner

• Create Call Report

• Create Note

• Add to Campaign

• Delete

• Reject

• Score

• Create Task

• Retire

• Qualify

• Create Appointment

• Convert

• Rank

• Run Assignment

• Log a Call

• Update

• Accept

• Delete

• Qualify

• Unqualify

• Rank

• Run Assignment

• Score

• Update

Opportunity • My Favorite Opportunities • Log a Call • Delete
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Business Object Predefined Saved Search Actions Multi-record Actions

 • My Open Opportunities

• My List for Opportunities

• Open Opportunities Where I
am on the Team

• My Team's Opportunities

Specific for Sales Manager,
 Sales VP, and Partner Sales
Manager roles.

• Create Appointment

• Save and Run Assignment

• Create Task

• Create Note

• Copy Opportunity

• Delete

• Update

• Update

Partner
 

• All Partners

Specific for Channel Account
Manager, Channel Operations
Manager, Channel Sales
Manager, and Partner
Administrator roles.

• My Partners

Specific for Channel Account
Manager, Channel Operations
Manager, and Channel Sales
Manager roles.

• My List for Partners

Specific for Channel Account
Manager, Channel Operations
Manager, and Channel Sales
Manager roles.

• My Team's Partners

Specific for Channel
Operations Manager, and
Channel Sales Manager roles.

• Create Appointment

• Create Note

• Create Task

• Log a Call

• Update

Update
 

Partner Contact
 

• All Partner Contacts

Specific for Channel Account
Manager, Channel Operations
Manager, Channel Sales
Manager, and Partner
Administrator roles.

• My Partner Contacts

Specific for Channel Account
Manager, Channel Operations
Manager, and Channel Sales
Manager roles.

Create Contact
 

None
 

Quotes and Orders
 

• All Active Quotes

• All Expired Quotes

• My Active Quotes

• My Expired Quotes

• Log a Call

• Create Appointment

• Create Task

• Create Note

None
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Business Object Predefined Saved Search Actions Multi-record Actions

Quote and Order Line
 

• All Active Quote Lines

• All Quote Lines

• My Active Quote Lines

None
 

None
 

Revenue Lines
 

• All Open Revenue Lines

• My Open Revenue Lines

• Revenue Lines on Open
Opportunities I Own

None
 

None
 

Service Requests
 

• All Open Service Requests

• My Open Service Requests

• Open Service Requests
Created by Me

• Open Service Requests Not
Assigned to a Queue

• Open Service Requests Where
I Am on the Team

• Unassigned Open Service
Requests in My Queue

• Delete

• Update

Update
 

Territory
 

All Territories
 

None
 

Update
 

Related Topics
• Update Multiple Records at the Same Time

• Overview of Smart Actions

• Manage Workspace Smart Actions

Use Dynamic Tabs and Nested Dynamic Tabs  
If you have the required privileges and role, then you can use dynamic and nested tabs to quickly and easily navigate
across and between grouped records without losing context. Under each open top-level dynamic tab, you can open
objects as nested tabs.

To open an associated record as a nested tab, click the object link. When you open a record in a nested tab, that record
automatically becomes the active tab. You can manage objects such as Service Requests, Accounts, Contacts, Assets,
Activities, Leads, Opportunities, Campaigns, Territories, and Custom Objects, with each supporting nested dynamic
tabs.

Note:  You can only use dynamic tabs in Workspace. Dynamic tabs are not supported in the individual work areas.

The dynamic tab and nested dynamic tab feature is already predefined for users with job roles such as Customer Service
Representative and Customer Service Manager job roles. Other users who want to open objects in dynamic and nested
dynamic tabs must request their administrator to grant them a custom role with the required privileges assigned.

64

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20072467
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20074227


Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 4
Workspace and Work Areas Search

For example, the Service Request object enables service users to interact with multiple records simultaneously through
top-level dynamic tabs to save time accessing related information about a service interaction. The primary tabs display
instances of objects such as SRs, Queues, Contacts, and Accounts. Other workspace objects not listed, such as Partner
Accounts and Partner Contacts, open as modal windows.

Work with Dynamic Tabs and Nested Dynamic Tabs
When you have an open record and then open another record associated with the initial record, the record is shown as a
nested tab of the primary record. For example, open an Account record as a top-level dynamic tab. Drill into other linked
objects associated with that Account, such as the Primary Contact or Service Request. These objects open in a nested
dynamic tab. The maximum number of dynamic tabs that you can open at one time is 10.

You can use the nested dynamic tabs to manage multiple related objects without confusion. The nested tabs enable
better support for multiple interaction agents such as chat agents, and help increase agent productivity. The maximum
number of nested tabs that you can open at one time is 5.

The nested dynamic tabs contain these buttons:

• Save: Saves any data changes and remain on the same page.

• Save and Close: Saves any data changes and closes the tab. This button displays on the first nested tab only if
there are no other nested tabs opened. As soon as another nested tab is opened, this button is hidden.

• Cancel: Discards any data changes and closes the tab. You're notified if there are unsaved changes.

You can close the top-level dynamic tab and all the nested tabs at one time by clicking the X icon on the top-level
dynamic tab name. If you have unsaved changes in a nested tab and move away from the tab, a blue dot appears next
to the tab label. A message also appears when you hover over the label to indicate the unsaved status. When you try to
close a dynamic tab with unsaved changes in its nested tabs, a warning message appears.

Note:  If you choose to use dynamic tabs, then record-level navigation won't be possible. That means that the
Previous and Next buttons on the record details page won't be available for navigating lists of records for Account,
Contact, Lead, Opportunity, Activity, Campaign, Territory, and custom objects through the Workspace UI.

Related Topics
• Overview of Adaptive Search

FAQs for Workspace and Work Areas Search  

Frequently Asked Questions (FAQs) for Workspace and Work Area
Search  
This section contains some frequently asked questions (FAQs) for Workspace and Work Area search. Scroll or search to
find answers to common questions.
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Can I navigate to work areas powered by Adaptive Search from my
Sales springboard?  
Yes, depending on your privileges, you can navigate directly to new work areas powered by Adaptive Search. The
new work areas provide enhanced search and other features of Workspace for accounts, contacts, activities, leads,
opportunities, and other objects.

Using the grid of icons on the springboard, click the sales feature icon to open a work area powered by Adaptive Search
for the specific sales object selected.

Your sales administrator must have set the opt-in Open Work Areas Powered by Adaptive Search feature to Yes. In
addition, the object you select from the springboard must be indexed and the Display Object in Workspace check box
must be selected from the Configure UI tab in the Configure Adaptive Search page.

Note:  Use the Workspace icon to access service requests because the Service Request object is currently not
supported by this direct access feature. Also, the dynamic tabs feature isn't available for those objects that you select
directly from the springboard or navigator.

Related Topics
• Switch to Work Areas Powered by Adaptive Search

• A Quick Rundown of the Adaptive Search Setup UI

Why can't I find the information I just entered in Workspace and
Work Area search?  
Workspace and work area search requires a few moments to index new information for it to become searchable. If you
search for information just entered and don't find it, wait a few moments and try again.

For example, after you perform a successful lead to opportunity conversion, you may notice that the lead still displays
a status of Unqualified. If you wait a few moments for the indexing to complete and refresh the list, the record status
changes to Converted.

Why can't I see the tabs from the Manage Saved Searches UI?  
To perform role-based administration in Workspace, including assigning saved searches to roles, and assigning a
default saved search to roles, you must have access to the My List, Workspace List, and Default by Role tabs in the
Manage Saved Searches box.

You must have the ZCA_MANAGE_INTERACTIVE_LISTS_SAVED_SEARCH privilege assigned to your role to see these
tabs. Otherwise you will see a single window in Manage Saved Searches enabling you to manage your personal saved
searches only.
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Let's say you have the Channel Operations Manager role. These tabs enable you to assign saved searches from the
Partner and Partner Contact objects to Partner and Channel user roles. Without the privilege added to your role, you're
limited to managing only personal saved searches.

The ZCA_MANAGE_INTERACTIVE_LISTS_SAVED_SEARCH privilege can be assigned to any user role who should have
administrative access to the Manage Saved Searches UI.

Why does the Default Saved Search field display with either no
name or with a Select drop-down list?  
If you don't have permission to view the object associated with the default saved search references, then the Default
Saved Search field in the Manage Saved Searches Defaults by Role window is either empty or contains the word "Select".

Let's say you don't have permission to view the Partner object. A role name such as Channel Account Manager, who has
a Partner default saved search assigned to that role, will not display in the Default Saved Search field. In addition, saved
searches that you don't have permission to access do not appear in the Default Saved Search drop-down list.

To view the assigned default saved search, or to assign a default saved search to a user role, you must have permission
to view the object underlying the saved search.

What can I do if I get too many results when searching for an
account by name?  
Workspace is designed to permit broad searches. If you're getting too many irrelevant results, then add filters. To display
only the matching account names, add the Name field as a filter and enter your search term there.

What happens when I search for Activities owned by my
subordinates?  
Workspace search returns both your activities and your subordinate activities. However, in the Activity simplified UI,
only your subordinate activities are returned. This is unique for the Activities object.

Searches for all other objects returns both your and your subordinate records in the Workspace search UI and in the
specific object's UI.

This image shows the search results (callout 2) based on the record set (callout 1). Matt Hooper has logged in and he can
see the activities that he owns when Record set is "My subordinates own"
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To get around this and to keep the Activities object search results consistent in both UI's, exclude the Owner name in
Workspace (callout 2) using the advanced search feature on the Owner filter (callout 1) as shown in this image.

Related Topics
• Refine Search Results Using Filter Values

Can I search for Territories by Dimension in Workspace?  
Yes. You can use Workspace to search additional filter criteria for your territories by dimension coverage details, such as
included accounts, products, or geographies. This search capability lets you locate the territories for a specific named
account or dimension while resolving territory gaps.

See also the section Search and Filter for more information.
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Related Topics
• Search for the Information You Need

• Refine Search Results Using Filter Values

How can I differentiate between Quote ID fields when I filter for
Opportunity search?  
There's only one field in the Opportunity object that's named Quote ID. However, the predefined Add fields feature
displays the Quote ID field as a filter to search for opportunities based on the External Quote Number attribute of their
associated quotes.

This results in the Quote ID field being available in a few predefined saved searches and can't be modified. Your
administrator can create a custom Quote ID field by using a different name so that you can easily differentiate the fields
to suit your requirements.

Note that if similar scenarios arise when searching across other objects where identical custom field names and
predefined field names display in your search results, then you can request your administrator to create a custom field
with a label that suits your specific business requirement.

How can I search for appointments that don't have a
corresponding call report?  
Use the My Calls to Log saved search in Workspace to look for appointments that don't have a corresponding call report.

From the list of search results returned, you can use either the Create Call Report or Decline Call Report Creation
actions to follow through on appointments.

How are recurring appointments managed in Workspace?  
When you create a recurring appointment, the record is displayed in Workspace and is immediately indexed. You must
include an end date or a number of instances.

However, all the recurring instances of the appointment record gets indexed and only display after a periodic index is
run. Likewise, if you delete a recurring appointment, the appointment record is removed but the recurring instances get
deleted after the periodic indexing job is processed.

If you change the recurrence rule for your appointment, then all existing recurrence records are deleted. New recurring
instances are recreated based on the new rules and the changes are reflected after a periodic indexing run. Any
exceptions to a recurring appointment gets created when a recurring instance is updated and is reflected after periodic
indexing.
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What actions can I take on multiple records at the same time?  
You can perform some actions on multiple records at the same time. This saves you time and helps improve efficiency.
For example, you can select multiple leads in Workspace and qualify them all by selecting the Qualify action.

Here's a list of the Lead actions that you can perform on multiple lead records: Accept, Delete, Qualify, Unqualify,
Update, Rank, Run Assignment, and Score.

When you select multiple activity records, you can also perform these Activity actions all at one time: Mark Complete,
Delete Task, Delete Appointment, and Delete Call Report.

How can I mark favorite records in Workspace?  
You can change the columns that display for your search results in both your Workspace UI and in work areas supported
by Adaptive Search. You can also mark your favorite records so that you can find them more easily.

For example, if your administrator has enabled the Favorite field for your business objects, you can add the Favorite
column to display on the search results page and in what order by clicking Edit Column (the pencil icon). From the Edit
Columns page, search for Favorite and move from the Available area to the Selected area and click OK.

Those records that are marked as Favorite are represented by a color filled star icon. Those items not marked as
favorites have a clear star. You can remove and add items to suit your requirements. When selected, the clear star icon
changes to a filled star. You can also change the width of the columns by dragging their sides. Your preferences can be
saved as part of a saved search.

Related Topics
• Mark Favorite Records

• Enable the Favorite Field for Quick Access to Records

How can I perform record-level navigation from Workspace?  
You can use Previous and Next buttons on the record details page to navigate lists of records in Workspace. This
significantly reduces the time spent going back and forth between edit and list pages.

Record-level navigation is available on the details pages only while navigating records for Account, Activity, Asset,
Campaign, Contact, Deal Registration, Lead, Opportunity, Partner, Partner Contact, Territory, and custom objects
through the Workspace UI.

If you use dynamic tabs, then the Previous and Next buttons on the record details page won't be available for
navigating lists of records.
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Can I use Workspace to manage accounts and contacts without
additional setup?  
Yes, Adaptive Search and the Workspace for accounts and contacts is available for all users, even those who haven’t
enabled Adaptive Search.

Oracle automatically runs the Publish process behind the scenes to index accounts and contacts for Adaptive Search.
This means that all salespeople see the Workspace icon on the home page and can use Workspace to manage accounts
and contacts without additional setup.

Can I merge similar account or contact records in Workspace ?  
You can select similar account or contact records and submit a request to merge them as one account or contact record
in Workspace. By consolidating and merging similar records, you help ensure data integrity so that clean customer data
is available to all users.

To avail of this feature, you must get your administrator to set the Merge Request Enabled profile option.

Related Topics
• Resolve Duplicate Accounts and Contacts

• Enable Merge Requests for Accounts and Contacts

Can I perform partial term matching when searching for my
records?  
Yes, partial term matching is available for identifying fields of objects. Each object has 1 field defined as the identifying
field.

For the objets that have detail pages, the identifying field is the one that is used to drill down into the details page of
that object. For example, Account Name is the identifying field for Account. If you want to perform a partial match on
the Account Name, enter Laptop as your search term, and Adaptive Search will return results like Laptops, Laptop Dell,
Laptop IBM and so on.

Only exact matches are returned for matching terms on non-identifying fields. However, if you add a wildcard to the
search term such as Laptop*, then you get all results including Laptops, Laptop Dell, Laptop IBM and so on.
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Can I add a signed-in user as a search filter for resource-based
fields?  
Yes, you can now use the Is Me operator on resource-based fields in Workspace to add the current user as a filter when
performing a search.

The Is Me operator lets you create saved searches with user-specific filters and supports the following objects and
fields:

Object Field

Account • Last Updated By

• Team Members

• Owner

• Created By

Activity • Last Updated By

• Owner

• Created By

• Delegated By

Asset • Last Updated By

• Team Members

• Created By

Campaign • Last Updated By

• Owner

• Created By

Contact • Last Updated By

• Team Members

• Owner

• Created By

Deal • Last Updated By

• Team Members

• Owner

• Created By

• Approval Decision By

• Submitted By

Lead • Last Updated By

• Team Members
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Object Field

• Owner

• Created By

Opportunity • Last Updated By

• Team Members

• Owner

• Created By

• Resource

Revenue Lines • Last Updated By

• Created By

• Owner

• Primary Partner

Service Request • Last Updated By

• Team Members

• Assigned To

• Created By

• Reported By

Territory • Last Updated By

• Team Members

• Owner

• Created By

Work Order • Last Updated By

• Owner

• Created By

Can I search dynamic choice list (DCL) values based on the
Resource object?  
Yes, you can view, search, and add filters on all dynamic choice list fields for the Resource object using Adaptive Search.

A dynamic choice list is a field that contains a list of values which are populated from the actual data of another object.
You can select filter dynamic choice lists by using saved searches as filter criteria to return a set of search records that
best suits your requirements.

Note:  To use this feature, your administrator must have enabled and published the Resource object and defined a
custom Resource dynamic choice list profile option so that it's available for searching.
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5  Global Search and Legacy Work Area Search

Two More Ways to Search Your Sales Application  
Aside from the search you get in Workspace and the new work areas powered by Adaptive Search, there are two more
ways you can search your application:

• You can use the global search located at the top of the application page to find all the records related to your
search term across application objects. Global search uses Adaptive Search, the same underlying search
technology as Workspace, so you can search for items using related information. For example, you can find all
the accounts in a city, by searching on the city name. Which related information you can use depends on how
your application is set up.

• If your organization hasn't opted in to the new work areas powered by Adaptive Search or you're searching in
the Products, Business Plans, and other work areas that aren't yet converted to Adaptive Search, your search
experience is going to be slightly different:

◦ You get different saved searches.

◦ Filters aren't as versatile.

◦ You can't search using related information from the search box.

◦ The wildcard character you use to represent missing letters in search terms is different too: Work areas
use the percent sign (%), while both global and Workspace searches use the star (*).

Use Global Search for Keyword Searches Across Sales
Objects  
Here are some tips on using global search to search by keyword across all of your sales information.

Note:  You can't search for contacts by email address or phone number because these are Personal Identifiable
Information (PII).

Check the List of Recent Items and Searches
Placing your cursor in the global search box displays a list of recent items you opened (callout 1 in the screenshot) and
your recent searches (callout 2). If you see what you're looking for, just select it. Or start typing any one of the words in
the search term. Capitalization doesn't matter. As you type, the application matches your entry to your recent searches
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and any records you viewed. Aside from the recent items, there's also a Personalize icon (the gears icon highlighted with
callout 3) that you can use to control which items are included in your searches.

Search Complete Words
Here's how to search:

1. Finish typing a complete word.

◦ If you're searching for an item with multiple words in the name, you can enter any of the words. For
example, a search for Angel retrieves matches for the account names Vitamin Angels, Los Angeles
Rubber, and Angeles Warehouse.

◦ Capitalization is ignored.

2. Press Return.

The application displays a list of records that contain your search term.

◦ Results with exact matches get displayed first.

◦ The search also matches your entry with similarly spelled words. Search results based on such fuzzy
matches are rendered below exact matches. The most relevant items are always displayed first. The
fuzzy match settings can be changed during setup. By default, the application displays spellings that
are one letter off provided that the first three letters of the word match exactly. A keyword search on the
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term Cernar, for example, may return "Cerner" or "Cernas" in the search results. It won't return "Cesner",
"Carner", or "Kerner".

When you're searching across multiple objects, the full results may take a while to complete. The application
displays the number of results (callout 1 in the following screenshot).

3. If you see the item you're looking for in the results, you can open it by drilling into the heading link (callout 2).

Narrow Down Your Search Results Using Filters
You can also narrow down the search results after you search. Just click Show Filters (highlighted by callout 3 in the
previous screenshot) to display the list of the objects included in the search (callout 1 in the following screenshot). You
can also filter your results by date by clicking All link (callout 2) and selecting a date range (callout 3).

You must click OK after you make filter changes for your changes to take effect.
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Search Partial Words, Exact Phrases, and Use Operators
You can search on partial words, exact phrases, and use operators between words. Here's how:

• Use the star (*) symbol to indicate missing characters or partial words. You can use the symbol at the
beginning, end, or middle of the search term.

For example, entering *tion as your search term to find all items ending with the letters tion. Entering the star
symbol in the middle of a word such as Pi*le, returns Pinnacle, Pineapple, and so on.

• Use the question mark (?) to match exactly one character. You can use this wildcard at the beginning, end or
middle of a word.

For example, entering Pri?e returns Price, Prize, Pride, and so on.
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• Put multiple search terms in quotes to search for exact phrases.

For example, entering "Pinnacle Corporation" returns only Pinnacle Corporation, and any other records with
those two terms in that specific order.

• Use the OR operator to search on multiple terms.

For example, entering Chicago OR Pittsburgh, finds accounts with those terms in the name. If your application
administrator enabled searching on addresses, the results also include all accounts in Chicago or Pittsburgh.

• Use the NOT operator to narrow down your search.

For example, entering Pinnacle NOT Technologies when searching for accounts, returns all accounts with
Pinnacle in the name, but not Pinnacle Technologies.

When you use NOT followed by two or more words you must enclose the words in double quotes (" ").
For example, entering Pinnacle NOT "Techologies Inc" when searching for accounts, excludes Pinnacle
Technologies Inc.

• Capitalization doesn't matter on search terms, but the operators OR and NOT must be in uppercase letters.

Limit the Number of Objects and Date Ranges in Your Searches
By default, your search runs against all of the available objects. If your searches are likely to return too many results, it's
a good idea to narrow down the list of objects. That's especially true if you're using one of the wildcard characters in
your search or you're searching on common terms. Here's how:

1. Click Personalize (the gears icon).
2. Select only the objects you want to search in the Search Categories tab.
3. Click OK to save your preferences.

The objects you selected remain in effect for all subsequent searches unless you change your selections. So, if
you restrict your searches to contacts, you must change your selection to include accounts before you search
accounts.

Note:  You can't reorder search results using the arrow buttons and Autosuggest Groups aren't used by your
application.

Search Within Work Areas for Fastest Results  
Use the different work areas to quickly search for accounts, opportunities, leads, and other objects:

• Start typing the record name and select the item from the list of recent items.

• Search for names using complete words or phrases.

• Search for partial words using the percentage sign (%) to stand for missing characters or words.

• Select a list, click the Show Advanced Search (the filter icon), and modify the search criteria.

• Search for the account itself first to find activities, leads and other objects related to an account.
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Start Typing the Name and Review the List of Most Recent Items
You can get to your most recent items, even before you finish typing their name:

1. Open the work area.
2. Click in the Find field.
3. Start typing any one of the words in the name.

Capitalization doesn't matter.

As you type, the application matches your entry to the records you opened, created, or updated recently and displays
them in the Recent Items window. If you see what you're looking for, just select it.

Here's a screenshot of the Recent Items window in the Opportunities work area. In this example, entering Server in the
Find search field, displays two recent opportunities: Green Server (Blade) 6000 and Server Upgrade Opportunity.

Search by Name Using Complete Words or Exact Phrases
If you don't find what you're looking for among the Recent Items, finish typing the word and click Search (the
magnifying glass icon). The application displays a list of records with names that contain your search term, followed by
records with related words, just in case you didn't type the word correctly. Say you're searching for accounts using the
word software. The application first displays the account names that contain that word, such as Compucon Software
and Forte Software Inc. That's followed by names with similar spellings, such as Softgear Inc.

Note:  The application administrator can turn off the display of search results with similar spellings by setting the
Include Similar Results in Searches profile option.

Here's a screenshot of the Accounts work area landing page showing a sample search for the word software. Callout
1 highlights the location of the two account names that include the exact spelling of the word in the name. Callout 2
shows the location of the account name with a similar spelling.
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If you want to find the exact name you're searching for, then put quotation marks around your search terms. For
example, "Forte Software Inc", returns just that one record.

Search for Partial Words in a Name
You can also search for partial words:

• Put a percent (%) sign after two or more letters, and you get all the names with words that start with those
letters.

For example, searching on pin%, returns Pinnacle Technologies and All Pines Furniture.

• Put the percent sign at the front of the term, and you get records that end with your term. For example,
searching for %ard, returns The Board of Education and Edward Ward and Co.

• Put the percent sign at both ends, and you get all the customer names with words that include those letters.

Note:  You can use the percent (%) sign at the beginning of your search term only in the Find field on the main page
of each object.

Using the percent (%) sign can slow your searches, so enter a whole word if you know it.
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Search by Other Criteria Besides the Name
Use advanced search to search by criteria other than the name:

1. Whatever search criteria you enter are limited by the list you start off with, so start by selecting a list that's a
superset of what you're looking for.

For example, selecting All Opportunities lets you search within all the opportunities you can access. Selecting
My Open Opportunities narrows down the scope of your search to just the open opportunities you own.

2. Click Show Advanced Search (the filter icon) to display the Advanced Search panel.

The panel displays the search criteria for the list you selected. Here's a screenshot highlighting the Advanced
Search panel.

3. Here's how you can modify your search:
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◦ Select a different record set to change the scope of your search. For example, selecting My territory
hierarchy searches all the records in your territories and their subordinate territories. The available
record sets vary from object to object.

To improve saved search performance, restrict your saved searches to smaller record sets. For example,
rather than searching all the records you can see, search all the records in your territory hierarchy. Or
restrict your searches to a smaller geographical area. For example, search all the accounts in one state
instead of the whole country.

◦ Add additional fields to the search by clicking Add.

◦ Select different operators for the fields in your search. Most of the operators, which differ field by field,
are self-explanatory. But here are some notes on the more complex:

- Between

Selecting the Between operator for a date field, prompts you to enter a specific date range for the
search.

- Rolling-time operators, including Yesterday, Today, Tomorrow, Last Week, This Week, Next
Week, Last Month, This Month, and Next Month

Searching for opportunities created this month, for example, returns opportunities created in the
current calendar month. The rolling-time filters use the time zone of the signed-in user for the
calculation.

- Current User

Including the Current User operator in the Last Updated By and Created By fields displays only the
records relevant to you, the signed-in user. For example, when you search for opportunities last
updated by the current user, you get a list of opportunities last updated by you.

- Is Blank, Is Not Blank, and Does Not Equal

Selecting the Is Blank operator, makes it possible to search for records missing values in a text
field or a field validated by a list of values, for example. Administrators must make these operators
available by setting two system profile options. The Enable Additional Search Operators for Text
Fields (ZCA_ENABLE_ADDITIONAL_TEXT_OPERATORS) profile option enables the Is Blank and
Is Not Blank operators in text field searches. The Enable Additional Search Operators for List of
Values (ZCA_ENABLE_ADDITIONAL_LOV_OPERATORS) enables the Is Blank, Is Not Blank, and
Does Not Equal operators on fields validated by list of values (both fixed choice and dynamic
choice list fields).

◦ Specify which attributes you want to display in the search results table by selecting Columns from the
View menu.

You can select specific columns or display all columns.

◦ Reorder the filter conditions by clicking Reorder.

◦ Delete any fields you added to the search.

You can't delete the fields provided by Oracle. You can only delete fields you added.
4. Click Search to display the results.
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5. You can save your modified search as a new saved search (list):

a. Click Save.

b. In the Create Saved Search window, enter a new name for the saved search.
c. Optionally, you can set this search to be the list that appears whenever you navigate to the work area by

selecting the Set as Default option.
d. Click OK.

Search for the Account to View Its Opportunities, Contacts, and Other
Related Information
Instead of searching for an opportunity or contact in their work areas, you can search for the account instead and then
drill down to the opportunity or contact from there. Whatever search method you use, always remember that you may
not have permission to access all information in the application. For example, to see an opportunity, you may have to
own the sales territory, be on the sales team, or manage someone who is.

There may be a delay of a few minutes between the time you create or update a record and when you and others can
search for it. That's because the application must update an index to enable searches. You can access newly-created
items from the Recent Items list in the meantime.

Related Topics
• How can I create saved searches with just one custom field?

• Two More Ways to Search Your Sales Application

• Create Your Personal List in a Work Area

• Delete or Hide a List

How can I add more fields to my search?  
To add additional fields to your search in a work area, click Show Advanced Search (the funnel icon) and click Add in
Advanced Search to select the field. The list shows only fields that are enabled for search.

If you don't see your field, an administrator may be able to make the field searchable using Application Composer. Not
all fields can be made searchable.
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Personal Lists  

Create Your Personal List in a Work Area  
Create your own personal list in any of the work areas where you see lists. That includes opportunities, leads, and
accounts. To create your own list, also known as saved search, just modify one of the existing lists.

The detailed steps are a bit different for each business object, but the principles are the same. Here's an example of
how to create a list of all accounts in the state of New York. Once you get the idea, you can create a new list in any work
area. If you're adding a custom field as part of the search criteria, be sure that the field is indexed for search to improve
performance.

The lists you create are available to you only. However, sales administrators can create lists for different sets of users by
using the same sets of steps. They just have to use Page Composer in a sandbox and publish the sandbox to make the
list available to others.

Tip:  To improve saved search performance, restrict your lists to smaller record sets. For example, rather than
searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a
smaller geographical area. For example, search all the accounts in one state instead of the whole country.

Create the List
1. In the work area landing page, click Show Advanced Search (the filter icon) to the right of the List field.
2. In the Advanced Search panel, from the Saved Search list, select the saved search you want to use as the basis

of your new saved search. In this example, you're creating a list of all accounts in New York, so you can use the
default My Accounts saved search.

Tip:  To create a saved search entirely from custom fields, select Account Name.

3. In this example, you want to display all of the New York accounts you can access, so select All records I can see
from the Record Set list.

The record set specifies the set of records to be searched. To improve search performance, you want to restrict
your searches to a smaller record set. In this example, however, you can select All records I can see because
you're restricting the number of records searched by adding the state field.

4. Click Add.
5. Select State from the list.
6. Enter NY in the State field.
7. Click Save.
8. In the Create Saved Search window, enter a new name.
9. If you don't want the new search to become the default, deselect the Set as Default option.

10. Make sure the Run Automatically option remains selected. This selection runs the query each time you select
the list in the UI.

11. Enter a new name, for example, NY Accounts.
12. Click OK.

The work area landing pad and the Advanced Search Panel display the new search and the search results.
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Delete or Hide a List  
You can delete any work area lists you created. While you can't delete any of the lists provided by Oracle or by your
application administrator, you can hide them from view. If you hide a list, you're affecting your own UI only.

Delete a List You Created
1. In the work area landing page, click Show Advanced Search (the filter icon).

The application displays the Advanced Search panel on the left side of the page.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches window, click Delete.
4. Confirm your deletion by clicking Yes on the warning.

Hide a List from View
1. In the work area landing page, click Show Advanced Search (the filter icon).

The application displays the Advanced Search panel on the left side of the page.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches window, select the saved search you want to hide and deselect the Show in

Search List option.
4. Click OK.

The list is now hidden. You can restore the list in the future by selecting the Show in Search List option.

Related Topics
• Create Your Personal List in a Work Area

How can I create saved searches with just one custom field?  
You can create a saved search using a single custom field by editing one of the two single-field saved searches provided
by Oracle: Name and Close Date. For opportunities and leads, use the Close Date list.

For all other objects, including accounts, use the Name list, for example, the Account Name list or the Contact Name
list. You can only create a new search by editing an existing saved search and you can't delete any of the existing fields.
However, you can leave the value of some fields blank, effectively enabling you to search using one custom field. For
best search performance, you must index the custom fields used in the search.

Here's an example of how to create a saved search for a particular value of an account custom field:

1. On the Accounts work area landing page, click Show Advanced Search (the filter icon).
2. In the Advanced Search panel on the left side of the page, select Account Name from the Saved Search list.
3. Click Add and select the custom field.
4. Enter a value in the custom field.
5. Click Save.
6. In the Create Saved Search window, enter a new name for your search.
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7. If you want the new search to become the default, select the Set as Default option.
8. Make sure the Run Automatically option remains selected. Selecting this option runs the query each time you

select the list in the UI.
9. Click OK.
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6  Infolets

Quick Way to Get Key Sales Information and Take Action 

The Sales Infolet page displays key sales information in containers called infolets. Some infolets provide you with an
overview, but others make it possible for you to take direct action.

Watch video
 

These actionable infolets summarize key sales data and let you take immediate action on the tasks presented. The
actionable infolets contain key metrics modified for sales roles in your organization. To get to the Sales Infolets page,
you click the page controls (dots at the center of the welcome page). You can take action in the infolet by making a
selection from a menu without having to drill down into a record.

Take advantage of the following sales-oriented infolets:

• My Tasks

Quickly view and work on your most urgent tasks with minimum additional navigation.

• My Appointments

Directly review, add, update, and add notes to your appointments. You can also access your calendar to create
appointments.

• My Accounts

View and manage account information from a single place. You can drill down to edit an account record as well
as create accounts, filter your accounts and perform other quick actions.

• My Opportunities

View, update, and add a note for your individual opportunities. You can drill down to edit an opportunity record
as well as create opportunities, tasks, and appointments.

• My Leads

View newly assigned leads, accept or reject individual lead records without having to drill down to the leads
landing page. You can also create a lead and drill down to edit individual leads.

Use filters to find the records that need your attention. For example, you can filter your leads to see unaccepted leads
only. Then use quick actions to accept a lead without leaving the infolet.

You can personalize your actionable infolets, refresh data, create and edit data as required. If you have the required
privileges, built in configuration features help you effectively plan your day thus saving valuable time. For example, you
can choose to select or hide predefined filters that you want to make available on the actionable infolets.
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Infolet Filters and Actions
With a few clicks, navigate to the relevant areas in your sales process where you can use filters to view the records that
you want and take immediate actions. For example, with just a single click of a button, you can complete or defer tasks
without having to drill down to view the record, or you can accept or reject new leads without having to navigate to the
Leads UI.

Use the Configure menu item to add or modify filters and actions. You can also refresh your record data, edit the title of
your infolet, move, hide, or show specific infolets on your infolet page.

Here are the predefined filters and actions available to you from your actionable infolets:

Actionable Infolet Select one of these filters... Select one of these record quick
actions...

Select one of these infolet
actions...

My Tasks
 

• Today's Task (default)

• Overdue Tasks

• Tomorrow's Task

• Beyond Tomorrow's Tasks

• Mark as Complete

• Defer by 1 Day

• Defer by 2 Days

• Defer by 1 Week

• Create Note

• Refresh

• Create Task

• Configure

• Edit Title and Views

• Hide

My Appointments
 

• Today's Appointments
(default)

• Tomorrow's Appointment

• Create Note

• Create Call Report

• Refresh

• My Calendar

• Configure

• Edit Title and Views

• Hide

My Accounts
 

• My Accounts (default)

• My Favorite Accounts

• My Team Accounts

• Create Lead

• Create Opportunity

• Create Appointment

• Create Task

• Create Note

• Create Call Report

• Log a Call

• Create Service Request

• Refresh

• Create Account

• Configure

• Edit Title and Views

• Hide

My Opportunities
 

• Closing in Next 7 Days
(default)

• Closing This Month

• Closing This Quarter

• Closing Next Quarter

• Open opportunities where I
am on the team

• My Open Opportunities

• Create Appointment

• Create Task

• Create Note

• Refresh

• Create Opportunity

• Configure

• Edit Title and Views

• Hide

My Leads
 

• Unaccepted Leads (default) • Accept • Refresh
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Actionable Infolet Select one of these filters... Select one of these record quick
actions...

Select one of these infolet
actions...

• My Open Leads

• Recent Open Leads

• Open Leads where I am on
the team

• Reject • Create Lead

• Configure

• Edit Title and Views

• Hide

Related Topics
• Personalize Your Key Infolets

• Modify Actionable Infolets

Personalize Your Key Infolets  
You can personalize actionable infolets from the Actions menu. For example, you can edit infolet titles and views, move,
hide, or show specific infolets and refresh the data displayed.

If enabled by your application administrator, you can personalize the layout, record count, filters, and actions at the
record level for each of your infolets.

Configure Layout of Actionable Infolets
Once enabled, the Configure menu item from the Actions menu becomes available so that you can personalize the
actionable infolets to suit your requirements. For example, you might want to change the layout and size of columns, as
well as the locations of the fields being displayed. You might want to use your own saved searches as view filters or hide
some of the quick actions that might not be relevant to you.

Here's how to modify the layout of the My Opportunities actionable infolet:

1. Navigate to the actionable infolet that you want to modify.
2. Go to My Opportunities, and select Configure from the Actions menu.

The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the Layout tab, select the attributes that you want to edit from the respective drop-down lists.
4. Set and adjust the two column table widths in percentage terms by sliding your mouse along the Column Width

ruler.
5. Make the changes that you want to the attribute and select another attribute to edit, if required.
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6. In the Drill Down Field, select the item that you want to use for drilling down to the detail page of an
opportunity.

Tip:  If Dynamic Choice List fields are added to the Actionable Infolet, then the drill down is automatically
enabled.

This table shows the field names and associated attribute names that you can select for drill-down for each of
the actionable infolets:

Actionable Infolet Drill Down Field Attribute

My Opportunities
 

Name
 

Amount
 
Close Date
 
Stage
 

My Leads
 

Lead Name
 

Rank
 

My Accounts
 

Name
 

Primary Contact
 
Primary Address
 

My Appointments
 

Subject
 

Primary Contact Address
 

My Tasks
 

Subject
 
Primary Contact
 

Type
 
Due Date
 

7. Click Save and Close when you have finished making the changes.

Change the Record Count Display for Actionable Infolets
You can also change the predefined number of records to display on the infolet. By default, 10 records display. You can
change the default to 10, 20, 25, or 30, as required.

Here's how to modify record counts for an actionable infolet:

1. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the
Actions menu.

The My Opportunities actionable infolet screen is displayed.
2. From the Record Count tab, select the number of records that you want to display on the infolet from the drop-

down list.
3. Click Save and Close.
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Modify Filters
Filtering reduces the number of searches required to view any outstanding items that might require attention. For
example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.

Predefined saved searches are available for selection. However, any custom saved searches that you create must include
Record Set values selected for either any records that you own or for records where you're on the team. In addition,
when saving your saved search, you must select the Run Automatically check box to run the search automatically
when your saved search is loaded. Otherwise, the custom saved search won't display in the available filters list in the
Configure UI for your actionable infolet.

You can show or hide filters, rearrange filters, and add custom filters. You can multiselect and double-click filters in the
Available list to move them to the Selected list. However, you must select at least one filter for the actionable infolet filter
list.

This table lists filters that you can modify.

Actionable Infolet Filter Filter Description

My Tasks
 

• Today's Tasks

• Tomorrow's Tasks

• Overdue Tasks

• Beyond Tomorrow's Tasks

• All Tasks

• Open Tasks

• High Priority Open Tasks

• Display all my tasks scheduled for today

• Display all my tasks scheduled for
tomorrow

• Display all my tasks that are now overdue

• Display all my tasks that are scheduled for
the day after next and beyond

• Display all my assigned tasks

• Display all my assigned tasks that are
currently open

• Display all my high priority tasks that are
currently open

My Appointments
 

• Today's Appointments

• Tomorrow's Appointments

• Display all my appointments scheduled for
today

• Display all my appointments scheduled for
tomorrow

My Accounts
 

• My Accounts

• My Favorite Accounts

• My Team Accounts

• Display only the accounts that I own

• Display my accounts that I've marked as
favorites

• Display all the accounts that I can view

My Opportunities
 

• Closing in Next 7 Days

• Closing This Month

• Closing This Quarter

• Closing Next Quarter

• Open opportunities where I am on the
team

• My Open Opportunities

• Display my open opportunities that are
due to close in the next 7 days

• Display my open opportunities that are
due to close this month

• Display my open opportunities that are
due to close within the current quarter

• Display my open opportunities that are
due to close within the next quarter

• Display my open opportunities where I'm
on the team
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Actionable Infolet Filter Filter Description

• Display only those open opportunities that
I own

My Leads
 

• Unaccepted Leads

• My Open Leads

• Recent Open Leads

• Open Leads where I am on the team

• Display a list of all unaccepted leads that
are assigned to me

• Display only those open leads that I own

• Display a list of my leads that have
recently been opened

• Display a list of open leads where I'm on
the team

Here's how to modify the filters of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the

Actions menu.
The My Opportunities actionable infolet screen is displayed with the predefined fields selected.

3. From the Filters tab, select the filters that you want to modify
4. Click Save and Close when you have finished making the changes.

Modify Quick Actions
You can navigate to the relevant areas in your sales process where you can perform quick actions at the record level. For
example, you can easily complete or defer tasks without having to drill down to view the record, or you can accept or
reject new leads at the click of a button.

You can show or hide actions, rearrange actions, and add custom quick actions. For example, you can multiselect and
double-click actions in the Selected list to move them to the Available list if you want to hide a quick action. However,
you must select at least one action for the actionable infolet quick actions list.

Here are the selected quick actions that you can modify in the order as they appear on the UI.

Actionable Infolet Quick Actions

My Tasks
 

• Mark as Complete

• Defer by 1 Day

• Defer by 2 Days

• Defer by 1 Week

• Create Note

My Appointments
 

• Create Note

• Create Call Report

My Accounts
 

• Create Lead

• Create Opportunity

• Create Appointment

• Create Task
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Actionable Infolet Quick Actions

• Create Note

• Create Call Report

• Log a Call

• Create Service Request

My Opportunities
 

• Create Appointment

• Create Task

• Create Note

My Leads
 

• Accept

• Reject

Here's how to modify the quick actions of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify and make sure that the infolet displays in expanded
view.

2. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the
Actions menu.

The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the Quick Actions tab, select the actions that you want to modify.
4. Click Save and Close when you have finished making the changes.

Edit Actionable Infolet Titles and Views
Here's how to edit titles and views for actionable infolets:

1. Click the Actions icon on the top right corner of the actionable infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.

The Enable option is automatically set to Yes. You can't disable a view of an infolet.
3. Click Save and Close.

Move Actionable Infolets
To change the position of an actionable infolet within an Infolet page, click and drag the infolet, and drop it at the
required position.

Hide or Show Actionable Infolets
To hide an actionable infolet from an infolet page, click the infolet repository icon, and deselect the actionable infolet
from the list of infolets. Alternatively, click the Actions icon on the top right corner of the actionable infolet, and select
Hide. To show a hidden infolet on an infolet page, click the infolet repository icon, and select the infolet from the list of
infolets.

Related Topics
• Modify Actionable Infolets
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What happens if I delete an actionable infolet?  
If you delete an actionable infolet by accident, then it's no longer available to you. You must contact your help desk to
retrieve the data and recover the actionable infolet.
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7  Workspace Infolets

Overview of Key Sales Information for Workspace
Infolets  
The Sales Infolets tab in the Analytics section of your sales application contains actionable infolets that summarize sales
information. These default classic infolets make it possible for you to take action on individual items without having to
drill down into individual records.

However, Oracle recommends you use Workspace infolets, which are based on the Adaptive Search and Workspace
framework. In addition, these Workspace infolets:

• Provide a set of predefined configuration templates that let you quickly create your own search-based infolets
with the Workspace user experience

• Let you personalize which information to display on your own pages, such as including features you frequently
use in Workspace.

• Let administrators display different infolets for different job roles in the organizations

Before you can start using Workspace infolets, your administrator must enable them.

Oracle provides these predefined Workspace infolets:

• My Accounts

• My Appointments

• My Contacts

• My Leads

• My Opportunities

• My Tasks

The application includes four blank Workspace infolets that you can configure to display any combination of saved
searches from Workspace. You can create custom Workspace infolets to display information on any of the objects, or
combination of objects, available in Workspace, including assets, service requests, and custom objects. For example, if
you created a project custom object to track projects involving multiple customers, you could configure one of the blank
infolets as My Projects to track the accounts and the tasks involved. After the administrator enables Workspace infolets,
the four blank infolets display automatically in the Infolet Repository. Each of the blank Workspace infolets has the same
Additional Actionable Infolet name.

Each of the Workspace infolets include different filters to narrow down the list of items you see. For example, you can
see all of the appointments for the whole week or just see today's appointments. The filters come from the saved
searches (lists) available in Workspace.

Here's a screenshot of the Sales Infolets tab displaying the Workspace infolets.
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See the chapters on Adaptive Search and Workspace in the Implementation Reference guide for setup information.

Workspace Infolet Filters and Actions  
With a few clicks, navigate to the relevant areas in your sales process where you can use filters to view the records and
take immediate actions.

For example, with just a single click of a button, you can complete or defer tasks without having to drill down to view
the record, or you can accept or reject new leads without having to navigate to the Leads UI. You can also refresh your
record data, edit the title of your infolets, and move, hide, or show specific Workspace infolets on your infolet page.

The smart actions match the smart actions available from the Workspace UI, and the quick action denoted by the
ellipsis icon opens an inline window where you perform your action without having to navigate outside the infolet. You
can also create a new record for your specific Workspace infolet by clicking the Create icon (plus sign) from the top right
corner of the infolet.

Make sure the infolet that's displayed on the page is a Workspace infolet. Workspace infolets include the Workspace icon
(callout 1) and the three dots for quick actions (callout 2). Here's a screenshot of the My Accounts Workspace infolet:
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Predefined Workspace Infolet Filters and Actions
Here are the predefined filters and actions available to you from your Workspace infolets:

Workspace Infolet Select one of these filters... Select one of these record quick
actions...

Select one of these infolet
actions...

My Accounts
 

• All Accounts

• My Accounts

• My List for Accounts

• My Team Accounts

• Create Appointment

• Create Note

• Create Opportunity

• Create Service Request

• Create Task

• Log a Call

• Refresh

• Create Account

• Configure

• Edit Title and Views

• Hide

My Appointments
 

• My Appointments • Create Call Report

• Create Follow-up
Appointment

• Create Follow-Up Task

• Create Note

• Decline Call Report Creation

• Delete Task

• Refresh

• My Calendar

• Configure

• Edit Title and Views

• Hide

My Contacts
 

• My Contacts

• My List for Contacts

• Add to Campaign

• Create Appointment

• Refresh

• Create Contact

99



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 7
Workspace Infolets

Workspace Infolet Select one of these filters... Select one of these record quick
actions...

Select one of these infolet
actions...

• Create Note

• Create Opportunity

• Create a Service Request

• Log a Call

• Configure

• Edit Title and Views

• Hide

My Leads
 

• My Open Leads

• My List for Leads

• My Team's Open Leads

• Open Leads Where I am on
the Team

• Add to Campaign

• Convert Lead

• Create Appointment

• Create Note

• Create Task

• Log a Call

• Qualify

• Rank

• Reject

• Retire Lead

• Run Assignment

• Score

• Refresh

• Create Lead

• Configure

• Edit Title and Views

• Hide

My Opportunities
 

• My Open Opportunities

• My List for Opportunities

• My Team's Opportunities

• Open Opportunities Where I
am on the Team

• Create Appointment

• Create Opportunity

• Create Service Request

• Create Note

• Create Task

• Log a Call

• Refresh

• Create Opportunity

• Configure

• Edit Title and Views

• Hide

My Tasks
 

• My Open Tasks

• My Overdue Tasks

• My Team's Tasks

• Create Call Report

• Create Follow-Up
Appointment

• Create Follow-Up Task

• Create Note

• Decline Call Report Creation

• Delete Task

• Mark Complete

• Refresh

• Create Task

• Configure

• Edit Title and Views

• Hide

Add a Saved Search List as a Filter to the Workspace Infolet
For each of the six predefined Workspace infolets, you can choose which Workspace saved search list to view from the
drop down filter menu configured by your administrator. Click the Workspace icon in the top right of the Infolet to drill
down to the currently selected filter list. This action takes you to the Workspace UI. Click Home to return to the Sales
Infolets tab on the Analytics page.
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To add a list as a filter:

1. Click Home to return to the home page.
2. Scroll down to the Analytics section where the infolet is located.
3. Click Actions (the arrow icon in the top right corner of the infolet) and select Configure.
4. In the window, click the Filters tab.
5. In the Search field, start to enter the name of the saved searches you want as filters to display, and from the list

returned in the Available column, highlight the saved searches you want.
6. Move the list you want from the Available to the Selected column.
7. You can use the arrow buttons to change the order of the filters.
8. Click Save and Close to close the window and return to the home page.

The filter is now available in your Workspace infolet.

How can I show quick actions on my Workspace infolets?
 
From the Manage Infolet page, click the Layout tab and ensure that the Show quick actions check box is selected. This
action displays the quick actions that you can perform at the record level for your Workspace infolet.

What happens if I delete a Workspace Infolet?  
If you delete a Workspace infolet by accident, then it's no longer available to you. You must contact your help desk to
retrieve the data and recover the infolet.
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8  Sales Insights

About Sales Insights  
Sales Insights help provide an objective understanding to salespeople working with accounts, leads, and opportunities.

Based on detailed analysis of account interaction and historical exchanges such as sales activities, status, duration,
contacts, and so on, salespeople can gain key insights and take appropriate corrective actions on records to further
increase their sales pipeline.

As sales insights evolve over time, context-based recommendations are made available to salespeople to help them
evaluate and decide on what actions to take on appropriate next best lead and opportunity records or tasks for an
account.

Sales data is mined, evaluated and analyzed through data analytical and statistical modules. Adaptive search finds key
metrics, calculate standard deviations, averages, and margins to deliver insights. Standard query language programs
sorts and classifies the data so that key sales metrics are readily available to salespeople to help them focus on those
records that need attention.

View Account Engagement Level From Sales Insights  
Sales representatives, managers, and leaders can view an objective understanding of the engagement level of accounts
based on detailed analysis of account interaction and historical exchanges.

They can view at a glance which accounts have high, moderate, or low engagement and this helps them plan and
prioritize the next set of actions. Knowing which accounts to target for the next sales outreach allows then to create
more leads and increase the pipeline.

Sales insight details about account tracking activities is accessed from the Profile tab on the Accounts page. Identifying
those accounts that are either highly or moderately engaged and by observing certain accounts helps salespeople to:

• Prioritize the next set of actions for records and tasks

• Improve productivity with moving the sales pipeline along

• Identify quickly what's wrong with a lead or opportunity and take the necessary corrective action

Here's an example of a sales insight for an account.
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Optimize Lead Nurturing Through Sales Insights  
You can improve your sales effectiveness by receiving key sales data insights on lead tracking activities. Using data
analytics and mining, this feature seeks any discrepancies in activities based on historical data to deliver key insights on
leads to optimize the nurturing process.

Data insight details about lead tracking activities is accessed from the Summary tab on the Lead page. By knowing if
the activities associated with a given sales lead are sufficient and accurate helps you effectively optimize your leads and
move them along the sales pipeline.

Here are some examples of how you can avail of key lead sales insights to help with your sales activity tasks. For
example, sales representative may want some insights to check if they're doing enough to nurture Leads while sales
managers may want to gain an objective understanding of:

• Which Leads aren't being nurtured effectively and need more attention?

• Who are our most engaged customers?

• Which accounts can be reached again to increase the sales pipeline?

Here's an example of sales insights for leads.
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Optimize Opportunity Nurturing Through Sales Insights  
You can improve your sales effectiveness by receiving key sales data insights on opportunity tracking activities. Using
data analytics and mining, this feature seeks any discrepancies in activities based on historical data to deliver key
insights on opportunities to optimize the nurturing process.

Data insight details about opportunity tracking activities is accessed from the Summary tab on the edit Opportunity
page. By knowing if the activities associated with a given opportunity are sufficient and accurate helps you effectively
optimize your opportunities and move them along the sales pipeline.

Here are some examples of how you can avail of key opportunity sales insights to help with your sales activity tasks. For
example, sales representative may want some insights to check if they're doing enough to nurture opportunities while
sales managers may want to gain an objective understanding of:

• Which opportunities aren't being nurtured effectively and need more attention?

• Who are our most engaged customers?

• Which accounts can be reached again to increase the sales pipeline?

Here's an example of sales insights for opportunities.
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Validate Contacts for Leads and Opportunities through
Sales Insights  
You can improve your sales effectiveness and gain productivity by receiving key data insights about contacts for
leads and opportunities. Contact validations are based on historical data, contacts relationships, and the successful
interactions associated with an opportunity or a lead.

You want to know if contact details associated with your leads and opportunities are accurate and correct all the
time. Data insight details about lead and opportunity contacts are validated based on historical data and contact
relationships. This helps improve your productivity by ensuring that you have correct and accurate contact without
having to research and validate your contacts manually.

Lead Contact Validation
You can access the data insights for lead contacts validation from the Summary tab on the Edit Lead page. By knowing
if the contacts associated with a given lead are sufficient and accurate helps you effectively optimize your leads and
move them along the sales pipeline.

Data insights use the average number of contacts for the past successful leads of a given account as object metrics.
Leads without an account don't qualify for both metrics and fact generation. Leads are classified as Good if the lead
includes a Key Decision Maker. A classification of Needs Attention indicates that there isn't any Key Decision Maker
identified for the lead. The comparison of current contacts count with that of past successful leads is added as part of
the explanation category text.

Here's an example of lead contact validation using sales insights.
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Opportunity Contact Validation
Data insight details about opportunity tracking activities is accessed from the Summary tab on the edit Opportunity
page. By knowing if the activities associated with a given opportunity are sufficient and accurate helps you effectively
optimize your opportunities and move them along the sales pipeline.

Data insights use the average number of contacts for the past successful opportunities with same product group of
a given account as object metrics. If historical data isn't available for the product group, then the account specific
common average number is used. Opportunities without an account don't qualify for both metrics and fact generation.
Opportunities are classified as Good if the current count of contacts is greater than or equal to the average contacts
count. Otherwise, they're classified as Needs Attention. If there isn't any Key Decision Maker identified for the
opportunity, then this information is added as part of the explanation category text.

Here's an example of sales insights for opportunities.
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Optimize Deal Execution and Lead Nurturing through
Sales Insights  
You can improve your sales effectiveness and gain productivity by receiving key data insights about contacts that
help optimize deal execution and lead nurturing. Contact recommendations are based on historical data, contacts
relationships, and the successful interactions associated with an opportunity or a lead.

Optimize Deal Execution and Lead Nurturing through Sales Insights

Using data analytics and mining, Sales Insights recommends key contacts for each active opportunity or lead for the
relevant account to help effectively close the deal.

Opportunity Contacts Recommendation
Data insight details about recommended opportunity contacts is accessed from the Summary tab on the edit
Opportunity page. By knowing that the recommended contacts associated with a given opportunity are sufficient and
accurate helps you effectively optimize your opportunities and move them along the sales pipeline.

Here's an example of contacts recommendation for an opportunity using sales insights.

Lead Contacts Recommendation
You can access the data insights for lead contacts recommendation from the Summary tab on the Edit Lead page. By
knowing that the recommended contacts associated with a given lead are sufficient and accurate helps you effectively
convert leads to opportunities and move them along the sales pipeline.

Here's an example of contacts recommendation for a lead using sales insights.
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9  Accounts, Contacts, and Households

Overview of Accounts, Contacts, and Households  
You can use the Accounts pages to manage the information related to your sales accounts, including customers,
prospects, contacts, and households.

Use the account management capabilities to:

• Create and update accounts, prospects, contacts, and households

• Maintain account hierarchy

• View household relationships

• Enrich customer data

As your work with the account management application, keep in mind the following terminology:

• Account: An account is an organization that a salesperson sells to. Accounts can be prospects or customers.

• Contact: A contact is an individual. A contact need not be related to a customer. A person may be a customer or
a customer contact.

• Customer: A customer is someone with whom you have a selling relationship. The selling relationship can result
from the purchase of products and services, or from the negotiation of terms and conditions that provide the
basis for future purchases.

• Household: A household is a group of contacts with whom you have a selling relationship. Households provide
valuable segmentation information about the household as a whole, as well as summary of information about
the household member contacts. Usually all the contacts reside at the same address and have a similar set of
attributes that accounts do, such as team members, territories, and contacts.

• B2B and B2C: Business-to-business and business-to-consumer, or B2B and B2C, are terms that indicate the
type of customer relationship:

◦ B2B: The customer is a business rather than an individual consumer.

◦ B2C: The customer is an individual consumer rather than a business.

Account Management  

Overview of Accounts  
An account refers to an organization that a salesperson sells to. An account may be a prospect or customer. Use
Workspace to access your accounts and contacts. For sales objects that aren't available in Workspace, use the landing
pages.
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Create Accounts
You can create accounts in the following ways:

• Create them from Workspace or the Accounts landing page.

• Import accounts using the Import Management framework.

• Use web services to create an account.

Overview of Account Management
Use account management capabilities to search for, create, update, delete, merge, and enrich accounts.

Here's a description of the account areas that you use to manage accounts:

Account Tabs Description

Overview
 

Provides an overview of the customer or prospect, including the number of open opportunities, leads,
 assets, active contracts, service requests and activities.
 
View the ultimate parent and parent account associated with an account. Access the account hierarchy
using the Manage Account Hierarchy link and add or remove child accounts in the hierarchy.
 

Profile
 

Provides details of the account, such as address and contacts. Here you can also:
 

• Associate a parent account from the available list of values. You can change the parent account at
any time.

• Update and verify account address.

• Add industry codes and organization types.

• Add the primary contact to the account.

Team
 

Shows team members and territories that are part of your account. Here you can also:
 

• Add team members

• Add territories

You can manually run territory assignment for the account through the Run Assignment process. For
example, a sales administrator can manually assign a specific account to verify that expected territories
are assigned after territory realignment.
 
The assignment action is enabled for the type of account enabled for assignment. If you have enabled
assignment for the account of type, customer, then the assignment object is shown as:
 

• Enabled for customer account

• Disabled for prospect account

Contacts
 

Lets you add and view contacts for the account. Review contacts in the following views:
 

• Table view

• Hierarchy view

The hierarchy view shows how the contacts are related to each other. Here you can manage reporting
relationships and drill into contact details.
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Account Tabs Description

Use this tab to add additional contacts to the account. You must have edit access on the Account to
add contacts. To add a contact, you can search by an account. The search results show the contacts
and their primary customers and account.
 

Opportunities
 

Lets you view, update, and create opportunities for the account.
 

Quotes and Orders
 

Lets you view, update, and create quotes and orders for the account.
 

Leads
 

Lets you view, update, and create leads for the account.
 

Contracts
 

If your administrator has enabled this view, then you can view contracts associated with the account.
Depending on your access, you can also preview the contract in a PDF format.
 

Notes
 

Lets you add and view notes for the account.
 

Assessments
 

Lets you assess the customer.
 

Activities
 

Lets you add and view appointments, tasks, and call logs.
 

Assets
 

Shows a list of assets for this account. Both types of assets - customer relationship management and
installed base assets - are owned by the account, but only one of them can be active.
 

Relationships
 

Lets you add account relationships to other account or contacts that aren't directly related to the
account but are influential. You can add the same contact to multiple accounts using different
relationships.
 
You must add your first contact from the Contacts subtab and add your subsequent contacts here.
 

Note:
You can't edit a role after you have added a relationship. To update the role, delete the existing
relationship and create another relationship with the role that you want.
 

You must enable these tabs using
Application Composer:
 

 

Interactions History
 

View the past interactions with the account, including calls, chats, and emails.
 

Service Requests
 

View and add service requests.
 

Installed Base Assets
 

View and add installed base assets. These are customer owned products from the organization's
product catalog.
 

Business Plans
 

View and add business plans for the account. A business plan lets you increase the sales or revenue of
that account.
 

Analytics Access key insights and metrics for all aspects of your sales organization.
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Account Tabs Description

  

Billing Accounts
 

View financial accounts created for the account in accounts receivable.
 

Reference Systems
 

View or add source systems. A source system reference is a unique ID that lets you maintain a record of
the source of the data in the sales applications.
 

Industries
 

View and add industries for the account.
 

Related Topics

Manage Multiple Classification Codes  
If your administrator has enabled the Multiple Classification Codes option and you have edit access to your account,
then you can add or remove multiple industries and organizations for your account.

This gives you the flexibility to assign the most accurate industry and organization type to your account that provides
greater accuracy for account qualification and territory assignment. You can assign primary as well as secondary
industry and organization type values to your account.

You can also load your own industry and organization classifications and use them to qualify your accounts. When an
account is assigned multiple classification values, you have the option to use all the values to determine territory and
rule-based assignment for accounts, or you can use only the primary account classification.

When you remove the primary organization type, then the application sets the next available organization type in the
hierarchy as the default organization type. If there isn't any organization available, then there is no default organization
attached to your account. Similarly, when you remove the primary industry code, then the application sets the next
available industry code in the hierarchy as the default industry. If there isn't any industry code available, then there is no
default industry attached to your account.

View Your Accounts in Slack  
Slack is a team communication tool that facilitates synchronous communication across different devices. Regardless of
whether your team is co-located or distributed, Slack provides an effective communication channel that's easy to use.

Let's say you're traveling and you would like to quickly view a list of the first five accounts owned by you. You can do this
on Slack using any device, without signing in to your sales application. This is very handy when you're on the go.

Note:  The only criterion is that your administrator has set up the integration of Slack with your sales application.

To view your first five accounts on Slack:

1. Navigate to your workspace in Slack.
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2. Select one of the following:

◦ Any public channel in the Slack workspace

◦ Slackbot

◦ Oracle Sales Slack app: This refers to the app that your administrator has created in Slack for integrating
with your sales application.

Note:  Due to security restrictions, you can't view your accounts if you select the following:

◦ Private channels

◦ Any user under direct messages

3. Enter the following command at the command line: /ec-my-accounts
4. Press the Enter key.

The first five accounts that you own are displayed in Slack. The following fields are displayed for each account:

◦ Name: This is the account name.

◦ Account Address

◦ Primary Contact

◦ Contact Phone: This is the primary contact's phone.

◦ Contact Email: This is the primary contact's email.

Note:  Every sales representative who executes the /ec-my-accounts command can see only the accounts owned by
him or her. You can't view the accounts owned by other sales representatives.

View and Manage Account Hierarchies  
You can use sales applications to view and manage your account hierarchy. You can access the account hierarchy from
the Manage Account Hierarchy link on the Account Overview page.

You can view both a graphical chart view and a table view for account hierarchies by clicking the view icon to alternate
between views. Here's what you can do with the chart view and table view.

Chart View Table View

See the hierarchy and the current active
hierarchy version.
 

See the hierarchy and the current active hierarchy version.
 

Use the Control Panel tools to change
the hierarchy layout, move the hierarchy
around, center the hierarchy in the view,
 and increase or decrease the amount of
zoom.
 

See the transactions associated with each node in the hierarchy. The transaction details region shows a
list of associated contacts, open opportunities, open leads, team members, and assets.
 

Use the scroll arrows to see the following
customer information:

Add or remove a node from the hierarchy (with the exception of the currently selected account).
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Chart View Table View

 
• Number of open opportunities

• Number of won opportunities

• Number of leads

• Number of contacts

• Number of team members

• Number of assets (value)

• Customer type

• Industry for the account

• Primary contact information

Use the scroll arrows to see the following
information for prospects:
 

• Customer type

• Industry for the account

• Primary contact information

Add an account to the hierarchy. You can add only one account to a given account hierarchy.
 

See the parent and children for the
selected account. You can see up to five
nodes for each level, and you can navigate
through and expand each level in the
hierarchy
 

Click and move a node (and the node's children) to a different hierarchical level.
 

Add an account to the hierarchy.
 

Print the hierarchy and export it to Microsoft Excel.
 

Add a Parent Account
For a new account, associate a parent account in the Account Profile tab of the Edit Account page. Remove the
association with a parent account using the delete icon and select another account from the available list of values.
When you add a parent account it creates a parent-to-child hierarchy between the two accounts. Here's how you can
associate a parent account to a selected account.

1. Click Accounts, and select an account to edit from the list.
2. Click the Profile tab.
3. Click the Search link from the drop-down list in the Parent Account field.
4. On the Select Parent Account page, search for and select the account that you want to add as a parent.
5. Click OK.

You return to the Profile page and the associated parent account displays as a link in the Parent Account field.
The link lets you navigate to the details of the account.

Manage Account Hierarchy
You can only add or remove child accounts in the Manage Account Hierarchy page. Create a hierarchy for your selected
account with these steps:

1. Click Accounts, and select an account to edit from the list.
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2. On the Edit Account Overview page, click the Manage Account Hierarchy  link.
3. The selected account displays in chart view on the Manage Account Hierarchy page. You can use the view icons

to switch between Chart and Table views.
4. From the Action menu, select Add Child.
5. Search for and select the child account you want to add.
6. (Optional) Continue adding accounts to your hierarchy.
7. Click OK after selecting the account.
8. Click OK to exit the Manage Account Hierarchy page to save the association and return to the Edit Account

Overview page.
9. Click Save and Close to return the Accounts list page.

View Ultimate Parent Account from Account Overview Page  
Get quick access to account information on the Account Overview page. View the ultimate parent and parent account
associated with the account that you're working on.

In an account hierarchy, the top account is the ultimate parent, and the parent account is the immediate parent to a
particular account. You can continue to manage the parent account from the Account Profile page.

Account Team Territories  

Account Territory Member Access  
Access for the territory owners and members are the same as that of the team members.

These access levels control the internal and partner territory privileges for the account:

• Internal territory owner: Full access

• Internal territory members (nonowner): Edit access

• Partner territory owner and members: View-only access

Note:  You must implement Territory Management before you can access territory owners.

Related Topics

Account Team Member Access Levels  
Access levels control the team member's privileges for the account.

There are three types of account team membership access levels:

• View Only

• Edit

• Full
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When you add a resource to the account team, a profile option setting determines the member's default access level. If
the member is removed from the account team, then that member no longer has access to the account. Only a member
of a territory who's assigned to an account retains access. Resources in the management hierarchy of a newly added
team member inherit the same access level of the subordinates. Resources in the management hierarchy of a newly
added team member inherit the same access level of the subordinates.

View Only
View Only is the minimum level you can assign to team members. Team members with View Only access can view
details of the account, such as: account team, assessments, notes, and activities. The team member's resource role
doesn't provide functional access to view a particular child attribute of an account. Without functional access a member
can't view the attribute, regardless of their account team access level. The data security inherent on objects, such as
leads and opportunities, determines whether team members can view details of that business object.

Edit
Team members with the Edit access can view and edit all customer-related objects. The data security inherent on
objects, such as leads and opportunities, determines whether team members can view details of that business object.
They can also run the territory reassignment process, but they can't change the composition of the account team.

Full
With Full access, team members can perform edit access functions and also change the composition of the account
team. Initially, only the account owner and sales administrators have Full access, but they can grant Full access to other
team members. Team members with Full access can do the following for other members:

• Manually add and remove other team members

• Change a member's access level

• Mark the lock assignment setting

Note:  Team members must have Full Access to edit Account Profile and Household Profile pages.

Contact Management  

Overview of Contacts  
Any person can be a contact and that person doesn't have to be related to an account. Use Workspace to access your
accounts and contacts. For sales applications that aren't available in Workspace, use the landing pages.

Create Contacts
You can create contacts in these ways:

• Create directly in sales applications

• Import contacts using import management

• Use a web service to create a contact
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Note:  If your sales application is integrated with Microsoft 365, then you can also create contacts using that
application.

When you create a contact, existing contacts are checked for duplicate entries. If there's a match, you can select from
the duplicates or continue creating a new contact. You can also search for relationships and edit them.

When you create or update a contact, the address field isn't mandatory by default. Depending on the country that you
choose, some fields are made mandatory. For example, if you select United States, then you must enter the address.
When you create a contact for an existing account, you can default the account address as the contact address. This
saves time during creation. Note that the primary address of the account is copied but this doesn't copy the address
type (for example, Bill To address, Ship To address and so on) to the contact address.

Manage Contacts
Use contact management capabilities to search for, create, update, delete, merge, and enrich contacts.

Here's a description of what the tabs do on the Contacts Overview page.

Contact Tabs Description

Overview
 

Provides a general overview of the contact, open opportunities, quotes, open leads, active contracts,
 assets and recommendations, and activities.
 

Profile
 

Gives a complete picture of the contact, including all the customer relationships associated with the
contact.
 
When a customer has multiple contacts, you can designate which contact is the primary contact from
the customer's profile page. This designation means that the selected contact is the primary means
of communication with the customer. You can also include a picture of the contact in the Additional
Details region.
 
You can capture important contact details, including job title, influence level, affinity, and buying role.
These help build the relationship matrix for the account and ensure that you have made the right
contacts in the account organization to win the deal. Here you can also:
 

• Add an account.

• Update and verify addresses.

• Mark a contact as a favorite contact.

Team
 

Lets you to view and add team members to the contact or the account associated with the contact. For
a B2C account, you can also see and add territories.
 
You can manually run territory assignment for the contact through the Run Assignment process. The
assignment action is enabled for the type of contact enabled for assignment.
 

Assets
 

Shows a list of assets for the contact. The tab is visible only if the contact is of type, customer.
 

Contracts
 

If your administrator has enabled this tab, then you can view contracts associated with the contact.
Depending on your access, you can also preview the contact in a PDF format.
 

Opportunities
 

Lets you add, view, drill down, and update opportunities for the contact.
 

Leads Lets you add, view, drill down, and update leads for the contact.
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Contact Tabs Description

  

Relationships
 

Lets you add account relationships to other account or contacts that aren't directly related to the
account, but are influential. You can add the same contact to multiple accounts using different
relationships.
 
You can't edit a role after you have added a relationship. To update the role, delete the existing
relationship and create another relationship with the wanted role.
 

Notes
 

Lets you add, view, and edit notes for the contact.
 

Assessments
 

Lets you add and view assessments for the contact. You can execute assessments to assess the
strength of the contact against the deal.
 

Activities
 

Lets you add and view appointments, tasks, and call logs.
 

You must enable these tabs using
Application Composer:
 

 

Interactions History
 

View the past interactions with a contact including calls, chats, and emails.
 

Service Requests
 

View and add service requests.
 

Installed Base Assets
 

View and add installed base assets. These are customer owned products from the organization's
product catalog.
 

Campaigns
 

View and add contacts to sales campaigns.
 

Analytics
 

Access key insights and metrics for all aspects of your sales organization.
 

Billing Accounts
 

View financial accounts created for the account in accounts receivable.
 

Reference Systems
 

View or add source systems. A source system reference is a unique ID that lets you maintain a record of
the source of the data in sales applications.
 

Industries
 

View and add industries for the account.
 

Related Topics

Use Contact Preferences  
You can manage the contact preferences for your accounts and contacts from the All Phones and All Emails pop up
window. You can access them from the Profile tab of Edit Account and Contact pages once the administrator has
enabled the fields.
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You can add multiple phone numbers and designate a usage such a home, mobile, work. Additionally, you can set
preferences to capture customer consent by selecting the OK to Call check box. If the customer has requested not to be
contacted on certain phone number or email, you can select the Do Not Call check box.

Manage Account Contacts  
When you create an account, you can select a contact as the primary contact. This contact is shown in the Contacts tab.

You can add or view the contacts in the following ways:

View Description

List View
 

Shows the available contacts in a tabular format. Each line represents an account and the table
structure represents the hierarchy. By default, the hierarchy shows all the parent levels and the
immediate children of the account.
 

Diagrammer View
 

Shows the available contacts in a graphical view in a hierarchical format. You get a quick snapshot of
how these contacts are related to each other in the organization. The node that represents the current
account is emphasized. By default, the hierarchy shows the immediate parent and children of the
account.
 

Note:  The Influence Level field appears after you add a contact to an account and save the account. The field is
available in the Contacts subtab of an account. Influence level lets you indicate the decision-making authority a
contact has in the organization.

Personally Identifiable Information  

About Personally Identifiable Information  
The data or information that's used to uniquely identify a contact or locate a person is called personally identifiable
information (PII). The information includes social security numbers, addresses, bank account numbers, phone numbers,
and so on.

PII is considered confidential and sensitive and is protected to prevent unauthorized use of personal information.
Sensitive PII is information which, when disclosed, could result in harm to the individual whose privacy has been
breached. Aspects of protecting PII include legal regulation, financial liability, and personal reputation. In the sales
application, the PII data is secured and only authorized users can access sensitive information. For example, only
authorized users are granted access to the social security numbers of people stored in the database. Administrators can
find setup information about PII in the Implementing Sales guide.
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Related Topics
• Overview of Contacts

• Manage Personally Identifiable Information

Household Management  

Overview of Households  
A household is a group of contacts generally sharing a common link or association.

Households provide valuable segmentation information about the household as a whole, as well as summary of
information about the household member contacts. Usually all the contacts reside at the same address and have a
similar set of entities that accounts do, such as team members, territories, and contacts.

Create Households
Here's how you can create households:

• Create directly in sales applications

• Import households using Import Management framework

• Create households using Web Services

Manage Households
Use household management capabilities to search for, create, update, and delete households.

Here's a description of the household tabs.

Household Tabs Description

Overview
 

Provides a general overview of the household, opportunities, active contracts, open leads, products,
 and activities.
 

Profile
 

Provides household-related details such as address and contacts.
 
Here you can also:
 

• Assign head of the household

• Update and verify household address

Team
 

Shows team members and territories that are part of the household. Here you can also:
 

• Add team members

• Add partner territories
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Household Tabs Description

Note:
You can manually run territory assignment for the household through the Run Assignment process.
The assignment action is enabled for the type of household enabled for assignment.
 

Assets
 

Enables you to add and view assets for the household.
 

Opportunities
 

Enables you to add and view opportunities for the household.
 

Leads
 

Enables you to add and view leads for the household.
 

Relationships
 

Enables you to add relationships to other households or contacts that aren't directly related to the
household but are influential. Review the relationships in the following views:
 

• List view

• Diagrammer view

Notes
 

Enables you to add and view notes for the household.
 

Assessments
 

Enables you to add and view assessments for the household.
 

Activities
 

Enables to add and view appointments, tasks, and call logs.
 

Contracts
 

If your administrator has enabled this view, then you can view contracts associated with the household.
 
If you have the appropriate access, then you can also preview the contract in a PDF format.
 

Related Topics

Household Relationships  
Relationships can be household contacts, such as parent, spouse, or child. Relationships can also be of other types, for
example a bank that has a financial dealing with the contact and so on. The other relationships can be of type person,
group, or organization.

The Relationships tab includes:

• Contacts: household members as the immediate beneficiaries.

Note:  If you have selected a primary contact, then it's included as a household contact, by default.

• Other relationships: other relationships of type person, group, or organization.
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Review relationships in the following views:

• List view: This view shows the available relationships is a tabular format.

• Diagrammer view: This view shows network visualization of the relationships. The visualization can show up to
four levels of connections. By default, the connections are shown up to the second level.

Your administrator must enable this view.

List View
The list view is the default view. It contains two tables; Household Contacts and Other Relationships.

The list view table displays household members who are your immediate beneficiaries. The other relationships table
shows other relationship that may not be your direct beneficiary. By default, both the tables are sorted by name.

Diagrammer View
Diagrammer shows a graphical representation of the contacts and other relationships that the household has.

The visualization can display up to four levels of connections. By default, the connections are shown up to the second
level. Each node in the graph represents an account or a household and each link between nodes represents a
connection between them.

Searches  

Manage Contact Saved Search Lists  
Here's how to manage your contact saved search lists in the Contacts page.

You can't edit or delete the preconfigured saved lists or any user-defined lists added by your administrator. You can
modify these saved searches to match your requirements, and then create a new saved search.

The Contacts page includes four predefined saved searches that let you filter the contacts you view in the page:

• My Contacts: Displays all contacts, of the type sales account, that you're an owner of.

• My Favorite Contacts: Displays all your favorite contacts.

• My Team and Territory Contacts: Displays all contacts, of the type sales account, where you're on the account
team member or you're on the account territory resources.

• My Business Contacts: Displays all contacts belonging to all the accounts you own.

Create a Saved Search
Here's how to create a saved search:

1. From the List menu, select Create or Edit Lists.
2. In the Saved Searches window, use the filters to modify your search, and click Search.
3. Click Save.
4. In the Create Saved Search window, enter a name for the saved search.
5. Click OK.
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Use Search Mode on Account or Contact Creation Page  
You can verify an address in the search mode while creating a new account. Search and select from multiple similar
addresses when verifying account or contact addresses from the Oracle Address, Email, and Phone Verification.

Select the most appropriate address from a list of similar verified addresses.

To verify an address:

1. On the Contacts landing page, click Create Contact.
2. Enter the name, address lines, state and postal code.
3. Click Verify Address.

A list of similar verified addresses appears.
This image shows an example of how a list of similar verified addresses appears in the page. The image shows a list of

addresses you can select from. 

Related Topics
• How You Enable Search Mode for Oracle Address, Email, and Phone Verification

Use Standard Fields to Search Records  
You can search and associate records for account, contact, household, and asset with a list of values and use data that's
relevant to their business.
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You can use standard fields to search and view them in the search results, where you can find and select the relevant
record.

Note:  MDM administrators can configure a data quality score based on the completeness and attribute values of a
customer profile. You can then use a batch process to assign and maintain the score as an attribute of the account
profile. After the scores are calculated, the sales accounts can be sorted using the Profile Quality Score field in saved
searches. Records with highest scores have better data quality and are identified as the master records. For more
information, see the Customer Profile Quality Score topic.

Record Integrity  

Resolve Duplicate Accounts and Contacts  
You can resolve duplicate records as you create accounts and contacts, if the administrator has enabled the
functionality. Resolving duplicate records ensures that clean customer data is available as you create, maintain, and use
customer records.

Since multiple salespeople can create and update the same accounts and contacts, the potential exists for duplicate
records in the application. You can view and act upon duplicate accounts and contacts as you create new records, if the
ability is enabled by your administrator.

When you create an account or a contact, the application searches for duplicate accounts or contacts based on one of
these conditions:

• The data quality rules established for accounts and contacts

• An exact name match

If the application finds duplicate accounts or contacts, then the application displays the records in the duplicate
notification page. You can either ignore the duplicate accounts and contacts and continue creating the record, or you
can select the correct account or contact from the list that's displayed.

Related Topics
• How can I make merge requests?

Phone and Email Verification  

Verify Email Addresses and Phone Numbers  
When your sales organization subscribes to the Oracle Address, Email, and Phone Verification service, you know right
away if you entered an invalid phone number or email address.

The application can't check if the phone numbers and emails you enter are valid for the specific person or account, of
course, but it does assure that a phone number will actually dial and that an email won't bounce.
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When a phone number or an email address is invalid for some reason, you get notified right under your entry. If nothing
appears, the information is valid and you're good to go. Here's a screenshot of an invalid phone number to give you an
idea of what you see under invalid information:

Callout Number What You See

1
 

Status. For phone numbers, this can be only Invalid. Email addresses can also display the status of
Partially-Valid: the domain is valid but the name isn't. If the person left the company, or changed their
name, you'll see the Partially-Valid status for the email, for example.
 

2
 

Date the email address or phone number was verified by the application.
 

3
 

Reverify button that you can use to verify again. You never know when area codes or email addresses
may change. What's valid today may not be in six months.
 

4
 

Overwrite button to manually set the status. The application, isn't perfect. If you know the number or
email is correct, you can set the status to Verified. When you do, you see Overwritten on instead of
Verified on.
 

Although the application doesn't display a Valid status for valid entries right away, you do eventually see it together
with the date the information was verified. (How much later is under the control of the application administrator). Why
display the status at all? When the information is old, you or your colleagues may want to verify it again by clicking
Reverify.

Manually Override Email and Phone Verification Status  
Services aren't infallible. If you don't agree with the verification status for the email address or phone number, you can
override it by clicking Overwrite (the double arrow icon highlighted below).

Reverify Email Addresses and Phone Numbers  
You can verify if a phone number or an email address is still valid by clicking Reverify (the arrow highlighted in the
screenshot).
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Data Enrichment  

Overview of Data Enrichment  
A key requirement in the lifecycle of a customer record is keeping the data clean, accurate, relevant, and easily
accessible. You can enrich accounts using Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) or Oracle
DataFox.

You can use different options to enrich your accounts:

• Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) to enrich your accounts and contacts.

• Oracle Address, Email, and Phone Verification to verify your account and contact addresses.

• Oracle DataFox to enrich your account data and increase your sales.

Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B)
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) provides the most up-to-date company and contact
data from Dun & Bradstreet Corporation.

You can use Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) to enrich account and contact data in
sales applications, including:

• Individual accounts and contacts

• Lists of accounts and contacts

• New contacts from any Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) enriched or
imported accounts

Oracle DataFox
Use Oracle DataFox to enrich your accounts and learn more about your customers. Information about your accounts
come from third-party data and real-time signals from Oracle DataFox.

Related Topics

Use DataFox Smart Data When Creating Accounts  
If your administrator has enabled DataFox smart data and enrichment, you get suggestions that match the account
name you're trying to create and get accurate information related to the account.
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Let's create an example account to learn how the DataFox smart data works.

1. Navigate to Sales > Accounts.
2. Click Create Account.
3. Use the search field to search for an organization by its name.

DataFox searches for the best matches and shows you a list of organizations along with their logo, name, and
location.

4. Select the one you're looking to add, for example, Pinnacle Business Systems located in Edmond.
DataFox fills in the Account fields with all the available company details.

5. Click Save and Continue.
The application searches for any duplicate accounts. If there aren't any, your account is created. The account
party number is saved as Registry ID in DataFox.
The Registry ID links the sales application and DataFox. Whenever the DataFox enrichment scheduled process
runs, the account in the sales application is enriched.

6. You can add other account details such as team, contacts, assets, opportunities, quotes and orders, leads,
relationships, service requests, notes, and activities.

7. Click Save and Close.

Enrich Accounts with DataFox  
You can profile and classify your customer base with account insights that you get from Oracle DataFox. Your accounts
are enriched and refreshed daily with the latest data.
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You can use your enriched accounts to:

• View up-to-date account data in the Accounts page so you can have complete information about the account.

• Act on high-scoring prioritized accounts and focus your efforts on prospecting top accounts.

• Expand your target market by identifying new companies to sell to.

Synchronize and Enrich Your Accounts
You can enrich each account in your sales application using DataFox. To enrich a new account, first create and save the
account, and then edit the account to enrich it.

Here's how you enrich existing accounts:

1. Sign in as a sales user.
2. Click Navigator > Sales  > Accounts.
3. Click an account that you want to edit.
4. In the Edit Account page, click Actions > Enrich Account.

A confirmation message appears stating that enrichment is in progress.
5. Open the Account Profile page and verify the enrichment status.

Contact Oracle Support to synchronize and enrich all your existing accounts with companies in DataFox. To synchronize
and enrich individual companies within DataFox to your accounts, see the topic Sync and Enrich Your Account in the
Using Oracle DataFox guide.

For information on how you enrich with DataFox, see the topic Enrich Oracle CX Sales in the Using Oracle DataFox
guide.

Enrich Accounts and Contacts with Oracle Account and Contact
Enrichment by Dun & Bradstreet  
You can enrich account and contact records, including enriching multiple records at once, from within your sales
application. Use the overview pages to enrich single records and use the landing pages (also called list pages) to enrich
multiple records.

The enrichment capabilities leverage Oracle Account and Contact Enrichment by Dun & Bradstreet to enrich your
accounts and contacts with the latest information available from Dun & Bradstreet.

Enrich Single Accounts and Contacts from the Overview Page
Use the Actions menu in the account and contact overview pages to enrich a single account or contact record. When
you enrich a single account or contact, the application displays a list of attributes available for that record with side-by-
side values for both Sales and the Oracle Account and Contact Enrichment by Dun & Bradstreet. You can accept part or
all of the attribute values from Oracle Account and Contact Enrichment by Dun & Bradstreet.

Here's how to enrich an account or contact.

1. From your Accounts or Contacts list page, select the record you want to enrich.
2. On the Overview page for the record, select Enrich Account or Enrich Contact as required from the Actions

menu.
3. On the Select Fields to Enrich dialog box, select the Oracle Account and Contact Enrichment by Dun &

Bradstreet values you want to add to the record, and click Enrich.

130



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 9
Accounts, Contacts, and Households

A confirmation message states that the enrichment was successful, and you return to the record's overview
page showing the enriched information.

Add New Contacts to a Previously Enriched Account
You can add new contacts to a previously enriched account. To add new contacts, on the Contacts tab, click Get
Contacts from the Actions menu.

When you start adding enriched contacts to an account, the application displays a list of contacts available for download
from Oracle Account and Contact Enrichment by Dun & Bradstreet. You can choose to see these contacts grouped by
job level or by location, and you can choose to add the contacts by job level, job location, or both.

Enrich Accounts and Contacts from the List Page
You can enrich multiple accounts, and the contacts associated with the accounts, from within your sales application.

The Enrichment Results page lists the selected accounts and the enrichment status of each. Use the Actions menu
on the Accounts and Contacts landing (list) pages to gain access to the enrichment capabilities and to enrich multiple
accounts or contacts at one time.

Note:  The match threshold confidence score automatically matches and enriches the record.

When you select multiple accounts, the application automatically enriches the records and displays the results. The
result information shows the records enriched and the status of each record. When you select multiple accounts or
contacts for enrichment, you see an indicator showing enrichment progress.

1. Navigate to the Accounts or Contacts list pages.
2. Select the Enrich option from the Actions menu. In the Create Account flow, the option is named Enrich

Account.
3. Select the records you want to enrich.

Note:  You can add only five new account records. For contacts, you can enrich only those which are
associated with enriched accounts.

4. Select the existing value or the Oracle Account and Contact Enrichment by Dun & Bradstreet value for each of
the fields.
As you enrich multiple accounts or contacts, you can't select which attributes to enrich.

5. Optionally, click Hide Identical Values to hide the fields where the sales data is the same as Oracle Account and
Contact Enrichment by Dun & Bradstreet data.

6. Click Enrich.
After the confirmation message, you return to the account or contact list page, and the additional information
now appears for the selected records.

After completion, review the enrichment summary report for details about:

• Records Selected

• Records Enriched

• Record with Multiple Matches

• Records with No Match

• Records Failed
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Attributes You Can Enrich
Here are the supplied attributes you can enrich:

Record Type Supplied Attributes

Account
 

• Company Name (not Sales Account Name)

• Current Fiscal Year Potential Revenue

• Primary Street Address

• Duns Number

• Line of Business

• Public Private Ownership Mark

• Stock Symbol

• Year Established

• Location Type

• Primary Address 1

• Primary Address 2

• Primary City

• Primary County

• Primary State

• Primary Postal Code

• Primary Postal Plus-4 Code

• Mailing Address 1

• Mailing Address 2

• Mailing City

• Mailing State

• Mailing Postal Code

• Mailing Postal Plus-4 Code

• Phone

• Fax

• URL

• Trade Style Name

• Major Industry

• North American Cartographic Information Society (NACIS) Classification

• SIC Classification

Contact
 

• Prefix

• First Name

• Middle Name

• Last Name

• Job Title
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Record Type Supplied Attributes

• Gender

• Suffix

• Work Street Address 1

• Work City

• Work State

• Work Postal Code

• Work Postal Plus-4 Code

• Work Country

• Contact Work Phone

• Contact Phone Extension

• Email Address

• Department

Administrators can use the Manage Oracle Data as a Service Attribute Mapping and Preferences task to determine
which attributes to enrich.

Add Accounts from Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B)  
When creating a new account in a sales application, you can search for the latest company information in Oracle
Account and Contact Enrichment by Dun & Bradstreet (D&B).

Use the filter criteria to search and add accounts. If you select an existing sales account to be added from Oracle
Account and Contact Enrichment by Dun & Bradstreet (D&B), then those accounts are enriched.

Add the selected (one or more) accounts and their contacts as new accounts. You can create a maximum of five real-
time accounts. You can use the advanced search for adding the account search filter criteria that are searchable in
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B), for example:

• County

• Created By

• Creation Date

• Current Fiscal Year's Potential Revenue

• D&B Credit Rating

• Data Confidence

• HQ Branch Indicator

• Global Ultimate D-U-N-S Number

• Domestic Ultimate D-U-N-S Number

To add accounts from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B):

1. Sign in as a sales representative.
2. Click Navigator >Sales> Accounts.
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The Accounts page appears.
3. From the Actions menu, click Add Accounts from Data Cloud.

The Get Accounts from Data Cloud: Select Accounts page appears.
4. Click the Show filter icon.

The Advanced Search pane appears.
5. Click the Data Cloud Accounts tab.
6. Add filters or attributes that are searchable such as Revenue, Industry Category.

The accounts are created and you receive a message stating the results.
7. Click View Results on the Account Creation: Results page.

A list of newly added, enriched, or failed to create or enrich accounts displays.
8. Click Done.

The View Results page is closed and the Get Accounts from Data Cloud page displays.
9. Add contacts to the newly created accounts.

10. Click Add to add more filter criteria by adding attributes to view Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B) searchable attributes.

The Data Cloud Accounts filter is available on the Advanced Search pane.
11. Verify that the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) usage is tracked for

successfully created accounts.

Overview of Using Smart Data for Account and Address  
You can use "smart data" to create accounts, add or edit an account, and add or edit a contact address.

Smart data for accounts is available on the Create Account page. Smart data for addresses is available on create or edit
pages for accounts and contacts. The highlights for smart data are:

• Use autosuggestion when searching and selecting verified companies using Oracle Account Enrichment Cloud
Service. This feature automatically fills over 90 company attributes into appropriate fields.

• Minimize the use of clicks and keystrokes during account entry in the account creation flow in CX Sales.

• Use autosuggestion when searching and selecting verified addresses using Oracle Address, Email, and Phone
Verification.

• Add or edit addresses across CX Sales for accounts and contacts.

Smart data is ready to use in the application without any additional setup. Smart data for accounts requires a license for
Oracle Account Enrichment Cloud Service, and smart data for addresses requires a license for Oracle Address, Email,
and Phone Verification.

Use Smart Data for Accounts
Smart data lets you to search and select validated Dun and Bradstreet accounts using autosuggestion functionality.
Smart data provides you with enriched, validated data without data entry issues.

Validated global accounts improve the completeness, accuracy, and integrity of data. For validated accounts, the
account data gets automatically populated into the fields, allowing you to quickly create an account without typing in
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account details. This improves efficiency and user experience when creating accounts. Additional benefits of smart data
are:

• Search in real time to predict and fill more than 90 company fields with accurate and validated data.

• Specify country or address details using autosuggestion.

• Save time searching and filling in data.

• Avoid errors when filling in data.

When you create an account, enter the name of the account in the search field (first text field you see on the Create
Account page). Automatically, possible accounts appear. The matching accounts list is rendered based on company
revenue. You can see the account name, location, revenue, and employee size of the matching accounts. You simply
select the appropriate account and the application automatically fills in the details for you.

Here's a screenshot showing the matching account names rendered by the smart data of D&B that show additional
details such as revenue and employee size.

Use Smart Data for Addresses
Smart data for addresses provides you with addresses and automatically enters complete data for you. When using
Smart Data for the Address, the Country dropdown on the Address region doesn't have any effect on the search using
Smart Data feature.

The benefits of smart data for account and contact addresses are:

• You type in a partial address and the application automatically suggests addresses for you.

• When you type more characters, the application automatically narrows the results.

• Select the address to automatically populate validated data.

Select appropriate options and all the details are populated with the relevant data.
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Undo Enrichment  

Undo Enrichment of an Enriched Account  
In certain scenarios, you may have to undo enrichment of a Dun & Bradstreet (D&B) or DataFox enriched account and
associate it again with Oracle Account and Contact Enrichment by Dun & Bradstreet or DataFox to get the right updates
for your account.

Let's see some examples:

• In the UK, when a private limited company goes public, D&B creates a new company record with a fresh DUNS
number, and it obsoletes the old DUNS number and records of the company. In such a case, you have to restart
the enrichment to get the latest updates for your account.

• In a rare case, enrichment can result in an incorrect operation and a Sales account is updated with incorrect
D&B or Oracle DataFox company data.

In such cases, you can undo the existing enrichment and redo it so that right data is updated in the Sales account
records. Here’s how you undo enrichment:

1. 1. Go to Navigator  > Sales > Accounts.
2. 2. Select a D&B or DataFox enriched account you don't want to enrich any longer.
3. 3. On the Accounts page, click Actions and select Undo Enrichment.
4. Save your changes.

Note:
• After undoing the enrichment, your account unlinks from D&B or Oracle DataFox, but the old data remains.

Redo the enrichment so that the latest data from D&B or DataFox replaces the old data.

• The enrichment sync jobs won't run for accounts unlinked from enrichment.

Mass Update  

Apply Mass Update to Accounts and Contacts  
You can use the mass update feature to update multiple fields at once on accounts and contacts. For example, you
might want to change the primary contact or owner on multiple records without having to go into each record and make
the changes.
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Among the fields that you can update for accounts are:

• Type

• Primary Contact

• Owner

• Industry

• Sales Profile Status

Among the fields that you can update for contacts are:

• Favorite Contact

• Job Title

• Prefix

• Account

• Owner

Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple accounts or contacts at once:

1. Navigate to the Accounts or Contacts landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.

◦ You can't apply mass update to conditionally updatable fields.

6. When you're done making updates click Submit.

Related Topics
• Enable Mass Update of Records

FAQs for Accounts, Contacts and Households  

Frequently Asked Questions (FAQs) for Accounts, Contacts, and
Households  
This section contains some frequently asked questions (FAQs) when working with accounts and contacts. Scroll or
search to find answers to common questions.

137

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20057973


Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 9
Accounts, Contacts, and Households

Which accounts are shown in My Accounts?  
When you select the My Accounts list in the Accounts work area, the application displays a list of all of the accounts
where you're listed as the account owner.

You're automatically the account owner if you create the account or are designated as the owner by an application
administrator.

What are all the search options on accounts?  
Use Workspace from the home page to access your accounts and contacts and search records. The record sets in the
Saved Searches window restrict your saved searches to different sets of accounts.

For example, the default My Accounts saved search, searches the Records I own record set, listing all of the accounts
you created or are assigned to as an owner.

Here's a list of the record sets for accounts. Not all record sets are available to all users. For example, the record sets
involving subordinates are available only to managers.

Record Set Name Description

Records I own
 

Accounts you own. You're the account owner if you created the account or if ownership was assigned
to you.
 

I am on the team
 

Accounts where you're on the account team. You're on the account team if you're the account owner or
were added as a member by another team member.
 

My territory
 

Accounts within sales territories you own or are listed as a member.
 

My subordinates own
 

Accounts owned by you and your subordinates.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

My subordinates are on the team
 

Accounts where you or your subordinates are on the account team.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

My territory hierarchy
 

Accounts in your sales territories and all of their subordinate territories in the sales territory hierarchy.
 

I am on the team or territory Accounts where you're either on the account team or a member of the sales territory.
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Record Set Name Description

  

My subordinates are on the team or
territory
 

Accounts where you or your subordinates are either on the account team or the sales territory.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

All records I can see
 

Accounts that you can view based on your account team membership, sales territory assignments,
 your position in the organization, and security permissions.
 

Tip:  To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather
than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches
to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

Related Topics
• Saved Searches

• Find an Item in the List of Search Results

• Create Saved Searches in Workspace

Why didn't search using the Contains option return the expected
search results?  
If the records aren't properly indexed, the search results of search queries using Contains option, may not be as
expected. To index the records, run the Optimize CRM Search Indexes and Synchronize CRM Search scheduled
processes.

If these scheduled processes are already scheduled, ensure that the user who scheduled them is still active. For more
information about setting up searches, see the Related Topics section.

Related Topics
• Overview of Work Area Search Setup

What should I do if I can't search an address in the UI with DaaS
integration?  
You can check if the address is a valid one in the US Postal Service (USPS) website or any national site for postal
addresses.
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What are favorite accounts?  
Favorite accounts are those that you want to focus on because of business or other reasons. Tag accounts as favorites
when creating or updating accounts, or when viewing the account list. Optionally, create a saved search based on your
favorite accounts.

Optionally, create a saved search based on your favorite accounts.

How can I edit territories directly from accounts?  
Edit territories directly from the accounts that they're assigned to. This lets you review and resolve issues with territory
coverage, such as removing an included account or updating a postal code range.

For the sales operations team, this feature is particularly useful when resolving territory overlap issues, as they can
easily view and update territory coverage and named accounts for a territory. This simplifies the ongoing administration
of territories by giving easy access the territory, team, and coverage details from accounts.

By default, standard territory security applies, enabling administrators to edit any assigned territory from the account.
Sales Managers and VPs can view the assigned territories they own and edit the assigned territories owned by their
subordinates.

Related Topics
• Modify Your Territories

How can I see contracts of an account?  
If you have necessary permissions, you can see the contracts and also download PDFs of individual contracts associated
with an account. Click Preview Contract, to view the contract in a PDF document format.

How can I make merge requests?  
You can create a merge request when you have duplicate records pointing to the same customer, and you want to
consolidate those records into one. An approved merge request results in one surviving record.

The status of all other duplicate records changes to Merged. You can select to merge two or more customer records
from the customer list on your Customer home page or in the customer search results.

Since the sales application Customer Data Hub processes all merge requests, you must implement Customer Data Hub
and set the profile option Merge Request Enabled to YES to make this feature available.
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Can I specify multiple accounts or contacts that I want to merge?  
Yes. You can select and submit a request to merge multiple accounts or contacts into a single surviving record.

Use the landing page for accounts or contacts to submit a merge request.

What happens when I remove the primary industry code?  
The application sets the next available industry code in the hierarchy as the default industry. If there isn't any industry
available, then there is no default industry attached to the account.

What happens when I remove the primary organization type?  
The application sets the next available organization type in the hierarchy as the default organization. If there isn't any
organization available, then there is no default organization attached to the account.

Can I delete accounts that belong to a hierarchy?  
You can't delete an account if the account is the ultimate parent (the root node) in an account hierarchy. However, you
can remove the account as the ultimate parent in the hierarchy and then delete the account.

You can delete an account that's in the middle or at the lowest subsidiary (the leaf node) of an account hierarchy.
The deleted account is no longer shown in the account hierarchy. The deleted account's sub accounts, if any, become
separate hierarchies.

Related Topics

What happens when I delete an account?  
When you delete an account, the entire record is removed from the sales application and can't be restored.

In general, when you delete an account:

• The account party status becomes inactive in the database.

• The deleted account doesn't appear in the accounts list, account search, account list of values, account data
quality match, segmentation, and recent items.

• The deleted account's profile and children, such as attachments and notes, can no longer be viewed.
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• The account's contact relationships, if any, are deleted. The contact can still be viewed, but deleted contact
relationships aren't shown in the contact.

• Deleting an account doesn't delete account-related objects, such as opportunities, leads and tasks. You can
still view related objects and the account name on these objects, but you can no longer access the deleted
account's details.

Related Topics

How can I transfer the ownership of an account?  
You can either manually update the account with new user as the owner or apply a mass update to the account.

What contacts are shown when I select My Contacts, My Favorite
Contacts, and My Business Contacts?  
Selecting the My Contacts list in the Contacts work area displays a list of all of the accounts where you're listed as the
contact owner.

You're automatically the contact owner if you create the contact or you can be designated as the owner by an
application administrator. Selecting the My Favorite Contacts list displays a list of contacts you designated as favorites.

Selecting My Business Contacts displays all contacts for accounts you own. You're the account owner if you created the
account or if an administrator assigned ownership to you.

What are all the search options on contacts?  
The different record sets provided in the Saved Searches window restrict your saved searches to different sets of
contacts.

For example, the default My Contacts saved search, searches the Records I own record set, listing all of the contacts
you created or are assigned to as an owner.

Here's a list of the record sets for contacts. Not all record sets are available to all users. For example, some record sets
are available only if you sell to consumers. Record sets involving subordinates are available only to managers.

Record Set Name Description

Records I own
 

Contacts you own. You're the contact owner if you created the contact or if ownership was assigned to
you.
 

Records where I am on the team
 

Contacts where you're on the contact team. You're on the contact team if you're the contact owner or
were added as a member by another team member.
 

Records my subordinates own Contacts owned by you and your subordinates.
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Record Set Name Description

  

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

Records where my subordinates are on the
team
 

Contacts where you or your subordinates are on the contact team.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

All records I can see
 

Contacts that you can view based on your contact team membership, sales territory assignments, your
position in the organization, and security permissions.
 

Records in accounts I own
 

Contacts in the accounts you own. You're the account owner if you created the account or ownership
was assigned to you.
 

Records in accounts where I am on the
account team or territory
 

Contacts in the accounts where you're on the account team or sales territory.
 

Records in my territory
 

Contacts in your sales territories.
 

Records in my territory hierarchy
 

Contacts in your sales territories and all of their subordinate territories in the sales territory hierarchy.
 

Records where I am on the team or
territory
 

Contacts where you're either on the contact team or the sales territory.
 

Records where my subordinates are on the
team or territory
 

Contacts where you or your subordinates are either on the contact team or the sales territory.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

How can I mark a contact as primary?  
The first contact added to the customer account is considered as the primary contact, by default. You designate a
contact as primary from the customer account.

On the customer's contacts page, you can click the check icon in the Primary column for the contact you want to be the
primary contact. You can't edit the primary contact designation from the contact's Profile page. You must make changes
in the customer's contacts page.
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How can I specify the customer relationships for my contacts?  
You add relationships for a contact in the contact's Relationships tab. If the contact is associated to a customer, you can
also add relationships for the contact from the customer's Contacts page by clicking the contact name and accessing
the contact's Relationships tab.

How can I add a contact photo?  
After your administrator enables the photo field on the profile page, you can attach a photo to a contact's profile.

Here's how to add a photo on the Contacts landing page.

1. On the home page, navigate to Sales > Contacts.
2. Click a contact name.
3. On the Edit Contact page, click the plus icon and select a photo from your computer.

The file name appears on the page.
4. Click Save and Close.

You can see the photo of the contact on the Contacts list page with the card view enabled.

What happens when I delete a contact?  
When you delete a contact, the record is removed and can't be restored.

In general, when you delete a contact:

• The person record of the contact is removed , including all profile data, customer usages, and group
memberships.

• Relationships with associated customers or sales accounts are deleted.

• Contact points or other child objects specific to the customer-contact relationship aren't shown.

• A deleted contact isn't shown or available in any other contact or customer lists. A deleted contact isn't visible
to all contact types (standalone, single, or multiple) including a customer-contact, a consumer or prospect, or in
cases where the contact is both a customer contact and a consumer or prospect.

• Even if you have the functional privilege to delete a contact, you can't delete contacts unless you have full or
edit access to at least one of the accounts associated with the contact.
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Related Topics

What households are shown on selecting My Households?  
When you select the My Households list in the Households work area, the application displays a list of all of the
households where you're listed as the household owner.

You're automatically the household owner if you created the household or you can be designated as the owner by an
application administrator.

What are all the search options on households?  
The different record sets provided in the Records field of the Saved Searches window restrict your saved searches to
different sets of households.

For example, the default My Households saved search, searches the I own record set, listing all of the households you
created or were assigned to as an owner.

Here are the record sets for households. Not all record sets are available to all users. For example, the record sets
involving subordinates are available only to managers.

Record Set Name Description

I own
 

Households you own. You're the household owner if you created the household or if ownership was
assigned to you.
 

I am on the team
 

Households where you're on the household team. You're on the household team if you're the
household owner or were added as a member by another team member.
 

My territory
 

Households in your sales territories.
 

My subordinates own
 

Households owned by you and your subordinates.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

My subordinates are on the team
 

Households where you or your subordinates are on the household team.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
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Record Set Name Description

My territory hierarchy
 

Households in your sales territories and all of their subordinate territories in the sales territory
hierarchy.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

I am on the team or territory
 

Households where you're either on the household team or a member of the sales territory.
 

My subordinates are on the team or
territory
 

Households where you or your subordinates are either on the household team or the sales territory.
 

Note:
Record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
 

All records I can see
 

Households that you can view based on your household team membership, sales territory
assignments, your position in the organization, and security permissions.
 

What happens when I create an account or household that has the
same name and address as the existing account or household?  
The new account or household is suffixed by null and a random number to make the whole name unique. The suffix of
an account or household's unique name is generated from its primary address, which is based on the Party Suffix style.

When the Party Suffix style formats are set to empty in the Manage Address Formats task, then null and a random value
is suffixed.

How can I access user updated values of address fields in groovy
scripts?  
The address attributes that are part of Address object (PartySite record) are reference fields and may not always return
the current updated values.

To always fetch up-to-date values of the address fields, you must access them using the Location object which is child
of the PartySite object.
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10  Activities and Calendars

Overview of Activities and Calendars  
As a sales representative, you typically check your calendar for appointments that you have on any particular day before
you begin your retail visit.

You can plan your day based on the appointments and the notes if any that you have or want to include in your
appointment. After performing your activities, notifications can be sent by email or added to a global notification list so
that you're kept informed of what you've completed.

Here's what you can do when you work with appointments:

• Add resources to an appointment.

• Use appointments to check your schedule and the visits that you need to make.

• Review the details of the visits for an account and plan your tasks for the day.

• Add an account to an appointment and the appointment is assigned to a field sales representative who's the
owner of that account and appears on the assignee's calendar.

• Create notes for any additional information that you may need to record regarding your retail visit.

The activities pages include the My Calendar, My Tasks, and Activities pages. You use these pages to manage tasks,
appointments, and call reports outside the context of a particular record. Within an activity, you can associate the
activity itself with a record, such as a lead or opportunity. Additionally, in some of the sales applications, you can
manage activities within the records themselves.

In the Activities pages, you can:

• Create new tasks and appointments.

• Search for and view tasks and appointments.

• Edit existing tasks and appointments.

• View reports and analytics information.

• Manage your calendar.

• View other sales users' calendars, as well as team calendars, with permission.

• View at-a-glance which tasks are overdue.

Get Started with Activities  
Activities help you keep track of things you plan to do, like tasks and appointments, or things that you need to track, like
customer calls.

Types of Activities
There are three types of activities:

• Tasks are to-do items assigned to people or groups.
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Tip:  You can use tasks to record completed customer interactions that aren't scheduled in your calendar as
appointments.

• Appointments are calendar events, for example, a meeting with another person or a scheduled phone call.

• Call reports let you record brief summaries of you phone calls. They can be created from an appointment, a
task, or standalone from the Activities landing page. When created from a task or appointment, the application
automatically populates all pertinent data into the call report for you.

Collectively called "activities", tasks and appointments can be meetings, calls, demonstrations, events, and so on. The
difference between a task and an appointment is that a task appears in a task list and has a due date and status, while
an appointment is scheduled on your calendar with a specific date and time. For all activities, the Type field lets you
categorize the item. For example, when you create a task you can set the type as a Call or a Meeting.

How You Access Activities
From the home page you can use the Activities landing page, or list page, to access all of your activities. Additionally,
the Activities tab in many of the edit pages lets you access the same functionality as the landing page.

Here are some things to keep in mind about the Activities list:

• Appointment and task icons make it easy to differentiate between the different types of activities.

• You can use the default search filters to quickly find a set of activities, and you can use the additional search
operators to further expand or refine your search.

• Note that in the list of activities, columns may be blank if there's no applicable data. For example, some fields
apply only to tasks and some only to appointments; thus, blank fields appear when there is nothing relevant to
display.

To access a list of Activities from the home page:

1. Sign in as a salesperson.
2. On the home page, click Sales > Activities.
3. Click the Activities tab.

Create New Tasks and Appointments
You can create new tasks and appointments in several ways:

• In the My Calendar page, click Create Appointment to create a new appointment.

• In the My Tasks page, click Create Task to create a new task.

• In the Activities page, click Create Task or Create Appointment.

• Create follow-up tasks or appointments from existing ones: In the Actions menu for the existing task or
appointment, select Create Follow-Up Task or Create Follow-Up Appointment.

• Create tasks or appointments related to opportunities or leads: Navigate to a lead or opportunity and click the
Activities tab. Tasks or appointments you create automatically are associated with the related record.
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Manage Your Calendar
Use the Calendar pages to keep track of all your appointments. You can:

• View your appointments in a daily, weekly, or monthly format, and either in a calendar view or as a list.

• Move appointments from one time and day to another day or time.

• Create new appointments, including recurring appointments.

• View and edit existing appointments.

• View your colleagues' appointments, if you have permission.

• Access additional calendars. Additional calendars, if enabled, are available after you click the Manage My
Calendar icon.

See the Calendars section in this chapter for more topics on using calendars.

Manage Your Tasks
The Tasks landing page displays your tasks that include a due date, allowing you to see at-a-glance which ones are
due on which dates. Icons help you spot overdue tasks quickly. You can use the My Tasks list to sort tasks by due date,
subject, or priority.

Manage Your Calendars  
Use the My Calendar page within Activities to manage calendar views.

View Calendars
You can view calendars by day, week, month, or agenda. You can view the status of other deals by selecting a different
calendar listed in the side panel. The steps to view a calendar using the side panel are the same for opportunity and
account. In the following procedure, account is used as an example.

Weekly View
The default calendar view is the Weekly View. From here, you can see all of the items on your calendar for the week. On
the left, each user added to the team calendar is displayed (by default only the signed-in user is displayed, as in single
calendar mode). Each day shows:

• Start time of appointment, with recurrence icon (if applicable)

• Whether the appointment is multi-day (indicated by an arrow)

• Appointment subject

You can view and edit the recurrence information in the Add: Recurrence dialog box that appears when you click the
Recurrence button. Nonrecurring appointments display the edit page for the appointment.

Note:  The appointment time isn't reset when the All Day check box is cleared.
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You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can't edit
them. Appointments marked by others as Private display as Busy on their calendar entry, and don't include details.

Day View
On the Day View, you can see all of the items on your calendar for the current day. On the left, each user added to the
team calendar is displayed (the default only shows the signed-in user).

Along the top are the hours of each day, where the calendar entries are displayed. Each day shows:

• Start time of appointment, with recurrence icon (if applicable)

• Whether the appointment is multi-day (indicated by an arrow)

• Appointment subject

You can view and edit the recurrence information in the Recurring Appointments dialog box. Nonrecurring
appointments display the edit page for the appointment.

You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can't edit
them. Others who can edit other users' appointments include:

• The administrator.

• The user's manager, if the person is in their resource hierarchy and the manager has the Sales Manager duty
role.

Appointments marked by others as Private display as busy on their calendar entry, and don't include details.

Appointment Colors
The legend at the bottom of the calendar displays the colors associated with different appointment types. If an
appointment is of one of these types, the appointment box in the calendar is displayed in that color. You can change
these colors using Setup Manager.

Appointments that show a user as busy don't display any details because you don't have access to their record.

Add Appointments
To add new appointments to the calendar click Create Appointment. Selecting the check boxes next to the user names
in your team calendar automatically adds those users as resources to the new appointment.

Add Resource Hierarchy
Build a resource hierarchy in your calendar to view the schedule of resources you work with. Click the Manage My
Calendar icon and use the search option below Resource Hierarchy to search and add a colleague. If you're adding a
manager, you see the team as well. Expand the manager's name to see the members in the hierarchy.

Make Your Calendar Appointments Visible to Others  
You can let other users access your calendar appointment details by giving them permission to view them.
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How to Let Others View Your Calendar Appointments
Here's how you give others permission to view your appointments.

1. In the global header, within the Settings and Actions menu, click your user name and select Set Preferences
under Personalization.

2. Select Calendar and Appointment Preferences. The Calendar and Activity page appears.
3. In the Additional Calendar Sharing Levels with Specific Resources section, add a row to the table. Select the

individuals that you want to share your appointment details with.
4. Set the Access Level value to Show appointment details.
5. Save your changes.

The users you select can access your calendar appointment details from the Calendar page by selecting your
name in the Resource list.

Related Topics
• Can my administrator view and edit my appointments?

Update Details in External Appointments  
You can update details such as your availability to the meeting and reminder in the external appointments synced to the
sales application from Outlook.

Though you can update most of the fields in the external appointments, a few fields still remain read-only. The table
here shows what you can change and what you can’t.

Fields You Can Update Read-Only Fields

• Account

• Opportunity

• Lead

• Show Time as indicates your
availability for the meeting.

• Set Reminder

• Add Attachments

• Add Objectives

• Add Notes

• Externally Owned setting

• Private

• Subject

• Location

• Time zone

• Start date and time

• End date and time

• All Day setting

• All the fields on the Recurrence window

• Owner

• Resources

• Contacts

• Primary Contact

• Description
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What You Can Do on an External Appointment
You can do these actions on an external appointment:

• Create a follow-up appointment

• Create a follow-up task

• Create a call report

• Delete appointment

Create Follow-up Activities for External Appointments  
Create the follow-up activities such as the follow-up tasks, appointments, and call reports for external appointments
synced from Microsoft 365.

Open an external appointment and click Actions to choose an appropriate action on your appointment. Use the Delete
Appointment option to remove an external appointment from the CX Sales activities. The appointment will still be
available in Outlook.

Create Tasks from a Task Template  
You can create tasks for a business object from a task template. First select a set of tasks for a template task and then
create tasks. In this topic, the opportunity business object is used as an example.

However, the procedure to create task templates is the same for all the objects.

Note:  Tasks can be autogenerated from a task template and displayed in the Activities subtab. For example, a
task template is associated with a sales stage. On updating the sales stage, the autogenerated tasks appear in the
opportunity Activities tab.

Here's how you create tasks from a task template:

1. From the Navigator, click Opportunities.
2. Select the opportunity for which you want to create a task.

The Edit Opportunity page opens.
3. Click the Activities subtab.
4. Click Create Tasks from a Template.

Note:  If the administrator hasn't set up task templates, a warning appears.

5. Select the template name from the available task templates.
6. (Optional) Enter the name of the owner of the task. If the field is blank, the signed-in user is set as default as the

owner of the task.
7. Click Save and Close, on the Create Tasks from a Template page.

The tasks are created from the template.
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Track Updates with Call Reports  
A call report is a central place for salespeople to capture what happened in a sales activity, make related changes,
and track key updates. Call reports can boost salespeople's productivity by saving time, increasing visibility into their
business, and selling more in less time.

A call report is a type of activity like tasks and appointments. You can create call reports for scheduled appointments
or ad hoc call reports from the Activities tab. Each scheduled appointment can have multiple call reports, created by
different salespeople. The call reports for an appointment are listed in and viewed from that appointment. Salespeople
can also create ad hoc call reports to report sales activities that aren't scheduled on their calendar.

Note:  The administrator must use Application Composer to enable the Create Call Reports button on the Activities
tab, the Activities list, and the Tasks tab.

Call reports record a snapshot of the outcome of the sales activity and key changes, including:

• Outcome summary, meeting minutes, complete objectives, attendees, attachments, notes, and so forth.

• Related objects, such as appointments, accounts, opportunities, and leads

Appointment resources and others who have access to an appointment can create a call report from it. Multiple call
reports can be created from one appointment.

Add and Remove Objectives
Appointment objectives are copied over to the call report by default. You can add additional objectives, or remove
existing ones.

To add objectives, you can either select them from a predefined list or type free text to add new ones. Predefined
objectives include:

• Demo product

• Determine next steps

• Discuss proposal

• Identify stakeholders

• Review RFP or RFI (Review Request for Proposal or Request for Information)

You can check an objective in a call report to mark it as complete, or deselect it to mark it incomplete. Objectives copied
over from the appointment or added by user are deselected by default.

Appointment Contacts and Resources
Appointment contacts and resources are copied to the call report. You can add or remove contacts and resources.
You can also check or deselect a contact or resource's attendance status to indicate whether he or she attended the
meeting.

• Contacts that are defaulted from the appointment are marked as attendees by default.

153



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 10
Activities and Calendars

• Resources that are defaulted from the appointment are marked as attendees by default if the resource's
response in the appointment isn't Declined.

• Resources and contacts that aren't defaulted from the appointment and added by the user are marked as
attendees by default.

Appointment Outcome
You can select an appointment outcome from a list of predefined values. Your sales administrator can add or remove
values from this list as needed. Default values are:

• Call answered

• Call transferred

• Captured issue

• Failed

• Left message

• Not available

• Provided information

• Successful

• Incomplete

• At risk

• Customer undecided

Attachments and Notes
You can add attachments to a call report in the same way that you add them to other objects.

Anyone who has access to the call report can create notes on it. Call reports support both internal and external notes.
You can use external notes to share with external contacts.

Any user who can view the call report can see non-private notes, but only the note creator can see private notes.

Call Report Security
Call reports include a Private setting, which determines who can view it:

• If the call report is set to Private, then only the call report resources can view it.

• If the call report isn't set to private, then anyone who can view the related appointment can view the call report.

Select Addresses for Activity Accounts and Contacts  
If the administrator has exposed the address selector in the Activities pages, you can associate an address with an
activity's account or contact. This association helps sales managers audit and relate call report contact or account
location with actual sales.

Managers can also view an audit trail of a salesperson's customer visits. On a call report, the address selector helps to
automatically populate the address of the account or contact.
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Remember the following rules:

• You can change the selected address as needed, except after a call report is submitted.

• The addresses are available for accounts, if both accounts and contacts are defined for the activity.

• If only contacts are defined for an activity, but not an account, then the address shown is related to the primary
contact.

Your administrator can enable the ability to select addresses on call reports, appointments, and tasks. Using the address
selector on a call report is used as an example in the following procedure. To select an address:

1. Open an appointment or a task to access a call report.
2. Click Create Call Report or open an existing Call Report.
3. Select an account.
4. Select an address related to the account from the Addresses section.
5. Click Save and Close.

Related Topics
• Let Salespeople Associate Addresses with Activities

Use Activity Subtype  
Track the activities by type and subtype. For example, you can track an email activity using its subtypes, outbound and
inbound.

Use the Type field to:

• Categorize your activity types by selecting values in the Type field on the activity create and edit pages.

• Search for activities based on type.

• View and sort activities by type.

• Update values on the Activities list page using the click-to-edit functionality.

Apply Mass Update to Activities  
You can select multiple activity records and update all of them to the same value for a field using the mass update
feature.

Among the fields that you can update are:

• Due Date

• Owner

• Priority

• Status

• Type
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Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple activities at once:

1. Navigate to the Activities landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.

◦ You can't apply mass update to conditionally updatable fields.

6. When you're done making updates click Submit.

Related Topics
• Enable Mass Update of Records

Activity Search and Lists  

Overview of Creating Lists  
You can refine your list of activities by creating lists from Activities using Saved Search in the Advanced Search pane.
For example, you can create a list of all completed tasks you own.

A date range is required when using the Saved Search list. The available Show filters are Open, All, and Completed.

Show Filter Description

Open
 

Displays all appointments that have a start date of today or in the future within defined date range, all
open tasks with a due date in the defined date range, and open tasks with no due date.
 

All
 

Displays all appointments within the defined date range, open tasks with no due date or with a due
date within the defined date range, and closed tasks with an end date in the defined date range.
 

Completed
 

Displays appointments in the past with a start date that falls within the defined date range, and tasks
having been completed within the defined date range.
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Use the Show Filter in Activities  
Use the Show filter in activities when you want to:

• Create saved searches for activities.

• Search for activities in associated objects, such as opportunities or accounts.

When the Show filter is set to All or Completed, the sort order displays your future activities first, followed by the historic
activities. To view future activities:

1. Sign in to the application as a sales representative.
2. Navigate to Sales > Activities.

The My Calendar page appears.
3. Click the Activities subtab.

The Activities landing page appears.
4. Click the Show Advanced Search icon.

The Advanced Search pane appears.
5. In the Advanced Search pane, select My Open Activities from the Saved Search drop-down list.
6. Select Complete or All from the Show field.

A list of all the future appointments and open tasks appears.

Create Your Own Activity Lists  
You can create your own list of activities. For creating your own lists you must set your search criteria and save the list.
You can view your list in the List field.

Here's how you can create your own lists:

1. Sign in as a sales representative.
2. On the home page, click Sales > Activities.

The My Calendar page appears.
3. Click the Activities subtab.

The Activities landing page appears.
4. Click the Show Advanced Search icon.

The Advanced Search pane appears.
5. In the Advanced Search pane, select I Own in the Record Set field.
6. Click Save.

The Create Saved Search dialog box appears.
7. Name the list.
8. Click the Run Automatically check box, and click OK.
9. View the list in the Saved Search field.
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Activity Notifications  

Overview of Activity Notifications  
Activities generate notifications when you perform various tasks or make certain updates. Notifications are sent by
email or on a global notification list (also called a bell notification list). Let's take a look at how the notification process
works.

When Notifications Are Sent
Email and bell notifications are triggered when a change is saved. Notifications can be sent when an appointment or
task is created, updated, or deleted. You can also send notifications as a reminder for appointments. You can choose
whether to receive email, a notification in the notifications list, or both.

Note:  For updates, notifications are triggered on any update except settings and values specific to an individual user.
For example, notifications are triggered by:

• Show Time As

• Reminder

• Response

Notification messages are displayed only on the bell notification list. The messages aren't displayed in the Worklist for
notifications and approvals.

Set Your Notification Preferences
To set your notification preferences, go to Settings and Actions under your user name in the global header and select
Set Preferences. See Use Notifications to Drill Down to Records for more information.

Use Notifications to Drill Down to Records  
You can opt in to use the capability to drill down and act from activity notifications and receive notifications through
notification lists and email.

If you opt in to receive notifications, then list and email notifications are generated when you create or update
appointments and tasks. Each notification includes a link that you can drill down on to view the record details before
you approve or reject the request. You can accept or decline appointments and complete tasks from notifications. You
can decide whether to use the enhanced notifications with drill-down capability or continue to use the earlier option
with no drill-down capabilities.

To receive notifications, you must set a preference in your Preferences page. See the section in this topic, Set the
Preference to Receive Notifications, for more information. After you opt in, you receive two types of notifications: Action
Required and FYI. In the Pending Notifications window, you can act on each notification by clicking Accept or Decline.
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Appointments and tasks have the following set of fields that appear by default in the email notifications:

• Task

• Due Date

• Owner

• Status

• Assigned to

Each appointment notification has the following default fields:

• Subject

• Date

• Location

• Invitees

In addition, all email notifications include the following fields, if they're defined on an activity.

• Account

• Opportunity

• Lead

• Asset

• Description

To drill down into an activity, click the subject or task link in the appointment notification. You can also accept or decline
an appointment or complete a task from the email notification.

Set the Preference to Receive Notifications
Here's how you can receive notifications by email and lists.

1. Sign in as a sales representative.
2. Click Setting and Actions  > Set Preferences in the global header.
3. Click Calendar and Appointment Preferences.

The Calendar and Activity page appears.
4. In the Appointments and Task sections, select the Notify me by check box.

5. Click Save.
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Activities and Assets  

Overview of Integrating Assets with Activities  
After the administrator enables the functionality, you can can associate assets with activities, including appointments,
call reports, and tasks.

Associating an asset with an activity and then viewing the asset calendar helps you manage your appointments. You
can view all the related appointments for an asset in a single place. After you or someone else in your organization
associates an asset with an appointment, then the asset calendar is enabled.

Related Topics
• Overview of Asset Calendars

Add Assets to Activities  
If the functionality is enabled by the administrator, you can add assets to all types of activities, including appointments,
call reports, and tasks. You can add assets to new and existing activities, using the activity create and edit pages.

After you add an asset to an activity, then you can view the asset on that activity's page.

After an asset is associated with an appointment, you can view the asset calendar from the Manage My Calendar
window available on the My Calendar page. For more information, see the related topics.

To add an asset to an appointment:

1. Access the activity page where the Assets list if enabled. For example, click Create Appointment in the My
Calendar page.

2. Click Search in the Asset drop-down list.

The Select: Asset page appears.
3. Click Search.

The search results appear.
4. In the search results, select an asset and click OK.

The Create Appointment page appears.
5. The asset number and asset serial number of the selected asset, if available, are automatically populated.
6. Click Save and Continue in the Create Appointment page.

The asset appears as a link.
7. Click Save and Close.
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Overview of Asset Calendars  
Use your calendar to manage assets. An asset calendar displays the appointments relevant to your assets. Team
members view all upcoming appointments related to an asset in the calendar and coordinate their activities for the
asset.

You can create an asset calendar for:

• Assets that you can access

• One asset at a time

The asset calendar displays all appointments for the asset and private appointments. The asset calendar identifies the
owners of the appointment with a picture or icon with the user initials or name. With the asset calendar you can:

• View all appointments related to an asset in a single calendar view.

• View all the owners of appointments related to an asset.

• Hide or show appointments of individual or multiple appointment owners.

• Save asset calendars to a list and access the calendar that you want.

• Determine the owner of each appointment on the calendar.

• Switch between all calendar views: day, week, month, and agenda.

Create an Asset Calendar View  
An asset calendar displays the appointments relevant to your assets. After an appointment is associated with an asset,
you can create an asset calendar view from the My Calendar page.

The asset calendar is available to the whole organization as soon as one person across an organization associates an
appointment with an asset.

The asset calendar displays:

• All appointments that are associated with an asset.

• All owners of appointments associated with an asset. The appointments can be owned by different people.

Here's how you can create an asset calendar view:

1. Click the Manage My Calendar icon on the My Calendar page.
2. Click Other Calendars.
3. Click Create Asset Calendar View.

The Create Asset Calendar page appears.

Tip:  Remember, an asset calendar can only be enabled after an appointment is associated with an asset.

4. Click Search in the Asset field.

The Select: Asset page appears.
5. Search for and select an asset. Alternatively, you can create an asset to use.
6. Click OK.
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The name of the asset is automatically populated as the calendar name, but you can change it if needed.
7. Save your changes.

You can access the asset calendar from the My Calendar page by clicking Manage My Calendar > Other
Calendars. You can filter the calendar to view appointments associated with a particular owner.

Related Topics
• Overview of Sales Assets

Activities and Interactions  

What activities can I do from the Interactions History subtab?  
You can track and view interactions if your sales administrator has enabled you to log interactions and has enabled the
Interactions History subtab on object pages such as Activity, Account, Lead, or Opportunity.

From the Interactions History subtab you can log interactions using the:

• Log an Interaction button
Interactions include phone calls, web conferences, or wrap up calls you had with your customers or prospects.

• Log an email button
When logging an email, you can:

◦ Add emails manually - You can’t reply or forward the message content of the conversations saved in the
Interactions History subtab.

◦ Delete a manually-added email. - However, the emails that are shared from the add-in or those flowing
in Digital Sales can’t be deleted. You can modify a manually entered email message, but you can’t see the
email thread or modify an auto-captured email.

In addition, you can also use the Log an Interaction smart action from the Workspace action menus on all the
relevant object pages of Workspace.

Note:  Once log interactions is enabled for you, then you won’t be able to log a call from activities or use the
Log a Call smart action on the object pages of Workspace.

Related Topics
• Log Interactions You Had with Customers

• Log Email Conversations Manually

Log Interactions You Had with Customers  
If your administrator has enabled the Interactions History subtab on the object pages such as Account, Lead, or
Opportunity, you can log your sales interaction details.
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Interactions include phone calls, web conferences, or wrap up calls you had with your customers or prospects.

Here's how you log an interaction:

1. Navigate to an object details page such as an account, contact, opportunity, or lead.
2. Scroll down and click the Interactions History subtab.

You can see the interactions logged by your team.
3. Click Log an Interaction.
4. In the Interaction Wrap Up window, select the channel such as phone or web conference.
5. Enter the date, type of interaction, outcome, and notes related to the interaction.

Depending on the object page you’re on, the account, lead, opportunity, or contact information is auto-filled.
For example, if you’re entering the details from the Contact page, contact name is auto-filled.

6. Click Save.
7. Click Save and Close on the object page.

Log Email Conversations Manually  
If you’re using Microsoft 365 add-in or Digital Sales, the emails you send or receive are automatically saved as
conversations. You can find them in the Interactions History subtab of your Fusion CX sales application.

In addition to the conversations that are automatically saved, you can also manually log emails.

Manually logged emails aren’t threaded into conversations. They are saved as messages.

Here's how you log an email manually:

1. Navigate to an object details page such as an account, contact, opportunity, or lead.
2. Scroll down and click the Interactions History subtab.

Note:  You can see the Interactions History subtab only if administrator has enabled it for the object pages.

On the Interactions History subtab, you see the conversations that were manually-logged by your team or
shared from the add-in.

3. Click Log an Email.
4. In the Email window, select the date when the email was sent and type of interaction.
5. Enter email address of the recipients in the To and CC fields.
6. Enter the subject of the email, and the account, contact, lead, and opportunity associated with the recipient.
7. Click Save.
8. Click Save and Close on the object page.

FAQs for Activities and Calendars  

Frequently Asked Questions (FAQs) for Activities and Calendars  
This section contains some frequently asked questions (FAQs) for activities (calendars, tasks, call reports). Scroll or
search to find answers to common questions.
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What activities does selecting My Open Activities display?  
When you select the My Open Activities list in the Activities work area, the application displays a list of all of the future
appointments and open tasks where you're listed as a resource.

You're automatically a resource if you created the activity or you can be assigned as a resource by another resource or
an automated process.

What activity records do the different record sets permit you to
search?  
The different record sets in the Saved Searches window restrict your saved searches to different sets of activities. To
improve saved search performance, restrict your saved searches to smaller record sets.

For example, rather than searching all the records you can see, search all the records you and your subordinates own.
Or restrict your searches to a smaller geographical area. For example, search all the activities in one state instead of the
whole country.

Here's a list of the record sets for activities. Not all record sets are available to all users. For example, the record set
involving subordinates is available only to managers.

Record Set Name Description

I own
 

Activities you either created or ownership was assigned to you.
 

I am a resource
 

Activities where you're a resource.
 

My subordinates own
 

Activities owned by you and your subordinates.
 

All records I can see
 

Activities that you can view based on your resource team membership, sales territory assignments,
 your position in the organization, and security permissions.
 
This record set is available only if the administrator enables it using a profile option.
 

How can I search all activity records?  
In the Activities landing page, you use the Find field to search all activities you're associated with.

To broaden the search to all activities, use the advanced search and select the record set you want to see. Your
administrator must enable this feature for you to search all activities, including those you don't own or aren't associated
with.
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Related Topics
• Enable the Search of All Activities

How does the Show filter refine my activity list?  
The Show filter displays activities based on certain criteria. Here's a list of the show filter criteria for activities:

Show Filter Tasks Appointments

Open
 

All open tasks with a due date in the defined
date range, and open tasks with no due date
 

All appointments that have a start date of today
or in the future within a defined date range
 

All
 

Open tasks with no due date or with a due date
within the defined date range. Closed tasks with
an end date in the defined date range
 

Open tasks with no due date or with a due date
within the defined date range. Closed tasks with
an end date in the defined date range
 

Completed
 

Tasks that are completed within the defined
date range
 

Appointments in the past with a start date that
falls within the defined date range
 

How can I view activities that are set as private?  
You can only view activities that are set as private if you're the owner of the activity, are delegated by other users to view
it, or are a resource or contact of the activity.

Tip:  The Private check box is hidden by default in the tasks pages. Administrators can use Application Composer to
display the check box on the Create Appointment page and enable you to set a task as private.

How can I track customer-facing activities?  
You can define your own criteria for an interaction using the Activities feature. Customer interactions are logged either
as completed tasks or as appointments using the activity types you want to report on.

To track your customer-facing interactions, generate a report to retrieve activities of a specific type with accounts or
contacts associated. For example, you can list all calls with an associated contact. To track a completed task, go to the
Activities page from the Customer, Opportunity, or Lead page, and click Log a Call.
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How can I view my appointment in a different time zone?  
You can use the time zone drop-down list to view the appointment time in a different time zone. The time zone for users
is defined in the Regional area within Set Preferences.

If no time zone is defined, the appointment time zone displays as null, and appointments are created based on
Universal Time Coordinated (UTC) time. You can't change the default time zone.

When appointments include attendees from a different region, the appointment time zone drop-down list can be used
to define an attendee-friendly time. For example, a user in Chicago selects 9 A.M., and sets the time zone to Cairo,
Egypt time zone. Upon saving, the appointment displays to the Chicago user as 2 A.M., and the time zone drop-down
list has the Chicago value.

Can my administrator view and edit my appointments?  
Your administrator can view and edit your calendar appointments by enabling a profile option. You can also enable
other sales users to view your calendar in the Preferences screens.

If you want others to view your appointments, make sure you don't set them to private, or no one except you can see
them.

To learn how to set the visibility for other sales users, see the topic, Make Your Calendar Appointments Visible to Others,
in this chapter.

For administrator instructions about the profile option, see the related topic.

Related Topics
• View and Edit Calendar Appointments of Users

What's the difference between a task, a call report, and an
appointment?  
A task is a unit of work to be completed by one or more people. Tasks are related to business objects such as
opportunities or contacts, and can include attachments.

An appointment is a calendar entry related to a business object, such as an opportunity or a customer. Appointments
can include attachments.

A call report provides a historical view of all communications initiated by you to a customer, or by a customer to you.
Call reports don't document internal communications.
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11  Business Plans

Overview of Business Plans  
Sales representatives and sales managers perform account planning to achieve specific goals. Goals for business plans
are represented through objectives.

Watch video
 

Access to the business plans is determined by the team membership and resource reporting hierarchy. This means
that managers have access to business plans of the sales representatives in their team. In an account business plan,
salespeople collaborate to discuss the sales of a specific account and analyze the need of a plan. An account business
plans focuses on a specific account, to increase the sales or revenue of that account. With a business plan you can:

• Analyze the strengths, weaknesses, opportunities, and threats of the business plan in the context of the
account.

• Add business plan classes to define plans for partner, account, opportunities, and contacts.

• Collaborate with team members to discuss prospective plans.

• Enable or disable any of the embedded classes for account and partner business plans.

• Add team members to work on a business plan to share information, identify objectives, and increase sales per
quarter.

• Create notes while working on a business plan and continue with discussions in the next meeting referring to
the notes created.

Make sure that your administrator has enabled the account business plan using Application Composer.

Related Topics
• Overview of Accounts

• Create Business Plans

• Add Business Plan Objectives

Create Business Plans  
You create a business plan by selecting a type of plan and then adding objectives to it. The type of a business plan helps
you to differentiate between business plans. The types you can create are: partner and account.

The procedure to create a business plan is the same for both partner and account. These steps represent a flow for
creating an account business plan:

1. Sign in to the sales application as a sales manager.
2. Click the Business Plan icon on the home page.

A list of business plans appears.
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3. Click Create Business Plan.
4. Enter the name of the plan.
5. Select an account from the Account drop-down list.
6. Define the period for the objectives that you want to achieve, in the Period field.

By default, the current year is displayed. You can change the period to year, quarter, or period.
7. Select a type from the options Regional and Global.

The current user is the owner, by default.
8. Select a status for the plan. Initially, the status is Draft.
9. Click Save and Continue.

You automatically navigate to the Edit Business Plan page.
10. Modify your business plans if required, and click Save and Continue.
11. Click the SWOT Analysis subtab to analyze the strength and weakness of your business plan.
12. Click the Activities subtab to add tasks to your plans.
13. Click Save and Close.

Add Business Plan Objectives  
Objectives are the key aspect of a business plan. Salespeople use business plans to achieve objectives to meet the
target goals.

To create objectives for a business plan:

1. Click Create Objective on the Edit Business Plan page.

The Create Objective page appears.
2. Enter a name for the business plan.
3. Select a type from the Type drop-down list.

Note:  You can add a type to the list of options. The type of a business plan determines the unit of measure
and the field is automatically populated on selection of a type.

4. Define the period in which you want to achieve your goals for the business plan.
5. Enter your target to achieve your objective in the defined period.
6. Click Save and Close.

The objective is displayed on the Edit Business Plan page.
7. If you click Save and Continue, then the Edit Objective page appears.

You can view the newly created objective and you can add notes, activities, and attachments to the objective.

Split Objectives
You can split an objective to specify how to achieve the objective between partner and account. To split an objective:

1. Click Split Objective on the Edit Objective page.

The Split Objective page appears.
2. Specify how you want to split your objective.
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3. Click Save and Close.
The split objective appears on the Edit Objective page.

4. Enter your plan to achieve your set target, in the specified period.
5. Select Attainment in the Show field.

The Attainment column appears.
6. Enter the details for the targets you achieved.
7. Click Save and Close.

Use the Business Plans Summary Tab  
You view the list of business plan objectives on the Edit Business Plan: Summary page, or on a separate subtab named
Objectives (depending on how the application is configured).

If an objective is listed in the Objectives subtab, you can search for objectives by name. For every objective you must
specify the following fields:

Fields Description

Split
 

Enables you to define dimensions for objectives.
 

Name
 

Displays the name of the account.
 

Type
 

Specifies the account type. The options are amount and quantity.
 

Unit of Measure
 

By default, the measure is determined by the type of account that you select.
 

Period
 

Defines the period to achieve the objective.
 

Target
 

Specify the amount or quantity to achieve the objective.
 

Business Plan Team Members  

Collaborate on Business Plans Using Microsoft Teams  
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Create a Microsoft Team with your business plan team members and collaborate with them for pursuing business plans.

Who can Create a Team
You must be the business plan owner and a Microsoft Teams user to create a team in Microsoft Teams. You will be
owning the team created in Microsoft Teams.

Note:  You can create only one team per business plan.

Who can be the Team Members
You can add any individual who is part of the Business plan resource team and is a Microsoft Teams user. To map a CX
Sales user to the user account in Microsoft Teams, the user's primary email address in their resource profile in the sales
application must match the user's email address in Microsoft Teams.

Management resources can’t be added to the team.

Note:  In Microsoft Teams, the teams can be public or private. Teams created from a business plan in CX Sales are
always private teams, which implies that only the team members can access the team.

Create the Team in Microsoft Teams
1. From the navigator, go to Business Plans > Business Plans.
2. Open a business plan you own. Ensure that your business plan has team members.
3. On the Edit Business Plan page, click Actions and select Create Team in Microsoft Teams. Here's a screenshot

that shows the Create Team in Microsoft Teams option from the Business Plan Actions menu.

After a team is created in Microsoft Teams, the Create Team in Microsoft Teams action automatically changes
to Go to Microsoft Teams action.
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4. From Actions, click Go to Microsoft Teams.

You’re navigated to the newly created teams page in Microsoft Teams. Here's a screenshot that shows a sample
team created in Microsoft Teams for the business plan.

Related Topics
• Set Up Microsoft Teams for Sales

Re-create a Team for a Business Plan Team in Microsoft Teams  
When you create a business plan team from your sales application, the Create Team in Microsoft Teams action on the
Edit Business Plan page Actions list automatically changes to the Go to Microsoft Teams action.

If for some reason, the original team no longer exists in Microsoft Teams, the Go to Microsoft Teams action triggers re-
creation of the team and saves it to the business plan. When you click the action again, it automatically opens the new
team created in Microsoft Teams.

This allows salespeople to continue to collaborate with each other on the reopened business plan.
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12  Assets

Overview of Sales Assets  
Assets are high-net-worth products owned by an organization. After the functionality is enabled by the administrator,
you can create and manage assets.

You use assets in the following ways:

• Click Sales > Assets on the springboard to use a full set of create, edit, and manage assets capabilities

• Manage assets within the context of accounts

• Associate assets with activities, such as tasks and appointments

• Create an organization-level view of calendars associated with assets

• Associate assets with opportunities and leads

What assets records can I search using saved searches?  
You can view different records from the two saved searches provided on the Assets landing page.

Here's a list of the supplied saved search for assets.

Record Set Name Description

My Customers' Active Assets
 

All active assets associated with your customers
 

All My Customers' Assets
 

All assets, purchased in the last six months, associated with your customers (although the time frame
can be modified by the administrator)
 

How can I view assets?  
You can view asset information for your accounts from the Assets or Accounts page.

Here's how to view assets from the Assets page.

1. Sign in to a sales application as a sales manager.
2. Click Sales > Assets on the home page.
3. On the Assets landing page, view the summary details.
4. Click an asset record to view and edit the asset details.
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Here's how to view assets from the Accounts page.

1. Sign in to a sales application as a sales manager.
2. Click Sales > Accounts on the home page.

The Accounts landing page appears with a list of accounts.
3. Click an account.

The Edit Account page appears.
4. Click the Assets subtab.

If enabled by the administrator, you can also view asset information in activities, such as appointments, tasks, and call
reports.

Related Topics
• Overview of Sales Assets

• How can I edit assets?

• How can I create assets?

• How can I delete assets?

• Export Assets

How can I create assets?  
You can create asset information for your accounts.

To create assets from the Assets page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Assets on the home page.
3. In the Assets landing page, click Create Asset.
4. Enter the details, such as the account, product, currency, status, quantity, and purchase unit price.

Based on the currency, Exchange Rate is shown. Similarly, Based on the quantity and purchase unit price of the
asset, Total Asset Amount is calculated.

Note:  For you to see the Exchange Rate and Total Asset Amount fields on the UI, your administrator must
enable them on the Create and Edit layouts for Assets.

5. Click Save and Close.
To create assets from the Accounts page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Accounts on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the Assets tab.
5. Click Create Asset and enter the details.
6. Click Save and Close.
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Related Topics
• Overview of Sales Assets

• How can I view assets?

• How can I edit assets?

• How can I delete assets?

• Export Assets

How can I edit assets?  
You can edit asset information for your accounts from the Assets or accounts page.

To edit the assets from the Assets page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Assets on the home page.
3. In the Assets landing page, select an asset to edit.
4. In the Edit Asset page, you can edit the asset information, such as owner, as well as details like status, quantity,

and purchase price.
5. Save your changes.

To edit the assets from the Accounts page:

1. Sign in to a sales application as a sales manager.
2. Click Sales > Accounts on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the Assets tab.
5. Select an asset to edit and edit the details.
6. Save your changes.

Related Topics
• Overview of Sales Assets

• How can I view assets?

• How can I create assets?

• How can I delete assets?

• Export Assets

How can I delete assets?  
You can delete asset information for your accounts from the Accounts landing page or the Assets landing page.

To delete assets from the Assets landing page:

1. Navigate to Sales > Assets on the springboard.
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2. In the Assets landing page, select an asset.
3. In the Edit Asset page, select Delete Asset from the Actions menu.
4. Respond to the confirmation message.

To delete assets from the Accounts landing page:

1. Navigate to Sales > Accounts on the springboard.
2. In the Accounts landing page, edit an account.
3. In the Edit page, click the Assets tab.
4. Select an asset to delete.
5. In the Edit Asset page, select Delete Asset from the Actions menu.
6. Respond to the confirmation message.

Related Topics
• Overview of Sales Assets

• How can I view assets?

• How can I edit assets?

• How can I create assets?

• Export Assets

Apply Mass Update to Assets  
You can use the mass update feature to update multiple fields on several asset records at once, without having to go
into each individual record.

Among the fields that you can update are:

• Asset Owner

• Status

• Quantity

• Purchase Date

Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple assets at once:

1. Navigate to the Assets landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.
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◦ You can't apply mass update to conditionally updatable fields.

6. When you're done making updates click Submit.

Related Topics
• Enable Mass Update of Records

Export Assets  
You can export a list of assets from the application. When you export assets, the application generates a spreadsheet
file that you can save locally.

To export assets, from the Assets landing page, click Export List in the Actions menu.

Related Topics
• Overview of Sales Assets

• How can I view assets?

• How can I edit assets?

• How can I delete assets?

• How can I create assets?
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13  Campaigns

Overview of Sales Campaigns  
This topic provides an overview of sales campaigns. Sales representatives and sales managers can create sales
campaigns for reaching out to contacts within their territories.

Use the sales campaigns feature from Sales Sales Campaigns to invite contacts to an event or inform them about a
product launch.

Note:  For existing CX Sales and Fusion Service users of Sales Campaigns, Oracle plans to decommission this feature
over the next few releases. As alternatives, Oracle recommends that you plan to use Engage Sales Tool by Oracle
Eloqua, and Integration between CX Sales and Eloqua, as you will no longer be able to use the Sales Campaign
functionality once discontinued.

Some of the features of sales campaigns include:

• The ability to target contacts from multiple sources including the contact repository and previous campaigns.

• An easy-to-use guided process

• Access to email templates

• A response gathering and monitoring capability

• The option to personalize email for individual contacts

• The ability to schedule a campaign to launch on a specific date

• Automated follow-up for specific response types

Sales campaigns make it easy for salespeople to keep their contacts informed, announce product launches, and invite
them to events. You can configure HTML email templates to send modified emails using your sales application built-
in email server. The application monitors responses and can create follow-up tasks or send emails to sales campaign
owners.

Create a Sales Campaign  
This topic describes how to create a sales campaign in your sales application.

Note:  You should sign in as a sales representative (or higher classification) in order to create a sales campaign.

Steps to Create a Sales Campaign
1. Sign in as the sales administrator and navigate to Sales > Sales Campaigns.

The Sales Campaign page appears. At the top of the page are competed campaigns, if available.
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2. Click Create Campaign.

The Create Sales Campaign: Select Contacts page appears.
3. Click Add Contacts.

The Add: Contacts page appears.
4. Enter your search criteria and click Search.
5. In the search results list, click the check box next to each contact you want to add to the campaign.
6. Click OK to save the changes and return to the Create Sales Campaign: Select Contacts page.
7. Click the right-arrow icon to advance the page to the next step in the process, the design email step.

The Create Sales Campaign: Design E-Mail page appears.
8. From the Actions list choose Change Template to use a different template.
9. Click Insert Elements to add response forms and show the Merge Fields list.

10. Select the Personalized Message standard field and click Insert, then Done.

Before you create a personal message, you must insert the merge field into the body of the email where the
personal message will appear. If the merge field for personalized message is not inserted into the template, the
text doesn't display anywhere in the email.

11. From the Action list select Personalize Message.
12. Click the pencil icon next to the contact who is to receive the personalized message
13. Enter the contents of your personalized message.
14. Enter your message and click Ok. Then click Done.
15. Click the right-arrow icon to move to the wrap-up stage.

The Create Sales Campaign: Wrap Up page appears.
16. Enter the name of the sales campaign and a short description.
17. Select Immediate as the launch date for your sales campaign and click Submit.

From your completed campaigns list, you can view the recently sent message, see how many contacts you
targeted, and check if you have received any responses to your campaign.

Sales Campaign Management  

Add Contacts to Sales Campaigns  
You can select a specific set of contacts to include in a sales campaign, or you can decide to include all contacts from a
previously created sales campaign.

Note:  The number of contacts to include in your sales campaign should not exceed 500.

From the Contacts subtab, you can search for contacts by Record Set, Name or Account. You can add additional
search criteria fields by clicking the Add  button. This action lets you further segment and target specific contacts to
include search criteria such as City, Country, Creation Date, Buying Role, and so on to further refine your search.

By selecting the Previous Campaigns subtab, you can select the campaign you want from the Campaign Name list.
You can then select and apply the contacts to your campaign.
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Here's how to select contacts for your sales campaign from the Contacts subtab.

1. Sign in as a sales representative or a sales manager.
2. Navigate to Sales > Sales Campaigns to go to the Sales Campaigns work area.
3. Click Create Campaign.
4. Click Add Contacts to go to the Add: Contacts screen.
5. Click Contacts subtab and enter search criteria for contacts by Record Set, Name or Account, and click

Search.
6. Click Add if you need to further refine your search for specific contacts.

Note:  Click Create Contact if you want to create a new contact to add to your sales campaign.

7. Select the contacts you want from the search list and click Apply and then OK.

Related Topics
• What is the recommended limit of contacts to include in a sales campaign?

Insert Response Forms to Sales Campaigns  
You can add forms to campaign content so that recipients can respond to your campaign. You can add customer
response forms to an e-mail template, track responses, and convert them to leads.

For example, during the Design E-Mail step of the creating sales campaign process, you can insert the following
response forms to your campaign:

• Forward To Friend

• Request Call Back

• Requested More Information

Here's how to insert a response form to your sales campaign:

1. Sign in as a sales representative or a sales manager.
2. Navigate to Sales > Sales Campaigns to go to the Sales Campaigns work area.
3. Click Create Campaign.
4. Click Add Contacts to add the contacts you want to target for your sales campaign.
5. Go to the Design E-Mail step and select the template you want to use.
6. Place your cursor in the area of the template where you want to insert a response form link.
7. Click Insert Elements and from the Show field, select Response Forms.
8. Select the response form you want and click Insert. Repeat this step if you want to include another response

form, and click Done when finished.

Related Topics
• Add Follow-up Tasks to Sales Campaigns

Add Follow-up Tasks to Sales Campaigns  
You can associate follow-up tasks with customer response forms on an email template when creating a sales campaign.

181



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 13
Campaigns

For example, during the final Wrap Up step of the create sales campaign process, you can associate one of these tasks
to the customer response forms you inserted from the Design Email step:

• Create call back task

• Receive e-mail notification

Here's how to add a follow-up task for your customer response form:

1. Sign in as a sales representative or a sales manager.
2. Click Sales > Sales Campaigns to go to the Sales Campaigns work area.
3. Click Create Campaign.
4. Click Add Contacts to add the contacts you want to target for your campaign.
5. Go to the Design E-Mail step and select a template to use.
6. Select the response form you want, and click Insert. Repeat this step if you want to include another response

form, and click Done when finished.
7. From the Wrap Up step, go to the My Follow-Up Actions, Customer Responses area.
8. From the Actions list, select the follow-up action you want to associate with each of the customer response

forms you previously inserted in your email template.

Related Topics
• Insert Response Forms to Sales Campaigns

Sales Campaign Content  
You can personalize your sales campaign by adding components such as images, merge fields and response forms.

To create the content of your sales campaign, you can add any combination of these components:

• Images

• Merge fields

• Response forms

• Standard and other URLs

• Conditional content

Images
Add graphic images to your email. You can provide a link to an image already on a server, or select a local file and
upload it to the server. Specify the size and placement of the image. You can add a URL of a publicly hosted image using
the img src  tag.

Merge Fields
Personalize your email message body by adding placeholders from a list of merge fields, such as the recipient's first
name. Merge fields are standard sets of attributes pertaining to an individual contact. You can insert them into your
email content. When you launch the campaign, merge fields are dynamically populated directly from the database. With
sales campaigns you can also compose a personalized text message for each recipient.
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Response Forms
Insert response forms as active links in your email campaign content. When a contact clicks one of the links, a specific
response is automatically generated. All such responses are gathered and monitored, to track contacts' actions.
Available response forms for sales campaigns are:

• Forward to Friend

• Request Call Back

• Request More Information

Standard URLs
You can add any of the following types of URL:

• Standard URLs are predefined and commonly used across the enterprise.

• A URL can be created when you define your email content.

By default, all standard URLs are tracked automatically. You can optionally enable tracking for other URLs, or disable
tracking for standard URLs. With tracking enabled, every time a contact clicks a link in a campaign email, the click is
recorded as a specific response, together with details pertaining to the URL.

Conditional Content
Conditional content is inserted or omitted based on the results of a rule. There are two elements that you can use to
generate conditional content within an email:

• If-Then-Else cases are used to determine if a block of text or HTML is removed from an outgoing email, by
verifying if a merge field value is defined. The merge field is defined if it isn't an empty string or, for numeric
merge fields, if it isn't a value of 0 (zero). If the merge field is defined, the block of text or HTML remains in the
outgoing email. If the merge field isn't defined, the block of text or HTML is removed from the outgoing email.

• Named Blocks are used to decide whether to insert a block of text or HTML into an outgoing email, by
comparing one string to another. If the two strings are identical, the block is inserted.

Related Topics
• Use Conditional Content to Personalize Sales Campaign Emails

Use Conditional Content to Personalize Sales Campaign Emails  
Conditional content lets you present information that's specific to individual email recipients without having to create
multiple messages. There are two ways to generate conditional content within a sales campaign template:

• Block statement personalization

• If-Then-Else personalization

Conditional content and merge fields are available in both HTML and Text format emails.
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Insert Text Using Block Statement Personalization
Blocks determine whether to insert a block of text or HTML into an outgoing email by comparing one string to another:

• If the two strings are identical, the block is inserted.

• If the two strings aren't identical, the block isn't inserted.

Note:  The string comparison is case-sensitive.

Here are the components of the block personalization element.

Personalization Component Description

$(DefineBlock "MatchString") Starts a block of text or HTML that's inserted in place of an Insert Block component when
MatchString is identical to the MatchString of the Insert Block component.
 

$(EndBlock) Ends a block of text or HTML that was started with the Define Block component.
 

$(InsertBlock "MatchString") A block of text or HTML is inserted at the location of this component when MatchString is identical
to the MatchString of a Define Block component.
 

Let's look at an example of a block personalization element:

You live in $(InsertBlock "${Account Country}").
$(DefineBlock "USA") <B>the United States.</B>
$(EndBlock)
$(DefineBlock "India") <B>India</B>
$(EndBlock)

If you enter USA in the Country field of the Account record, then this displays:

You live in the United States.
 

If a given recipient has no associated value for a block variable listed in the InsertBlock MatchString component, then
nothing is inserted into the message for that block.

Insert Text Using a Block Statement
Here's how to insert a block statement:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the insert the block.
3. Create the Insert Block statement as follows:

◦ In the editor toolbar, select Insert Block from the rule conditions drop-down list.

◦ In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.

◦ In the next drop-down list, select the field in the record.

◦ Click Insert.

4. Here's how to create a Define Block component:
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◦ In the drop-down list immediately within the email tag, select Create Block.

A $(DefineBlock "") and $(EndBlock) statement appear in the text.

◦ Type a field value within the quotation marks of the $(DefineBlock "") statement.

This is the value that drives the content displayed in the block.

◦ Type the text that you want to insert into the email between the $(DefineBlock "") and $(EndBlock) tags.

5. Repeat Step 4 until you have added all the Define Block components that you need.

Insert or Remove Text Using If-Then-Else Personalization
You can insert or remove text in your email depending on the value of a merge field by using If-Then-Else
personalization. The merge field is defined if it contains a value, or, for numeric merge fields, if the value isn't 0 (zero).

• If the merge field is defined, the text remains in the outgoing email.

• If the merge field isn't defined, the text is removed from the outgoing email.

Here are the components of the If-Then-Else personalization element.

Personalization Component Description

$(if {Record.FieldName}) Use the If component to start an If-Then-Else personalization element. It determines whether the
merge field named [FieldName] has a value. If there's a value for [FieldName, the text between this
If-Then-Else component and the next If-Then-Else component isn't removed from the email.
 

$(elseif {Record.FieldName}) Ends a block of text or HTML that was started with the Define Block component.
 

$(else) Use the Else component after a $(if)  or $(elseif) component. If the preceding $(if) or
$(elseif) component removes the preceding block of text or HTML from the email, the $(else)
component's block of text or HTML is included in the email. If the preceding$(if) or $(elseif)
component doesn't remove its block of text or HTML, the $(else) component's block of text or HTML
isn't included in the email.
 

$(endif) The End-If component closes the If-Then-Else personalization element.
 

Here's an example of an If-Then-Else personalization element:

$(if ${Contact.First Name})
Dear ${Contact.First Name}${Contact.Last Name},
$(else)
Dear Mr. or Ms. ${Contact.Last Name},
$(endif)

• If the Contact.First Name field is defined, the email begins with "Dear First Name Last Name".

• If the Contact.First Name field isn't defined, the email begins with "Dear Mr. or Ms. Last Name".

You can use If-Then-Else statements similarly to block statements, by including operators such as Equal to, Starts
with, or Contains. You can select these operators from a drop-down list when you generate If or If-Else statements.
Unlike blocks, this permits you to insert conditional content where the variable is true or not true.
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For example, to modify the email with a condition for accounts in the state of California, you use the following
statement:

$(if ${Account.Bill to State} == "CA") Join us all month long for special events and workshops held in each of

our California locations.

$(else) Join us all month long for weekly online workshops and special offers at www.mycompany.com/events.

$(endif)

You can also nest If-Then-Else statements, placing one within another.

Note:  The components of personalization elements must be placed in the correct locations in the text. Any incorrect
placement causes an error.

Insert an If-Then-Else Personalization Statement
Here's how to insert an If-Then-Else statement:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the If-Then-Else statement.
3. Create the If or ElseIf statement as follows:

◦ In the editor Toolbar, from the drop-down list, select either If or ElseIf.

◦ In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.

◦ In the next drop-down list, select the field in the record.

◦ In the next drop-down list, select the operator.

◦ In the next text box, enter the value that the field is compared with.

◦ Click Insert.

4. Following the If or ElseIf statement, enter the text that appears if the condition in the statement is satisfied.
5. At the end of the entire If-Then-Else statement, enter $(endif).

Related Topics
• Sales Campaign Content

• Marketing Content and Standard URLs

Example of Adding Personalized Text in a Sales Campaign  
You are creating a sales campaign inviting contacts to an event that your company will host next month. You already
have a template that provides most of the information.

In addition to standard merge fields that will automatically populate contact data, you want to add a more personal
touch, for a selected few contacts, to the otherwise generic email content.

Add Personalized Text
1. Create a campaign, enter the details, select all the contacts for the campaign (not just the ones to whom you

will send a personalized message) and, optionally, choose a template.
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2. When you edit the email content, add the personalized text merge field where you want the personalized text to
appear.

3. When you enter advanced options, locate the contact for whom you want to create a personal text in the list
of contacts. Click the edit icon in the Personalize column to open a new HTML editor window where you can
enter a message for the selected contact. You can apply styles just as in the common area of the email. You
can preview and edit the personal message until you have what you want. You can repeat this step to create
individual personal messages for as many contacts as you choose.

Response Follow-Up Actions for Sales Campaigns  
When you create a sales campaign, you may want to be notified automatically when a targeted contact responds in a
specific way.

You can associate follow-up actions with specific responses, so that the follow-up action is triggered automatically when
a contact responds to your campaign email.

Response Form
You can include response forms in the content of your campaign. These appear to recipients as links that they can click
within the email. Every click is recorded, and used to track usage statistics. In addition, each response can also trigger an
associated action to be performed automatically.

Follow-up Action
Follow-up actions are predefined actions that can be triggered by contacts' responses. The purpose of these actions
is to inform you, the creator of the campaign, when a particular contact clicks a specific response. You can choose to
either receive this information in an email notification, or by the creation of a task that appears in your user task list.
In either case, the information you receive includes campaign details, contact details, the specific response that the
contact submitted, and the date and time of the response submission.

FAQs for Sales Campaigns  

Frequently Asked Questions (FAQs) for Sales Campaigns  
This section contains some frequently asked questions (FAQs) for sales campaigns. Scroll or search to find answers to
common questions.

What is the recommended limit of contacts to include in a sales
campaign?  
The number of contacts to include in your sales campaign should not exceed 500. Oracle recommends to create a new
sales campaigns if you want to add more contacts beyond the recommended specification.
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Related Topics
• Add Contacts to Sales Campaigns

What campaign records do the different record sets permit you to
search?  
The different record sets provided in the Saved Searches window restrict your saved searches to different sets of sales
campaigns.

The following table lists and describes the record sets for sales campaigns. Not all record sets are available to all users.
For example, the record set involving subordinates is available only to managers.

Tip:  To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather
than searching all the records you can see, search all the records you and your subordinates own. Or restrict your
searches to a smaller geographical area. For example, search all the sales campaigns in one state instead of the whole
country.

Record Set Name Description

I own
 

Sales campaigns that you created.
 

My subordinates own
 

Sales campaigns owned by your subordinates.
 

All records I can see
 

Sales campaigns that you can view based on your sales team membership, your position in the
organization, and security permissions.
 

How can I add optional text to the Forward to Friend response
form?  
Using the Design E-Mail step of the Sales Campaigns process, insert the Forward to Friend link from the Insert Elements
> Response Forms list.

Next, show the Merge Fields list, and insert the Forwarder Message standard merge field in the message content:
${Standard.ForwarderMessage}. The standard merge field is replaced with any optional text you might enter when you
forward the e-mail campaign to your friend using the Forward to Friend link.

Related Topics
• Add Follow-up Tasks to Sales Campaigns

• Insert Response Forms to Sales Campaigns
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What sales campaigns display when I select the My Draft
Campaigns and the My Completed Campaigns lists?  
When you select the My Draft Campaigns list in the Sales Campaigns work area, the application displays a list of all of
the campaigns you own that are pending activation.

Selecting the My Completed Campaigns list displays all sales campaigns you own that have been completed within the
last three months.

Marketing Content  

Treatment Components  
Use treatments to represent the combination of a marketing message for targeted audience members and delivery
options for third-party suppliers. This topic provides a brief overview of the treatment components.

A treatment defines the channel-specific marketing message for targeted audience members. For example, depending
on the channel you select, the treatment can include options that control how marketing messages are sent to third-
party suppliers. You can change the content and attach marketing collateral to personalize a treatment for a specific
segment.

Treatments can contain these components:

• Products and promotions

• Distribution options

• Associated lists

• Confirmation e-mails

• Content and attachments

Products and Promotions
When you create treatment content, you can:

• Associate products and product groups with treatments.

• Use the available collateral for the products and product groups.

• Associate time-limited promotions and coupon codes to support the tracking of offers given to customers.

Distribution Options
Select the supplier and the supplier's distribution profile if you use a supplier to fulfill your marketing campaign. The
distribution profile provides instructions for creating and delivering campaign information to the supplier when the
campaign is launched.
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Associated Lists
In addition to your external recipients, you can associate a predefined list with your campaign. A predefined list is a
static list of internal employees who receive the same campaign information as your external recipients. Sending your
campaign content to a predefined list is a useful way to verify the quality of service that the supplier is providing to your
contacts.

A subscription list associated with a treatment is the list of contacts that's updated when e-mail recipients select
whether they want to subscribe or unsubscribe. You can associate a subscription list with multiple treatments. You can
use a treatment-specific subscription list to have opt-in and opt-out responses associated with a particular list.

Confirmation E-Mails
If you're required to confirm or cancel a subscription, then you must have three treatments. To illustrate this
requirement, consider the following example of three treatments that are referred to as Treatment One, Treatment Two,
and Treatment Three.

Treatment One offers recipients the options to request a subscription or cancel a subscription. Those who respond
receive a second e-mail to finalize their request. Although Treatment One is the first treatment to be sent, it's the last
that you create because it refers to the other two treatments. The table shows the required attributes and values for
Treatment One.

Treatment Step Attribute Value

Treatment Details
 

Channel
 

E-mail
 

Channel Details, Confirmation E-Mails
 

Confirm-in Treatment
 

Click the Subscribe confirmation request
link included in the e-mail content. For this
example, select Treatment Two.
 

Channel Details, Confirmation E-Mails
 

Confirm-out Treatment
 

Click the Unsubscribe confirmation request
link included in the e-mail content. For this
example, select Treatment Three.
 

Content
 

Response Forms
 

Click  Subscribe confirmation request
 
or click
 
Unsubscribe confirmation request
 

Treatment Two provides the subscribe confirmation request to recipients who click the Subscribe confirmation
request link included in the e-mail content of Treatment One. Recipients who respond to Treatment Two are added to
the subscription list associated with this treatment. This table shows the required attributes and values for Treatment
Two.

Treatment Step Attribute Value

Treatment Details
 

Channel
 

E-mail confirmation in
 

Channel Details, Associated Lists Subscription List Select a list
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Treatment Step Attribute Value

   

Content
 

Response Forms
 

Subscribe to list
 

Treatment Three provides the unsubscribe confirmation request to recipients who click the Unsubscribe confirmation
request link included in the e-mail content of Treatment One. Recipients who respond to this Treatment Three are
removed from the subscription list associated with this treatment. This table shows the required attributes and values
for Treatment Three.

Treatment Step Attribute Value

Treatment Details
 

Channel
 

E-mail confirmation out
 

Channel Details, Associated Lists
 

Subscription List
 

Select a list
 

Content
 

Response Forms
 

Unsubscribe from list
 

Content and Attachments
To create your content, select a treatment template, or you can start with a blank page. You can either upload content
from your desktop or switch the HTML editor to source mode and paste the HTML source code.

In the body of the e-mail, include text, merge fields, graphic links, and response forms. If you have both plain text and
HTML versions of the treatment, the MIME standard ensures that the appropriate version is delivered to each recipient's
email client. You can attach a file, a URL, or a text block to the treatment. You can also select product specific content.

Guidelines for Creating Global Sales Campaigns  
When you create campaigns that target multiple geographic regions, languages and currencies, consider what products
to market, what languages to include, and how the campaigns will be fulfilled. Here's some typical factors to consider:

• Product eligibility

• Contact Lists

• Treatments

• Campaigns

Product Eligibility
You must select products that apply to each geographic area that you target with your global campaign.

Contact Lists
You can create lists of contacts that are filtered by language or by geography. Name your lists so that you can identify
them by language when you add your contacts to your sales campaign.
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Treatments
If you have multiple language-specific contacts, then you must create a corresponding treatment for each language.
Name your treatments so that you can identify them by language when you add them to your sales campaigns. When
creating your marketing message and choosing supporting product collateral, consider the following:

• Marketing message text

• Text, images, and colors included in graphics

• Date and time formats

• Currency and local taxes

• Content of any collateral attached to the treatment

• Content of any web pages linked to the treatment

You must also verify that your third-party fulfillment supplier can manage your language requirements.

Campaigns
For campaigns, you can create separate treatment template for each language. For example, for Latin America, you
could create a Spanish campaign applicable to multiple countries and a Brazilian Portuguese version for Brazil.

Marketing Source Codes  
A marketing source code is a unique identifier that represents a sales campaign or marketing activity and is used to
track marketing effectiveness.

Source Codes
Marketing source codes are automatically generated for every sales campaign and marketing activity. To view a listing
of source codes and associated campaign components, navigate to the Review Marketing Source Codes task from Setup
and Maintenance. Note that a source code can be listed more than once in this page to support querying on specific
promotions and coupons.

Associate Source Codes to Responses and Leads
Source codes associated with responses and leads provide a reference to sales campaign activities for tracking
campaign effectiveness.

You can provide a source code when creating, editing, or importing a response. A response generated as a result of an
e-mail campaign trackable URL or an e-mail bounce inherits the source code derived from the originating e-mail sales
campaign.

A source code can be associated with leads when designing a sales campaign, when manually creating or editing a lead,
or when importing a lead. A lead created from a converted response inherits the source code from the response.
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Marketing Campaigns  

Overview of Campaign Management and Reporting  
You can store marketing related data, such as campaigns and campaign members created and updated in Oracle
Marketing Cloud, also called Oracle Eloqua, in your sales application.

Campaign management and reporting is greatly improved by having campaign related data maintained and
synchronized between Oracle Marketing Cloud and Oracle CX Sales.

You can view meaningful information about marketing campaigns and campaign members from the Campaigns user
interface. The Campaigns UI provides visibility into the campaign effectiveness to support the sales processes. For
example, you can view the campaigns and campaign members associated with a given lead and contact to gain key
insights for closing a sale.

In addition, your administrator can also display a campaigns subtab and an Add to Campaign button
on the Leads and Contacts user interface pages from where you can view data about the marketing
campaigns and add the associated leads and contacts to the campaign. The functional security privilege
MKT_MANAGE_MARKETING_INTEGRATION_CAMPAIGN_MEMBER must be assigned to the intended user or their role.

Note:  If you want users to have access only to Marketing Campaigns without granting them additional roles to
other objects, then you can create a custom access group. Access groups are an alternative way of granting data
permissions to users, and they use a different access path to that provided by the predefined data security policies.
For more information, see the Create a Custom Access Group topic in the Securing Sales and Fusion Service guide.

The topic describes how to create an access group, create object sharing rules to give group members access to object
data, and add members to the group. For the object sharing rules, use the All Marketing Campaigns predefined rule
which gives full access to campaign records. You can create a group membership rule to add members to your access
group based on user name, role, organization and so on. For more information, see the Create Membership Rules for
Custom Access Groups topic in the Securing Sales and Fusion Service guide.

You can add contacts or leads to marketing campaigns from these locations within your sales application:

• Campaigns subtab on the Edit Contact page

• Campaigns subtab on the Edit Lead page

• Campaign Members subtab on the View Campaign page

• Contact and Lead saved search pages in Workspace

Use the campaign summary data to view associated leads, contacts, opportunities, and revenue amounts. You can add
contacts and leads to marketing campaigns, and view only already added contacts or leads through the Campaign
Members subtab. The total number responding to a campaign represents the total count of campaign members who
have responded to a marketing campaign and can only be viewed from the Analytics subtab. Campaign members
include either leads or contacts that were sent or responded to a marketing campaign and have a status of Responded
or Sent. Note that the response is only counted once even when a campaign member has responded multiple times to
the same campaign.
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Related Topics
• About Campaign Management Reports

• Enable the Campaigns Subtab and Add to Campaign Button in Leads

• Enable the Campaigns Subtab and Add to Campaign Button in Contacts

• Enable the Campaign Analytics Tab in Campaigns List Page

About Campaign Management Reports  
You can view predefined campaign-related reports and charts to determine the effectiveness of your campaigns are
evaluate how they're progressing and performing.

You can also create your own specific Campaign reports and charts using the Campaign and Campaign Member subject
areas to suit your business needs.

The following subject areas enable the creation of reports on the Marketing Cloud and your sales application data.

• Campaign Members

• Campaign Opportunities

For example, sales and marketing operations can run campaign related reports and perform analysis on marketing
attribution and evaluate a campaign's return on investment (ROI). The Profile link on the View Campaign shows
some details about the campaign such as name, type and current status of the campaign. It also shows the owner,
and the dates when the campaign started and ended as well as a brief description and costs of the campaign. Your
administrator can use Application Composer to expose or hide such details or change the layout of the fields as they
appear in the Profile page.

The Campaign Analytics subtab on the View Campaign page shows the campaign member dashboard. Your
administrator can use Application Composer to expose a Campaign ROI dashboard from the Campaign List page.

Access these reports by clicking the Campaign ROI Analytics link from the Campaign List page.

Report Access this report to...

Campaign ROI Analysis
 

• Determine how each of your campaigns are performing.

• Measure the effectiveness of the campaign by calculating the return on investment (ROI) and
average costs for your campaigns.

The Actual ROI is represented as a percentage (total opportunity revenue minus the actual cost
divided by the actual cost).

• View the pipeline ROI calculated as a percentage (total revenue on open opportunities minus the
actual cost divided by the actual cost).

• Filter the report data by campaigns with start date in the last 180 days.

Other time filter criteria include last quarter, last two quarters, and last year. You can set your own
time period to run this report.

Campaign Revenue
 

• Measures the total revenue of successful campaigns that are tied to won opportunities.

• Analyze which won opportunities have resulted from which campaigns.
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Report Access this report to...

• Filter the report data by campaigns with the default start date in the last 180 days.

Other time filter criteria include last quarter, last two quarters, and last year. You can set your own
time period for which to run this report.

Top Campaigns
 

• Displays the top 20 campaigns having the highest ROI in the last six months.

• View the total revenue won opportunities value for each of the campaigns.

Related Topics
• Overview of Campaign Management and Reporting

Add Leads and Contacts to Marketing Campaigns  
You can include contacts and leads created from your sales application as campaign members to your marketing
campaigns created and updated in Oracle Eloqua. After the added campaign members are synchronized to Oracle
Eloqua, they get added to the specified marketing campaigns.

Add contacts or leads as campaign members to marketing campaigns from these locations within your sales
application:

• Campaigns subtab on the Edit Lead page

• Campaigns subtab on the Edit Contact page

• Campaign Members subtab on the View Campaign page

Note:  These subtabs are hidden by default but your administrator can make them available to you through
Application Composer. See the related topics for more information.

Add a Lead or a Contact to Campaigns
From the Campaigns subtab in your Edit Lead and Edit Contact pages, you can add a lead or contact that you want
to an existing marketing campaign as campaign members. Once you click Add to Campaign you select the specific
campaigns to where your leads or contacts are added.

Here's an example of how to add a lead to a marketing campaign from the Edit Lead UI:

1. Sign in as a sales representative or a sales manager.
2. Navigate to Sales > Leads to go to the Leads work area.
3. Select a lead that you want to add as a campaign member to a marketing campaign.
4. From the Edit Lead page, click the Campaigns subtab.
5. Click Add to Campaign to go to the Add: Campaigns screen.
6. Search for and select the existing marketing campaigns that you want.
7. Click Apply and then click OK.

The selected lead is now included as a campaign member in your selected marketing campaigns.
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To add a contact to a marketing campaign, go to the Sales > Contacts work area and follow similar steps. From the Edit
Contact page, click Add to Campaign and select the specific campaigns to where you want your contact added as a
campaign member.

Add Leads and Contacts to a Campaign
When you have added the marketing campaigns that you want, you can view and access them from the Campaign
Members subtab on the Campaign Details page.

From here, you can add additional campaign members (leads and contacts) as follows:

1. Navigate to the Campaigns work area.
2. From the View Campaign: Overview page, select and open a campaign that you want to add additional leads

and contacts.
3. Click the Campaign Members subtab.
4. Click Add Contacts to go to the Add: Contacts screen.
5. Search for and select the contacts that you want to add to your existing marketing campaign as campaign

members.
6. Click Apply and then click OK.

Note:  You can't remove contacts from a campaign once the campaign is activated.

The selected contacts are now included as campaign members to your selected marketing campaigns.

Similarly, if you want to add additional leads as campaign members to an existing marketing campaign, click Add Leads
to go to the Add: Leads screen and follow similar steps.

Associate Campaigns with Leads and Opportunities  
You can determine the effectiveness of your campaigns by associating and selecting campaigns for both leads and
opportunities. For example, you might want to know which campaigns have influenced the lead and contributed
towards the sales pipeline.

You can now associate one or more campaigns with lead and opportunity records in your sales application. You can also
mark one of the associated campaigns as your primary campaign for a specific lead or opportunity. When you convert a
lead to an opportunity, the campaign associations and the primary campaign check box is preserved on the converted
opportunity.

1. From the Campaigns list page, select the campaign you want.
2. From the Campaign Members subtab, click Add Leads to add leads as campaign members to the selected campaign.

After the added campaign members are synchronized to Oracle Eloqua, they get added to the specified marketing
campaigns.

Note:  You can't remove leads from a camapign once the campaign is activated.
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3. Navigate to edit the associated lead page and the selected campaign is displayed as your Primary Campaign as

shown here:  
4. From the Actions menu, select Convert to convert the lead to an opportunity.

After the successful conversion, the campaign associations and the primary campaign check box is preserved on the
converted opportunity.

5. Use the Campaigns subtab to view a summary page of the associated leads and opportunities
with the Primary campaign highlighted as shown in this Edit Opportunity page example.
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FAQs for Marketing Content and Campaigns  

Frequently Asked Questions (FAQs) for Marketing Content and
Campaigns  
This section contains some frequently asked questions (FAQs) for marketing content and campaigns. Scroll or search to
find answers to common questions.

How can I view the amount of responses for a campaign?  
From the Campaigns List page, you can drill down into each campaign record to view campaign members that have
responded to a given campaign, and view campaign member details.

In addition, you can view campaign details including campaign name, start and end dates, status, and other standard or
custom attributes. The total number responding to a campaign represents the total count of campaign members with
a status of Responded. Note that the response is only counted once even when a campaign member has responded
multiple times to the same campaign.

How many campaign members are associated with a campaign?  
From the Campaigns List page, you can drill down into each campaign record to view campaign members that have
responded to a given campaign.

You can also access the Campaign Members report that shows the amount of members in a campaign from the
Campaign Analytics subtab on the View Campaign summary page. You can filter the report data by lead or contact
name and response date range.

Your application administrator can filter what user-defined or predefined campaign related reports to display to
campaign users. For example, the default Campaign Analytics subtab search filter is Record Set = All Members. This
search returns all campaign members with a status of Responded and Sent.

How can I ensure Opportunity amounts get displayed in Marketing
Campaigns?  
You can use the View Campaign summary page to view associated leads, contacts, opportunities, and revenue amounts.

To ensure that opportunities and revenue amounts are visible in your Campaigns UI, you must:

• Convert the lead to an opportunity after you associate it to the campaign

• Correctly map the lead attributes to the newly created opportunity
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For more information about mapping attributes, see the related topic Attribute Mapping When Converting Leads to
Opportunities in the Implementation Reference guide.

What happens to existing campaigns if I update the campaign
template?  
Existing campaigns that were created from the template are unaffected. Your changes will only affect campaigns
created after the template is updated.

Campaign templates provide models to use as a basis when planning and designing sales campaigns. When you use a
template to create a sales campaign, the template values are copied to the new campaign and the template's purpose
then ends for that campaign.

What's the difference between a predefined list and a subscription
list?  
A predefined list is a static list of contacts.

A subscription list is another type of static list. When associated with a specific treatment that has subscription response
forms included in the treatment content, it will reflect the responses of campaign recipients who choose to subscribe.
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14  Leads

Overview of Lead Management  
Leads provide a way for your sales organization to capture the potential interest in your products. After your
organization qualifies the information and determines the lead is worth pursuing, you turn it into an opportunity and
the sales process begins in earnest.

Use the Contact time zone field to capture the preferred time zone of a contact pursued on your lead. The contact time
zone is based on the contact address and helps you know the preferred time to call or email a prospect or customer. You
can also use the functional who columns to capture the record history of a lead. The columns let you accurately report
on leads that are imported from other systems.

Other lead management features help to align marketing and sales objectives from lead generation to lead execution.
Lead information is generated from a variety of sources and captured from:

• A company's existing contacts

• Sales campaigns

All leads then undergo the qualification and assessment process and are qualified either manually by a salesperson or
automatically based on predefined rules. Finally, qualified leads are converted into opportunities.

Related Topics
• How Lead Components Work Together

Lead Processing  

Overview of Lead Processing  
Lead data is generated from a variety of sources and goes through further enrichment based on updates and follow-
up activities. Lead quality must be assessed periodically so that leads are distributed to the right salesperson to ensure
timely lead follow up and closure.

This section contains information about how to import lead data from an external data source into your sales
application using the Import Management feature.

Overview of Import Process  
This topic provides an overview of the components used to import data.

201



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 14
Leads

Import Process Flow
The following figure explains the various stages in the import process:

1. Evaluate your import data.
2. Identify the relevant import objects.
3. Map your data to the import objects.
4. Create an import activity.
5. Verify the import results.

Import Objects and Import Queue
You can find details about the attributes such as data type, length, and user key information for each object on the
Import Objects tab. You can download the template for each import object by clicking the Download icon. You can
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create a mapping either while creating an import or separately using the Import Objects tab. On the Import Object
Details page, click the Display Name link for the object to navigate to the Manage Mapping page. On this page, you
can create a new import mapping, upload a map, or manage an existing mapping.

The Import Queue tab lets you view the imports that are in various statuses, such as active, completed, or unsuccessful.
You can further drill down into an import activity by clicking the import name link to view the status details.

Application Composer and Custom Extensions
If you create additional attributes to an existing object or create custom objects in Application Composer, then these
extensions are available for import and export once you publish your sandbox.

Related Topics
• Define Objects

Import Your Sales Lead Data  
Use this topic to import Sales Lead data into Oracle Applications Cloud. You can use the import functionality to create,
update, or delete Sales Lead records.

To import Sales Lead records, perform the following tasks:

1. Map your source sales lead data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

Use the Contact time zone field to save the preferred time zone of a contact pursued on your sales lead. The contact
time zone is based on the contact address and helps you know the preferred time to call or email a prospect or
customer. You can also use the functional "who" columns to save the record history of a sales lead. The columns let you
accurately report on sales leads that are imported from other systems.

Other sales lead management features help to align marketing and sales objectives from sales lead generation to sales
lead execution. Sales Lead information is generated from a variety of sources and obtained from:

• A company's existing contacts

• Sales campaigns

All sales leads then undergo the qualification and assessment process and are qualified either manually by a
salesperson or automatically based on predefined rules. Finally, qualified sales leads are converted into opportunities.

How You Map Your Source Data to Target Object Attributes
To import your sales lead data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.
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• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

To better manage your sales lead information, the sales lead object has the following child objects:

• Sales Lead Contact

• Sales Lead Product

• Sales Lead Resource

If you want to import only a few records, then you can create a single CSV file for all sales lead attributes. However if
you want to import a large number of records, then you may decide to create multiple CSV files, one for each of the
sales lead child objects. Note that you must have imported the CSV file for sales lead object successfully before trying
to import the CSV files for the child objects. There are separate help topics describing how to import each of these child
objects. For more information, see the related topics section.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the
import process to uniquely identify the records. The file import process uses the attribute values to automatically map
your source data to the target object attributes in Oracle Applications Cloud.

The preferred options to uniquely identify an object record are as follows:

• Internal ID: If you're identifying a record that already exists in Oracle Applications Cloud, then you can use
the internal ID of the record, a system-generated unique identifier Attributes with "id" in the attribute name
are typically internal IDs. You can determine the internal ID of a record by exporting Oracle Applications
Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better
performance and reduces the import duration. For the Sales Lead object, this attribute is LeadId.

• Public unique identifiers: If you're creating new records, then you can provide a user-friendly public unique
identifier (attributes denoted with 'Number' and usually visible in the business object's UI). If you update a
record for which you have previously provided a Number attribute, or for which a Number attribute is visible in
the object's UI, you can use the Number attribute to identify the record. For the Sales Lead object, the attribute
is LeadNumber.

Required Attributes and Validations for Sales Lead Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for importing new Sales Lead records, required attributes for updating Sales Lead
records, prerequisite setup tasks for the attributes, and specific validations, if any, for Sales Lead import:
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
record

Updating an Existing
Sales Lead record

AcceptedDate
 

The date the recommended
lead generated by the Sales
Prediction engine was
accepted by a sales person
or lead qualifier to pursue
 

No validation
 

A value is required if
you specify the value for
LeadAcceptedFlag as Y.
 

Not required
 

ActionCode
 

Indicates explicitly the
operation to be performed
on a row: INSERT to
create a new record in the
destination tables, UPDATE
to update an existing record
in the destination table,
 DELETE to delete the
record.
 

If no value is provided,
 the record is updated if
it already exists. Else, it's
inserted
 

Not required
 

Not required
 

ConvertedTm
 

The date when the lead
was converted to an
opportunity
 

No validation
 

A value is required if you
specify the value for Lead
StatusCd as CONVERTED.
 

Not required
 

LeadName
 

The name that identifies
the lead
 

No validation
 

A value is required if you're
creating a new lead.
 

Not required
 

LeadNumber
 

The Lead's public unique
identifier value
 

If providing a value to
update an existing lead,
 the value must exist in the
column LEAD_NUMBER.of
the MKL_LM_LEADS table.
 

If providing a value and
creating a new lead, the
value must be unique.
 

A value is required, if
updating an existing lead
and you're not providing
the unique ID of the lead
(ObjectKey)
 

ObjectKey
 

The unique ID for the
existing lead record in the
destination table
 

Automatically generated
by the import process
if creating new record.
If updating an existing
record and providing the
LEAD_NUMBER, the import
process defaults the LEAD_
ID.
 

Do not provide a value if
creating a new lead.
 

A value is required, if
updating an existing lead
and you're not providing
the LeadNumber.
 

OwnerId
 

The unique ID for the
existing resource party
in the destination table.
The owner must also be an
internal resource included
as a member of the lead's
sales team
 

If providing a value, the
value must exist in the
column PARTY_ID of the
HZ_PARTIES table, The
value must also exist in
the column PARTY_ID of
the JTF_RS_RESOURCE_
PROFILES table. The
identified party must be
assigned as a sales team
resource for the existing
lead or included in the
resources imported in the
same batch as this record.
 

A value is required, if
creating a new lead and
you don't provide the
owner's source system
code and reference
(OwnerOrigSystem and
OwnerOrigSystemReference)
 

Not required
 

QualifiedDate
 

The date when the lead was
qualified

No validation
 

A value is required, if you
optionally provide the lead

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
record

Updating an Existing
Sales Lead record

 status (StatusCd) value as
QUALIFIED, indicating that
the lead is qualified.
 

RejectedTm
 

The date when the lead was
rejected
 

No validation
 

A value is required, if you
optionally provide the
lead registration status
(ApprovalStatus) value as
REJECTED, indicating that
the lead is rejected.
 

Not required
 

RetiredTm
 

The date when the lead was
retired
 

No validation
 

A value is required, if you
optionally provide the lead
lead status (StatusCd) value
as RETIRED, indicating that
the lead is retired.
 

Not required
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the sales lead object.
The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Sales Lead object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the sales lead information. To create an import
activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Sales Lead from the

Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.
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Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

• Import Data

Import Your Sales Lead Contact Data  
You can use the Import Management to create, update, or delete sales lead contact records.

You can import sales lead contact records using these steps:

1. Map your source sales lead contact data to Oracle Applications Cloud object attributes. This way the import
process would know where to insert each of the information bits.

2. Create the source CSV file with the sales lead contact data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
To import your sales lead contact data into Oracle Applications Cloud, you must populate a .csv file with your source
data and map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.
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Select a Unique Identifier for Your Records

All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new sales lead contacts or
are updating sales lead contacts that have source system reference data, then provide the source system and
source system reference values.

Required Attributes and Validations for Sales Lead Contact Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for sales lead contact records, prerequisite setup tasks and specific validations, if
any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Contact record

Updating an Existing
Sales Lead Contact record

LeadOrigSystem
 

The code that identifies the
original source system for
the sales lead
 

If providing a value and
importing a new sales lead
in the same import as this
lead contact association,
 the value must be part of a
unique combination of the
source system reference
(LeadOrigSystemReference)
and the source system code
(LeadOrigSystem) in the
MKT_IMP_LEADS_T table.
 

Conditionally required,
 when the lead is created in
the same batch as adding a
new lead contact
 

Not required
 

LeadOrigSystemReference
 

The ID that identifies the
original source system
reference for the sales lead
 

If providing a value and
importing a new sales lead
in the same import as this
lead contact association,
 the value must be part of a
unique combination of the
source system reference
(LeadOrigSystemReference)
and the source system code
(LeadOrigSystem) in the
MKT_IMP_LEADS_t table.
 

Conditionally required,
 when the lead is created in
the same batch as adding a
new lead contact
 

Not required
 

LeadId
 

The unique ID for the
existing lead record in the
destination table
 

The value provided must
match the value in the
LEAD_ID column of the
MKL_LM_LEADS table.
 

Conditionally required,
 when the lead is created in
a different batch as adding
a new lead contact.
 

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Contact record

Updating an Existing
Sales Lead Contact record

PartyOrigSystem
 

The code that identifies the
original source system for
the contact
 

If providing a value,
 the combination of
source system reference
(PartyOrigSystemReference)
and source system code
(PartyOrigSystem) must
exist in the columns ORIG_
SYSTEM_REFERENCE and
ORIG_SYSTEM of the HZ_
ORIG_SYS_REFERENCES
table.
 

Conditionally required,
 when you don't provide the
contact's party ID (PartyId)
 

Conditionally required,
 when you don't provide
the unique ID for the record
(LeadTcMembersId) or the
contact's party ID (PartyId)
 

PartyOrigSystemReference
 

The ID that identifies the
original source system
reference for the contact
 

If providing a value,
 the combination of
source system reference
(PartyOrigSystemReference)
and source system code
(PartyOrigSystem) must
exist in the columns ORIG_
SYSTEM_REFERENCE and
ORIG_SYSTEM of the HZ_
ORIG_SYS_REFERENCES
table.
 

Conditionally required
when you don't provide the
contact's party ID
 

Conditionally required
when you don't provide the
unique ID for the record
(LeadTcMembersId) or the
contact's party ID (PartyId)
 

PartyId
 

The unique ID for the
existing contact's party
record in the destination
table
 

The value provided must
match the value in the
PARTY_ID column of the
HZ_PARTIES table.
 

Conditionally required
when you don't provide
the contact's source
system and source system
reference
 

Conditionally required
when you don't provide
the contact's source
system and source system
reference
 

PrimaryFlag
 

Specifies whether the
provided contact is a
primary contact on the
sales lead
 

The value must be either Y
or N.
 

Conditionally required, as at
least one contact for a lead
has this value set to Y.
 

Conditionally required, as at
least one contact for a lead
has this value set to Y.
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the sales lead contact
object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Sales Lead Contact object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.
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Create the Import Activity
After you have the CSV file ready, create an import activity to import the sales lead contact information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Sales Lead Contact from

the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

• Import Data

Import Your Sales Lead Product Data  
You can use the Import Management to create, update, or delete sales lead product records.

You can import sales lead product records using these steps:

1. Map your source sales lead product data to Oracle Applications Cloud object attributes. This way the import
process would know where to insert each of the information bits.

2. Create the source CSV file with the sales lead product data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
To import your sales lead product data into Oracle Applications Cloud, you must populate a .csv file with your source
data and map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
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• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new sales lead products
or are updating sales lead products that have source system reference data, then provide the source system
and source system reference values.

Required Attributes and Validations for Sales Lead Product Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for sales lead product records, prerequisite setup tasks and specific validations, if
any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Product record

Updating an Existing
Sales Lead Product record

ItemId
 

The unique ID for the
existing sales catalog
product (item) record in the
destination table
 

The value provided must
match the value in the
INVENTORY_ITEM_
ID column of the EGP_
SYSTEM_ITEMS_B table.
 

Conditionally required,
 when you don't provide
the ProductName
and ProductGroupId/
ProductGroupName
 

Conditionally required,
 when you don't provide
the ProductName
and ProductGroupId/
ProductGroupName
 

ItemNumber
 

The unique ID for the
existing sales catalog
product (item number)
record in the destination
table
 

The value provided must
match the value in the
ITEM_NUMBER column of
the EGP_SYSTEM_ITEMS_
B table.
 

Conditionally required,
 when you don't provide
the ProductName
and ProductGroupId/
ProductGroupName
 

Conditionally required,
 when you don't provide
the ProductName
and ProductGroupId/
ProductGroupName
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Product record

Updating an Existing
Sales Lead Product record

LeadNumber
 

Leads Public Unique
Identifier value
 

The value provided must
match the value in the
LEAD_NUMBER column of
the MKL_LM_LEADS table.
 

Conditionally required,
 when you don't provide the
LeadId
 

Conditionally required,
 when you don't provide the
LeadId
 

PrimaryFlag
 

Indicates whether the
product or product group
is the primary product of
interest for the lead
 

The value must be either Y
or N.
 

Conditionally required,
 as at least one product or
product group for a lead
has this value set to Y
 

Conditionally required,
 as at least one product or
product group for a lead
has this value set to Y
 

ProductGroupInternalName
 

Internal name for the sales
catalog product group
 

The value provided
must match the value in
the INTERNAL_NAME
column of the QSC_PROD_
GROUPS_B table.
 

Conditionally required,
 when you don't provide
the ProductGroupId and
ItemId/ProductName
 

Conditionally required,
 when you don't provide
the ProductGroupId and
ItemId/ProductName
 

ProductGroupId
 

The unique ID for the
existing product group
record in the destination
table
 

The value provided
must match the value
in the PROD_GROUP_ID
column of the QSC_PROD_
GROUPS_B table.
 

Conditionally required,
 when you don't provide the
ProductGroupName and
ItemId/ProductName
 

Conditionally required,
 when you don't provide the
ProductGroupName and
ItemId/ProductName
 

ProductGroupName
 

The internal name for the
sales catalog product group
 

The value provided
must match the value in
the INTERNAL_NAME
column of the QSC_PROD_
GROUPS_B table.
 

Conditionally required,
 when you don't provide
ProductGroupId and
ItemId/ProductName
 

Conditionally required,
 when you don't provide
ProductGroupId and
ItemId/ProductName
 

ProductName
 

The internal name for the
sales catalog product
 

The value provided must
be defined for the sales
catalog specified for the
QSC_SALES_PRODUCTS_
INVENTORY_ORG_ID
profile.
 

Conditionally required,
 when you don't
provide the ItemId
and ProductGroupId/
ProductGroupName
 

Conditionally required,
 when you don't
provide the ItemId
and ProductGroupId/
ProductGroupName
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the sales lead product
object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Sales Lead Product object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.
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Create the Import Activity
After you have the CSV file ready, create an import activity to import the sales lead product information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Sales Lead Product from

the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

• Import Data

Import Your Sales Lead Resource Data  
You can use the Import Management to create, update, or delete sales lead resource records.

You can import sales lead resource records using these steps:

1. Map your source sales lead resource data to Oracle Applications Cloud object attributes. This way the import
process would know where to insert each of the information bits.

2. Create the source CSV file with the sales lead resource data you want to import.
3. Kick off an import activity.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes
To import your sales lead resource data into Oracle Applications Cloud, you must populate a .csv file with your source
data and map that source data to target object attributes in Oracle Applications Cloud.

You must do the following before creating the .csv file for data import:

• Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
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• Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your
objects.

• Understand your options for uniquely identifying the records.

• Ensure parent records exist before importing child records.

• Identify the target object attributes that are required in the .csv file for a successful import

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

• You have completed all the prerequisites for importing each attribute in your source data.

• You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

All records must be unique in the application. You can use one of these to identify records:

• Public unique identifiers: If you're creating records, then you can provide an easily understandable public
unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID
attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use
the Number attribute to identify the record. For more information about public unique identifiers, see the topic
"How You Use Alternate Keys to Import Records" in Related Topics section.

• Source system and source system reference: Source system is an identifier for the external system, and source
system reference is a unique identifier within the external system. If you're importing new sales lead resources
or are updating sales lead resources that have source system reference data, then provide the source system
and source system reference values.

Required Attributes and Validations for Sales Lead Resource Object
To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure
that you provide valid values for the attributes.

This table lists the required attributes for sales lead resource records, prerequisite setup tasks and specific validations, if
any:

Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Resource record

Updating an Existing
Sales Lead Resource
record

LeadId
 

The unique ID for the
existing lead record in the
destination table
 

The value provided must
match the value in the
LEAD_ID column of the
MKL_LM_LEADS table.
 

Conditionally required,
 when you don't provide the
LeadNumber
 

Conditionally required,
 when you don't provide the
LeadNumber
 

LeadNumber
 

The Lead's Public Unique
Identifier value
 

The value provided must
match the value in the
LEAD_NUMBER column of
the MKL_LM_LEADS table.
 

Conditionally required,
 when you don't provide the
LeadId
 

Conditionally required,
 when you don't provide the
LeadId
 

LeadOrigSystem
 

The code that identifies the
original source system for
the sales lead

If providing a value and
importing a new sales lead
in the same import as this

Conditionally required,
 when the lead is created in

Not required
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Resource record

Updating an Existing
Sales Lead Resource
record

 lead resource association,
 the value must be part of a
unique combination of the
source system reference
(LeadOrigSystemReference)
and the source system code
(LeadOrigsystem) in the
MKT_IMP_LEADS_T table.
 

the same batch as adding a
new team member
 

LeadOrigSystemReference
 

The ID that identifies the
original source system
reference for the sales lead
 

If providing a value and
importing a new sales lead
in the same import as this
lead resource association,
 the value must be part of a
unique combination of the
source system reference
(LeadOrigSystemReference)
and the source system code
(LeadOrigSystem) in the
MKT_IMP_LEADS_T table.
 

Conditionally required,
 when the lead is created in
the same batch as adding a
new team member
 

Not required
 

LeadResourceId
 

The unique ID for the
existing sales team
member (resource)
association record in the
destination table
 

Automatically generated by
the import process
 

Automatically generated
by the import process if
creating a new record
 

Required
 

ResourceId
 

The unique ID for the
existing resource's party
record in the destination
table
 

Provided value must match
with PARTY_ID column of
HZ_PARTIES table.
 

Conditionally required,
 when you don't provide
the resource's source
system and source system
reference or the resource's
user name.
 

Conditionally required,
 when you don't provide
the unique ID for the record
or the resource's source
system and source system
reference.
 

ResourceOrigSys
 

The source system code
that identifies the original
source system of the lead
sales team members party
 

If providing a value,
 the combination of
source system reference
(ResourceOrigSysRef)
and source system code
(ResourceOrigSys) must
exist in the columns ORIG_
SYSTEM_REFERENCE and
ORIG_SYSTEM of the HZ_
ORIG_SYS_REFERENCES
table.
 

Conditionally required,
 when you don't provide
the resource's party ID
(ResourceId)
 

Conditionally required,
 when you don't provide
the unique ID for the
record (LeadResourceId)
or the resource's party ID
(ResourceId)
 

ResourceOrigSysRef
 

The ID that identifies the
lead sales team member's
party in your legacy or
external system
 

If providing a value,
 the combination of
source system reference
(ResourceOrigSysRef)
and source system code
(ResourceOrigSys) must
exist in the columns ORIG_
SYSTEM_REFERENCE and
ORIG_SYSTEM of the HZ_

Conditionally required,
 when you don't provide
the resource's party ID
(ResourceId)
 

Conditionally required,
 when you don't provide
the unique ID for the
record (LeadResourceId)
or the resource's party ID
(ResourceId)
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Attribute Description Prerequisite Setup Task/
Import Validations

Creating a Sales Lead
Resource record

Updating an Existing
Sales Lead Resource
record

ORIG_SYS_REFERENCES
table.
 

UserName
 

The resources application
user name.
 

No validation
 

Conditionally required,
 when you don't provide
the resource's source
system and source system
reference or the resource's
unique ID
 

Not required
 

PrimaryFlag
 

Indicates whether the
resource is the Owner of
the lead
 

The value must be either Y
or N.
 

Conditionally required, as at
least one contact for a lead
has this value set to Y
 

Conditionally required, as at
least one contact for a lead
has this value set to Y
 

Go to Navigator  > Tools >  Import Management >  Import Objects, to see all the attributes of the sales lead resource
object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File
You include the data that you want to import into Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator  > Tools >  Import Management >  Import Objects.
2. Select the Sales Lead Resource object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note:  For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the sales lead resource information. To create an
import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Sales Lead Resource from

the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review

and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.
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Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator  > Tools >  Import Management >  Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed.

You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Related Topics
• Potential Issues When Opening CSV Files in Excel

• How You Use Alternate Keys to Import Records

• Import Data

Lead Follow Up  

How Lead Components Work Together  
The lead life cycle includes an automated process that captures leads and then prioritizes them for sales engagement
through a scoring and ranking process. Leads are distributed to appropriate sales resources for further lead
qualification, follow-up, and conversion.

A sales lead cycle ends when salespeople convert a lead to an opportunity or when they retire a lead. A lead is retired if
no possibility exists for converting the lead to an opportunity.

Lead Life Cycle
Leads are automatically monitored for sales representative acceptance. Unaccepted or rejected leads are reassigned as
appropriate. The quality of the lead is continuously reviewed and adjusted by the lead owner at different stages of the
lead life cycle. The lead owner can be a marketing resource or a sales resource, depending at what stage the lead is at in
its life cycle. The lead life cycle is captured in the following sections:

• Lead Generation

• Lead Qualification

• Lead Distribution

• Lead Assessment

• Lead Conversion

Lead Generation
Leads are generated and captured from many different sources, such as:

• Campaign responses

• Third-party lead sources
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Flexible lead import, customer and contact creation, and deduplication ensure that sales lead generation efforts are
optimized. For example, the lead import process checks whether leads represent new or existing customers. For new
customers, data must be created for the lead. If the lead is an existing customer, then part of the lead import process
checks to ensure customer and lead information isn't duplicated.

Lead Qualification
Marketing departments help with the lead qualification process to ensure that only qualified leads are handed over
to sales. Leads are typically ranked as Hot, Warm, or Cool. Leads are further qualified by the use of company-specific
standard questions to score a lead. Lead scores are numeric values typically ranging from 1 to 100, in which a high score
represents high quality.

It isn't good practice to let stale leads build up. Standardized criteria for lead qualification ensure that quality leads
reach the sales representative and help maximize the conversion rate from leads to opportunities. For example, your
organization has criteria and processes for ensuring that leads are either developed or retired within 30 days. When
the lead age is greater than 30 days and the rank is Warm, Marketing reassigns the leads for follow-up by an internal
telemarketing group. If leads can't be qualified or further developed to revenue opportunities, then rejected leads are
reassigned or manually set to retired.

Lead Distribution
As the qualification of leads progresses into real potential prospects, assignment manager uses expression-based
rules to associate one or more internal sales representatives with each lead. If the lead is associated with either a sales
prospect or a sales account, then assignment manager uses territory definitions to associate (typically one) internal
territory with each lead. The sales representative newly assigned to the lead can be related to the lead record directly
through the lead team or indirectly through a territory associated with the lead. The sales representatives can view and
update those leads assigned to them in the lead work area and can claim ownership of the lead by accepting the lead.

Other assigned resources can view and update the lead, but they can't make themselves the owners. If a sales prospect
changes to a sales account by adding an address, assignment manager is automatically called during the next
automated assignment cycle. Depending on the assignment logic, the lead can be reassigned to a different territory
or sales resource. If the assigned sales representative takes no action on a lead for several days, then the lead can be
manually reassigned to another sales representative.

Lead Assessment
Sales representatives must evaluate the quality of the information that they have received for the lead. They determine
whether the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the
help of preconfigured assessment templates. Assessment templates help qualify the lead by:

• Reviewing the content shared with the customer during a campaign

• Framing the lead in the context of the campaign

• Ensuring the salesperson understands the information sent to the customer

You use the lead assessment feature to assess leads. Predefined questions help determine the likelihood of the lead
being accepted by Sales. For example, you're a sales representative and you ask the customer a series of questions
created by Marketing and Sales to assess the quality of the lead. You record the answer of each question and the lead
assessment tool automatically factors the answer into the assessment score of the lead. At the end of the call, you note
that the assessment lead score is high, so you request that the lead is assigned to the direct sales team. If the lead score
was low, then you might want to retire the lead. If the lead needs qualifying, then you can decide to leave it in your list
of leads for follow-up. Finally, if the lead is good, but the potential revenue opportunity is less than a predetermined
monetary amount, for example, twenty-five thousand dollars, then you can convert the lead to an opportunity to pursue
as part of the sales cycle.
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Lead Conversion
After establishing that the lead has potential, the sales representative can convert the lead to an opportunity. You can
schedule meetings and presentations with your lead contact to move the opportunity along the sales pipeline. To track
the progress of the lead, you can capture contact notes and associate them with the contact and opportunity.

Note:  Administrators can write a validation rule to check if there's more than one lead attached to an opportunity. For
example, using a Groovy script, you can restrict the creation of another opportunity from a lead. To learn more about
writing validation rules and scripts, see the Groovy Tips and Techniques chapter in the Groovy Scripting Reference
guide, and the Groovy Scripts chapter in the Configuring Applications Using Application Composer guide.

As the lead progresses through its life cycle, decisions to retire the lead are based on reasons such as:

• You can't verify the customer and lead details.

• The customer isn't interested in pursuing the lead any further.

Differences Between Response, Lead, and Opportunity  
This table describes the main differences between a response, a lead, and an opportunity.

Response Lead Opportunity

A response is an interaction initiated by
the customer in response to a marketing
stimulus. Every outbound sales activity is a
sales stimulus.
 

A lead is an inquiry, referral, or other
information, obtained through a sales
campaigns, or other means that identifies:
 

• Potential contact or prospect

• Specific purchase interest

You can create a lead if the specific purchase
interest isn't known at the time. However,
 to qualify a lead you must record a primary
purchase interest.
 

An opportunity is a pending sale of a product
or service that can be forecasted and tracked
using summary data such as:
 

• Potential revenue

• Sales stage

• Win probability

• Expected close date

Responses are created from interest recorded in
response to sales activities. Responses include:
 

• Providing answers to phone survey
questions

• Subscribing to a list

• Replying to an email response form
request

As interest for the product or service matures,
 responses are elevated as leads.
 

Leads are mostly created by automated
lead capture or lead import processes which
periodically create qualified responses as sales
leads.
 
Leads are sometimes created from the
response data of a contact or prospect who has
expressed a need or interest in a product or
service offered by the business.
 

Opportunities are created by sales
administrators when they have identified
a qualified lead with a potential revenue
opportunity. Leads are converted to
opportunities when significant sales investment
is foreseen to close the deal.
 
A salesperson can create opportunities from
scratch, without previously having a response
or lead created.
 

Responses aren't included as part of the sales
forecast.
 

Leads aren't included as part of the sales
forecast.
 
 

Inclusion of opportunities in the sales forecast
is at the discretion of the sales administrator.
However, not all opportunities are included and
the decision to include them may depend on
your company's requirements.
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Response Lead Opportunity

 

Lead Actions  
Use lead actions to manage leads. This topic provides a brief description of the actions that you perform on a lead. Lead
actions are generally grouped into these categories:

• Standard create, edit, delete, and update functions such as performing a mass update

• Ranking, scoring, and qualifying actions to assist in prioritizing leads

• Accepting, rejecting, reassigning, and retiring actions to ensure leads are in the right queue for pursuing

• Converting leads to opportunities to continue sales pursuits and include in sales forecasting

The ability to perform each action depends on:

• Privileges assigned to your role

• Access level as a lead sales team member

• Current status of the lead

Perform Lead Actions
Here are some of the actions you can perform to manage single and multiple lead records.

Action Description

Accept
 

Updates the lead with you as the owner. The Request Sales Lead Assignments process assigns sales
team territories and resources based on predefined rules. The rules are specified in the Assignment
Rule for Ranking Leads profile option.
 

Add to Campaign
 

You can add leads as campaign members to your marketing campaigns created and updated in Oracle
Eloqua. After the added campaign members are synchronized to Oracle Eloqua, they get added to the
specified marketing campaigns.
 

Assign Partner
 

Use to assign a single lead to a partner. The sales channel of a lead indicates whether the lead is being
handled directly by an internal salesperson (Direct), or indirectly (Partner) by an outside partner, such
as a distributor or a reseller.
 

Convert to Opportunity
 

Creates an opportunity based on lead information. The lead status is updated to converted.
 

Create Appointment
 

Use to create an appointment when working on your lead.
 

Create Call Report
 

Use to create a call report when working on your lead. A call report is a central place for salespeople to
capture what happened in a sales activity, make related changes, and track key updates.
 

Create Note
 

Use to create a note when working on your lead.
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Action Description

Create Task
 

Use to create a task when working on your lead.
 

Delete
 

Use the Delete action to remove a lead from your list of leads you own.
 

Log a Call After you complete a call with your lead, you can log the call details.
 

Qualify
 

Updates the lead status to Qualified, bypassing the automated sales lead classification process.
 

Mass Update
 

Performs a mass update of specific attributes and user-defined attributes from the Leads Overview
work area when selecting multiple records.
 

Rank
 

Submits the Request Sales Lead Assignments process to automatically assign a lead rank based on
predefined rules specified in the Assignment Rule for Ranking Leads profile option. A rank represents
the priority of the lead, such as Hot, Medium, and Cool.
 

Reassign
 

Provides choices for when the sales lead assignment process evaluates the lead to reassign sales team
members and territories to the lead:
 

• Automatic assignment

Lead is selected for reassignment and is reassigned when the Request Sales Lead Assignments
process next runs using the Reassign process selection criteria.

• Immediate automatic assignment

Immediately runs the Request Sales Lead Assignments process, reevaluating, and reassigning per
the process.

• Manual assignment

You can select an owner to assign to the lead from a list of eligible resources.

A lead must have a Qualified or Unqualified status to be reassigned.
 

Note:
You can send a notification when a Lead is assigned to a new owner. See the section Sample Groovy
Scripts for Notifications in the Notifications chapter of the Implementation Reference guide for more
information.
 

Retire
 

Updates the lead status to a retired lead indicating the lead is no longer one that needs pursuing.
 

Reject
 

Removes you as the lead owner. The accepted indicator and assignment status are also updated to
reflect that the lead is no longer accepted. The lead is eligible for reassignment when:
 

• The next scheduled Sales Lead Processing Activity submits the Request Sales Lead Assignments
process

• The lead meets the processing activity's selection criteria

• The previous lead owner is excluded when assigning team resources

The reject reason, and the number of times the lead is rejected, is available when searching leads. This
information is displayed in the Overview page for analysis and to provide possible indicators that the
lead should be retired.
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Action Description

 

Score
 

Submits the Request Sales Lead Assignments process to automatically assign a lead score based on
predefined rules specified in the Assignment Rule for Scoring Leads profile option.
 
Lead assignment score is different from qualification and assessment scores. A lead score can be used
as a source for predefined rules that automatically assign lead rank, qualification status, territories, and
resources.
 

Related Topics
• Lead Statuses

• Add Leads and Contacts to Marketing Campaigns

Lead Statuses  
The status of a lead is primarily determined by a user performing an action on a lead, or upon successful completion
of the lead qualification activity. Once leads have been assigned to lead qualifiers or related sales roles, lead follow-up
activities begin.

As specific actions are performed on a lead, the status of the lead changes accordingly.

Lead Status
This table describes the statuses of leads.

Status Description

Unqualified
 

A lead with a status of unqualified signifies that the lead requires additional information and
qualification activities by the lead team. Unqualified is the default status assigned to all newly created
leads.
 

Qualified
 

A qualified lead signifies that the lead is ready for sales attention. The status can be updated to
qualified by either the user selecting the Qualify action or upon successful completion of the
qualification processing activity. Leads can have a status of qualified based on many factors including
the status of the budget and the time frame of the project.
 

Converted
 

When a lead is converted to an opportunity, then the status is set to Converted.
 

Retired
 

The status of a lead is updated to Retired when a user selects the Retire action. A lead is retired when:
 

• There's no likelihood of the lead being converted to an opportunity

• A lead is no longer followed up by Sales

• A lead isn't evaluated by Marketing over a certain period of time

A retired lead can't be converted to an opportunity. Marketing users can review retired leads and then
delete them as required.
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Related Topics
• Lead Actions

Lead Conversion  
A lead's life cycle ends either when a lead is converted to a sales opportunity, or when the lead is retired. Conversion to
an opportunity stage allows the sales representative to pursue the account in the sales cycle.

After establishing that the lead has potential, the sales representative converts the lead to an opportunity. Contact is
established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

To convert a lead to an opportunity depends on the privileges assigned to your role, your access level as a lead sales
team member, and the current status of the lead. You can convert a lead to an opportunity from the Actions menu
by selecting Convert. This action creates an opportunity based on lead information. When a lead is converted to an
opportunity, the lead status is set to Converted.

Leads to Opportunities Conversion
You convert a lead to an opportunity when the lead is ready for further processing along the sales cycle. Once the
conversion is successfully completed, you can review the newly created opportunity using the opportunities UI. During
your review, you might want to retain only a select few lead product lines to pursue as opportunity revenue line items.
Since the conversion process automatically creates revenue lines from all lead lines, you can remove unwanted revenue
lines from the opportunities UI. You can, at a later stage, create another opportunity from the removed lead revenue
lines by converting the lead to an opportunity again. You can then decide to keep only those revenue lines that you want
on the newly created opportunity.

When you convert a lead to an opportunity, the following rules may apply depending on the setup criteria for your
company:

• The person converting the lead becomes the primary sales team member for the opportunity.

• The customer reference on the original lead is maintained for the opportunity.

• The associated lead team members are copied with the same primary team member.

• The newly created opportunity is assigned to the appropriate sales territories.

Note:  If a lead is converted to an opportunity by a user who isn't the owner of the lead, then that user becomes the
owner of both the converted lead and opportunity.

You can view opportunities associated with leads in the leads UI. If you don't see the converted lead in your list of
opportunities, this means that the opportunity is assigned to a different territory.

Convert Leads Using a Smart Action
You can take actions on lead items from your list of lead records by using the Actions menu (three dots on the right
of the item) on the My List for Leads page. For example, you can use the Convert quick action to covert a lead to an
opportunity. From the Convert Lead window, you can change the opportunity name, enter an account and contact, and
reassign opportunity ownership. When you click Submit, the application creates the new opportunity and you can view
it from the Opportunities UI.
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Redirect to Opportunity After Lead Conversion  
Converting a lead to an opportunity lets you pursue the account in the sales cycle. You can choose whether you want to
be redirected immediately to the opportunity page after the successful conversion.

This reduces the time spent going to the Opportunities subtab on the Lead and finding the right opportunity to open.
To get redirected to the edit opportunity page depends on the privileges assigned to your role, your access level as
a lead sales team member, and whether your sales administrator has configured the Redirect to Opportunity After
Conversion check box on the Convert Lead page in Application Composer.

Note:  This feature is available only for converting leads using the simplified UI. Workspace smart actions doesn't
support being directed to an opportunity after performing a lead conversion so if you want to convert leads in
Workspace, then don't enable this feature.

You can convert a lead to an opportunity from the Actions menu by selecting Convert. An error message displays if you
don't have the required privilege to convert the lead. You will be returned to the lead details page or the lead list page
from where you started the lead conversion action.

Note:  The Redirect to Opportunity After Conversion check box is deselected by default and is available only for single
lead conversions. It isn't available on the Mass Convert Layout Pages for Leads.

How to Redirect to Opportunities Page After Conversion
You convert a lead to an opportunity when the lead is ready for further processing along the sales cycle. Here's how to
select whether you want to be redirected immediately to the opportunity page after a successful lead to opportunity
conversion.

1. Navigate to the Leads UI and select the lead you want to convert to an opportunity.
2. From the Actions drop-down list, select Convert.
3. From the Convert Leads dialog, select the Redirect to Opportunity After Conversion check box.
4. Click Submit.

Once the conversion is successfully completed, you're brought immediately to the opportunities UI where you can
review and edit the newly created opportunity.

Verify Email Addresses and Phone Numbers for Leads  
When your sales organization subscribes to the Oracle Address, Email, and Phone Verification service, you know right
away if you entered an invalid phone number or email address for your leads.

The application can't check if the phone numbers and emails you enter are valid for the specific person or account, of
course, but it can make sure that a phone number will actually dial and that an email won't bounce.

When a phone number or an email address is invalid for some reason, you get notified right under your entry. If nothing
appears, your entry is valid. Here's a screenshot of an invalid phone number for a lead to give you an idea of what you
see under invalid information:

224



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 14
Leads

Callout Number What You See

1
 

Status. For phone numbers, this can be only Invalid. Email addresses can also display the status of
Partially-Valid: the domain is valid but the name isn't. For example, if the contact left the company, or
changed their name, you'll see the Partially-Valid status for the email.
 

2
 

Date the email address or phone number was verified by the application.
 

3
 

Re-verify button that you can use to verify again. You never know when area codes or email addresses
may change. Contact details that are valid today mightn't be valid in six months.
 

4
 

Overwrite button to manually set the status. If you know the phone number or email is correct, you can
set the status to Verified. When you do, you see Overwritten on instead of Verified on.
 

The application does display a Valid status, but only much later. By default, the status appears 180 days later. If the
contact information is old, you may want to verify it again by clicking the Re-verify button. You can specify the number
of days before the Valid status appears or even turn this option off during setup. For details, see the related topic:
Enable the Verification of Addresses, Emails, and Phone Numbers for Leads.

Manually Override Your Lead Email and Phone Verification Status
If you don't agree with the verification status for the email address or phone number for your lead, you can override it
by clicking Overwrite (the double arrow icon highlighted below).

Re-verify Email Addresses and Phone Numbers for Leads
You can verify if a lead phone number or an email address is still valid by clicking Re-verify (the curved arrow
highlighted in the screenshot).
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Apply Mass Update of Fields to Leads  
You can apply changes to several fields on multiple leads at once using the mass update feature. For example, you can
update the rank of multiple leads at the same time without having to go into each individual record.

Among the fields that you can update are:

• Account

• Budget Amount

• Budget Status

• Campaign

• Currency

• Customer Need

• Deal Size

• Decision Maker Identified

• Description

• Primary Contact

• Primary Product

• Rank

• Sales Channel

• Source

• Time Frame

Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple leads at once:

1. Navigate to the Leads landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.

◦ You can't apply mass update to conditionally updatable fields.

6. When you're done making updates click Submit.

Related Topics
• Enable Mass Update of Records
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How Users Gain Access to Leads  
This topic explains how the security reference implementation provided by Oracle determines who can access what lead
information in your sales organization.

Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead
qualifiers either manually or based on rules defined in the assignment manager application. Whether or not you can
access a particular lead depends on your membership in the resource and territory hierarchies.

You can access a lead if the following conditions apply:

• You're the lead owner.

• The lead owner or sales team member is your direct or indirect report in the resource hierarchy.

• You're a member of the lead sales team.

Resources in the management hierarchy of a newly added lead sales team member have the same level of
access to the sales leads as the team member.

• You're the owner or you're a member of the territory assigned to the lead.

• You're the owner or member of an ancestor territory of the territory assigned to the lead.

Note:  Your administrator can provide view only access to users by creating a custom role and adding new data
security for the sales lead with all values set to view only privileges. See the Data Sharing Mechanisms and Object
Visibility chapter of the Securing Sales and Fusion Service guide on Oracle Help Center (https://docs.oracle.com).

The flowchart illustrates some of the different ways you can gain access to a lead:

• Named agents in the diagram (A, B, and C) can access the lead.

• Unnamed agents (highlighted in yellow) can't access the lead.

• Sales managers can access the lead because a salesperson in their management chain has access.
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Here's an example flowchart that shows who in a sales hierarchy can access a sales lead. Access using accounts isn't

shown. 
• Agent A can access the lead because agent A created it. When you create a lead, you're the initial owner.

• Agent B can access the lead because agent B is on the sales team.

• Agent C can access the lead because agent C is the owner of the NW territory.

• Sales managers who are higher up in the management chain can also see the lead because access is provided
through the resource hierarchy. The manager of agent C can access the lead information, but colleagues of
agent C don't have access to the lead.
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Special Access
Not all access is affected by the management hierarchy and membership in sales teams or territories. For example,
special access includes:

• Administrators: Administrators get access to leads and other objects. This access is based on their privileges,
regardless of where the administrators are in the management hierarchy. Administrators don't have to be on
the sales team or members of territories.

• Deal Registration: Salespeople assigned to a deal registration retain access even if they're moved to another
deal registration.

Lead Ownership and Sales Team Resources  
A market is typically organized into territories that include customers and prospects. Marketing is closely aligned with
sales, and marketing activities are launched to generate leads and maintain the strength of the sales pipeline. This topic
explains lead ownership and sales team resources.

When the lead doesn't have any owner, the sales representative can accept the lead which makes him or her the lead
owner. All resources who are given access to leads get full access. Full access level allows the user to update the sales
lead team by adding or removing individual resources. Hence, territory resources, sales team members and lead owner
and resources in their hierarchy, all get full access. Territory team members inherit the access level of the territory. All
members of sales territories assigned to the lead have full access to the lead. Ancestor territory owners of all sales
territories assigned to the lead also have full access to the lead. Resources who access leads have different roles such as:

• Operations

Support an automated process to capture leads, prioritize leads for sales engagement, and distribute the leads
to appropriate sales or territory team resources.

• Marketing and lead qualifiers

Monitor leads, reassign leads, and continually review and adjust the lead quality.

• Sales and territory teams

Enable lead qualification, perform follow-up lead activities, and convert leads to opportunities.

This topic includes these sections:

• Lead, Sales, and Territory Resources

• Assignment of Leads to Marketing and Sales Resources

• Sales Resource Role

Lead, Sales, and Territory Resources
Sales resources are organized into flexible teams and are associated with the sales territories. These sales territories
are then assigned to customers, leads, and opportunities to carry out the sales process. The lead follow-up team can
include a lead team made up of individual sales resources who are predominantly active during the lead qualification
stage. All sales resources who are assigned to the territory team can view and follow up the lead.
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Assignment of Leads to Marketing and Sales Resources
Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead
qualifiers either manually or based on rules defined in the assignment manager engine. Users can be assigned to a lead
in one of several ways:

• Ownership through lead creation

• Territory-based lead assignment

• Rule-based sales team member assignment

• Manual selection of resources

Sales Resource Role
Here are some of the activities performed by sales resources.

• Review quality leads that are augmented with sales collateral, marketing content, customer contact
interactions, and references.

• Qualify and assess the lead quality further with the help of user-defined or company-defined assessment
templates.

• Use the resource drop-down list to manually select a resource to add to the team.

Include a description to indicate what role the resource has on the sales team. Many sales team members
can access each lead, and each team member is identified as either an internal (sales force), or an external
(channel partner sales force) resource. Each sales team member can be associated with a specific resource role
to indicate what capacity the member has on the lead.

• Add additional contacts and products to the lead as the lead moves further down the sales cycle.

Related Topics
• Examples of Sales Lead Team

Examples of Sales Lead Team  
A sales lead team is made up of assigned territories and individual team members. Here are some examples that
illustrate some of the features available for the sales lead team.

• Automate assignment of individual resources to sales lead team

• Add ad hoc members to sales lead team

• Update access rights based on the resource

• Change the lead owner

Automate Assignment of Individual Resources to Sales Lead Team
The sales lead team for your company wants to add a support person to the lead. Typically, support people aren't part
of any sales territory. Use the Manage Sales Lead Assignment Rules task to set up a rule set for the category, Sales Lead
Resource Rule Category. For example, assign support team members as individual resources based on rules which
match the lead product with specific support team members.
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Add Ad Hoc Members to Sales Lead Team
Generally, sales team resources are automatically assigned to leads based on configured assignment rules. The
following scenarios provide examples of when you may want to manually add additional team members to assist with
the lead.

• The lead owner, who has full access to your company lead, wants to add one of his company's contractual
experts to his team to help pursue the lead. The lead owner manually accesses the resource drop-down list and
selects the ad hoc resource that he wants to add to his team.

• When pursuing a lead for an insurance policy, the customer contact requests a unique and complex
combination of policy components that require a review from an expert in the company. The lead owner
adds the expert resource to the lead with full access. Now, the expert resource can update the lead with valid
combinations of products and services, and, if required, add more team members to the team.

• A salesperson is pursuing a lead that requires the export of products outside the country. He wants to ensure
there are no legal issues with exporting the products. The salesperson adds a member of their company's legal
team to the lead to review the details before contacting the customer again.

Update Access Rights Based on the Resource
When a resource is added to the sales lead team through rule-based assignment, a profile option determines the
member's default access level. Resources in the management hierarchy of a newly added team member have the same
level of access to the sales leads as the team member.

All members of the sales territories assigned to the lead have full access to the lead. Owners of ancestor territories of all
sales territories assigned to the lead also have full access to the lead.

Change the Lead Owner
Only the lead owner, or the resources in the management hierarchy of the lead owner, can change the ownership of the
lead.

Related Topics
• How Users Gain Access to Leads

Qualification  

Lead Qualification  
The lead qualification process can either be performed by internal marketing or internal sales groups. This topic
provides a brief overview of what constitutes a qualified lead.

Qualifying leads is an important first step in bringing the sales lead to a conclusion. At the end of the lead qualification
process, you can classify the lead as a qualified lead that's ready for conversion to an opportunity. Or you can retire the
lead if the purchase interest for the lead can't be validated. What constitutes a qualified lead varies from company to
company.
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Basic Lead Qualification
In some companies, basic lead qualification data is gathered by lead qualifiers and contains data such as:

• Customer need

• Urgency or time frame for the project

• Budget considerations such as available amount and status

The scheduled process that determines lead qualification status also takes into consideration basic lead data.

Additional Lead Qualification
In other companies, the lead qualifier or salesperson uses a lead qualification questionnaire as part of the qualification
process. Based on the answers received, he or she can decide to manually set the lead to a Qualified status using the
lead actions menu. Your application administrator assigns the questionnaire to your Lead Qualification Template profile.
The answers entered are assessed using a weighted scoring model with instant feedback available as a scoring status
bar in the UI.

Related Topics
• Example of Defining a Sales Lead Qualification Template

Perform a Lead Qualification  
Lead qualification helps you in the lead follow-up process. Assess the lead quality and lead conversion potential by
using the preconfigured qualification templates.

Lead qualification is part of the lead follow-up activity where you further nurture the lead in order to qualify it. Your
administrator must set the Advanced Lead Qualification Enabled profile option after the qualification templates are
created. This action specifies the qualification template to display in the Edit Lead UI to assist with evaluating the lead.

You can conduct a lead qualification, view completed lead qualifications, and view the responses to the questions posed
in the qualification template. Qualification templates enable you to analyze the lead and suggest the appropriate next
steps based on the overall assessment score and feedback for the lead.

Edit a New Lead Qualification

1. From the Navigator, click Leads.
2. In the list of leads, click on a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the default qualification template.
4. Fill out and complete the lead qualification template.

If there are multiple qualification templates associated with the lead, then you can choose to select a different
qualification by clicking Replace Qualification.

Related Topics
• How to Create Assessment Templates

• How Assessment Template Score Range is Calculated

• Assessment Template Components
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Overview of Lead Qualification Templates  
When you create a lead, you can qualify the lead by leveraging the many templates provided by your sales organization.
Evaluate various aspects of the lead which can subsequently help you sell more by converting the leads in less time.

Qualification Templates
After you create the lead, go to the Qualifications tab to view and complete the recommended qualification template
created for you by your organization. If there are multiple templates associated with the lead, select one by clicking
Replace Qualification. Any responses for the current qualification will be reset and can't be restored. You can choose to
cancel the operation and use the current qualification template, or you can choose to continue.

If you continue, the qualification UI is refreshed to display the questions from the template you selected. Start entering
responses to the questions and track the updates from the Qualification status fields on the page. Statuses toggle
between: Not Started, In Progress, and Completed. You can also include other status values such as the number of
questions answered, last updated date, and name of the template. Track the total score by summing up the weighted
answers and display a graphical circular format of the score.

Related Topics
• Perform a Lead Qualification

Perform Multiple Lead Qualifications Using the Same Template  
You can requalify your sales lead information and perform multiple qualifications for leads using the same qualification
template. To do this, your administrator must set the profile option Enable Multiple Assessments Per Qualification
Template to Yes at the site level.

From the Edit Qualification page click Add Qualification and then select the template you want from the available
templates for your sales lead. If you add an additional qualification using the same qualification template, the
application automatically generates a qualification name using the qualification template name plus a counter suffix.
For example, if you have an existing qualification for a lead named Lead Qualification V1, then if you add another
qualification using the same template, the new qualification name is displayed as Lead Qualification V2. You can edit
this name to suit your own requirements.

When all questions are answered, the qualification is set to Complete status and continues to be available for edit. You
can view all ongoing or historical qualifications, scores, statuses, and qualification template names. Use the Delete
and Submit features only if the buttons are enabled by your administrator using Page Composer. You can delete a
qualification that's no longer required or if it was created by mistake as long as it hasn't been submitted. The Submit
button, if enabled, becomes available only when you have entered responses for all questions. Submit isn't available on
the single lead qualification page. You can't edit the lead qualification once the status is set to Submitted but you can
continue to view it.

Perform Multiple Lead Qualification
Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Qualification Template
(MOW_MULTIPLE_QUALIFICATIONS_ENABLED) profile option to Yes. You must also have Full or Edit access on a lead to
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perform multiple qualifications and update existing qualifications for leads using the same qualification template. With
View Only access, you can view qualifications but not update them.

Here's how to perform multiple lead qualifications using the same qualification template:

1. From the Navigator, click Leads.
2. In the list of leads, select a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the Edit Qualification page.

If existing qualifications are available for the selected lead, they're listed here.
4. Click Add Qualification. The Add Qualification dialog appears.
5. From the Template drop-down list, select the qualification template previously chosen for the selected lead

qualification.
6. Click Save and Continue.
7. Select the appropriate responses to all the questions.
8. Click Submit and then click Yes from the confirmation dialog box.

Once the qualification has a status of Submitted, it can't be revised.

Examples of Lead Qualification  
This topic explains the lead qualification process and provides examples of the different methods used for qualifying
leads.

Lead Qualification Process
Lead quality is assessed as soon as a lead is generated and is mainly based on:

• The characteristics of the customer contact on the lead

• The type of response which caused the lead to be generated

• The type of sales campaign that the lead may be associated with

Leads are enriched further, typically by means of prequalification telemarketing activities performed by internal
marketing, internal sales groups, or external third-parties. Qualification data is added to the lead such as:

• Customer need

• Urgency or time frame for the project

• Budget considerations such as available amount and status

At the end of this process, the lead is either:

• Classified as a qualified lead which is ready for conversion to a sale

• Retired if purchase interest for the lead can't be validated

The following scenarios illustrate some of the lead qualification processes.

Rule-Based Lead Qualification
The rule-based lead qualification process requires that the value of the Lead Status attribute be set to Qualified if
qualification rules evaluate to a positive answer. For example, consider the sample rule:
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If this rule evaluates to TRUE, the value of Lead Status is set to Qualified.

Internal Marketing Qualification
Internal lead qualifiers or inside salespeople conduct phone conversations to gather qualification data about leads. They
can use qualification templates to define consistent and specific qualification criteria for similar leads. The qualification
questions are tailored to a specific product, industry, and source of the lead.

Before updating the lead status to qualified, the lead must have a valid primary product associated with it. Users can
select multiple leads and select Qualify from the Actions list. Leads meeting the requirements for lead qualification are
processed.

As the qualification data is gathered using the leads management user interface, the lead qualifier or salesperson can
decide to manually set the lead to Qualified status. In some companies, the lead qualification data gathered by lead
qualifiers is considered in the scheduled automated lead process. For example, the assignment manager engine can
calculate lead score or lead rank, as well as assign sales team territories. For such companies, a simple rule to move
leads to a Qualified status when the lead score reaches a specific threshold is sufficient.

A lead can be qualified when the basic attributes of the lead indicate interest in the purchase of a product. For example,
basic attributes might include:

• Contact attended a product event

• Budget is approved

• Purchase time frame is less than a year

The Additional Qualification tab displays the qualification template with questions where you can enter the answers
on the same page. Most of the data required to qualify the lead is available from the Basic Qualification area of the Lead
details page. Supporting data is included in the contextual area for easy reference.

Internal Sales Group Qualification
Leads are generated and captured from many different sources. Leads are created when customers are created. Leads
are also generated from leads that already exist. After salespeople accept the generated leads, they can evaluate the
quality of the information received for the lead. They determine if the details are sufficient to reach out to the customer
and assess whether a lead is worth pursuing with the help of predefined assessment templates. If they can establish
that the lead has potential and can be marked as qualified, they can then convert the lead to an opportunity. Contact is
established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

External Third-Party Qualification
External third-party qualification involves using input from a third-party source to qualify leads. For example, your
company has obtained a list of contacts that purchased a car in the last 90 days. You have hired a telemarketing
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company to call each contact to determine if there is interest in your company's auto security products. The third-
party telemarketer provides weekly files of potential contacts who are interested in your products. Using the Import
Management framework and qualification rules configured using the assignment manager engine, the interactions
resulting from the telemarketer's activities are imported as leads. The marketing operations manager schedules the
rule-based qualification process to occur as soon as the enriched lead data is imported to the lead management
application. If the rules evaluation is successful, the result sets the lead status as Qualified.

Related Topics
• Lead Assessments

• Lead Ranking

Lead Artificial Intelligent (AI) Score  

About Artificial Intelligent (AI) Lead Score  
You can use the AI Lead Score field to indicate the lead conversion probability of a sales lead being converted to an
opportunity.

Lead scores are numeric values typically ranging from 1 to 100 and where the higher value represents a high conversion
probability. At a glance, the AI Leads Score helps you to prioritize and focus on those leads that are more likely to get
converted to opportunities.

What happens when the AI lead score changes ?  
The AI Lead Score is associated with the AI Update Who Columns Threshold
(ORA_ZCA_AI_UPDATE_WHO_THRESHOLD) profile option value.

The profile option is set to a predefined value of 5 which represents the percentage threshold value of a potential
change in the Artificial Intelligence (AI) lead score based on data from Oracle AI Apps for Sales.When the AI Lead Score
changes, and if your administrator has exposed the AI Lead Score field, then the latest score value is displayed on the
Lead details page. In the Workspace UI, the latest value of the AI lead score is available only if the recent change exceeds
or equals the percentage threshold value specified in the AI Update Who Columns Threshold profile option.

When a change to the AI Lead Score exceeds or equals the percentage threshold value, the Last Updated Date field gets
updated for the lead. This ensures that the updated records are included in the next run of the Adaptive Search indexing
process.
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Use Slack for Leads  

View Your Leads in Slack  
Slack is a team communication tool that facilitates synchronous communication across different devices. Regardless of
whether your team is co-located or distributed, Slack provides an effective communication channel that's easy to use.

Let's say you're traveling and you would like to quickly view a list of the current leads owned by you. You can do this on
Slack using any device, without signing in to your sales application.

Note:  The only criterion is that your administrator has set up the integration of Slack with your sales application.

You can view the first five leads owned by you. These first five leads are selected from only the qualified and unqualified
leads owned by you in the last three months.

To view your first five leads in the last three months on Slack:

1. Navigate to your workspace in Slack.
2. Select one of the following:

◦ Any public channel in the Slack workspace

◦ Slackbot

◦ Oracle Sales Slack app: This refers to the app that your administrator has created in Slack for integrating
with your sales application.

Note:  Due to security restrictions, you can't view your leads if you select the following:

◦ Private channels

◦ Any user under direct messages

3. Enter the following command at the command line: /ec-my-leads
4. Press Enter.

The first five leads owned by you in the last three months are displayed in Slack. The following fields are
displayed for each lead:

◦ Lead Name

◦ Lead Status

◦ Account Name or Customer Party Name

◦ Description

◦ Campaign Name

◦ Rank

Note:  Every sales representative who executes the /ec-my-leads command can see only the leads owned by him or
her. You can't view the leads owned by other sales representatives. Moreover, your leads are only visible to you and
not to any other user.

237



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 14
Leads

FAQs for Leads  

Frequently Asked Questions (FAQs) for Leads  
This section contains some frequently asked questions (FAQs) for Leads. Scroll or search to find answers to common
questions.

How can I quickly enter and search address details for leads?  
Lead address fields such as Country, City, State, and Postal Code have type-ahead and autocomplete features based on
the values you start to enter.

For example, when you begin to enter one of these fields, the application either displays the matching filter names
and makes it possible for you to select filter values or the associated values are automatically inserted for you in the
appropriate fields.

Use letter keys on your keyboard to display values within the Country field. You can also filter by City, State, and Postal
Code fields based on the selected country, and you can filter by City and Postal Codes, based on the state selected.

Related Topics
• Overview of Using Smart Data for Account and Address

What leads are displayed when I select My Open Leads?  
My Open Leads displays a list of all qualified and unqualified leads where you're listed as the lead owner and for leads
created in the last 90 days, or another number of days as specified in a system profile.

You are automatically the lead owner if you create the lead or you can be designated as the owner by an application
administrator.

Who can view the record sets for leads for saved searches?  
The different record sets provided in the Saved Searches window restrict your saved searches to different sets of leads.

The following table lists and describes the record sets for leads. Not all record sets are available to all users. For example,
the record sets involving subordinates are available only to managers.

Tip:  To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather
than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches
to a smaller geographical area. For example, search all the leads in one state instead of the whole country.
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Record Set Name Description

I own
 

Leads you own, including those leads you created or where ownership is assigned to you.
 

I am on the team
 

Leads where you're on the lead team. You are on the lead team if you're the lead owner or were added
as a member by another team member.
 

My territory
 

Leads in your sales territories.
 

My subordinates own
 

Leads where you or your subordinates are on the lead team.
 

My territory hierarchy
 

Leads in your sales territories and all of their subordinate territories in the sales territory hierarchy.
 

All records I can see
 

Leads that you can view based on your lead team membership, sales territory assignments, your
position in the organization, and security permissions.
 

Why do I see two Primary Product options for Advanced Search on
Leads?  
Two Primary Product search options are available in the Lead Advanced Search dialog. Both options point to the same
Primary Product field, but when selected, one option performs a List of Values search and the other option performs a
Text search.

The first option is the default List of Values search (as Primary Product is a Dynamic Choice List (DCL) field) and the
second Primary Product search option lets you use a text search with improved search results performance.

How can I create a lead with new contact and new account for a
sales prospect?  
By default, the leads pages display only names of accounts and contacts that already exist in the application.

If you want to create leads for new accounts or add new contacts, then you must create the appropriate account and
contact records before creating the lead.

If your business uses net new leads where contact and account values are entered manually using free form text
fields, then your administrator can make the New Account and New Contact fields available on the Leads UI through
Application Composer. These fields are hidden by default so to use them for your new leads, your administrator must
manually unhide these fields.

Related Topics
• Expose New Account and New Contact Fields for Leads
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What happens when I enter a last name with two parts?  
During lead creation, if you enter a value for Last Name with two parts that aren't separated by a hyphen, the application
removes the first part of the last name and moves the value to the Middle Name.

Why was a customer reference displayed for my lead?  
A customer reference is based on the customer industry and associated lead product or product group related to the
specific lead. For example, a customer reference displays for your lead if a customer has purchased a similar product or
service.

You can leverage the reference details for effective lead follow-up. The leads UI is designed to ensure that you're
productive and can readily access related lead information with as few clicks as possible. Supporting data related
to each lead is included in the contextual area for easy reference. It includes references to all open leads and open
opportunities for the lead customer, as well as supporting collateral. This information is useful to the lead sales team to
facilitate an effective lead follow-up.

Can I create more than one opportunity from a single lead?  
Yes, you can convert the same lead into another opportunity and then delete unwanted product lines. For example,
during your review of an opportunity, you want to retain only a select few of the lead product lines to pursue as
opportunity revenue.

Since the conversion process automatically creates the product lines from all lead lines, you can remove unwanted
product lines from the opportunity details page. You can, at a later stage, create another opportunity from the removed
lead product lines by converting the lead to an opportunity again. You can then decide to keep only those product lines
that you want on the newly created opportunity.

Can I capture competitor details for my leads?  
Yes, you can track competitors for a lead and identify one of them as a primary competitor. When you convert a lead to
an opportunity, the mapped competitor information is automatically carried over to the opportunity.

Tracking competitor data provides you with useful insights for your leads and prospects. For example, you can plan
appropriate sales strategies to help close deals more effectively. To capture competitor details for your lead, your
administrator must expose the Competitor subtab in the Leads page, and enable the Primary Competitor field.

How can I check for duplicate leads?  
As a sales representative you want to know if your leads for new contacts or accounts have any duplicates in the
application. You can manually check for leads duplicates from the edit leads page.
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Select the lead that you want to check and from the Actions menu, select Duplicate Check. Duplicate check can only be
run on new (non-existing) contacts and accounts.

A message is displayed if no duplicates are found for new contacts or accounts. If potential duplicates exist, the Resolve
Duplicates page is displayed for the contact or account where you can select the appropriate contact or account to
resolve any duplicates.

Why did the deal size change?  
The deal size is automatically determined by the products entered for the lead. When you add or remove products for a
lead the deal size is recalculated. You can override the calculated amount after all products are entered.

For example, if the lead is eligible for a discount, you can manually change the total of the deal size to apply the
discount. However, the application overrides the deal size total if you add or remove a product from the lead after
having manually adjusted the deal size. In this case, you have to reapply the manual change.

Can I perform a mass update for leads of different business units? 

You can't perform a mass update of modified values for leads that apply to different business units. A dialog box is
displayed if the selected leads belong to different business units which don't share the same reference data sets.

You must remove the set-enabled attribute for the offending leads and perform the mass update only for leads with
business units containing the same reference data sets. For more information on reference data sets, see the topic How
Business Units Work with Reference Data Sets. Also, consult the online help, using keywords "reference data".

Why can't I see the lead source channel from the lead details
page?  
The Source field value is removed from the lead details each time the lead business unit (BU) is changed. You enter your
source field value based on a BU and set ID lookup types when you create a lead.

Since multiple business units can exist, the set ID lookups are reset each time a BU is changed to reflect the values
specific for the changed business unit. For more information about lead business units and set ID lookups, see the
Multiple Business Units in Leads section of the Implementation Reference guide.

Where can I find the primary phone number for my lead contact?  
The primary phone number for you contact is available from the Contacts overview page. The phone number displayed
is the same phone number that's displayed in the Contact Phone field in the Edit Lead summary page.
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Why aren't the modified details of my contact reflected in my lead
contact details?  
You enter contact details such as phone and email on the lead record when you first associate the contact to your lead.
If you later make changes directly to the contact record, those contact updates aren't reflected in your lead contact
details.

This is expected functionality because the fields are different and changes made to the contact won't automatically
synchronize to the lead contact record. You must manually update the contact details on the lead or get your application
administrator to create a groovy script for the BeforeUpdate attribute to sync the updated contact data with the
associated leads.

Why did I receive an error when I convert a lead that has more
than 255 characters in a custom Description field?  
You can't convert a lead if your custom Description field has exceeded the maximum limit of 255 characters.

The long text Description custom field must correspond to the Description field character limit values that are copied
from the lead to the account during the conversion process. Reduce the number of characters by less than or equal to
255 characters and try again. Alternatively, request that your administrator increase or remove the character constraint
for the custom Description field in Leads.

What happens if I manually change a lead rank that was
automatically assigned?  
Lead rank suggests a priority to help you select leads for follow up. When the lead is created, a lead rank is first
calculated by the assignment manager engine based on ranking rules.

You can select a different lead rank from the list in the UI. When the lead is further processed, a different rank may be
assigned based on enriched lead data, or the rules may cause the lead to revert to its original rank.

How can I add lead contacts to my sales campaign?  
From the Leads overview area, select the lead you want to be part of your sales campaign. From the Lead details page,
click the Contacts tab. Select the contacts that you want to add to your sales campaign.

From the Actions menu, select Add to Sales Campaigns to view and select a campaign from your saved campaigns.
Your selected contacts are notified when you launch your sales campaign.
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How can I select and add products or product groups to my lead?  
To browse the sales catalog and select and add products or product groups to your lead, your administrator must have
added the Browse Catalog button to the Product region of the Edit Lead page.

Click Browse Catalog to open the sales catalog page from where you can search the product or product group that you
want. Select the groups or products to include for your selected lead, and when done, click OK to return to editing your
selected lead.

What happens if I convert a lead to an opportunity?  
You convert a lead to an opportunity when the lead is qualified and is ready for further processing along the sales cycle.
Once the conversion is successfully completed, you can review the newly created opportunity using the opportunities
UI.

During your review, you might want to retain only a select few lead product lines to pursue as revenue on the
opportunity. Since the conversion process automatically creates product lines (representing revenue) from all lead lines,
you can remove unwanted product lines from the opportunities UI.

You can view opportunities associated with leads in the leads UI. When you convert a lead to an opportunity, the
following rules may apply depending on the setup criteria for your company:

• The person converting the lead becomes the primary sales team member for the opportunity.

• The customer reference on the original lead is maintained for the opportunity.

• The associated lead team members are copied with the same primary team member.

• The newly created opportunity is assigned to the appropriate sales territories.

What happens when I convert a lead to an opportunity using a
smart action?  
You can take actions on lead items from your list item by using the Actions menu (three dots on the right of the item) on
the My List of Leads page.

For example, you can use the Convert quick action to covert a lead to an opportunity. In the Convert Lead window, you
can change the opportunity name, enter an account and contact, and reassign opportunity ownership. When you click
Submit, the application creates the new opportunity and you can view it from the Opportunities UI.

The conversion process copies key information from the lead into the opportunity and links the converted lead to the
new opportunity. Copied information includes notes, interactions, and conversation messages from the lead activity
stream.
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How can I copy notes, attachments, and activities during Lead to
Opportunity conversion?  
You can copy notes, attachments, and activities from a lead record to an opportunity record during the lead to
opportunity conversion process. Your administrator must set the Standard Reference Copy Lead to Opportunity Map
value to the Direct Lead to Opportunity Mapping profile option.

Related Topics
• Enable a User-Defined Copy Lead To Opportunity Map Value

Why can't I see converted leads in my list of opportunities?  
If you don't see the converted lead in your list of opportunities, this means that the opportunity is assigned to a
different territory.

How can I fix an invalid relationship error when converting leads?  
If you try to convert a lead that contains an invalid contact relationship, you may receive an invalid relationship error
during the conversion.

For example, you create a lead with a valid active primary contact and account. An issue might arise when you go
to convert the lead if an incorrect relationship exists for a second contact on the lead. In such a scenario, you must
deactivate the relationship and after some time try to convert the lead again.

However if you want the association of the lead and contact to remain, you must add the contact back on the lead
through the Contacts tab on the Edit Lead page. Here's how to resolve the issue:

1. Navigate to the Edit Lead page.
2. In the Contacts tab, remove the second (nonprimary) contact.
3. Click Save.
4. Add the contact that you just removed back again to the lead.
5. Click Save.
6. Convert the lead.

What's the difference between lead qualification and lead
assessment?  
Lead qualification determines whether a lead has a budget and project timeline defined, and indicates if someone with
purchasing authority is identified. Company-specific standard questions and the associated scoring mechanism help to
capture the additional data critical to qualifying leads.
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A lead is typically considered qualified when the need and purchase interest are confirmed. Lead assessment helps
in the lead follow-up process, where the salesperson continues to assess the lead quality and lead conversion
potential through preconfigured assessment templates. From the Assessment tab, the salesperson can conduct a new
assessment, view completed assessments, and view the responses to the questions. Assessment templates provide the
mechanism for the salesperson to analyze the lead and suggest appropriate next steps based on the overall assessment
score and feedback for the lead.

Related Topics
• Examples of Lead Qualification

• Lead Assessments

• How Assessment Template Score Range is Calculated

What are assessment templates?  
You can use assessments to evaluate the health of a business object, such as an opportunity or a lead.

Administrators set up assessment templates that consist of weighted questions and possible responses that get scored.
After selecting the appropriate assessment type, you enter responses for all the questions in an assessment, and
achieve a score once the assessment is submitted. This score is used to evaluate the health of the business object. For
example, the score could help determine whether an opportunity is viable enough to offer the potential customer a
discount.

Related Topics
• Overview of Assessments

Why does the sales channel default to Partner when I open a lead?
 
The sales channel of a lead indicates whether the lead is being handled directly by an internal salesperson (Direct), or
indirectly (Partner) by an outside partner, such as a distributor or a reseller.

Depending on your configuration and business need, you can use different sales methods based on the sales channel
value. For example, your sales channel defaults to Partner if your sales administrator has assigned you with either the
MKL_CONVERT_SALES_LEAD_PRIV or the MKL_SELECT_SALES_LEAD_PRIMARY_PARTNER_PRIV functional privileges,
or both.

In addition, your sales administrator can assign rules or create a groovy script to default the value of the Sales Channel
without any modifications to privileges.
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15  Responses

Overview of Response Management  
When prospects or contacts respond to an offer through a channel, such as inbound email, internet, or call center,
the details are captured by the response management feature. You can review response details and convert qualified
responses to sales leads.

You can then determine which responses to pursue as leads or which ones you can convert to opportunities.

Campaign channels can be different from response channels. Recipients of an internet campaign can respond through
a call center. Recipients of a direct mail offer may respond by clicking a Web offer URL link. Responses are generated
because of sales and marketing activities. Responses gathered from external call centers and suppliers are imported to
your sales application.

Websites can capture response details, while phone calls or direct mail responses must be recorded manually. When
these responses are recorded, you can import them. Inbound email replies aren't automatically captured as responses.
You must configure your email response product to support inbound email processing. Each response type has several
parameters that store details about a given response. You can modify an automatically captured response if you have
permission. Responses are tracked for an offer and for a campaign.

Response Management Summary
Responses are captured either through the file import feature, or they're automatically captured by recording the
various clicks when opening emails associated with the sales campaign. You can review imported and autogenerated
responses and convert qualified responses to leads and opportunities.

Response Management Features
You can create responses provided by prospects and contacts, and you can convert responses to leads and
opportunities. You can record campaign responses to:

• Calculate campaign response rates

• Target promotional material to those prospects and contacts who are more receptive to offers

• Build a profile of prospects and contacts who responded to run targeted campaigns

• Extract and source key data from the responses to generate quality leads

Differences Between Response, Lead, and Opportunity  
This table describes the main differences between a response, a lead, and an opportunity.
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Response Lead Opportunity

A response is an interaction initiated by
the customer in response to a marketing
stimulus. Every outbound sales activity is a
sales stimulus.
 

A lead is an inquiry, referral, or other
information, obtained through a sales
campaigns, or other means that identifies:
 

• Potential contact or prospect

• Specific purchase interest

You can create a lead if the specific purchase
interest isn't known at the time. However,
 to qualify a lead you must record a primary
purchase interest.
 

An opportunity is a pending sale of a product
or service that can be forecasted and tracked
using summary data such as:
 

• Potential revenue

• Sales stage

• Win probability

• Expected close date

Responses are created from interest recorded in
response to sales activities. Responses include:
 

• Providing answers to phone survey
questions

• Subscribing to a list

• Replying to an email response form
request

As interest for the product or service matures,
 responses are elevated as leads.
 

Leads are mostly created by automated
lead capture or lead import processes which
periodically create qualified responses as sales
leads.
 
Leads are sometimes created from the
response data of a contact or prospect who has
expressed a need or interest in a product or
service offered by the business.
 

Opportunities are created by sales
administrators when they have identified
a qualified lead with a potential revenue
opportunity. Leads are converted to
opportunities when significant sales investment
is foreseen to close the deal.
 
A salesperson can create opportunities from
scratch, without previously having a response
or lead created.
 

Responses aren't included as part of the sales
forecast.
 

Leads aren't included as part of the sales
forecast.
 
 

Inclusion of opportunities in the sales forecast
is at the discretion of the sales administrator.
However, not all opportunities are included and
the decision to include them may depend on
your company's requirements.
 

What's the difference between a response and an
interaction?  
A response signifies a recorded reaction of a prospect or contact to a sales or marketing activity. An interaction is a
record of communication between your company and the prospect or contact or customer.

The following table outlines the key points about responses and interactions:

Responses Interactions

A response can be converted into a sales
lead for further qualification or sales
opportunity to be pursued and included in
sales forecasting.
 

An interaction is recorded when a communication occurs with customer contacts by means of any
communication channel such as e-mail, phone, direct mail, or web.
 

Responses received by phone, e-mail,
or web are saved and positive responses

An interaction is typically created for each outbound and inbound communication. An outbound
communication is initiated by a company employee such as a salesperson by a phone call, or
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Responses Interactions

can be converted to sales leads and
opportunities.
 

marketing manager by means of an e-mail campaign. An inbound communication is initiated by a
prospect or contact by means of web activity or through a call center.
 

Responses are typically captured by
automated processes or are imported in
the application.
 

Interactions for a particular customer or contact can be viewed in Customer Center.
 

A response captures information specific
to the sales or marketing activity such
as source codes and specific destination
URLs.
 

The channel details on a marketing treatment include the option to create interactions when a
response is created.
 

What happens when I convert a response to a lead?  
A lead is created and becomes available for follow up from the Leads work area. As the user who converted the response
to the lead, you're listed as the lead owner.
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16  Opportunities

Overview of Opportunities  
Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up
analytics.

Within opportunities, sales organizations can capture a wide variety of information related to an opportunity, such as
customer (account) and the products to be sold. They can use the supplied sales methods and sales stages to step the
opportunity to its eventual conclusion.

In addition, account intelligence, sales actions, and historical sales analysis further enable salespeople to increase
their win rates by offering data-driven pipeline management and recommendations for the next best sales action. For
example, setting win probability variance thresholds and providing multiple recommendations per opportunity enables
sales representatives to optimize their sales opportunities.

This table lists opportunity features.

Feature Details

Support the sales life cycle
 

Create, manage, and close opportunities, supporting the entire sales life cycle. By integrating with
leads, you can convert leads to opportunities. Post-sale, take advantage of supplied business
intelligence reports related to sales.
 

Maintain opportunity information
 

Here are just some of the data that sales teams can capture for an opportunity:
 

• Accounts: You can associate an account (for example, a customer or prospect) with the
opportunity.

• Opportunity owner: The person who creates an opportunity is automatically assigned ownership.
You can change owner if needed.

• Contacts: You can associate contacts with an opportunity. In addition, you can specify a contact's
role, affinity, and influence level on an opportunity. A single contact can be marked as primary.

• Currency: The application supports multiple currencies at both the opportunity header and
revenue-line levels.

• Budget: A Budgeted indicator lets you display whether the opportunity revenue amount has been
budgeted by the customer, as well as the date that the budget was made available.

• Competitors and partners: You can associate partners and competitors with opportunities, both
at the opportunity and revenue line levels.

• Marketing data: The Source field allows the association of sales campaigns with an opportunity.

• Mass update opportunities: Allow sales personnel to update several opportunity attributes at
once on multiple opportunities.

Employ sales methodology
 

Your company can employ its own sales methodology by using the supplied sales methods and
stages. For each sales stage, administrators can create action items (process steps), task templates,
 recommended documents, assessment templates, and fields that are required for use in opportunities.
In addition, administrators can specify a different default win probability percentage for each sales
stage.
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Feature Details

Use Sales Coach for guided selling
 

Sales Coach, part of sales methods, guides salespeople through each step of the sales cycle with
an organization's own sales methodology and best practices. The action items (process steps), task
templates, recommended documents, assessment templates, and mandatory fields set up by your
administrator in each of the sales stages translate into guided notes and appropriate opportunity UI
interactions.
 

Leverage the product revenue model
 

Opportunities support a product revenue model that features revenue-based forecasting, products and
product groups, recurring revenue, and revenue data captured at the line level, such as win probability,
close date, include in forecast, and status.
 

Support recommended actions
 

Prompts salespeople to respond to the next best set of recommended actions for customer
engagement, drive pipeline and determine how often to reach out to customers post sales.
 
Here are some of the benefits of the next best sales action feature:
 

• Support multiple recommendations per opportunity.

• Enables smarter sales experiences and optimizes the selling process.

• Provides a percentage win probability in comparison to other opportunities from your sales
organization or a prediction about the close date of the opportunity.

For example, based on historical data, the likelihood to close an opportunity is less than 40%.

• Supports user feedback per opportunity.

• Enables administrative and supervisory controls.

For example, manage the win probability variance thresholds for opportunities and define
user actions to suit the organization's requirements. As salespeople update the opportunity
information, win likelihood and recommended actions are regenerated.

Assign sales team
 

Opportunities align with territories and the assignment engine for rule-based or territory-based
autoassignment of salespeople to opportunities. In the team pages, you also can manually add sales
team members to an opportunity.
 

Allocate sales credit
 

By allocating sales credit to salespeople on product lines, you can capture the amount of credit
salespeople receive for the sale. You can track direct, channel, and overlay resources and their
contributions using revenue and nonrevenue credit splits.
 

Use forecast territories on product lines
 

By integrating with forecasting, you can use forecast criteria to automatically include product-line
revenue in the forecast. You can leave the default forecast territory on the product lines or assign
another forecast territory. The forecast is refreshed in real-time from revenue when an opportunity is
created or updated.
 

Assess opportunities and their products,
 contacts, and competitors
 

You can use assessments to evaluate the health of an opportunity or an opportunity product, contact,
 or competitor. After setup by the administrator, assessments are available to salespeople in the
Assessments tab.
 

View business intelligence reports
 

Several supplied business intelligence reports give you views into sales metrics, from lists of
opportunities and accounts, to pipeline data, sales team performance, and other revenue metrics.
 

252



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 16
Opportunities

Related Topics
• Overview of Opportunity Products and Revenue

• Best Practices for Sales Credits

• Overview of Sales Methods, Sales Stages, and Sales Coach

How to Apply Mass Update to Opportunities  
Use the mass update feature to update several fields on multiple opportunities at once. For example, you can update the
status or add comments for multiple opportunities without having to go into each individual record.

Among the fields that you can update are:

• Account

• Budgeted

• Close Date

• Comments

• Currency

• Date Budget Available

• Estimated Deal Duration

• Include in Forecast

• Level of Risk

• Owner

• Primary Competitor

• Primary Contact

• Sales Stage

• Status

• Win Probability

• Win/Loss Reason

These predefined fields can't have a blank value:

• Currency

• Close Date

• Sales Stage

• Include in Forecast

Note:  Your administrator must enable this feature before it's available in the application.

Steps to Apply Mass Update
Here's how to update several fields on multiple opportunities at once:
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1. Navigate to the Opportunities landing page.
2. Search for the records you want to update.
3. Click Update from the Actions menu.
4. Select the records that you want to update and click the Update button.
5. Select the fields and assign or enter values for them. Keep in mind:

◦ If you want to update a field that has a parent field, then the value of the parent field must be the same
across all child records selected for mass update.

◦ You can't apply mass update to conditionally updatable fields.
6. When you're done making updates click Submit.

Related Topics
• Enable Mass Update of Records

FAQs for Opportunities  

Frequently Asked Questions (FAQs) for Opportunities  
This section contains some frequently asked questions (FAQs) for Opportunities. Scroll or search to find answers to
common questions.

What opportunities are displayed for My Open Opportunities and
Open opportunities where I am on the team?  
Selecting My Open Opportunities displays a list of all open opportunities expected to close within the current calendar
or fiscal period where you're listed as the opportunity owner.

You're automatically the opportunity owner if you created the opportunity. You also can be assigned as the owner by
someone else.

Selecting the Open opportunities where I am on the team list displays a list of all of the open opportunities expected
to close within the current calendar or fiscal period where you're on the opportunity team. You're on the opportunity
team if you created the opportunity or you can be assigned to the team either by an automatic assignment process or
by another team member.

What do the opportunity saved searches mean?  
In the opportunities landing page, several different saved searches retrieve specific sets of records. Here's a list of the
record sets. Not all record sets are available to all users.

For example, the record sets involving subordinates, which are resources within an organization or a line manager's
hierarchy, are available only to managers.
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Note:  The My territory membership and My territory membership hierarchy record sets are predefined but you
must enable them before your salespeople can use them.

Record Set Name Description

All records I can see
 

Opportunities that you can view based on any of the following:
 

• Your opportunity team membership

• Sales territory assignments on opportunity, customer, or partner accounts

• Your position in the organization

• Security permissions

I own
 

Opportunities you own include those opportunities you created or where ownership is assigned to you.
 

I am on the team
 

Opportunities where you're on the opportunity team. You're on the opportunity team if you're the
opportunity owner or if you were added as a member.
 

My territory
 

Opportunities within sales territories you own.
 

My territory hierarchy
 

Opportunities within sales territories where you're the territory owner or the descendant territory
owner.
 

My territory membership
 

Opportunities for your territory where you're either the owner or a team member of a territory
assigned to the opportunity.
 

My territory membership hierarchy
 

Opportunities for your sales territories where you're the territory owner or member and all of your
subordinate territories in the sales territory hierarchy assigned to the opportunity.
 

My subordinates own
 

Opportunities owned by you and your subordinates (resources within your organization).
 

My subordinates are on the team
 

Opportunities where you or your subordinates (resources within your organization) are on the
opportunity team.
 

Related Topics
• Enable Opportunity Search Filter Record Set Values for Territory Membership

Can I sort opportunity searches by the last update date?  
Yes, you can sort the records returned from your opportunity search by last updated date in descending order. Request
your administrator to change the Opportunity List Sort profile option from N to Y. You can then quickly review and
action recently updated opportunities.
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Can I create opportunity lists from territory membership record
sets?  
Yes, you can use record sets to create opportunity lists based on both territory membership and territory membership
hierarchy filtering criteria.

For example, you can now create lists for opportunities for your territory where you're the territory owner or a team
member of a territory assigned to the opportunity. If you're a manager, you can filter records where you're either the
owner or a member of a territory assigned to the opportunity, or owner or member of a territory that's ascendant to an
assigned territory.

Request your administrator to enable the My territory membership and My territory membership hierarchy values to
display in the opportunity search filter record sets.

Related Topics
• Enable Opportunity Search Filter Record Set Values for Territory Membership

What information is required to create an opportunity?  
Opportunity Name is the only field required to be filled out when creating an opportunity. Note, however, that the name
and sales account combination must be unique.

In other words, you can't have two opportunities with exactly the same name and associated to the same sales account.

What happens if I change win probability?  
If you change win probability at the opportunity level, the application updates the win probability of all opportunity
product lines that are in sync.

In addition, if you update win probability at the product level, the product lines included in the forecast may change,
depending on whether the line matches forecast criteria or not.

Can I select more than one account address when creating an
opportunity?  
No, currently you can only select the primary address of the Account associated with the opportunity when creating or
editing an opportunity. Only the primary address of the Account will be displayed on the opportunity.

It isn't possible to select any other Account addresses from the opportunity page.
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Which fields or data are initially set on an opportunity?  
Several fields are initially set to default values when you create an opportunity, as described in this topic.

Following are the fields initially set to default values when you create an opportunity:

• Sales Channel: Set to Direct

• Currency: Determined by the settings in user preferences

• Win Probability: Set to percentage determined by sales method or profile option

• Close Date: Set to 90 days from creation date

• Status: Set to Open

• Sales Method: Set to default sales method

• Sales Stage: Set to first sales stage in default sales method

• Owner: Set to user creating opportunity

• Revenue: Set to zero

• Worst Case: Set to zero

• Best Case: Set to zero

• Opportunity Number: Unique, application-generated number

• Created By: Set to user creating opportunity

• Creation Date: Set to current date

• Include in Forecast: Based on forecast settings

What's a billing account on an opportunity?  
A billing account on an opportunity is the customer's financial account to be used for the transaction. This field only
displays the billing accounts if you have an Account associated with the opportunity.

The billing account won't display any values if you only have a Contact associated with the opportunity. For example,
if you select the business-to-consumer (B2C) contact on the Account, then the billing account field displays the
corresponding billing account but no value is shown if you select the normal contact on the Primary Contact field.

How do I delete an opportunity?  
To delete an opportunity, open it for editing and click Delete Opportunity from the Actions menu.

After you delete an opportunity, it's no longer available in the application.
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How can I copy an opportunity?  
While viewing the opportunity details, select Copy Opportunity from the Actions menu and enter a new, unique name
for the opportunity.

Related Topics
• What is copied when I copy an opportunity?

What is copied when I copy an opportunity?  
The application copies the following attributes when you copy an opportunity:

• Opportunity header attributes, including standard and user-defined fields

• Contacts

• Products:

◦ Revenue information, such as quantity, unit price, revenue amount

◦ Schedule information and the underlying scheduled transactions

◦ Sales credits, including recipients, amounts, and percentages

◦ User-defined attributes of revenue

• Sales team, including partner resources

• Source

• Partners

• References

• Competitors

• Leads

• User-defined child objects of the opportunity

The following aren't copied:

• Notes

• Tasks

• Appointments

• Assessments

• Attachments

• Deal registrations

Related Topics
• How can I copy an opportunity?
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Can I move Opportunities to different Business Units?  
Yes, you can update the Business Unit field for opportunities from the UI. Move an opportunity to a different business
unit simply by selecting the target business unit while editing the opportunity.

After you change the business unit for the opportunity, any dependent opportunity attributes are reset to the default
values of the new business unit.

Your administration can also move Opportunities to different Business Units using import management or web services.

Why did some fields change when I changed the sales stage?  
When you move an opportunity from one sales stage to the next, the opportunity-level win probability increases to
reflect the progress of the opportunity.

The win probabilities of all product lines that are in sync with the opportunity-level win probability also change to match
the opportunity-level probability. During setup, the application administrator can specify the default win probability for
each sales stage.

What happens to the conversion rate when an open or closed
opportunity is changed?  
When an open opportunity is updated, its conversion rate to the corporate currency is updated to the opportunity
currency's rate on the current date.

When a closed opportunity is updated, its conversion rate is updated to the rate on the opportunity's actual close date.

Related Topics
• Set Up Multiple Currencies for Sales

• Let Salespeople Select the Currency in Opportunities and Leads

How is the expected close date of an opportunity initially set?  
When defining a sales method, administrators can insert the average close window of the sales method, in days. The
value is then used to set the default close date of opportunities using that sales method.
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What happens to forecasted revenue when an opportunity is
changed?  
The current forecast is automatically updated to reflect the changes. Past forecasts remain unchanged. Scheduled
processes synchronize changes to territories and update active forecasts.

Related Topics
• Forecast Synchronization

How To View Renewal Opportunities  
Oracle CPQ checks for subscriptions that are due to expire soon and automatically creates opportunities of type
'renewal'. You can see them in the Opportunities list of the sales application.

Here are the steps to see the renewal opportunities:

1. Navigate to Sales > Opportunities.

On the landing page, the Opportunity Type column indicates 'renewal' against the renewal opportunities that
have been populated from Oracle CPQ.

2. Click a renewal opportunity to identify the revenue lines that are due for renewal.

In the Details page, under Products, the Revenue Type Category indicates if the revenue lines are Renew, New
or Expansion. You can also distinguish new and renewal pipeline forecasts as separate categories for tracking
and managing the sales forecasts based on the revenue type category values.

Note:  You can create renewal opportunities manually as well. When creating an opportunity, select Renewal
from the Opportunity Type drop-down list. The other opportunity types you can create are New and Expansion.
Create an Expansion opportunity when a customer wants to buy more products or expand services in their regular
subscriptions.

Use Slack for Opportunities  

View Your Opportunities in Slack  
Slack is a team communication tool that facilitates synchronous communication across different devices. Regardless of
whether your team is co-located or distributed, Slack provides an effective communication channel that's easy to use.

Let's say you would like to quickly review a list of the main opportunities owned by you and take some actions. You can
do all this on Slack using any device, without signing in to your sales application.
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Note:  The only criterion is that your administrator has set up the integration of Slack with your sales application.

You can view the list of the top five opportunities owned by you with the close date in the current fiscal quarter. You can
also log a call, create a task, or schedule a meeting for each listed opportunity.

To view your top five opportunities with the close date in the current fiscal quarter in Slack:

1. Navigate to your workspace in Slack.
2. Select one of the following:

◦ Any public channel in the Slack workspace

◦ Slackbot

◦ Oracle Sales Slack app: This refers to the app that your administrator has created in Slack for integrating
with your sales application.

Note:  Due to security restrictions, you can't view your opportunities if you select the following:

◦ Private channels

◦ Any user under direct messages

3. Enter the following command at the command line: /ec-my-opportunities
4. Press Enter.

Your top five opportunities are displayed. The following fields are displayed for each opportunity:

◦ Stage: For example, Qualification or Closed

◦ Close Date

◦ Account

◦ Win Probability (%)

◦ Amount

◦ Currency Code

◦ Recommended Action

Note:  Every sales representative who executes the /ec-my-opportunities command can see only the opportunities
owned by him or her. So you can't view the opportunities owned by other sales representatives. Moreover, your
opportunities are only visible to you and not to any other user.

Create a Task for Your Opportunity from Slack  
You can create tasks for your top five opportunities in Slack. When you create a task in Slack, you're the default owner of
the task.

If you want to assign the task to someone else, you can do so only in your sales application, and not from Slack.
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To create a task for your opportunity from Slack:

1. Use the /ec-my-opportunities command in Slack to view a list of your top five opportunities.

For more information about how to use the command, see "View Your Opportunities in Slack".
2. Navigate to the opportunity for which you want to create a task.
3. Click Create a Task.
4. In the Create a Task dialog box, enter a subject in the Subject field.

For example: Follow up with customer.
5. In the Due Date field, enter the date and time for the task.

Note:  Ensure that you specify the date and time only in the following format: YYYY-MM-DD HH:MM AM or
PM. For example: 2019-08-16 09:15 AM The time zone that you have set in your Slack profile is used.

6. From the Type drop-down list, select the type of task.
7. From the Priority drop-down list, select a priority for this task.
8. In the Description field, enter a description for the task.
9. Click Submit to complete the process or click Cancel to discard it.

After you create a task, it shows up among the Open Activities in the Activities tab of this opportunity in your sales
application.

Related Topics
• View Your Opportunities in Slack

Log a Call for Your Opportunity from Slack  
After you complete a call with your customer, you can also log the call details from Slack.

To log a call for your opportunity from Slack:

1. Use the /ec-my-opportunities command in Slack to view a list of your top five opportunities.

For more information about how to use the command, see "View Your Opportunities in Slack".
2. Navigate to the opportunity for which you want to log a call.
3. Click Log a Call.
4. In the Log a Call dialog box, enter a subject in the Subject field.
5. From the Priority drop-down list, select a priority for the call.
6. In the Description box, enter a description for the call.
7. Click Submit to complete the process or click Cancel to discard it.

After you log a call, it shows up among the Completed Activities in the Activities tab of this opportunity in your sales
application.

Related Topics
• View Your Opportunities in Slack
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Schedule a Meeting for Your Opportunity from Slack  
You can schedule a meeting for your opportunity from Slack.

Here's how:

1. Use the /ec-my-opportunities command in Slack to view a list of your top five opportunities.
For more information about how to use the command, see "View Your Opportunities in Slack".

2. Navigate to the opportunity for which you want to schedule a meeting.
3. Click Schedule Meeting.
4. In the Schedule Meeting dialog box, enter a subject in the Subject field.
5. In the Start Date field, enter the start date and time for the meeting.

Note:  For both the start date and end date, ensure that you specify the date and time only in the following
format: YYYY-MM-DD HH:MM AM or PM. For example: 2019-08-16 09:15 AM The time zone that you have
set in your Slack profile is used.

6. In the End Date field, enter the end date and time for the meeting.
7. In the Description field, enter a description for the meeting.

Recommended Actions  

Overview of Recommended Actions for Opportunities  
Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-
up analytics. Within opportunities, sales organizations use the supplied sales methods and sales stages to step the
opportunity to its eventual conclusion.

Account intelligence, sales actions, and historical sales analysis further enable salespeople to increase their win rates
by offering data-driven pipeline management and recommendations for the next best sales recommended actions. For
example, setting win probability variance thresholds and providing multiple recommendations per opportunity help
sales representatives optimize their sales opportunities.

Using the recommended actions feature lets sales representatives know which opportunities to focus on, which ones
are at risk to close, and specifically, what's the next best recommended action to take to close opportunities.

Your administrator must enable the Enable Adaptive Intelligence profile option
(ZCA_ENABLE_ADAPTIVE_INTELLIGENCE) and extend the opportunity detail page to display the Recommended
Actions section and related steps in the opportunities UI.

This table lists some of the ways recommended actions can help close deals.

Feature Details

Smarter sales experiences and optimizes
the selling process
 

Helps you identify best opportunities to pursue based on:
 

• Current and past deal assessments
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Feature Details

• Opportunities needing most attention

• Sales volatility

Multiple recommendations per
opportunity
 

Prompts you to respond to the next best set of actions to help you engage with your customer and
further extend the sales pipeline. For example, provide the relevant data to:
 

• Perform competitive analysis through competitive data alert messages.

• Initiate a follow-up call with the customer.

• Focus on the top five deals, to reduce sales volatility.

• Determine the likelihood of closing an opportunity.

• Provide a percentage win probability in comparison to other opportunities from your sales
organization or a prediction about the close date of the opportunity.

For example, based on historical data, the likelihood to close an opportunity is less than 40%.

User feedback per opportunity
 

Lets you provide feedback, such as to how helpful, or not, are the recommended next best actions
provided for the opportunity. Salespeople can select the recommended action they completed or
signify whether or not the suggested action was helpful.
 

Administrative controls
 

Enables sales administrators to manage the win probability variance thresholds for opportunities. As
you update the opportunity information, the application regenerates win likelihood probability and
recommended actions.
 
 

You must complete the following configuration steps in Oracle CX Sales to ensure that recommendations are displayed
on opportunities:

• Update relevant profile options.

• Add the Recommended Action column to the Opportunities page using Application Composer.

For more information, see Set Up Best Sales Action for Opportunities.

Related Topics
• Overview of Opportunities

• Recommended Actions for Opportunities

Recommended Actions for Opportunities  
Recommended actions in opportunities are prompts that provide you with suggestions about how to reduce the risk
of opportunities being lost. The prompts, which leverage artificial intelligence data, guides you by suggesting which
actions can improve the likelihood of winning and closing deals.

You can regenerate the win likelihood and recommended actions by providing feedback and updating information for
the opportunity.
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Recommended Actions
Using artificial intelligence, system learning, and other data science capabilities, optimized recommended actions
and predicted win likelihood data is presented to you for opportunities. Recommended actions provide insights into
the possible issues in the opportunity and suggest recommended actions to improve your chances of winning the
opportunity. You engage with those opportunities requiring the most attention and move them to the next sales
stage. For example, suppose the role marked as the primary contact on an opportunity correlates with a low win rate
in the past. The reason might be that this contact isn't the decision maker in the customer organization. Therefore, the
artificial intelligent algorithm recommends that you check that the primary contact is the decision maker.

Other examples of recommended actions include:

• Schedule an appointment

• Focus on the top five deals to reduce sales volatility

• Perform competitive analysis

• Other opportunity-specific recommended actions prompted to move a deal to the next sales stage and closer
to a win

Feedback on Recommended Actions
When you select a recommended action for a specific opportunity, a dialog box appears which provides additional
information about the recommended action. There's also a link to any additional recommended actions to take for the
selected opportunity. After reading the explanation or after you perform the action, you can indicate if the suggestion
was helpful or not. You can also indicate whether the recommended actions were helpful with moving the opportunity
to the next stage.

You provide feedback by clicking either Good Suggestion or Not Helpful. As soon as you provide your feedback, the
recommendation isn't visible anymore.

Create a Task from Recommended Actions
You can create a task for each recommended action by clicking the Task icon from the contextual Recommendations
dialog box. You can also create a task from the edit opportunity's recommended region page by clicking Create Task to
create a related task for yourself.

Related Topics
• What's the difference between win probability and predicted win probability?

• Overview of Recommended Actions for Opportunities

What's the difference between win probability and predicted win
probability?  
Win probability represents the likelihood (in percent form) of winning the opportunity. You manually set the win
probability at the opportunity level for the sales stage.

If you don't want your sales stages to control opportunity win probability, make sure that no value exists in the win
probability field. The predicted win probability displays the automated predicted win probability based on artificial
intelligence (AI), system learning, and other data science capabilities. It provides a percentage of the predicted win
probability in comparison to other opportunities from your sales organization or a prediction about the close date of
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the opportunity. For example, the artificial intelligent models might suggest a win probability for an opportunity that's
significantly different to the salesperson's estimation. In that case, your sales application displays a warning icon on the
Opportunities page.

You can hover over a warning indicator icon next to the Win Probability (%) field which is displayed only when the
differences between the win probability percentage value and the predicted win probability percentage value is greater
than the defined threshold. The text is read only and displays both win and AI predicted probability values as well as the
Opportunity name.

Related Topics
• Recommended Actions for Opportunities

• Overview of Recommended Actions for Opportunities

• Edit the Opportunity Win Probability Risk Threshold Profile Option

What's the difference between Recommended Actions, Action
Items, and Recommended Documents?  
Recommended actions in opportunities are the next best sales recommendations for you to follow. Helping you
manage your pipeline, recommended actions are based on account intelligence, sales actions, and historical sales
analysis.

Action items and recommended documents are coaching components or job aids associated with a specific sales stage.
Each sales stage potentially can have multiple action items and recommended documents associated with it.

Action items are steps you should follow during a sales stage. For example, your company might recommend that you
interview a potential customer, develop a product list, and schedule a presentation for a product launch.

Recommended documents are helpful documents and resources, such as customer letter templates, relevant websites,
and training materials.

Related Topics
• Recommended Actions for Opportunities

Opportunity Team Members  

Add Team Members to an Opportunity  
You must have Full or Edit access control privileges to add or remove team members to or from an opportunity. From
the opportunity team page, you can add team members to the opportunity team.

Watch video
 

You can also view assigned territories and the associated territory team members on the opportunity team by selecting
Territories from the Show list of values. With View Only access, you can view team members but not update them.
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Add a Member to an Opportunity
As owner of the opportunity, you're listed on the opportunity team page as the owner with Full access.

Here's how to add a member to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. From the Edit Opportunity page, click the Team icon to open the Team page.
5. Click Add Team Members.
6. Search for the team member you want to add to your opportunity team.
7. Select the team member you want from the Search Results, then click OK.
8. Select the access level control for the team member's privileges from the Access list of values.
9. Select the function for the team member from the Function list of values.

10. Click Save to add the team member to the opportunity team.

You can change the primary owner of the opportunity by selecting Owner from the team page.

Note:   You can remove a team member from the opportunity team by clicking the delete icon represented by X next
to the team member. However, you can't remove the owner from the opportunity team.

Related Topics
• Account Team Member Access Levels

How can I collaborate on Opportunities using Microsoft Teams?  
Directly from an opportunity, click the Create Team in Microsoft Teams action and then build the team with internal
resources and external users for the opportunity in Microsoft Teams.

Any team member who's both part of the Opportunity resource team and is a Microsoft Teams user is added to the
created team. Management resources aren't added to the team.

In Microsoft Teams, teams can be public or private. A private team can only by accessed by the team members. Teams
created from an opportunity in CX Sales are always private teams. Any opportunity team member can create the team
in Microsoft Teams but only one team can be created per opportunity. Once you have successfully created your team,
the Create Team in Microsoft Teams action on the Edit Opportunity actions list automatically changes to the Go to
Microsoft Teams action.

Related Topics
• Add Actions for Microsoft Teams to Opportunity and Business Plan Actions Menus
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What happens to the Microsoft team I created, when an
opportunity closes?  
If your administrator has enabled auto-archiving of teams of closed opportunities, the teams you have created in
Microsoft Teams are auto-archived when the corresponding opportunities close in CX Sales.

To see the team of the closed opportunity, go to Microsoft Teams > Archived. You can see your team in the Archived
list.

Note:  The team in Microsoft Teams is restored when the associated opportunity reopens in CX Sales.

Re-create a Team for an Opportunity Team in Microsoft Teams  
When you create an opportunity team from your sales application, the Create Team in Microsoft Teams action on the
Edit Opportunity actions list automatically changes to the Go to Microsoft Teams action.

If for some reason, the original team no longer exists in Microsoft Teams, the Go to Microsoft Teams action triggers re-
creation of the team and saves it to the opportunity. When you click the action again, it automatically opens the new
team created in Microsoft Teams.

This allows salespeople to continue to collaborate with each other on the reopened opportunity.

Sales Coach  

Overview of Sales Coach  
Sales Coach is a mechanism to present best practice sales methodology and teaching aids to help improve your sales
effectiveness.

Watch video
 

Application administrators set up Sales Coach by associating action items and recommended documents with a sales
stage. You can then view these items as you progress your opportunities. The coaching components or job aids are
associated with a specific sales stage. Each sales stage potentially can have multiple action items and recommended
documents associated with it.

Here are the areas that administrators can define for each sales stage:

• Action items (process steps)

• Recommended documents
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Action Items
Action items are steps you should follow during a sales stage. For example, your company might recommend that you
interview a potential customer, develop a product list, and schedule a presentation for a product launch.

Recommended Documents
Recommended documents are helpful documents and resources, such as customer letter templates, relevant websites,
and training materials.

Related Topics
• Overview of Recommended Actions for Opportunities

• Overview of Sales Methods, Sales Stages, and Sales Coach

Opportunity Access  

How Sales Users Gain Access to Sales Information  
The security reference implementation provided by Oracle determines who can access opportunity information in your
sales organization. While basic information on accounts and contacts is available to all salespeople, your access to sales
data is restricted by your position in the resource hierarchy, membership in the sales team, and ownership.

Whether or not you can access a particular opportunity or a lead depends on your membership in the resource and
territory hierarchies. Here's how you gain access to opportunities. Lead access follows the same pattern. You can access
an opportunity if:

• You create the opportunity.

• You're on the opportunity sales team.

• The opportunity owner or sales team member is your direct or indirect report in the resource hierarchy.

• You're the owner or are a member of the territory assigned to the opportunity.

• You're the owner or member of a parent territory of the territory assigned to the opportunity.

• You're assigned to a territory for the account associated with the opportunity.

• You're assigned to a territory that's a parent of the territory for the account associated with the opportunity.

Salespeople can see all opportunities related to their accounts but access differs between territory members and
opportunity members:

• An opportunity owner gets full access to the opportunity, which includes the ability to edit as well as add and
remove team members.

• Owners and members of territories or parent territories assigned to the opportunity account get read-only
access to the opportunity and aren't added to the opportunity sales team.

• Owners and members of territories assigned to the opportunity product lines are added as a distinct list
of territories to the opportunity sales team. Owners and members of these territories get full access to the
opportunity. Depending on a profile option, either only the owner or all the members of the territory are added
as resources to the opportunity sales team. Regardless of the access level for these members as a resource on
the opportunity team, they always have full access.
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Owners and members of parent territories of the territory assigned to the opportunity aren't added to the
opportunity sales team but they always get full access.

The following diagram illustrates some of the different ways that you can gain access to an opportunity:

• Named agents in the diagram (A, B, and C) can access the opportunity.

• Unnamed agents (highlighted in yellow) can't access the opportunity.

• Sales managers can access the opportunity because a salesperson in their management chain has access.

• Owners of parent territories can access the opportunity through the sales territory hierarchy.

This diagram shows who in a sales hierarchy can access an opportunity. 

• Agent A can access the opportunity because she created it. When you create an opportunity, you're the initial
owner.
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• Agent B can access the opportunity because he's on the sales team.

• Sales managers who are higher up in the management chain can also see the opportunity because access is
provided through the resource hierarchy. The managers of Agent A and Agent B can access the opportunity
information, but agent A and Agent B's colleagues can't.

• Agent C can access the opportunity because he's the owner of the NW territory. The owner of the parent
territory can also access the opportunity.

• Sales administrators can access the opportunity.

Note:  Access using accounts isn't shown in this diagram.

Special Access
Some access isn't affected by the management hierarchy and membership in sales teams or territories. This special
access includes:

• Administrators: Users assigned the Sales Administrator job role get full access to opportunities and other
objects. This access is based on their privileges, regardless of where the administrators are in the management
hierarchy. Administrators don't have to be on the sales team or members of territories.

• Deal Protection: Salespeople assigned to an opportunity retain the sales credit on an opportunity even if they're
moved to another opportunity.

Why can't I edit some fields for an opportunity?  
Salespeople can see all opportunities related to their accounts. However, depending on how your opportunity access
profile has been set up, your access may be different between territory members and opportunity members.

If you're listed as the owner of the opportunity, you have full access to the opportunity, which includes the ability to edit
as well as add and remove team members. If you're a territory or ancestor territory member assigned to the account of
the opportunity, you can edit some fields in the opportunity record, but you can't make changes to the team or change
the record ownership.

For example, the following fields in the edit opportunity page aren't editable for territory or ancestor territory members:

• Name

• Account

• Primary Contact

• Owner

• Status

• Currency

• Sales method

• Sales Stage

• Primary Source

Related Topics
• How Sales Users Gain Access to Sales Information
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Why can't I see the Partners tab and Primary Partner field when I
edit an opportunity?  
When editing an opportunity, you need the right privileges to see partner information. The Primary Partner field and
Partner subtab are secured by the privilege MOO_MANAGE_OPPORTUNITY_PARTNERS_PRIV and are only visible to
users who have a job role that includes this privilege.

Sales Competitors  

Overview of Sales Competitors  
Want your team to get insight into the competition while working deals? It's easy -- simply set up your competitor
records and then associate competitors with your opportunities.

After you add information on the competition and associate competitors with opportunities, you and the rest of your
sales team can access to important competitor data that can help you more effectively close deals.

Here's the type of details you can store on the competition:

• Company details, such as stock symbol, website, industry, and geography

• Perceived threat level, such as high, medium, or low

• Experts who have knowledge about the competitor

• Collateral about the competitor, such as data sheets and the like

• Opportunities where the competitor is associated

• Revenue at stake, which is potential revenue that could be lost

• Notes about the competitor

Link Competitors with Opportunities
When you're ready to enter competitor information on a deal, link competitors at the opportunity-level or at the
product-line level. Once linked, the competitor and opportunity are associated in the competitor's profile screens
(available in the Competitor pages of Sales, outside of the opportunities UI). The revenue amount entered on an
opportunity drives the revenue-at-stake metric, also available in the competitor profile screens. See the related topics
for more information.

Related Topics
• Associate Competitors with Opportunities

• View Competitor Information Outside Opportunities
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View Competitor Information Outside Opportunities  
Sales administrators can store a many details about sales competitor companies. As a salesperson, you can associate
competitors with opportunities to get insight into which competitors may have won a deal against your company.

You can also use competitor details when you want specific information about a competitor during a sales deal. Here's
how to view competitor information:

1. Navigate to Sales > Competitors.
2. Select a competitor in the list and view the details.
3. Here's a summary of information that gets stored about competitors in their profiles:

Field Description

Organization Name
 

Name of the competitor.
 

Name Suffix
 

Value appended to the name of the Organization Name for the competitor.
 

Chief Executive Name
 

Name of the competitor company's chief executive officer or highest-level employee.
 

Line of Business
 

Line of business of the competitor company's products.
 

D-U-N-S Number
 

Dun & Bradstreet Corporation unique nine-digit identification number for the competitor
company.
 

Organization Size
 

Size of the competitor company.
 

Year Established
 

Year the competitor company was first started.
 

Threat Level
 

Perceived threat level of the competitor in closing deals, such as low, medium, and high.
 

Year Incorporated
 

Year the competitor company was first incorporated.
 

Stock Symbol
 

Stock symbol for the competitor company in the financial markets.
 

Fiscal Year End Month
 

Month that the competitor company closes its fiscal year.
 

Dun & Bradstreet Corporation Credit
Rating
 

Credit rating of the competitor company with Dun & Bradstreet Corporation.
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Field Description

Privately Owned
 

Indicates the competitor company is privately owned.
 

Minority Owned
 

Indicates that the competitor company is minority owned.
 

Small Business
 

Indicates that the competitor company is a small business.
 

Status
 

Status of the competitor record, either active or inactive.
 

This table shows the information available in the details tabs of the Edit Competitor page:

Item Description

SWOT Analysis
 

Strength, weakness, opportunity, and threat (SWOT) value for a competitor. This analysis helps
you understand, plan, and craft an effective competitive strategy when facing a competitive
threat on a deal.
 

Product groups
 

Product groups the competitor company is associated with. You can associate product groups
using the Competitive Presence node in the desktop UI customer pages.
 

Opportunities
 

View historical and current opportunities associated with the competitor.
 

Attachments
 

Attachments are files, free-form text, or URLs that can give you information that helps you
position products or solutions against specific competitors.
 

Internal Experts
 

Internal experts are people in your company who are experts on the competitor.
 

Geographies
 

Geographies where the competitor company is present.
 

Industries
 

Industries where the competitor competes with your company.
 

You can also view revenue at stake for the competitor. The Revenue at Stake area in the Edit Competitor page shows the
revenue that potentially could be lost to the competitor. The data comes from product or product group revenue on the
opportunities where the customer is present.

You may want to view notes associated with the competitor, if entered by the administrator. Notes are stored in the
contextual area of the Edit Competitor page.
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Related Topics
• Overview of Sales Competitors

• Associate Competitors with Opportunities

Associate Competitors with Opportunities  
Capture the competitive information for a deal when you associate competitors with an opportunity, either at the
header-level or product-line level.

Associate Competitors at the Opportunity Level
Here's how you associate a competitor at the opportunity level:

1. Sign in as a sales user, such as a salesperson or sales manager.
2. From the Sales > Opportunities page, drill into an opportunity.
3. Depending on how the application is configured, you can access competitors on an opportunity by:

◦ Use the Competitors subtab: If it's enabled, click the Competitors subtab and make your changes in the
Competitors page.

◦ Use the Primary Competitor or Competitors field: If they're enabled, these fields appear in the edit page.

4. In the competitor association pages, you can:

◦ Search for and select a competitors to add to the opportunity.

◦ Remove competitors from the opportunity.

5. Save your changes.

Note:  To associate multiple competitors with an opportunity, more than one competitor must be set up in the
application. Competitors are set up by the administrator.

Associate Competitors at the Product-Line Level
Here's how you associate a competitor at the product-line level on an opportunity:

Prerequisites:

• More than one competitor must be set up by the administrator.

• The administrator must have enabled the Competitor field in the Products table using Application Composer.

• To select a competitor in the Competitor list in the Products table, it must first have been associated with the
opportunity at the opportunity level. Competitors won't show up in the list of values in the Products table
unless they were first added to the opportunity at the header level.

1. From the Opportunities list, click the name of an opportunity to edit it.
2. In the Primary Competitor list, click Search.
3. Search for and select a competitor.
4. Click OK.
5. Save your changes.
6. Add a product line to the table.
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7. In the Competitor list of values, select a competitor.
8. Save your changes.
9. Repeat this procedure to add more competitors.

Related Topics
• Overview of Sales Competitors

• View Competitor Information Outside Opportunities

FAQs for Sales Competitors  

Frequently Asked Questions (FAQs) for Sales Competitors  
This section contains some frequently asked questions (FAQs) for sales competitors. Scroll or search to find answers to
common questions.

How can I see the opportunities that I lost to a competitor?  
Look at the competitor record details. It includes a consolidated view of past and current opportunities where the
competitor is at play. It gives you important details so that you can plan future sales strategies.

How can I see the win/loss distribution on competitors?  
Use competitor analysis graphs to see why opportunities were won or lost. You can also analyze the reasons for losing
or winning against specific competitors. As a sales manager, you can use this analysis to improve your overall deal
success rates and revenues.

For more information, see the Creating and Administering Analytics guide.

Related Topics

How can I see win/loss trends against selected competitors?  
Take a look at the Win Loss Trends report. It displays opportunity revenue won by your organization against
competitors. The report shows the number of wins and losses and closed-won opportunity revenue by quarter and by
competitor.

The report can also show overall opportunity won revenue and number of wins and losses regardless of whether there
was a competitor on the opportunity. For more information, see the Creating and Administering Analytics guide.
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Related Topics

How can I get more information about a competitor?  
Take a look at the list of your colleagues on the Internal Experts tab. The list contains experts who know something
about the competitor.

What's SWOT?  
SWOT stands for: Strengths, Weaknesses, Opportunities, and Threats. The SWOT attribute in the Competitors feature of
your sales application gives organizations a way to examine the strengths, weaknesses, opportunities, and threats of a
competitor.

FAQs for Opportunity Assignment  

Frequently Asked Questions (FAQs) for Opportunity Assignment  
This section contains some frequently asked questions (FAQs) for opportunity assignment. Scroll or search to find
answers to common questions.

How are territories assigned to opportunities?  
You can't explicitly add territories to an opportunity. Rather, the assignment engine automatically assigns territories
to opportunity product lines by matching the dimensional attributes of product lines to territory dimensions, such as
Customer Size or Industry.

When the assignment engine assigns territories to opportunity product lines, the territory owner is also copied to the
opportunity team.

Profile options set by the administrator determine the following:

• Whether, when a territory is assigned to an opportunity product line, all territory team members are also copied
to the opportunity team, in addition to the territory owner.

• Whether the assign opportunity action is available from within an opportunity for salespeople to run
assignment.

• Whether the application runs assignment when salespeople save an opportunity.
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Note:  With partner integration, partner territories (territories whose sales channel dimension is equal to Partner)
aren't assigned to product lines. Partner organizations can only be associated with an opportunity manually, or they
can be automatically associated through an approved lead registration.

Related Topics
• About Sales Resources and Opportunity Assignment

• Overview of Territory Account Assignment

How do I assign team members automatically to an opportunity?  
While editing an opportunity, from the Actions menu, select Save and Run Assignment.

You must have Full access to the opportunity to see the Save and Run Assignment action.

Tip:  You can view assigned territories and the associated territory team members on the opportunity team in the
opportunity Team pages.

Related Topics
• Why can't I assign an opportunity?

Why can't I assign an opportunity?  
You must have Full permission on an opportunity to see the Save and Run Assignment action.

Note that a profile option determines whether the assignment action is available in opportunities.

Related Topics
• How do I assign team members automatically to an opportunity?

What's lock assignment?  
The Lock assignment check box is automatically selected when you run a manual assignment from the UI. Lock
assignment prevents a salesperson from being automatically removed from an opportunity through the assignment
engine.

Only users with Full access on the opportunity can select or deselect the Lock Assignment check box for sales team
members. Resources are assigned automatically to an opportunity during an automatic assignment process or through
a groovy script.

When the lock assignment is selected, an automatic territory assignment can't remove any sales account team
resources or team members. If the lock assignment is deselected, team members may be replaced if they no longer
match the assignment rules.
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Note:  The Lock Assignment check box is not available by default and must be added to the Team subtab within the
Edit Opportunity page using Application Composer. See the related links for more information.

Related Topics
• Extend Pages for Opportunities

• Example of Extending Pages for Opportunities Using Application Composer

What's deal protection?  
With the deal protection feature, all salespeople are automatically protected from being removed from a product line for
which they're receiving sales credit, or from the opportunity team, when territory realignment happens.

Deal protection applies to sales resources that get automatically assigned to product lines as credit recipients or to the
opportunity team using territory-based assignment.

A profile option set by the administrator specifies the default number of days for which salespeople are protected. An
opportunity team member with Full access level can override the dates for which the protection is active.

Opportunity Closure  

Considerations for Closing an Opportunity  
You can close opportunities as needed, for example, when they're won, lost, or no longer active.

When closing an opportunity, you may be required to enter a win/loss reason and a competitor, if enabled during setup.

There are two ways to close an opportunity:

• Use the edit opportunity UI: See the topic, Close an Opportunity Using Edit Opportunity UI, for more
information.

• Use the update feature: See the topic, Close Multiple Opportunities, for more information.

Related Topics
• Close an Opportunity Using the Edit Opportunity UI

• Close Multiple Opportunities

Close an Opportunity Using the Edit Opportunity UI  
You can use the Edit Opportunity page to close an opportunity by setting its status to one of the closed status
categories and entering any required information.
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Close an Opportunity
Here's how to close an opportunity from the Edit Opportunity page.

1. Sign in as a salesperson and navigate to Sales  > Opportunities.

The opportunity landing page displays the list of your opportunities.
2. Find an opportunity and edit it.
3. From the Status field, select a status that belongs to a Closed status category. For example, select Won.

The Close Date field changes to the current date.

The Win/Loss Reason field becomes active.

Note:  Depending how your administrator configured the closing action, the Win/Loss Reason and
Competitor fields may or may not require your input.

4. Select a Win/Loss Reason, if required.
5. Select a Competitor.

This screenshot shows an example of the applicable fields when closing an opportunity in the Edit Opportunity

page. 
6. Click Save or Save and Close.

Tip:  You can find closed opportunities by searching for them using the search utility.

Related Topics
• Close Multiple Opportunities

Close Multiple Opportunities  
You can select several opportunities in the opportunity list and close them at once. You must have Full or Edit access to
the opportunities to update them.

Close Multiple Opportunities at Once
Here's how to close multiple opportunities at once.
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Note:  If Competitor is a required field in the close opportunity flow, the opportunities you update must already have
competitors associated with them before you attempt to update them.

1. Sign in as a salesperson and navigate to Sales  > Opportunities.
2. In the Opportunities overview (also called the landing page or list page), enter the search criteria for the

opportunities that you want to close, and click Search.

The application returns a list of results based on your search criteria.
3. From the Actions menu, click Update.
4. Select the opportunities you want to close.

To select multiple opportunities, hold the Ctrl key down as you select them. You can click the Select All link if
you want to close all the opportunities up to a maximum of 25. Click Deselect All to undo your selection.

5. After you have made your selections, click the Update button.

The Update Opportunities page appears. The page title indicates how many opportunities you're updating.
6. From the Field drop-down list, select Status.

After you make your selection, the application activates the corresponding Value column for data entry or
selection.

7. Select one of the values that belongs to a Closed status category. For example, select Won.
8. Enter a Win/Loss Reason, if enabled as required by your administrator.
9. If you want to enter a date to close your selected opportunities, enter Close Date in the Field drop-down list.

Then enter a date to close the opportunities from the corresponding Value field.
10. Click Add if you want to add more fields to update for your closed opportunities.
11. Click Submit to commit the changes.

A page appears, confirming that the changes were successfully applied.
12. Click Close in the confirmation page to return to the overview page.

Related Topics
• Close an Opportunity Using the Edit Opportunity UI

• Opportunity and Product Line Attributes Synchronization

Examples of Using Opportunity Search Close Period and Close
Date Range Fields  
The opportunity search fields Close Period and Close Date Range can be used together or separately.

Use the Close Period field to set the calendar period for the opportunity close date. Predefined values are Current
Quarter, Previous Quarter, Next Quarter, Previous and Current Quarter, Current and Next Quarter. When you set a value
in this field, the Close Date Range field automatically changes to the dates for the calendar period.

To use the Close Date Range separately, enter your own Close Date Range values instead. The application clears the
Close Period list so that it displays nothing.
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Examples of Field Actions
Here's an example of the Close Date Range and Close Date fields working together:

• The CRM calendar is defined as:

◦ Q1 2014 - January 1 to March 31

◦ Q2 2014 - April 1 to June 30

• In January 2014, you select Current Quarter in the Close Period field.

◦ The application sets the default Close Date range as 01/31/2013 to 3/31/2013.

Here's an example of using the Close Date field by itself:

• You want to review opportunities for a five-month range: March 1 through July 31, 2014.

• In the Close Date fields, you select 03/1/2014 to 7/31/2014.

• The application clears the Close Period field and retrieves opportunities whose close date falls within the date
range.

Related Topics

Opportunity Assessments  

Perform an Opportunity Assessment  
Opportunity assessments contain a series of questions, responses and comments that help you evaluate the health of
an opportunity. After you answer the questions and submit the assessment, you get a rating score.

Such feedback enables you better pursue the opportunity and increase the chance of winning the deal. For example,
you complete an assessment intended to determine whether an opportunity is healthy enough to offer the customer
a 15 percent discount. Based on the assessment score, you and your manager determine whether the opportunity
qualifies for the discount. Giving a discount increases the chance of winning the deal.

Assessments Available for Sales Stages
Assessments are enabled for a specific opportunity sales stage within the sales method used on the opportunity.
Assessments available in one sales stage may not be available in another sales stage.

Perform an Opportunity Assessment
You must have Full or Edit access on an opportunity to perform new assessments and update existing assessments.
With View Only access, you can view assessments but can't update them.

Here's how to perform an opportunity assessment.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Assessments page.
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Note that if only one assessment is available, it displays in the Assessments page, ready for entry.

If multiple assessments are available, the most recently created (by the administrator) assessment displays. You
can use the Show list of values to select other assessments.

You can add assessments, if more are available, by clicking Add Assessment, and then selecting the
assessment. The Add Assessment button displays only if multiple assessments are available.

After a salesperson has answered and submitted all the assessment questions, you can't revise the questions. However,
you can click on the edit icon to view the entire assessment comments text. You can also add a comment for questions
that don't have existing comments to display.

Update an In-Progress Assessment
Here's how to update an assessment that's in progress.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Assessments page.
4. To retrieve the assessment you have in progress, click the Show list of values and select the assessment from

the list. Note that the assessment that was worked on last is the one that appears by default in the Assessment
tab.

View and Edit Assessment Comments
You can view all assessment responses, including free-form response text and comments. If the question has existing
comments, then a two-line read-only Comments text box is displayed. If there's more than two lines' worth of text to
display, then the text is truncated and ends with an ellipsis. You can click on the edit icon to view the entire text. You can
also add a comment for questions that don't have existing comments to display.

Delete Assessments
Your administrator may have enabled the Delete Assessment button in the Assessments page. The delete action lets
you delete an existing assessment. After you delete an assessment, it's available to rerun using the Add Assessment
button. Note that you must have Full or Edit access on the opportunity to delete an assessment.

Perform Multiple Opportunity Assessments Using the Same
Template  
From time to time, you might want to reassess your opportunity information and perform several assessments for
opportunities using the same assessment template.

To perform multiple assessments per template, your sales administrator must set the profile option Enable Multiple
Assessments Per Assessment Template to Yes at the site level. You can add assessments, if more are available, by
clicking Add Assessment, and then selecting the assessment template. When you add another assessment for your
opportunity using the same assessment template, the application automatically generates an assessment name using
the assessment template name plus a counter suffix. If you have an existing assessment for an opportunity named
Discount Eligibility V1, then if you add another opportunity assessment using the same template, the new assessment
name is displayed as Discount Eligibility V2. You can edit this name to suit your own requirements.
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When all questions are answered, the status of the assessment is set to Complete and continues to be editable. You can
view all ongoing or historical assessments, scores, statuses, and template names. You can use the Delete and Submit
features only if the buttons are enabled by your administrator using Page Composer. You can delete an assessment
that's no longer required or if it was created by mistake as long as it hasn't been submitted. The Submit button becomes
available only when you have entered responses for all questions. You can't edit the assessment once the status is set to
Submitted but you can continue to view it.

Perform Multiple Opportunity Assessments
Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Assessment Template
(MOW_MULTIPLE_ASSESSMENTS_ENABLED) profile option to Yes. You must also have Full or Edit access on an
opportunity to perform multiple assessments and update existing assessments using the same assessment template.
With View Only access, you can view assessments but not update them.

Here's how to perform multiple opportunity assessments using the same assessment template.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Edit Opportunity Assessments page.

If existing assessments are available for the selected opportunity, they're listed here.
4. Click Add Assessment. The Add Assessment dialog appears
5. From the Template drop-down list, select the assessment template previously chosen for the selected

opportunity assessment.
6. Click Save and Continue.
7. Select the appropriate responses to all the questions.
8. Click Submit and then click Yes from the confirmation dialog box.

The assessment status is changed to Submitted.

After you submit an assessment, you can't revise it.
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17  Opportunity Products and Revenue

Overview of Opportunity Products and Revenue  
You typically add product groups or products to opportunities to record potential sales revenue while working the deal.
After an opportunity is won and closed, the revenue from the products sold becomes actual revenue, for reporting
purposes.

Companies use opportunity revenue information for several reasons, such as analyzing sales pipelines and win/loss
trends, monitoring the performance of salespeople, and generating revenue forecasts. Here are some typical tasks that
you can perform with opportunity products and revenue:

• Add products and product groups that the customer is interested in.

• Set product line revenue attributes, such as revenue amount, price, and quantity.

• Set other product line attributes, such as inclusion in the forecast, expected close date, win probability, and
competitors.

• Enter and maintain recurring revenue schedules, such as those for subscription services or training plans.

• Allocate and manage sales credit amounts that opportunity team members receive.

• Run the assignment process to assign salespeople to the product lines.

Related Topics
• Manage Opportunity Products and Revenue

• Opportunity and Product Line Attributes Synchronization

Opportunity Products and Revenue Management  

Manage Opportunity Products and Revenue  
You can add products or product groups to opportunities and then update the product lines, including revenue
attributes, if required.

Add Products or Product Groups
Here's how to add a product or product group to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click Add to add a row to the table.
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5. In the Type field, select Group if you're adding a product group. Select Product if you're adding a single
product.

Note:  Depending on your implementation, you may have the option to browse the sales catalog. The catalog
contains the same product groups and products as those accessible from the table.

6. Select the Name list, and then select the product group or product.

If the product group or product isn't in the recently used items list, access the search page by clicking the
Search link in the Name list.

7. In the Search page, the product groups or products you have access to may be automatically filtered to show
only the products in your sales territories.

For type Product, you can search for the product you want by entering a keyword, name, or product number.
For type Group, you can search by name and reference number, if known.

To search all products in the database without the territory filtering, deselect the Filter by Territory option.
8. Select the product group or product and click OK to return to the Products table, where you can set other

attributes of the product line, such as quantity, price, and so forth.
9. Save your work.

This table explains the product line attributes.

Product Field Description

Type
 

Select either product group or product.
 

Name
 

Use to select a product or product group. If individual products aren't implemented, then only product
groups are available.
 

Quantity
 

Enter values in whole numbers. The application multiplies this field by Estimated Price to calculate the
revenue amount.
 

Estimated Price
 

Enter estimated price per item. The application multiplies this field by Quantity to calculate the revenue
amount.
 

Amount
 

Amount used in forecasting and for reporting. The application calculated this field from price
multiplied by quantity, but you can override the value.
 

Currency
 

The initial value is based on the opportunity-level currency. If multiple currencies are implemented, you
can pick a different currency.
 

Sales Credit
 

Use sales credits to specify who gets revenue and overlay sales credit for the sale.
 

Depending upon how your application is configured, you may have these additional product line attributes available.

Product Field Description

Close Date
 

Indicates the expected close date of the product line. The initial value is the opportunity-level close
date, but each line can have its own close date.
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Product Field Description

 

Forecast
 

Displays a check mark if the product line matches the established forecast criteria.
 

UOM (Unit of Measure)
 

The initial value is based on the product or product group selected.
 

Status
 

Use to set the product line status, such as Open or Won.
 

Win Probability
 

The initial value is the opportunity-level win probability, but can be overridden.
 

Best Case
 

The initial value is the revenue amount for the item or group (providing Revenue is greater than Best
Case).
 

Worst Case
 

Use to set a worst case revenue amount.
 

Include in Forecast
 

The application sets the initial value to When matches forecast, if forecasting criteria have been
enabled. Can be overridden to Yes (meaning always include in forecast) or No (meaning never include
in forecast), if forecasting criteria override has been enabled.
 

Territories
 

Displays the territories assigned to the product lines. You can drill down into the field to view all of the
associated territories.
 

Competitor
 

You can set a competitor at product-line level. The choice list is limited to those associated at the
opportunity level. Depending upon your implementation, you may be required to enter a competitor
when setting an opportunity or product line to closed.
 

Win/Loss Reason
 

When a product line or the opportunity is closed, this field indicates why the product line was won or
lost.
 

Actual Close Date
 

This is a read-only field set by the application automatically when you set a product line to a closed
status.
 

For procedures on managing recurring opportunity products or product groups that are part of a subscription business
model, see the topic, Create and Maintain Recurring Opportunity Products.

Remove Product Lines
Here's how to remove any products you don't need from the Products table in opportunities.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales >  Opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click the X icon located at the end of the applicable table row to remove a product line

from your opportunity.
5. Save your work.
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Related Topics
• Overview of Opportunity Products and Revenue

• Best Practices for Sales Credits

• Example of Product Line Synchronization with Win Probability

Can I update products on multiple opportunity lines at the same
time?  
Yes, if you have the mass update feature enabled at either the opportunity summary or product tab level, then you can
update attributes and apply changes to fields at once on multiple opportunity product lines.

Mass update of attributes at the product line level works similar to the mass update of top-level objects such as
opportunities and accounts. The main difference is that your opportunity revenue and product line changes are saved
at the product line level. Mass update of changes at the opportunity object level are saved at the parent opportunity
level.

Related Topics
• How to Apply Mass Update to Opportunities

• Enable Mass Update of Records

Recurring Opportunity Products  

Overview of Recurring Opportunity Products  
Recurring schedules in opportunities enables you to enter and track opportunity products or product groups that are
part of a subscription business model.

The subscription business model applies to the sale of goods, software, or services where the customer is required to
pay a subscription price for access to the goods, software, or services, with additional usage or pay-as-you go charges
in some cases. Some examples are:

• Data and phone services

• Credit collection or payment processing services

• Software, platform, or data-as-a-service costs

• Magazine subscriptions

• Product life cycle costs

• Engineering and infrastructure services

The subscription model can encompass both business-to-business (B2B) and business-to-consumer (B2C) customers.
For example, a telecommunications company may sell mobile phone services to individuals, and multiple phone lines to
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a business for their employees. The supplier of these services typically charges the customer a periodic rate applicable
to the plan that they subscribed to.

After you define a schedule for a subscription product or service, the application creates the recurring transactions from
the frequency and the number of transactions specified in the schedule. There are several time frequencies to choose
from, such as weekly, monthly, quarterly, yearly, and so on. The multiple frequencies make it easy to set up a recurring
schedule, like a monthly subscription for three years, or a biweekly annual subscription. You can review the schedule
and quickly add a one-time registration or installation fee, and adjust the amount or date of any transaction.

Subscription changes are easy to manage. If there is a change in the terms or price of the subscription, you can quickly
define a new schedule to replace the previous one. If the original subscription is extended, say, for another year, you can
easily extend the existing schedule on the product for the period that you want.

Product amounts from recurring schedules are summed into the corresponding quarterly or yearly periods, and are
readily available in pipeline reports and forecast rollups for you and sales managers.

Related Topics
• Create and Maintain Recurring Opportunity Products

Create and Maintain Recurring Opportunity Products  
You use recurring transactions to enter and track opportunity products or product groups that are part of a subscription
business model.

Watch video
 

You use recurring transactions to enter and track opportunity products or product groups that are part of a subscription
business model. Use the procedures in this topic to create and maintain recurring revenue schedules in opportunities.

Note:  Recurring opportunities functionality is available only if your administrator has enabled it.

Create a Recurring Revenue Schedule
Here's how to create a recurring revenue schedule for a product or product group in the opportunities UI.

1. Sign in as a sales user, such as a sales representative or sales manager.
2. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.
3. Edit an opportunity by clicking the name in the list. Or, create an opportunity and save and edit it.
4. In the Products table, click the Add button and enter the details about the product or product group.
5. In the Schedule column, click the add icon (plus sign). The Set Schedule page appears.

Enter data into the fields, using the guidance in this table.

Field Guidance

Frequency
 

Select a frequency that the revenue should be generated for. Note that:
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Field Guidance

◦ Bi-Weekly is twice a month (every two weeks)

◦ Bi-Monthly is every other month

Start Date
 

◦ The default date is opportunity close date.

◦ You can update the field to any other value (equal to or later than current date).

End By
 

Enter the number of transactions or a calendar end date.
 

Note:
The number of transactions to include in your recurring revenue schedule for a product or
product group should not exceed 500.
 

Quantity
 

Enter quantity of the product or product group being sold, as a whole number.
 

Amount
 

Enter the amount of the product or product group being sold.
 

6. Click Next. The Manage Schedule page appears. Note the following actions:

◦ The appropriate number of transactions are created based on frequency, start date, and number of
transactions or end date.

◦ The close date on each transaction is set to a value derived from the combination of frequency, start
date, and end date.

◦ Quantity and amount are repeated for each transaction.

◦ Other values (like status, win probability, product, currency, and so on) are cascaded from the parent
revenue line.

◦ Transactions are ordered by ascending close date by default.

◦ Total quantity and amount are displayed for the schedule. Total amount shows the applicable currency
symbol of the product currency.

7. Review the transactions in the schedule and adjust if required.
You can add a schedule transaction row by clicking the Add button and entering the required information.

8. Click OK to save the schedule. The application returns to the edit opportunity page.
9. Click Save or Save and Close to save the changes.

Manage Scheduled Transactions
All other actions you can perform with an existing recurring schedule are done in the Manage Schedule page, available
by editing the schedule.

You can:

• Edit the existing transactions in the schedule.

• Extend the schedule by entering new dates.

• Replace the schedule altogether.
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• Delete the schedule.

Here's how to manage existing scheduled transactions.

1. Sign in as a sales end user, such as a sales representative or sales manager.
2. Navigate to Sales > Opportunities.

The opportunity landing page displays your opportunities.
3. Edit an opportunity by clicking the name in the list.
4. In the Products table, click the edit icon in the Schedule column. The Manage Schedule page appears.
5. In the Manage Schedule page, perform, if required, the actions in this table.

Action Details

Edit schedule transactions
 

◦ To add a row to the transactions table, click the Add button and enter the required
information.

◦ To remove a row in the transactions table, click the X in the row.

Replace a schedule
 

◦ Click the Replace Schedule button.

◦ The Replace Schedule page behaves as if you're creating a new schedule.

◦ Enter the new schedule details and save. The new schedule replaces the old schedule.

Extend a schedule
 

◦ Click the Extend Schedule button to retrieve the Extend Schedule page.

◦ Edit the schedule details as needed.

◦ Note the following actions:

- If the previous schedule had the number of occurrences stored, then that value is set as
the default.

- The recurring quantity and recurring amount are set by default, based on previous values.
If you update these to any other values, the resulting transactions are generated based on
the updated values.

- If the start date of the new schedule is prior to the end of current schedule, then the
process replaces all existing transactions with a close date later than the new schedule's
start date.

Delete a schedule
 

◦ Click the Delete Schedule button.

◦ Respond with Yes to the warning message.

◦ All underlying scheduled transactions are deleted, and the schedule parameters on the
parent line are removed.

◦ The product line is converted to a standard revenue line and the quantity and amount
field are set to blank.

6. Click Save or Save and Close in the edit opportunity page to commit the changes made in the recurring
schedules page

Related Topics
• Overview of Recurring Opportunity Products

• Manage Opportunity Products and Revenue
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Sales Credits  

Best Practices for Sales Credits  
Companies use sales credits to report on the performance and quota attainment of their sales personnel. They also use
sales credits to aid in compensation calculation and to facilitate forecasting by territories.

Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment.
You assign sales credits to sales resources (salespeople or other sales users) while editing product lines in opportunities.
When a product line is first added to an opportunity, the application sets the user who added it, as the sole sales credit
recipient. This means that the sole recipient receives 100 percent of the sales credit.

Two types of sales credit exist for opportunities:

• Revenue sales credit: Typically allocated to salespeople working the deal.

• Overlay sales credit: Typically allocated to other resources helping out with the deal, such as a product or
market specialist. Overlay sales credit is also known as nonrevenue sales credit.

Revenue Sales Credit
When assigning revenue sales credits, keep in mind:

• Only internal resources are eligible as revenue credit recipients.

• Revenue sales credits must add up to 100 percent.

• The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and
Nonrevenue Forecast Participation.

Overlay Sales Credit
When assigning overlay sales credits, keep in mind:

• Both internal and external (for example, partner) resources are eligible as nonrevenue credit recipients.

• Nonrevenue sales credits doesn't have to add up to 100 percent.

• If the selected Allocation Style is Proportional to Revenue, the sales credit amounts adjust automatically and
proportionally when the product line amount changes.

• If the selected Allocation Style is Ad Hoc Amounts the sales credit amounts don't change with product line
amount changes.

• The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and
Nonrevenue Forecast Participation.

Note:  Territories with a Forecast Participation of Nonforecast aren't eligible to be set as the forecast territory on either
revenue or nonrevenue sales credits.

Configure Revenue Territory Default Assignment
You can configure the revenue territory assignment default logic to meet your specific business needs for reporting
and forecasting the product amounts on an opportunity. When a sales representative creates an opportunity, the
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opportunity amount gets reported in the sales representative's pipeline and forecasted in their territory. This is achieved
through the seeded defaulting logic, part of the revenue territory assignment process, that sets the appropriate credit
recipient and forecast territory on the opportunity product lines.

Some companies have territory setup that may result in many overlapping territories assigned to the opportunity
products. They may have specific business logic that determines to whom the pipeline from an opportunity should be
reported and forecast. For example, the opportunity creator may not be the owning sales representative. Instead the
owner of the sale may be determined by the role or geography of the sales representative involved in closing the sale,
or the business unit of the sale. Many of these scenarios can be met through appropriate territory setup, the standard
revenue territory assignment processing, and subsequent sales credit recipient and forecast territory defaulting logic.

Note:  A sales credit recipient selected by a user doesn't get replaced by the application unless the recipient is no
longer a qualified credit receiver. The application won't change the recipient if:

• The Lock Owner setting for the revenue item is enabled

• The current credit recipient is under deal protection.

• The current credit recipient is an owner or member of the forecast territory.

The application sets the forecast territory owner as the new credit recipient if the preceding criteria isn't met.

This table outlines the predefined deal protection logic to set the forecast territory for each revenue line in the sales
credit.

If you're using Deal protection... If you aren't using Deal protection...

Sets the owner of the revenue line as the
Forecast territory's owner. As a result,
 multiple revenue lines have the same
owner after assignment.
 

Sets the owner of the revenue line as the owner of the forecast territory after setting the Primary
forecast territory of the sales credit revenue line.
 

You can make the revenue line owner deal
protected by setting a deal protection
period in the MOO_DEAL_PROTECTION_
PERIOD profile option. Go to Setup and
Maintenance >  Manage Opportunity
Profile Options and set MOO_DEAL_
PROTECTION_PERIOD to a value as
required.
 

If you need to bypass setting the owner of the revenue line as the owner of the forecast territory,
 you will have to lock the owner either through running a Groovy script while adding the Sales Credit
Recipient (SCR). Alternatively, you can set the MOO_DEAL_PROTECTION_PERIOD profile option, as
required.
 

In the trigger createNonRevenueSplitLineAndAssignSCR
add the following lines in places where you're adding the SCR.

splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y');

This will retain the resource that you're adding to the overlay from the
 territory resources.
From the script, the places are as follows:
1. //==============================================================
// Block of code to create Non-Revenue Sales Credit Splits
//==============================================================
def splitRevenueNonQuotaIterator =
 nvl(getAttribute("SplitRevenueNonQuota"),null);
splitRevenueNonQuotaIterator?.reset();
if (!splitRevenueNonQuotaIterator?.hasNext()) {
splitNonRevenueRow = splitRevenueNonQuotaIterator.createRow();

293



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 17
Opportunity Products and Revenue

If you're using Deal protection... If you aren't using Deal protection...

splitNonRevenueRow.setAttribute('SplitParentRevnId',getAttribute("RevnId"));
splitNonRevenueRow.setAttribute('SalesCreditTypeCode','NONQUOTA');
splitNonRevenueRow.setAttribute('SplitPercent',60);
splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y'); //<--Added code here
splitNonRevenueRow.setAttribute('ResourcePartyId',Opportunity?.OwnerResourcePartyId);
println('Opportunity?.OwnerResourcePartyId
 '+Opportunity?.OwnerResourcePartyId)
setAttribute('ResourcePartyId',Opportunity?.OwnerResourcePartyId)

2.
if (splitRevenueNonQuotaIterator1?.hasNext()) {
splitNonRevenueRow = splitRevenueNonQuotaIterator1.createRow();

splitNonRevenueRow.setAttribute('SplitParentRevnId',getAttribute("RevnId"));
splitNonRevenueRow.setAttribute('SalesCreditTypeCode','NONQUOTA');
splitNonRevenueRow.setAttribute('SplitPercent',84);
splitNonRevenueRow.setAttribute('OwnerLockAsgnFlag','Y'); //Added code here
splitNonRevenueRow.setAttribute('ResourcePartyId',newSCR);
splitRevenueNonQuotaIterator1.insertRow(splitNonRevenueRow);
setAttribute('SplitTypeCode','PARENTSPLIT');
setAttribute('ResourcePartyId',newSCR);
println('Inside IF SET ATTRIBUTE.. (!
splitRevenueNonQuotaIterator1?.hasNext())....SplitTypeCode' +SplitTypeCode)

See the article, Configuring Credit Recipients and Forecast Territories Assignment (Doc. ID 2089301.1), available on My
Oracle Support (support.oracle.com).

Manual Territory Assignment by Administrators
In the sales credits screens, sales administrators can manually assign a sales representative's territory to a product
line when the territory hasn't been assigned automatically. Manual assignment allows sales personnel to forecast an
opportunity immediately while the territory setup is being reviewed and updated.

Related Topics
• Allocate Sales Credits

• How can I lock in a sales credit recipient?

• Sales Credit Recipient and Forecast Territory Predefined Logic

• Set Deal Protection on Opportunities

Allocate Sales Credits  
Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota
attainment. Your company can use sales credits to report on salesperson performance and quota attainment, to aid in
compensation calculation, and to facilitate forecasting by territories.

When a product line is first added to an opportunity, the user who added it, is automatically set as the sole revenue
sales credit recipient (receiving 100 percent of the sales credit). For each product line, you can assign a portion or all of
the sales credit from the product revenue to individual salespeople.
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Note:  You must have Full access to an opportunity to assign sales credits.

Allocate Revenue Sales Credit
You typically allocate revenue sales credit to salespeople working the deal.

Here's how to allocate revenue sales credit to a user.

1. Sign in as a salesperson or sales manager and navigate to Sales > Opportunities.

The opportunity landing page displays the list of your opportunities.
2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.
3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you're

editing. The Edit Sales Credit window appears.
4. Click the Add Revenue Credit button to add another row to the sales credits table.
5. Select the drop-down list in the Name column for the new row. Select a name from the recently used list, or

click Search to search for the salesperson.

a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales
credit.

b. In the search results, select the user and click OK.
6. In the table, enter the percent of sales credit for the user or an amount. With revenue sales credit, the total of all

percentages entered must add up to 100 percent.
7. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory

can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast
Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this
step if you want.

8. When you're finished setting the sales credit, click OK.
9. In the Edit Opportunity page, save your changes.

Allocate Overlay Sales Credit
You typically allocate overlay sales credit, or nonrevenue credit, to other resources helping out with the deal, such as a
product or market specialist.

Here's how to allocate overlay sales credit to a user.

1. Sign in as a salesperson and navigate to Sales > Opportunities.

The opportunity landing page displays the list of your opportunities.
2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.
3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you're

editing.

The Edit Sales Credit window appears.
4. Decide which type of overlay credit you want to enter and then select that type from the Allocation Style list of

values:

◦ Proportional to Revenue: With this type, the sales credit amounts adjust automatically and
proportionally when the revenue item amount changes.

◦ Ad Hoc Amounts: With this type, the sales credit amounts don't change with revenue item amount
changes.
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5. Click the Add Overlay Credit button to add another row to the sales credits table.
6. Select the drop-down list in the Name column for the new row. Select a name from the recently used list, or

click Search to search for the salesperson.

a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales
credit.

b. In the search results, select the user and click OK.
7. In the Edit Sales Credit window, in the Sales Credit column of the table, enter the percent of sales credit for the

user. With overlay sales credit, the total of all percentages doesn't have to add up to 100 percent.
8. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory

can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast
Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this
step if you want to.

9. When you're finished setting the sales credit, click OK.
10. In the Edit Opportunity page, save your changes.

Related Topics
• Best Practices for Sales Credits

• How can I lock in a sales credit recipient?

• What's deal protection?

How can I lock in a sales credit recipient?  
When assigning sales credits, you can lock the sales credit recipients of a revenue line by setting the corresponding
Lock Credit Owner check box on the line. This setting prevents the recipient from automatic replacement when
assignment is run.

Generally, you don't need to lock resources who are members of a forecast territory on the sales credit. However, you
should consider locking ad hoc resources or non-territory-based recipients, such as partner resources, to prevent
automatic assignment from removing them as credit recipients.

Related Topics
• Best Practices for Sales Credits

• Allocate Sales Credits

• Sales Credit Recipient and Forecast Territory Predefined Logic

Product Attribute Synchronization  

Example of Product Line Synchronization with Win Probability  
When you change the win probably percentage on an opportunity, the application automatically resynchronizes any
product lines whose win probability percentages were previously in sync with the opportunity win probability.
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Scenario
This example illustrates what happens when you change the opportunity win probability:

• Opportunity win probability is 50%.

• Product line 1 win probability is 50%.

• Product line 2 win probability is 50%.

• Product line 3 win probability is 40% .

You change the opportunity win probability to 60%. The application automatically changes the win probability for
product lines 1 and 2 to 60% as well, because they were previously in sync with the opportunity-level win probability.

The win probability for product line 3 doesn't change, because it wasn't previously in sync with the opportunity-level win
probability.

Related Topics
• Overview of Opportunity Products and Revenue

• What happens if I change win probability?

• Manage Opportunity Products and Revenue

Opportunity and Product Line Attributes Synchronization  
Opportunities and their product lines share common attributes, for example, status or win probability percentage. For
several attributes, under certain conditions, the application automatically synchronizes them so that they're the same.

In addition, the application updates certain opportunity and product line attributes based on the values of other
attributes. The attributes that the application synchronizes or updates automatically are:

• Win probability

• Close date

• Include in forecast setting

• Status

• Win/loss reason

• Competitor

Note:  An attribute is said to be synchronized if its opportunity and product line values are the same, and if the
product line is in the same status category as its opportunity. If a product line and its opportunity both have
undefined values, they're considered to have the same value.

Synchronization of Opportunity and Product Line Attribute
The application synchronizes certain product line attributes based on the opportunity-level attribute, under certain
conditions.

Synchronization occurs for these attributes:

• Win probability
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• Close date

• Include in forecast setting

• Status (not status category)

Here is an example of close date synchronization:

• An opportunity with an Open status category has a close date of July 14, 2018.

• Product lines 1, 2, and 3 have the same close date and they're in the same status category.

• Product line 4 has a different close date, but the same status category.

• The close date of the opportunity is changed to August 14, 2018. The application automatically sets the close
dates of product lines 1, 2, and 3 to the same close date as that of the opportunity. The close date of product
line 4 remains unchanged, because it has close date that wasn't already synchronized with the date of the
opportunity.

Opportunity Status Updates
These scenarios explain what happens when the opportunity status is updated. Note that status values display in
alphabetic order on the UI.

• Opportunity status is updated to a Won status:

◦ The application updates the opportunity win probability to 100 percent. It also updates all synchronized
product lines' win probability to 100 percent.

• Opportunity status is updated to a Lost or No Sale status:

◦ The application updates the opportunity close date to the current date. It doesn't update the close date
on synchronized product lines.

• Opportunity status is updated from an Open status to a Closed status:

◦ The application enables the opportunity win/loss reason attribute.

◦ If an opportunity primary competitor has been defined, the application updates the product line
competitor to the opportunity primary competitor for all opportunity product lines, if they aren't already
defined. This action applies only to the close opportunity and mass update opportunities flows.

• Opportunity status is updated from a Closed status to an Open status:

◦ The application disables the opportunity win/loss reason attribute.

◦ The application sets the opportunity win/loss reason attribute to "undefined". It doesn't update the win/
loss reason on synchronized product lines.

Product Line Status Updates
These scenarios explain what happens when the product line status is updated:

• Product line status is updated to a Won status: The application sets the product line win probability to 100
percent.

• Product line status is updated to a Lost or No Sale status: The application sets the product line close date to the
current date.

• Product line status is updated to a Closed status: The application enables the product line win/loss reason
attribute.
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• Product line status is updated to an Open status:

◦ The application disables the product line win/loss reason attribute.

◦ The application updates the product line win/loss reason attribute to "undefined".

Opportunity Win/Loss Reason Updates
When an opportunity is in an Open status, the opportunity win/loss reason attribute is disabled. Win/loss reason
is activated when the opportunity is set to a Closed status. When the opportunity win/loss reason is updated, the
application updates all opportunity product lines where the win/loss reason attribute is synchronized.

Note:  If the opportunity line item status is set to inactive, then Reason field is editable in the List view so that you
can include a reason why the line item isn't active. However, the Reason field isn't editable on the Form view of the
Opportunity Line Item. This is expected behavior due to the difference in the page structure. The edit page from the
List view has a table view for Revenues, while the Form page has a form view and is therefore not editable.

Opportunity and Product Line Competitor Updates
If a primary competitor has been defined at the opportunity level, when the opportunity status changes from an Open
status to a Closed status, the application updates the product line competitor to the primary competitor for all lines that
don't already have a competitor.

Tip:  If a product line without a competitor is set to closed and the opportunity is saved, the application displays a
dialog box that lets you copy the opportunity primary competitor to the product lines without competitors.

This action applies only to edit opportunity and close opportunity flows. It doesn't apply to the mass update flow.

Related Topics
• Example of Product Line Synchronization with Win Probability

• Set Opportunity Revenue Forecast Criteria
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18  Forecasts

Overview of Forecasts  
Your forecasts of future sales provides predictions of future revenue for specific time periods. Management uses sales
forecast data to set production schedules and volumes, to determine resource requirements, and to report financial
guidance to investors.

What You Can Do Details

Submit forecasts
 

You can view, manage, and submit your forecasts in the office and using the mobile application. You
can:
 

• Review your forecasted product items and submit the forecast.

• View your pipeline that isn't forecasted.

• Use embedded analytics to improve forecast accuracy.

View automatically generated forecasts
 

Your forecast for a period is automatically generated from eligible opportunity product items
scheduled to close within the period. Forecasts are refreshed from the pipeline revenue in real time.
Opportunities and forecast items continue to synchronize until you submit forecast items for final
approval.
 
The sales administrator sets the criteria that determine whether a product item is eligible to be
automatically included in a forecast. The administrator also provides the option for you to override the
established criteria and manually include or exclude a product item from the forecast.
 
Forecasting reflects any edits you make to an opportunity, or any adjustments at the deal level in real
time.
 

Forecast by territory
 

You forecast sales by territory. The forecasts roll up following the territory hierarchy. If enabled,
 subscription renewal forecasts roll up in a separate column from new forecasts that aren't renewals.
The Forecast column shows the total for both new and renewal forecasts.
 
Changes to the active territory hierarchy are periodically synchronized with the forecast hierarchy up
until a freeze date. After the territory freeze date, you can make changes to your forecasts.
 

Compare forecasts
 

You can view current, future, and past forecasts. The current forecast is open for editing at certain
times and then frozen. Your manager can view the latest forecasting data and compare it to key
metrics such as pipeline and won revenue.
 

Adjust forecasts
 

Sales managers can review and adjust forecasts anywhere. Subscription renewals can be adjusted
separately by choosing the Renewals category to display. The New category shows all except renewals.
Select All to see the total forecast.
 

Manage subordinates' forecasts
 

You can quickly see which salespeople have submitted their forecasts, what has changed since the
previous forecast, and the opportunities that comprise the forecast. You can also drill into your
subordinates' forecasts to view a forecast the same way that the salesperson sees it. This provides
sales managers with the opportunity for more effective coaching and greater forecast accuracy.
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What You Can Do Details

You can add, remove, or adjust individual lines in a salesperson's forecast, segment the totals by
time period, and override forecast totals for each salesperson. Any adjustments are clearly identified
throughout the forecast hierarchy, allowing management to quickly view the changes made by sales
managers who are on their team.
 

Record overlay forecasts
 

You can record overlay forecasts on opportunity revenue transactions in addition to the revenue
sales credit split. Overlay forecasts allow nonprimary salespeople to forecast sales expectations for all
overlay sales credits.
 

Forecast by product
 

If enabled, you can forecast by product, forecasting amount, and quantity. If your products include
subscriptions, you can forecast subscription renewals separately from new forecast items by choosing
the category.
 

How can I add forecast items to a forecast?  
To add forecast items to a forecast, navigate to Forecasts and click Review or Edit.

Watch video
 

Search for opportunity items on the Unforecasted Pipeline tab and add them to the forecast. For any forecast item with
a warning icon, you must change any attributes that don't meet the forecast criteria. When all attributes fall within the
forecast criteria, the product item becomes part of your forecast.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option
to Always to override the lack of matching forecast criteria. An icon warns you when a product item doesn't match the
forecast criteria and requires the forecast override.

If you're unable to edit the forecast item you're adding, then the item is added with the forecast amount set to zero. But,
the item now has a positive adjustment amount to match the original product item revenue amount. For example, if the
revenue amount is 3,000, then the forecast is 0, the forecast adjustment is 3,000, and the adjusted forecast is 3,000.
You can further refine the adjusted forecast item amount, or remove the forecast item if you no longer want the item
included in the forecast.

If you don't see the Unforecasted Pipeline tab, then click the Add Forecast Items button to search for and select
opportunity items to add.

About Forecasting by Territory, Product, or Unit  
You can forecast sales by territory and amount, by product and amount, or by product and quantity of units.

A forecast covers a specified time period, such as quarter or month. A territory owner submits the current forecast to
the owner of the parent territory, who's likely the owner's manager.
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The application generates the forecast by capturing information from opportunity lines as follows:

• Opportunity items are placed in time periods according to the planned or actual close date.

• Only opportunities that meet the forecast criteria are included in a forecast.

• Opportunities assigned to a territory are added to the forecast for that territory.

• Opportunity lines with the Renew revenue type category are added to Renewal forecasts. Subscriptions are an
example.

Forecast Amounts by Territory
The territory owner forecasts the amount of sales for the territory by time period. The sum of the amounts for all
included opportunity items is the forecast amount. Use the Edit Forecast page Territories tab and Forecast Items tab to
forecast amounts by territory.

You can:

• Manually add opportunity items to your forecasts or remove them.

• Change the amounts for individual forecast items.

• Make adjustments by changing the total forecast amount for individual time periods for a subordinate's
territory forecast.

• Make adjustments to the amounts for a subordinate's forecast items.

Forecast Amounts by Product
Within the territory, the territory owner forecasts the amount of sales for each product by time period. The forecast
amount for each product is the sum of the amounts from opportunity items for that product. Use the Edit Forecast page
Products tab and Forecast Items tab to forecast amounts by product.

You can:

• Manually add opportunity items to your forecasts or remove them.

• Change the amounts for individual forecast items.

• Make adjustments to the individual product amounts by category (if renewal forecasting is enabled) and by
time period.

• Make adjustments to the amounts for a subordinate's forecast items.

• Make adjustments to the product amounts for a subordinate's territory forecast.

Forecast Unit Quantities by Product
Within the territory, the territory owner forecasts the quantities of each product by time period. The forecast quantity for
each product is the sum of the quantities from opportunity items for that product. Use the Edit Forecast page Products
tab and Forecast Items tab to forecast unit quantities by product. In the Products tab, select to show Quantity or All
Totals.

You can then, for your territory:

• Manually add opportunity items to your forecasts or remove them.

• Change the quantities for individual forecast items.

• Make adjustments to the individual product quantities by time period.
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• Make adjustments to the quantities for a subordinate's forecast items.

Manage Your Forecast  
Sales managers review and adjust the forecasts of their sales teams. You can add or remove items from your or a
subordinate's forecast.

Watch video
 

When you make adjustments, you can adjust quantities and amounts directly for an opportunity item. You can also
make adjustments for a territory and add amounts that don't come from existing opportunities.

Review Your Forecast
To review your forecast:

1. During an open forecast time period, navigate to Sales > Forecasts.
2. Review the graph to compare your group's forecast with won revenue and the pipeline.
3. The second chart shows your group's percentage of quota attained. Roll over the target quota amount to

review quota and won revenue amounts.
4. Click the breadcrumbs to switch to your next forecast for review and back to your current forecast.
5. Click Review to see the details of your forecast.
6. Click Edit to make your changes.

Any subordinate forecasts that weren't submitted by their owners will now be submitted for them

Edit the Forecast
The Territories tab shows your team's forecasts, won revenues, open pipelines, and quotas. To edit your forecast:

1. Roll over the icons in the first column to see which territory owners submitted their forecasts.
2. Hover over the Forecast Change arrow to see what's changed since you last submitted your forecast.
3. Click the Products tab.
4. Click Show and choose All Totals.
5. You can view and change the totals for current, best case, and worst case forecasts as well as the quantity for

each product.

Adjust Opportunity Items in the Forecast
You can adjust the forecast for accuracy in two ways. Edit the totals by product or adjust the opportunities that sum to
the totals. To adjust your forecast:

1. Click the Forecast Items tab.

The tab lists the opportunity items currently in your forecast. The items meet the forecast criteria.
2. In the Show list, select one subordinate's territory.
3. Select the opportunity item you want to change, and enter new values for quantity or forecast, or both.
4. Click the icon to remove an opportunity item.
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5. Click Add Forecast Items to find and add a missing opportunity item.
6. Click Save.

The opportunity items you edited show the new values, and the forecast totals are recalculated.
7. Hover over a blue dot next to one of your changed opportunity items.

You see the adjustment you made, as well as the un-adjusted forecast submitted to you by the salesperson. The
salesperson can't see any of the changes you made.

Adjust and Submit the Forecast
You can adjust the forecast by product and submit the forecast to your manager. To complete your forecast:

1. Click the Products tab.

You can see the changes you made to the opportunities reflected in the respective product totals.
2. Deselect Exclude All Rows with All Zero Values.

You can now see and adjust all products.
3. Make your changes to quantities and forecast amounts to any products, including those with zero values.
4. Save your forecast.
5. Submit your forecast to your manager.

You can make no further changes after submitting your forecast.

Sales Forecast Adjustments  
Changes you make to the original forecast up or down are adjustments. If your forecast is by product, then you can
adjust quantities as well as the amounts for individual forecast items.

Depending on your configuration, you can adjust the following:

• The amounts for individual forecast items

• The total amounts for each territory owned by your subordinates and by time

• The total amounts by product and also by time period for your territory

• The quantities for individual forecast items

• The total quantities by product and also by time period for your territory

• Adjustments for subscription renewals only and for new forecast items that aren't renewals.

Remove Adjustments
To remove all of your adjustments, go to the Actions menu and select Remove My Adjustments.

Copy Forecasts
If you copy the prior forecast, then your copy takes the total forecast numbers from the previous forecast, including
adjustments, and pastes them into your current forecast. These numbers overwrite any calculated totals from rolled up
opportunity or adjustment data.

305



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 18
Forecasts

Adjusted Best Case and Worst Case Forecasts
The adjusted best case forecast is the sum of:

• The best case for all forecasted items

• Item-level adjustments for the best case

• Any summary level adjustment to best case

The adjusted worst case forecast is the sum of:

• The worst case values for all forecasted items

• Item-level adjustments for worst case

• Any summary level adjustment to worst case

Forecast Adjustment Notes
If enabled, you can add a note to each forecast item you adjust and add one consolidated note for all summary
adjustments. Each note includes who created the note and when you created it. You can edit the notes that you created.
Managers and senior management can view notes within their territory hierarchy. You can create notes for the following:

• Forecast Items

A sales manager can add a note to each item included in subordinates' forecasts provided the item is not in
won status. Use the Note column in the Items tab to add, edit, or delete an adjustment note for an item. A
VP sees item adjustment notes added by subordinates. When the VP drills down into the manager territory
forecast, he can add notes to items.

• Territory Summary

This is a single consolidated note for all the territory summary adjustments that the user can make in the
territories tab. A VP sees summary adjustment notes added by subordinates in the territory row of the
Territories tab. When the VP drills into the manager territory forecast, he sees the summary adjustment note
added by the subordinate in the Territories tab.

• Product Summary

This is a single consolidated note for the product summary adjustment you create in the products tab. A VP
sees summary adjustment notes added by subordinates in the territory row of the Territories tab. When the VP
drills into the manager territory forecast, she sees the summary adjustment note added by the subordinate in
the Products tab.

Copy the Prior Forecast  
Use the Copy Prior Forecast action to ignore the rolled up opportunity data and copy the numbers from the previously
submitted forecast to the current forecast.

Your copy takes the total forecast numbers, including adjustments, and pastes them to your current forecast. These
numbers overwrite any calculated totals from rolled up opportunity or adjustment data.
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Forecast Actions and Results  
The actions you take with your forecast produce different results depending on the timing and the actions of others.
Most forecast actions take place during the submission window. After the end of the submission window, everyone's
current forecast is frozen regardless of submission status.

Action Result

Make changes to opportunities
 
Add or remove forecast items
 

The forecast is updated to reflect changes.
 

Submit your forecast
 

The forecast is frozen. You can't make changes.
 

Withdraw your forecast after submission,
 but before your manager submits or
adjusts his forecast
 

You can again make changes to the forecast and resubmit. Forecast numbers update from the pipeline.
 

If you have subordinates, then you can also do these actions.

Action Result

Adjust numbers for forecast items
 
Adjust totals, including copy previous
forecast totals to the current forecast
 

If previously unsubmitted, all subordinates' forecasts are submitted and frozen when you edit your
forecast. The subordinate's forecast is frozen and can't be changed by the subordinate. All direct
and indirect subordinates can't make changes unless you remove your adjustments and reject each
subordinate's forecast.
 
Forecast numbers no longer update from the pipeline. The adjustment becomes the current forecast
and ignores the rollup values from current forecast items.
 

Edit a subordinate's unsubmitted or
rejected forecast
 

You can act as your subordinate, so all edits and adjustments can be seen by your subordinate. You can
adjust the forecast only if your subordinate can adjust his own forecast.
 

Submit a subordinate's unsubmitted
forecast
 

Your subordinate's forecast is frozen and can't be changed by her. All direct and indirect subordinates
can't make changes to the forecast unless you remove your adjustments and reject each subordinate's
forecast.
 
Forecast numbers no longer update from the pipeline.
 

Remove your adjustments
 

Adjustments are removed. Opportunity changes are ignored for as long as your subordinate's forecast
remains submitted.
 

Reject a subordinate's forecast
 

The application will clear all your adjustments of your subordinate's forecast.
 
Your subordinate can again make changes to the forecast and resubmit. If the subordinate is a sales
representative, then the forecast numbers update again from the pipeline.
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Available Forecast Metrics  
Metrics provide calculated measures based on historical or current transactional data. You can refer to metrics when
making forecasting decisions.

This table shows the available metrics and how they're calculated:

Metric Description

Best Case Forecast
 

The sum of all best case revenue values for all forecast items in the forecast period.
 

Closed Revenue
 

Actual revenue that was closed during the forecast period.
 

Estimated Adjustment
 

The sum of the difference between estimated revenue and revenue for all transactions in the forecast
period. Statistical analysis provides the estimated revenue amounts based on historical sales for the
product.
 

Expected Forecast
 

The sum of all weighted revenue values for all forecast items in the forecast period. Weighted revenue
is the revenue amount multiplied by the probability of the deal closing.
 

Likelihood to Buy Product
 

The percentage of confidence that a deal will close with the specified revenue on the specified close
date. Statistical analysis provides the likelihood to buy product based on historical sales for the
product.
 

Pipeline
 

The total revenue amount of all product lines where the Status category is Open, the primary territory
is the target territory, and the close date lies in the forecast period.
 

Quota
 

The quota metric is the revenue target associated with the expected performance of a salesperson's
territory for a given forecast period.
 

Worst Case Forecast
 

The sum of all worst case revenue values for all forecast items in the forecast period.
 

FAQs for Forecasts  

Frequently Asked Questions (FAQs) for Forecasts  
This section contains some frequently asked questions (FAQs) for forecasts. Scroll or search to find answers to common
questions.
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How can I remove forecast items from a forecast?  
You can click the item in the Forecast Items tab to open the opportunity and make changes.

For any product item with a warning icon, you must change any attributes so that the product item doesn't meet the
forecast criteria or so that the forecast item no longer closes within the forecasting period.

A sales manager can drop the item by selecting Remove from the Action menu for the item in the Forecast Items tab. To
see your deleted items, choose Dropped Forecast Items from the Show list. You can then add any dropped items back to
your forecast by clicking the Add icon for the item.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option to
Never to override the matching forecast criteria. An icon warns you when a product item matches the forecast criteria
and requires the forecast override.

If you're unable to either change the forecast criteria for the item or use the override, the item disappears from your
forecast items list, but the forecast amounts remain the same. But, the item now has negative adjustment amounts to
match the forecast amounts. For example, if the forecast amount is 3,000, then the forecast adjustment is negative
3,000 and the adjusted forecast is 0. With the removed forecast item selected, you can add it back in if you want to
include the item back in the forecast.

When does my forecast appear in my currency?  
Your forecast appears in your preferred currency. You can select a different currency from the Currency list.

Your selected currency also applies to your view of subordinate forecasts. However, the currency selection doesn't apply
to any graphs or reports that were added to the forecasting screens.

When do I submit my forecast?  
You can make changes to your forecast and submit it during the submission window. You can submit your child territory
forecasts on behalf of your subordinates and then make adjustments to your forecast before submitting.

Related Topics
• What happens if I submit my forecast?

What happens if I submit my forecast?  
You can't make adjustments or update your forecast after you submit it. Your manager can make adjustments to your
forecast only after your submission. If your manager rejects your forecast, then you can make further changes to the
rejected forecast and then resubmit it.
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What happens if I select Forecast not visible to territory owner?  
The owner of a parent territory sets the Forecast Invisible to Owner option to perform all forecasting actions and hide
forecasts from the child territory owners.

The owner of the parent territory can submit the forecast for the child territory. If the child territory owner also owns the
parent territory, then the territory owner can edit forecast items, add and remove forecast items as adjustments, and
adjust the territory forecast.
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19  Territories

Overview of Territories  
Your territories contain rules for automatically assigning salespeople and other resources to accounts, contacts,
households, partners, leads, and opportunity items.

Salesperson
As a salesperson viewing an account, partner, lead, or opportunity, you can see the assigned territories when you view
the sales team information. You also forecast your sales by territory. Sales quotas can be assigned to you by territory.

Sales Managers
As a sales manager, you can modify the territories in the hierarchies below your assigned territories. Your sales
administrator must create the top territory first. If you see no Parent field and no existing territories, then the top
territory doesn't exist. Here are examples of changes you can make to territories:

• Add a new child territory.

• Change the owner of an existing territory.

• Add team members to a territory.

• Remove an existing territory.

• Add specific accounts, contacts, and households to the coverage of a territory.

• Exclude specific accounts, contacts, and households from the coverage of a territory.

• Define or change the definition of a territory coverage.

You can change an active territory directly without using a territory proposal. You can:

• View a list of territories.

• Look at the details for a territory.

• Use the Summary tab to change attributes of the territory.

• Use the Dimensions tab to modify the boundaries of the territory.

• Use the Inclusions tab to add specific accounts, contacts, and households to the territory.

• Use the Exclusions tab to exclude specific accounts, contacts, and households from the territory.

• Use the Team Members tab to change team members or the territory owner.

• Use the Child Territories tab to navigate the territory hierarchy and to add a new child territory.

• Edit territories directly while editing an account. The territory name on the Team tab in the Edit Account page
opens the Edit Territory UI.O

Related Topics
• How can I edit territories directly from accounts?
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Modify Your Territories  
This example describes each tab in the Territories work area and the typical tasks you perform as a sales manager.
You're in the Less Details work area where your changes become active right away and you don't use territory proposals.

Watch video
 

Let's explore the following tabs in the work area:

• Summary tab

• Dimensions tab

• Team Members tab

• Child Territories tab

View the Summary and Dimension Tabs
1. Click Navigator > Territories.
2. If Click to Edit is enabled, you can click a row to highlight it and some or all fields become active for editing,

depending on your access to the selected territory. You can save changes you make in the list and they become
active, or discard them.

3. In the list of your team's territories, click the Central - Products - Div I territory name.
The Summary tab displays commonly used territory attributes. You can use Application Composer to add other
attributes to this tab.

4. Click the Actions menu.
From this menu you can delete this territory including all of its children. You can also delete this territory
coverage including dimensions and values, or add coverage if it has none.

5. Click the Dimensions tab.
The Dimensions tab displays the defined boundaries of the territory. Objects that matches these attributes will
be assigned to this territory.

6. Click Edit.
You can make changes to or remove the Address coverage.

7. In the Edit menu, click Edit Dimensions and Coverage.
The coverage dimensions include a set of attributes and their corresponding values. You can add or change the
values.

8. Select the Industry dimension.
9. To add an industry to the coverage, select it in the Available region and use the arrow to move it to the Selected

region.
10. Select the Geography dimension.

Geography is available only if you aren't using the Address dimension.
11. Click Add Members in Bulk to enter values for the dimension, separated by commas..
12. Enter values separated by commas, or a range of values. Enter a range of postal codes, 85001-85030.

You can use a range of values only for the Geography or Address dimensions.
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13. Choose to add the values you select to the existing values for geography and click OK.
14. Click Cancel until you return to the Edit Coverage Dimensions page.
15. Click the list arrow next to the Edit button and note the Remove All selection will remove all coverage for this

territory.

You can add individual customers to this territory in the Inclusions tab. If the Exclusions tab is enabled, you can
select customers to be excluded from the territory, even if the customers match the dimensions for the territory.

View the Team Members Tab
1. Click the Team Members tab.

This tab displays the territory team members. You can add or remove team members and change the territory
owner.

2. The Owner column contains a check mark to indicate Peter Branch is the owner of this territory. Click his name.

The Resource Details dialog shows information about Peter Branch. You can send an e-mail to Peter by clicking
the e-mail address on this dialog or in the Team Members page.

3. In the Function field for Peter, change his function to Salesperson. This is the function Peter has in this
territory team.

View the Territory Hierarchy
1. Click the Summary tab.
2. Click the name of the parent territory to open the Edit Territory page for the parent.
3. Click the Child Territories tab to see all child territories of the open territory.
4. Click the Central - Products - Div I territory.
5. Click the Child Territories tab.
6. Click Create Territory.

Notice that the parent territory is Central - Products - Div I.
7. Click Cancel.

When you click Save, or Save and Close, your changes immediately become the active definition for this
territory.

Work with Active Territories in Workspace  
Use Workspace to create and make changes to your active territory hierarchy. If you prefer to use proposals to change
multiple territories, go to the Sales Territories Hierarchy tab.

Search and filter your list to begin working. When you open and edit a territory from your list, the Next button opens
the next territory to edit. If enabled and you have the correct privileges, you can work in nested tabs to navigate across
and between territory records without losing context. Use dynamic tabs and nested tabs to resolve territory gaps and
overlaps. Manage customer-centric territories in Workspace. Use other methods for partner-centric, resource-centric,
and inheritance recipient territories.

You can search by territory details and coverage attributes. Here are some coverage search tips.

• The industry, organization type, product group, and auxiliary 1-3 dimensions are hierarchical. A search for
descendant member values finds only territories defined explicitly with the descendant value. For example, to

313



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 19
Territories

search for territories which cover the product group Laptop X, but not its parent Hardware, Laptop X must be
present in the territory coverage.

• To search for territories using customer inclusions or exclusions, use the Coverage: Account: Name filter.

• Accounts are hierarchical. To search for territories based on a descendant account, the account must be
explicitly selected in the territory coverage. For example, to search for territories which include Account ABC
USA, this account, and not the parent ABC Global must be present in the territory coverage.

• Accounts are hierarchical. To search for territories based on a descendant account, the account must be
explicitly selected in the territory coverage. For example, to search for territories which include Account "ABC
USA", this account, and not the parent "ABC Global" must be present in the territory coverage.

• When you use dimension filters to search, you can use only one dimension filter. Here are some exceptions:

◦ You can use the coverage type filter together with a dimension filter.

◦ Multiple address dimension filters can be used together. For example: Coverage: Country and Coverage:
Postal Code

◦ The Coverage: Sales Channel and coverage: Sales Subchannel filters can be used together.

• For most dimension filters the search finds all territories with a regular dimension coverage or an inclusion or
exclusion coverage matching the value.

• You can't search using these coverage fields:

◦ Include Hierarchy: This indicates that the account plus its hierarchy is included or excluded from the
territory coverage.

◦ Coverage: Partner: This field represents the partner accounts that are included or excluded in the territory
coverage.

Related Topics
• Get Started with Search in Workspace and Work Areas

• Use Dynamic Tabs and Nested Dynamic Tabs

• Adaptive Search Configuration Provided by Oracle

• How can I enable territory dynamic tabs and nested dynamic tabs in Workspace?

• Switch to Work Areas Powered by Adaptive Search

• Enable Business Objects for Adaptive Search

Create a Territory Proposal  
You can update active territories directly, or use a territory proposal as a sandbox where you make your proposed
changes to your territory hierarchy before activating the changes.

Tip:  Use proposals for territory realignments or changes to be activated at a future date.

1. Click Navigator > Territories.
2. Click the Sales Territories Hierarchy tab.
3. In the Active Territories page, click the Manage Proposals button.
4. In the Current Territory Proposals region, click Create.
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5. In the Create Territory Proposal window, enter a name for your proposal.
6. You can enter an Activation Date or accept the default which is immediate activation.
7. Click Save and View.

Your territory proposal opens and displays your current territory hierarchy. You can start making your changes.

Add Child Territories to Your Territory Hierarchy  
You can add child territories to your own territory or to another territory in your hierarchy. The child territory copies
the parent territory information such as territory type, dimensions, and account inclusions. You then make changes as
needed.

Change Active Territories
You can make immediate changes to your active territories. If you see no territories and no parent territory field, then
your sales administrator must first create the top territory for the hierarchy.

1. Select from your territories list the territory that will be the parent to your new territory.
2. Go to the Child Territories tab.
3. Click Create Territory.
4. Enter the territory name.
5. Select a different owner for the territory if needed.
6. Change the territory type, if needed.
7. If Territory Precedence is enabled, then you can select a territory function. Assignment compares all territories

with the same function and gives precedence to the territories containing included accounts.
8. Click Save and Close to keep the definitions that match the parent. You then return to the Child Territories tab

for the parent territory. Click Save and Continue to stay on the Summary tab for your new territory.
9. In the Dimensions tab, you have several choices in the Edit list, depending on your enabled dimensions and the

coverage from the parent.

◦ Edit Address Coverage

◦ Clear Address Coverage

◦ Edit Dimensions and Coverage

Select a dimension and move the values you want to the Selected column. Or click Add Members in Bulk
and enter several members or ranges of members separated by commas.

◦ Remove All

10. To add accounts, select the Inclusions tab.

a. Click Add Customers and select Accounts from the list.
b. Search for and select customers you want included.
c. Select Include Hierarchy to also include the hierarchy of each customer you added.

11. Use the Exclusions tab to select customers to be excluded from the territory. (Use Application Composer to
enable the Exclusions tab.)

12. Use the Team Members tab add and remove team members and designate the territory owner.
13. When you complete making all changes, click Save and Close.

Your new territory is now active.
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Use Territory Proposals
Add territories using a territory proposal you created.

1. In the Manage Territory Proposals page, select the name of your proposal.
2. In the Edit Territory Proposal page, select the parent territory.
3. From the Actions menu, select Create and Update > Create Child.
4. Enter the territory name.
5. Select the owner for the territory.
6. If Territory Precedence is enabled, then you can select a territory function. Assignment compares all territories

with the same function and gives precedence to the territories with included accounts.
7. Click Save and Close.
8. Click Edit Coverage.
9. The coverage for the child territory is the same as the parent's coverage. Select the members for each

dimension that you want to change.
10. Click Save and Close.

How can I move a territory in the hierarchy?  
When you edit an active territory, you can change the parent territory on the Summary tab. Click the X to delete the
current parent and use the choice list or the search to select a new parent territory.

In a proposal, select the territory you want to move. In the Actions menu, select Create and Update > Move. Select
the new parent on the Move Territory page and click Save and Close. The territory appears in the new position in your
proposal hierarchy.

Change Territory Coverage in a Proposal  
A new child territory has the same coverage as the parent. Change dimension selections and included or excluded
accounts, contacts, and households to refine the coverage. Your changes aren't active until you activate the proposal.

1. In the Manage Territory Proposals page, select the name of your proposal.
2. In the Territories table, select the territory you want to change.
3. If the territory isn't already added to the proposal, then click Add to Proposal.
4. Click Edit Coverage.
5. In the Edit Coverage window, do this for every dimension you want to change:

a. Select the dimension from the Dimensions list. (For the Address dimension, enter values in the correct
address column.)

b. Add or remove dimension members from the Selected Dimension Members box.
c. Optionally, click Add Members in Bulk and enter several members or ranges of members separated by

commas and click OK.
d. Click Save and Close.

6. In the Included Customers region, select and add specific accounts, contacts, and households to include in the
territory.
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7. In the Excluded Customers region, select and add specific accounts, contacts, and households to exclude from
the territory.

8. Click Done.

Activate a Territory Proposal  
When you finish making changes to your territories, use this procedure to activate your territory proposal and start
using the new territories for assignment.

1. Click Navigator > Territories.
2. Select the Sales Territories Hierarchy tab.
3. In the Active Territories page, click the Manage Proposals button.
4. If the proposal you want to activate doesn't appear in the Current Territory Proposals table, select All Proposals

from the Proposals list.
5. Select the proposal and click Activate.

You can see the activation process status in the Details region of your proposal.
6. Click Done to return to Manage Proposals.
7. Click Done to return to the Overview page. Your territory changes now appear in the list of active territories.

How Dimensions Define Territories  
Dimensions define territory boundaries. A territory captures business objects, such as customers, that fall within the
defined boundaries of the territory. If your territory boundary covers Spain, then an account in Spain is your customer.

Dimensions to Assign Customers or Partners
You can define a territory either for partners or for customers, but not for both. You select either Customer or Partner for
the coverage model. When creating a territory, you can include individual customers or partners by selecting them for
the territory coverage. Dimensions to define customer or partner territories are:

• Geography or Address, but not both

• Account type

The account type designates the customer designated as a named account or not named. This dimension is
only available for customer territories.

• Customer size

• Industry

• Organization type

Your administrator can also use classification categories to define up to three additional dimensions.
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Dimensions to Assign Leads and Opportunities
Your territory is assigned to leads and opportunities using the attributes of the customer or partner on the transaction.
These additional dimensions can match attributes of the lead or opportunity to assign your territory:

• Business unit

• Product

Groups of products form a hierarchy in the sales catalog.

• Sales channel

The available sales channels are Direct, Indirect, and Partner.

For example, your company is launching a new product line in all countries. One sales manager with a small sales team
specializes in selling only the new product line. You define the sales manager's territory only by the new product line
and define geography as Any.

Related Topics
• Territory Coverage
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Overview of Using Quotes  
Create quotes and orders from an opportunity as part of a deal or directly from an account using the automated
opportunity-to-quote-to-order process.

The quotes and orders feature lets you:

• Create professional proposal documents.

• Share quotes and collaborate with customers to close deals.

• View quote summary information and drill down into quotes to view details.

• Create product configurations in the integrated quoting application.

• Perform automated pricing calculations.

• Specify pricing and discounts.

• Streamline approval processes.

Create Quotes
While working on an opportunity or account, you can create, update, duplicate, and version quotes. You can add and
remove products and change pricing. When you're satisfied with a quote, you can save it and then mark that quote as
active. When you create, edit, or version a quote, you navigate to the integrated quoting application, Oracle Configure,
Price and Quote (Oracle CPQ). The application carries the opportunity ID and account ID into Oracle CPQ, and when you
save the quote, Oracle CPQ creates the new quote. When you return to the sales application, the newly created quote
displays there, associated with the opportunity or account it relates to.

Access Quotes
In the Sales work area, you access quotes by:

• Searching for quotes using the global search.

• Navigating to the Quotes and Orders landing page within the Sales work area. (Note: The Quotes and Orders
page displays only opportunity-related quotes.)

• Viewing and updating quotes from within an opportunity or an account.

For the quotes you have access to, the details include quote number, quote amount, status, and proposal document.

You can find quotes on these UIs in CX Sales:

• In an opportunity, on the Quotes and Orders tab that displays only opportunity-based quotes.

• In an account, on the Quotes and Orders tab that displays only account-based quotes.

• At the top level on the Quotes and Orders page, that displays only opportunity-based quotes.

319



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 20
Quotes

Synchronized Opportunity Products and Status
The application automatically synchronizes opportunity products and associated revenue in the quote lines. Marking a
quote as active enables the automatic synchronization of the quote lines with the opportunity revenue lines that were
the source of that quote.

Related Topics
• Create and Update a Quote for an Opportunity

Get Started with Quotes and Orders  
Create quotes from an opportunity as part of a deal or directly from an account. From the Quotes and Orders landing
page, get summary information like opportunity, account, and amount.

Watch video
 

Get quick access to the quotes you need using the global search. For example, search on number, order total, status,
and so on. Or, create your own personal lists. Let's say you want to list all quotes where an order has been submitted
or quotes with amounts greater than $1 million. You simply enter the criteria in the search, and then save the search to
access over and over.

From the landing page, drill into quote details. Modify quotes in real-time in the quoting application, Oracle CPQ. For
example, in your servers quote, update the quantity, and the application immediately updates the relevant sales figures.
In the quoting application, update the opportunity to sync your changes back to the sales application and then return to
the sales application for further work.

To see your quotes in opportunities, from the Opportunities landing page, click on an opportunity and then click the
Quotes and Orders tab. From here, create new quotes and new versions, edit quotes, or duplicate quotes.

Create and Update a Quote for an Opportunity  
You can create, view, and share quote information from the opportunities UI through integration with Oracle CPQ.

With opportunity quotes, you can:

• Create professional proposal documents that include current product and pricing information within an existing
opportunity.

• Create multiple quotes and orders for an opportunity, including multiple versions for the same quote.

Note:  Only one quote can be active for an opportunity.

When you create or update a quote or sales order in the Oracle CPQ quoting application, the associated opportunity,
if active, must be updated in your sales application with the same changes. Updates include additions, deletions, and
updates to product (revenue) lines on the opportunity.
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Other updates, such as issuing the quote to a customer and submitting it as a sales order, are performed only within
Oracle CPQ.

Create a Quote from an Opportunity
When you create a quote from an opportunity in your sales application, Oracle CPQ automatically starts. The
opportunity ID and account ID are copied to Oracle CPQ, and when you save the quote, Oracle CPQ creates the new
quote. When you return to the sales application, the newly created quote is available for you and is associated with the
opportunity or account it relates to.

Here's how to create a quote from an opportunity:

1. From the springboard or Navigator, click Sales > Quotes and Orders.
2. From the Quotes and Orders landing page, edit an opportunity.
3. From the Edit Opportunity page, click the Quotes and Orders tab.
4. Click Create Quote, and the application automatically signs you in to Oracle CPQ.
5. In Oracle CPQ, start creating the quote by clicking Add Line Item.
6. Enter the remaining quote information.

See the online help for Oracle CPQ for information about adding line items to your quote.
7. When done, click the Update Opportunity tab to synchronize your changes back to your sales application.

Note:  You can create an order only from a Quote and not from an opportunity or account.

8. Return to your sales application.

Update Opportunity Products and Status
You can automatically synchronize opportunity products and associated revenue with quote lines. If you're satisfied with
a quote, save it, and then mark that quote as active. Setting a quote as active enables the synchronization of the quote
line items with the opportunity revenue lines.

Here's how to update a quote from an opportunity:

1. From the springboard or Navigator, click Sales > Quotes and Orders.
2. From the Quotes and Orders List page, select an opportunity.
3. From the Edit Opportunity page, click the Quotes and Orders tab.
4. Locate the quote you want and click Edit from the Actions menu. You're signed in to Oracle CPQ.
5. In Oracle CPQ, update the quote.
6. Click the Update Opportunity tab to synchronize your changes back to your sales application.
7. Return to your sales application.

For more information about using Oracle CPQ, see the Oracle CPQ online help.

Related Topics
• Overview of Opportunities
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Make a Copy from an Opportunity Quote  
When you sell similar products to different customers, you can make a copy of an existing opportunity quote and reuse
the quote lines and other details for another opportunity.

Making a copy saves a lot of time than creating one from scratch.

Note:  You can make copies from opportunity quotes only. Opportunity quotes are the quotes created from an
opportunity.

Here’s how you make a copy from a quote:

1. Go to the Quotes and Orders sub-tab of the Opportunity or the Account details page.

Note:  From the Account details page, you can create a copy only if the quote is associated with an
opportunity. You can’t copy quotes that are created from accounts without an opportunity associated.

2. Click the Actions icon for the quote you want to copy and select Duplicate.
3. On the Duplicate Quote window, select the Opportunity.

4. Click Save and Continue.

The sales application opens the copied quote in Oracle CPQ.
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5. Rename the quote, review the quote lines, update the contact, and make other changes.
6. In Oracle CPQ, click Save and then click Update Sales.

When you close Oracle CPQ, the changes reflect in the sales application. You’ll find the quote in the Quotes and
Orders sub-tab of the opportunity to which you copied the quote.

7. Click Save and Close.

Related Topics
• Enable Salespeople to Create a Copy from an Opportunity Quote

Create and Update a Quote for an Account  
While working on an account, you can create, update, duplicate, and version associated quotes to reflect the product
and pricing configuration.

Here's how to create a quote from an account:

1. From the springboard or Navigator, click Sales > Accounts > Quotes and Orders.
2. From the Quotes and Orders landing page, select an account.
3. In the Edit Accounts page, click the Quotes and Orders tab.
4. Click Create Quote, and the application automatically signs you into Oracle CPQ.
5. Click Add Line Item and start creating the quote
6. Enter the remaining quote information.
7. When done, click the Update Account tab to synchronize the changes.

Note:  You can create an order only from a quote and not from an opportunity or account.

8. Return to your sales application.
For more information about using Oracle CPQ, see the Oracle CPQ online help.

Related Topics
• Overview of Accounts, Contacts, and Households

Make Quotes Active without Navigating to Oracle CPQ  
You can set an inactive quote to active without navigating to Oracle CPQ. Here's how:

1. In your sales application, edit an opportunity or an account.
2. Go to the Quotes and Orders tab.
3. In the Active column, click the tick icon against the quote you want to make active. It changes to a green tick,

indicating that your quote is active.

◦ Immediately, the sales application runs a revenue reconciliation process that reconciles your revenue
lines from Oracle CPQ quote lines. The scope of the reconciliation process is based on the reconcile
option (Root or Part) that your administrator has set.
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◦ Your opportunity is locked until the revenue reconciliation process ends. This means you can't make any
changes to the opportunity during this time. Once the process ends, the opportunity lock is released.

4. Click the quote name to see your new revenue lines and price type.

Note:  If the process is interrupted, your quote is set to its previous state. Click Active again after some time
to restart the reconciliation.

Active and Inactive Quotes
If an opportunity has a single quote, that quote is considered active and you can't inactivate it.

If an opportunity has multiple quotes, only one of the quotes can be active at a time. So, when you make a quote active,
the previously active quote becomes inactive. However, the information related to inactivated quote -- such as credit
split, revenue schedules, and custom attribute information -- remains as is. When you set this inactive quote to active
again, all of its information comes back.

Search Quotes and Quote Lines in Workspace  
You can search quote header information and quote line item details in Workspace. Search for specific products and
view the quotes that contain the specific products. You can also select a quote and view the quote details in Oracle CPQ.

Note:  This search applies only to quotes created from opportunities.

Quotes created from opportunities can have multiple quote line items. When you create quotes from opportunities, you
store line item details, such as product name, quantity, price, and discount percentage.

Related Topics
• Find the Most Recent Items You Worked On

• Saved Searches

How is the number of open quotes on the Quotes and
Orders summary box calculated?  
The Open Quotes and Orders summary box on the Account Overview page shows the number of all active and open
quotes associated with opportunities. Active and open quotes refer to the quotes that are marked as in progress for Win
Status.

If a quote has multiple versions, the last version of the quote synchronized with the application is considered as an open
quote.
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How can I exit the Oracle CPQ Quotes application that
opened within the sales application?  

Refresh the browser window to exit the Oracle CPQ Quotes application. To go to sales application Home, click the back
button on the browser.
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21  Quotas

Overview of Sales Quotas  
You set annual quotas for your sales organization from the top down.

Effective top-down planning with bottom-up assessments ensures that quotas relate to corporate goals. After the sales
plan is deployed for the year, sales executives can then monitor and track sales performance by comparing forecasts
with sales and with quotas.

Features
Here are some key features:

• Assign territory quotas to territories and resource quotas to people.

• Create sales goals such as number of sales calls.

• Review quotas assigned to you by your senior manager and allocate quotas to your salespeople.

• Compare quota to revenue, pipeline, forecast, and other metrics using business intelligence.

• Use formulas to calculate territory quotas using measurements of historical data and future potential.

• Add adjustments to your quota to cushion against attainment risk.

• Track current quota achievement compared with quota targets.

• Manage seasonal variations in sales by distributing the revenue quota among several calendar periods using
seasonality guidance.

• Send notification to Incentive Compensation with new and changed individual quota assignments for all sales
goals.

• Use a round trip export, update, import of quotas to add bulk quotas from spreadsheets.

How You Allocate, Publish, and Revise Quotas  
When you complete assigning quotas to your directs, you publish the quotas to the owners and resources of your child
territories. Child territory owners can then view their quotas for the territories they own.

Publishing your quotas also sends notifications containing resource quota information to an incentive compensation
analyst. The territory owner and your manager receive notifications that the quotas are published.

Allocate Quotas
You can allocate quotas in the Manage Sales Quotas page. Sales administrators can enter and edit territory, owner, and
team member quotas for any territory quotas that aren't published. Sales managers can enter and edit child quotas that
aren't published. For territory quotas that aren't published, you can also:

• Enter or edit a quota for each period
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• Apply seasonality factors

Select a parent territory and click Details to use the Edit Sales Quotas page to enter or edit quotas. You can enter annual
quotas, period quotas, and apply seasonality to any quotas not published. Assign resource quotas on the Resource
Quota tab in the Details region. Besides the owner's resource quota, you can add and assign quotas to other team
members.

Publish Quotas
When you finish allocating your quota, you publish the quotas to make them available to your directs. After publishing,
you can't make changes to the quotas.

You can select one or more territories to publish. If you click Publish Child Territories, then the selected territories and
their children are published. A sales administrator can publish a hierarchy of territories from the Actions menu. When
you publish a territory, you publish the following, and the data becomes available for Business Intelligence:

• Territory quota

• Resource quotas for all sales goals for the selected territory

• Resource quotas assigned to team members

• Quotas assigned to finer time periods

If you didn't apply seasonality to quotas, then the publishing process applies the seasonality factor that was defined
in the sales quota plan for the territory. If there are no seasonality factor groups defined, then seasonality factors
aren't applied and there is no granular time period quota. Excluded territories can't be published. Publishing fails if the
selected territory or any territory resource has no quota.

Tip:  Save time entering period quotas. Seasonality gets applied automatically when you publish if you haven't
manually entered period quotas.

Copy Territory Quotas to Resource Quotas
By setting two profile options, the administrator enables the automatic copying of quotas during publishing. Publishing
does the following:

• Copies the territory owner's annual quota for the sales revenue goal to the owner's resource quota.

• If the owner's annual resource quota is zero, then publishing copies the territory period quotas to resource
period quotas. It overwrites any existing resource period quotas.

Revise Quotas
Before you can revise published quotas, you must change the quota status to Pending Revision. The Revise action
changes the status for your selected territory and its children. You can then revise territory quotas, and add, revise, or
end date resource quotas. When you complete your revisions you can again publish the quotas and send notifications.
The territory quotas change to the Published status and resource quotas change to the Submitted status.

When you revise quotas, the revised values aren't available in Business Intelligence until you republish the revised
quotas.

Related Topics
• Copy Territory Quota to Resource Quota Options
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FAQs for Quotas  

Frequently Asked Questions (FAQs) for Quotas  
This section contains some frequently asked questions (FAQs) for quotas. Scroll or search to find answers to common
questions.

What's seasonality?  
You distribute annual quotas to shorter time periods, factoring in seasonal expectations in sales. This expectation is
represented as a percentage factor, which reflects the share of quota for the season, or time period.

For example, your sales are typically higher the last quarter of the year and at their lowest the first quarter of the year
for several of your product lines. You create a seasonality group named Retail to automatically distribute your annual
quota and factor in the seasons.

• 10 percent for the first quarter

• 25 percent for the second quarter

• 25 percent for the third quarter

• 40 percent for the fourth quarter

When you assign quota to territories that include these product lines, you apply the Retail seasonality group to correctly
distribute the annual quota amounts.

What's an adjustment?  
An adjustment is the amount that territory owners, or sales managers who have child territories, add to the territory
quota assigned to the territory they own. The territory owner can then allocate the adjusted territory quota to child
territories.

What's a variance?  
The variance is the difference between the adjusted quota amount for the parent territory and the rolled up total
amount from the child territory quotas. The variance can be spread, meaning it gets added to the child territories.
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22  Analytics

Overview of Sales Analytics Pages  
Oracle provides a broad set of analytics and analytic pages to give you quick access to key insights and metrics for all
aspects of your sales organization.

This table shows the various options for using analytics for sales organizations.

Sales Analytics What's Available

Prebuilt or Build-Your-Own Analytics
 

Your application comes with over 150 prebuilt analytics. There are role-based analytics as well as
analytics for the organization in general. Administrators create and edit analytics, as well as add them
to the user interfaces. If you want to build your own, there is an easy drag-and-drop editor for creating
analytics.
 

Sales Infolet Page / Sales Pages
 

You get to the Sales Pages by navigating from the Home page using the white navigation dots. The
Sales Infolet page comes enabled, and prebuilt with infolets specific to many of the roles in your
organization. The five Sales Pages are enabled and configured by your administrator.
 

Analytics Tabs
 

Many of your work areas such as Opportunities, Contacts, Accounts, and the Analytics page, provide
additional Analytics tabs with detail in context to the information you're viewing. These tabs appear
along the side of the page.
 
Typically, administrators and some manager roles add analytics tabs to work areas for users.
 

Analytics Page
 

From the Home page click Sales and then click Analytics. Users search and make analytic favorites
which persist on this page as long as they remain favorites. This page also shows analytics recently
viewed by the signed-in user.
 

Sales Analytics Interfaces  
Oracle Sales provides many options for getting key analytic data for sales users.

Watch video
 

Sales Analytics Pages
With Oracle Sales analytics you have analytics interfaces right at your fingertips. You can make favorite analytics on
your Analytics page, and your administrator can add analytics to your Sales Pages.
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Interfaces where you view analytics:

• The Sales Pagess: The Sales Infolet page comes enabled and prebuilt with analytics specific to many of the
sales roles. The Sales Pages are enabled and configured by your administrator.

• The Analytics Page: You personalize this page by adding favorite analytics. It also shows recently viewed
analytics.

Note:  Depending on your implementation and software version, some page icons, menu links, and navigator options
may not be available.

Exploring the Sales Infolet Pages
The sales infolet pages contain analytics that can be viewed on mobile, tablet, or laptop. Clicking an infolet drills down
to more detail on an analysis. Your administrator can change the content that you see on these pages. The Sales Infolet
page comes prebuilt with analytics that show data specific to the many sales roles in your organization..

Exploring the Analytics Page
From the Home page you get to your Analytics page by clicking Sales and then Analytics. You configure which
analytics you see on this page by searching for analytics, and marking them as your favorites. Favorites remain on your
Analytics page to view at any time.

This figure shows the Analytics page with the Search for analytics option and the favorites marked with the gold star.
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23  Microsoft 365

Overview of Microsoft 365 for Sales  
Your sales organization can use the integration between CX Sales and Microsoft 365 to access sales application data
from within Microsoft 365 and apps that use Microsoft Exchange.

Watch video
 

The integration includes an add-in that opens as a side-panel in Microsoft Outlook. This means that when composing
emails and creating meetings, the sales organization can access sales data directly in Outlook.

Here's how the sales organization benefits from the integration:

• Salespeople can capture interactions with customers, including emails and meetings, in CX Sales. This allows
the sales organization to remain informed on the latest status of customer engagement, including various
communications, ongoing meetings, and meeting outcomes.

• Salespeople can perform their sales-related work without having to leave Outlook -- often their most frequently
used application.

• Because the integration synchronizes sales data with Microsoft Exchange, salespeople can see their sales
appointments on their native phone apps and other applications integrated with Microsoft Exchange.

Related Topics
• Home Page

Sign In to Outlook for the First Time  
Here's how to sign in to Outlook for the first time:

1. Navigate to Microsoft Outlook on the web or open Outlook on your computer and sign in. Respond with yes to
any messages about Outlook being a trusted device.

2. In Outlook, click on an email to preview it.
3. In the menu bar of the email, click the More actions menu. This image shows an example:

Note:  If you don't preview or open an email, you won't be able to see the More actions menu.

4. Select the Outlook add-in.
5. The connection may take a while to establish. Wait for the connection to establish. If the add-in is attempting to

connect, you'll see a "working" indicator.
6. Click Connect.
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Main Add-In Components  

Home Page  
Integrate your sales application and Microsoft 365 to access your cloud data, such as contacts and appointments,
through the side panel. You can also manage synchronization settings for contacts and activities using the side panel.

As long as you're signed into the add-in, you see the add-in home page when you open or preview an email. The add-in
displays relevant information about all the known and unknown contacts associated with the email.

Here are the three main regions of the add-in home page:

• Records

• Connections

• Activities
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Records
View the accounts, open opportunities, and open leads associated with a contact in the Records tab. Associate an email
as an activity with any of the accounts, opportunities, and leads. Resources on the email are automatically added to the
activity.

Note:  If the contact you're viewing isn't the primary contact of a lead, the lead isn't displayed as a related record.

When you have gone deep into the records and want to get back to the homepage, use the home icon instead of back
button.

Connections
View a list of resources from your company who have interacted most with the contact. These connections are listed
in the order of resources with most interactions to resources with least interactions. Interactions are a set of emails,
appointments, and calls with the contact.

You can view interactions from the current month, back to the first email, appointment, or call logged against the
contact. You can also select a specific month or year to view activity history for that point in time.

Example of Familiarizing with Contacts Using Top Connections

If you're a new salesperson who just took over a sales account and want to learn more about that account from your
colleagues, look at the Top Connections tab. Here, you can see the salespeople from your company who interacted
the most with the contacts on your customer side. You can connect with such colleagues and learn more about that
sales account and people on that account. Take a look at this example where Robin prepares himself before he starts
communicating with his new customer, Smith.

Robin Marlow is a salesperson in Penny Pack LLP. He spends a significant amount of time working on Outlook. Recently,
he took over Service Sales in the North America region and is introduced to several new accounts that he's not familiar
with.

Robin receives an email from Smith Wilson of First Software.

• He looks through the top connections to see if anyone from his company has worked with Smith in the past and
decides that Daniel Grayson is the ideal resource to contact.

• He views Smith's upcoming activities through the side panel and finds that Smith has an appointment
scheduled with Daniel.

• He creates a task to call Daniel later in the day to learn more about Smith and the appointment scheduled for
next week.

Robin's call with Daniel gives him details about Smith's interests and activities and Robin is now better informed about
the contact before he interacts with him.

Activities
View the history of a contact's activities in the Activities tab. You can also create, edit, and delete activities using the side
panel.

The activities created, edited, or deleted in the side panel are automatically updated in your sales application. However,
if you import an activity to your sales application and synchronize it with Microsoft 365, the activity exists in Microsoft
365, even after you delete in your sales application. You must delete the activity in Microsoft 365 as well.
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Related Topics
• Create New Sales Records

• Share Email and Meetings

Lists of Sales Records  
The add-in provides convenient access to the other sales records that are relevant for you. Use the navigator to see
them. You can select an object to see its corresponding sales records. For example, select Accounts, to get the list of
accounts you own.

Share Email and Meetings  
Share emails and meetings that you send or receive from your Microsoft 365 account with your sales application.

You can share emails and meetings related to a specific account, contact, opportunity, or lead with your team in your
sales application to provide them with any relevant information or history related to the customer. Sharing emails and
meetings associates the email or meeting as an activity with the relevant account, opportunity, or lead. You can also
search for other accounts, opportunities, and leads that you have access to.

Take a look at these examples to help you understand sharing emails and meetings:
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Share Emails
Let's say you're a salesperson handling the North America region for laptop sales. You're in conversations with a
customer on their requirements for your new range of laptops.

You have just received an email reply from the customer with some questions on pricing. You would like to associate
this email with an existing opportunity in your sales application so that you can share it with your manager and other
salespeople on your team.

Open the email to view the side panel. Click Share Item on the Related Records tab. On the Share Email page, search
for and select the relevant opportunity, and click Save. You have now saved your email in your sales application for the
selected opportunity, making it available for your team to review. When salespeople open the opportunity, they can now
view this email as an activity associated with the opportunity.

Share Meetings
To further discuss the customer's requirement, you decide to organize a meeting to discuss with the customer.

Create a meeting in Outlook. While creating the meeting, open the side panel. Click Share Item on the Related Records
tab. On the Share Meeting page, search for and select the customer, and click Save.

Note:  If you don't find the Share button, contact your administrator so that she can enable the Share button on the
tab.

Share a Meeting Received from an Email ID Held by Multiple Contacts
Assume that you were invited to a meeting by a customer contact. When you try to share, you find that more than one
existing contact in your sales application uses the same Email ID from which you received the meeting. In such cases,
you can select the right contact you want to share the meeting with in the sales application. Here are the steps:

1. Select the appointment you want to share with the sales application. The Microsoft 365 add-in home page
shows a number on top of the contact photo. The number corresponds to the number of contacts sharing the
same Email ID from which you received the appointment.

2. Click Share Item to share the appointment with the sales application. The Share page shows the list of contacts
sharing the same Email ID. By default, you find that all the contacts are selected. You can deselect the contacts
not relevant to the Email ID.

3. Click Share. The add-in associates the meeting with the selected contact. You find that the appointment is now
labeled as "Shared with Oracle".

Note:  This way, you can get rid of email duplication.

Related Topics
• What happens when I share an email with my sales application?

• How can I share an email with my sales application?

• Can I share my Microsoft 365 email attachments with my sales application?

View Sales Record Details  
From the add-in, you can see sales record details in various ways.
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View Account, Contact, Lead, and Opportunity Details
See the accounts, contacts, leads, and opportunity details from the side panel.

See Opportunity Quotes and Download the Proposal
From the Microsoft 365 add-in, you can see quotes for your opportunities. If a proposal was generated for a quote in the
sales application, you can download it from the add-in. Here are the steps to view quotes and download the proposal
associated with a quote:

1. Open an opportunity and go to the Quotes and Orders tab.
2. You can see the details, such as quote name, status, amount, and version.
3. If a quote has a proposal generated in your sales application, you can find the link to the proposal. Click the link

to download the proposal. The proposal is downloaded as a PDF file.
4. To view the corresponding record of this quote in your sales application, select the Open in CX Sales option

from the menu (the ellipsis ... icon).

View Service Requests
Use the service request functionality to review and update service requests in the Microsoft 365 side panel, without
explicitly going into your sales application. You can also link service requests to emails to send to or receive information
from your customers.

Service requests are available here:

• Related records in the side panel

• Related items in the Accounts and Contacts tabs

Click on an applicable service request to see its details.

Create New Sales Records  
Add contacts to your sales application from your Microsoft 365 account and maintain a consolidated list of contacts to
work more effectively.

Use the side panel to identify which of your contacts, from an email or a meeting, exist in your sales application and
which you need to add.

Add Contacts to Your Sales Application
You must have an email open in Microsoft 365 Outlook to add a contact to your sales application. If your contact already
exists in the sales application, the side panel displays the name of the contact. If the contact doesn't exist in the sales
application, the Microsoft 365 home page prompts you to add the contact.

Here's how you can add a contact to your sales application:

1. Open an email in Microsoft 365.
2. Click Create Contact.
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3. In the Create Contact page, add details like first name, last name, or mobile number. The Email field already
shows the sender's email. Change it, if needed.

◦ The add-in tries to match the details of your existing Outlook contacts that aren't yet shared with the
sales application. If there are any matches, the people icon on the top of the page shows the number of
matching records. Click the icon to see if the contact you were trying to add is in the list. If yes, select that
record and click the Copy Details button. The details are copied from Outlook.

◦ If there are no matching records with Outlook contacts, fill in the required information about your new
contact.

4. Usually, the contacts you add are all business contacts. So, you may want to tie the contacts to the accounts
they belong to.

5. Fill in other details such as job title, affinity, and mobile or work phone.
6. For the address fields, you can use the account address of the contact instead of typing in their personal

address. To do so, select the Use Account Address check box.
7. Save the contact. The full name of the contact you just added appears in the side panel, confirming that the

contact is added to your sales application.

Note:  All the contacts you add appear in the Contacts list view. If your contact list is too big, use the search
option to look up a contact. When searching, enter first name of the contact and press Enter key on your
keyboard, so that the add-in searches for the contact details on the server as well.

To edit or open the contact in your sales application, click the ellipsis icon on the home page and select the option you
want.

Set Communication Preference of a Contact
Among your contacts, some people may not want to be called on the phone, emailed, or get mails to their home or
office address. You can indicate the communication preference as Do Not Call, Do Not Email, or Do Not Mail from the
Microsoft 365 add-in. If you have set do-not-contact preferences in the sales application, the add-in indicates them in
the Contacts list view.

Here are the steps to turn on the communication preferences from the add-in:

1. Open Contacts from the menu.
2. For an existing contact, edit the record. For a new contact, set the preference when creating the contact.

◦ Do Not Call is available on the contact number fields. Once you set this, the indicator reflects the
preference for all the contact numbers.

◦ Do Not Email is available on the Email fields. Once you set this, the indicator reflects the preference for
all the email IDs of the contact.

◦ Do Not Mail is available on the Address fields. Once you set this, the indicator reflects the preference for
all the addresses of the contact.

3. Save the contact.
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Bi-Directional Sync for Appointments  

Overview of Bidirectional Sync  
Bidirectional sync is the sync pattern where the current and future appointments are synced between Outlook and
Sales. It’s the default sync pattern for appointments.

During synchronization, all appointments that users share from Outlook with Sales are categorized as Shared
with Oracle. This category means that a copy of the appointment has been created in Sales. Depending on your
configuration of appointment sync, when a user updates or deletes an appointment in Sales, the changes are synced to
Outlook, and vice versa.

Note:  Any appointment that's not included in the default saved search criteria set by the user or the administrator is
never synced.

Appointments That Aren’t Synced in Bi-Directional Sync  
These appointments aren’t synced in bidirectional sync:

• Appointments that are outside of a saved search

• Past appointments

Appointments Outside of Saved Search Aren’t Synced
Appointments that fall out of the saved search criteria set by the user or the administrator, aren’t synced.

Updates to Past Appointments Aren’t Synced
Appointments that have a start time or an end time before the sync job runs, aren’t synced between Outlook and the
sales application, irrespective of the saved search chosen by the user. However, if a past appointment has a Shared
with Oracle category, it is shared with the sales application but updates to that appointment aren’t synced.

Here’s a list of scenarios, where past appointments aren’t synced:

• Past appointments that were modified in the sales application or in the saved search aren’t synced to Outlook.
The Shared with Oracle category isn’t cleared for the appointment in Outlook because the copy of the
appointment still exists in the sales application.

Note:  The administrator gets an error message when a saved search that fetches past appointments is
selected in Microsoft 365 designer.

• Past appointments that fall outside of saved search in the sales application aren’t synced. The Shared with
Oracle category isn’t cleared for the appointment in Outlook because the copy of the appointment still exists in
the sales application.

• Past appointments that were modified in the sales application and not in saved search aren’t synced.
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• A past appointment that was already shared with the sales application and is modified later in Outlook isn’t
synced to the sales application.

• A past appointment that is deleted in the sales application isn’t deleted in Outlook, however, the Shared with
Oracle category is cleared because the appointment no longer exists in the sales application.

• A past appointment that is deleted in Outlook is not deleted from the sales application.

FAQs for Bi-Directional Sync  

Do the appointments shared with the sales application show the account they're
related to?  
An appointment shared with the sales application displays the account name that's associated with the recipient. The
table below covers the scenarios when the account name is shown for a shared appointment.

Invitee of the Appointment Shows the Account Name?

The invitee is a CX Sales contact,
 associated with an account.
 

Yes
 

The invitee is a CX Sales contact, not
associated with any account.
 

No
 

The invitees are CX Sales contacts from
the same account.
 

Yes
 

The invitees are CX Sales contacts. Some
of them are from the same account and
the others aren't associated with any
account.
 

Yes
 

The invitees are CX Sales contacts from
different accounts.
 

No
 

None of the invitees are associated with
any account.
 

No
 

Can I manually share a past appointment from Outlook in bidirectional sync?  
If a past appointment has the Shared with Oracle category, you can share the appointment manually with the sales
application.

However, updates you make to the past appointment aren’t synced to the sales application.
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What happens if I manually remove the Shared with Oracle category for a past
appointment in Outlook?  
In bi-directional sync, even if you manually remove the Shared with Oracle category for a past appointment in Outlook,
the appointment won’t be deleted from the sales application.

In one-way sync, when you remove the category of a past appointment, the copy shared with the sales application is
deleted.

Adaptive Search for the Add-in  

How does Adaptive Search work in the Microsoft 365 add-in?  
For the Microsoft 365 add-in, Oracle's Adaptive Search works on these dynamic choice lists:

• Accounts

• Contacts

• Opportunities

• Leads

To begin the search, users start typing few characters and click the search icon. Based on the setup, the add-in returns
the search results for you.

Let's understand this with an example. You're creating an appointment in the add-in, and you want to associate an
opportunity with that appointment. The Sales application may contain hundreds of opportunities, and searching for
one, especially if you have forgotten the name, can be challenging. If the administrator has enabled Adaptive Search
and keyword search on opportunity attributes like the account, the contact, or the creation date, you can search for your
opportunity by entering a value for any of these. For example, you remember that you created the opportunity in May;
you can search with the keyword: 5/.

You begin the search on the fly. You can see all the opportunities that contain 5 or 5/ in the name, creation date, or any
attribute enabled for Adaptive Search. Simply select the opportunity and save the appointment you were creating.

Note:  You must enter a few characters for the search to begin.

Related Topics
• How Dynamic Choice Lists Show Options

What are dynamic choice lists?  
Dynamic choice lists are the fields that show you several values to select from. You select the most relevant one for your
task. Dynamic choice list fields display a search icon, indicating that you can search for a specific option.

In the Microsoft 365 add-in, you can find dynamic choice lists for accounts, opportunities, leads, and contacts.
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Note:  Dynamic Choice lists with simple and advanced filters aren't supported in the Microsoft 365 add-in. If you
add such a dynamic choice list to an edit page in the mobile application, it displays all the values in the list, not just a
filtered list. On selecting a value that's not in the filtered list, you see an error when saving the record.

What's a smart list?  
When you click the search icon in a dynamic choice list field in the Microsoft 365 add-in without entering any search
criteria, the add-in retrieves a "smart list" of items using certain predefined parameters.

Examples of these predefined parameters include recently created, updated, or visited records, based on user
interactions in the sales applications.

Because smart lists are based on user context, they can help you quickly find the right items you're searching for. Smart
lists are enabled on the dynamic choice lists in accounts, primary contact search, activity contact search, opportunities,
and leads. Your administrator configures the additional details (attributes) that are displayed for each item in the smart
list.

Note:  Smart lists are based on interactions in the sales application, in the add-in, and in the mobile app.

How Dynamic Choice Lists Show Options  
Dynamic choice lists display options in several ways:

• Autofilling with default values

• Showing inline suggestions, based on certain conditions, especially when Advanced Share mode is enabled

• Showing a search list powered by Adaptive Search

• Rendering a smart list when you haven't entered any search keywords

Note:  Dynamic choice lists with simple and advanced filters aren't supported in the Microsoft 365 add-in. If you
add such a dynamic choice list to an edit page in the mobile application, it displays all the values in the list, not just a
filtered list. On selecting a value that's not in the filtered list, you see an error when saving the record.

This table explains how the different dynamic choice lists display options in Advanced Share mode and in the create or
edit mode.

Dynamic Choice List Advanced Share Flow Create or Edit Record Flow

Account
 

Auto-filling:
 
The add-in auto-fills an account name, based
on the primary contact that's selected.
 
Inline suggestions:
 
When you click the field, it shows a list of
primary accounts of the contacts on your email
or meeting as inline suggestions.

The auto-filling, Adaptive Search, and smart list
act the same way as described in the column,
Advanced Share Flow.
 
The difference is, you don't get inline
suggestions in this mode.
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Dynamic Choice List Advanced Share Flow Create or Edit Record Flow

 

Primary Contact
 

Auto-filling:
 
The add-in auto-fills the name of the contact
you selected in the home page, as your primary
contact. If you have selected a resource or
person not in sales application, the add-in auto-
fills the name of first contact found on the
email or meeting.
 
Inline suggestions:
 
When you click the field to change the auto-
filled primary contact, the add-in shows inline
suggestions.
 

No auto-filling
 
Inline suggestions:
 
When the account is selected: The add-in
shows the list of contacts related to that
account as inline suggestions.
 
When the account isn't selected: You don't get
inline suggestions. Move on to search or smart
list.
 

Activity Contact
 

Auto-filling:
 
The add-in auto-fills other contacts on the
email and meeting.
 
No inline suggestions.
 

No auto-filling
 
No inline suggestions
 

Opportunity
 

No auto-filling
 
Based on the contact selected, inline
suggestions appear when you click or tab into
the Opportunity field.
 
Tip: If you're tabbing into the field using
a keyboard, press the down arrow to see
the inline suggestions. For email and
appointment share, when you click or tab into
the Opportunity field, the inline suggestions are
based on the account selected, not the contact.
 

No auto-filling
 
Inline suggestions available if an account is
selected.
 

Lead
 

No auto-filling
 
Based on the contact selected, inline
suggestions appear when you click or tab into
the Lead field.
 
Tip: If you're tabbing into the field using a
keyboard, press the down arrow to see the
inline suggestions. For email and appointment
share, when you click or tab into the Lead field,
the inline suggestions are based on the account
selected, not the contact.
 

No auto-filling
 
Inline suggestions available if an account is
selected
 

Note:  Adaptive Search and smart lists are same for all these fields. See the other search-related topics in this chapter
to learn more about them.

344



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 23
Microsoft 365

Related Topics
• What's a smart list?

• How does Adaptive Search work in the Microsoft 365 add-in?

• What are dynamic choice lists?

Add Objectives to Your Appointment, Call Report, or
Tasks  
From the Microsoft 365 add-in, you can add goals or objectives you want to achieve or have achieved from an
appointment, call report, or task.

With objectives laid out, you can stay focused on what you want to target and gain from these meetings or tasks.

Here's how you can add objectives to your appointments, call reports, or tasks:

1. In the add-in, open an Appointment, Call Report, or Task for which you want to add objectives. Go to the Edit
mode.

2. In the Activity Objective section, use the + icon to add the objectives. The add-in shows default objectives. You
can create custom objectives as well. To create custom objectives, enter your objective's name in the text field
that has the watermark 'Create custom objective' and press the Create button.

3. Next, opt the objectives and add them to the appointment, call report, or task.
4. If an objective is already met, mark it as Complete.
5. Save the appointment, call report, or task.

Sync Records Between the Sales Application and
Microsoft 365 Outlook  
Save time by using the synchronization feature. Sync your Microsoft 365 and sales application data by running the sync
engine.

The sync engine comprises these regions:

• Enable sync

• Define the sales records to be synced with Microsoft 365 Outlook

• Synchronize contacts

◦ Contact sync settings

• Activities sync settings

• Summary of sync errors
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Enable Sync
Your administrator can enable or disable the sync engine. If sync is enabled, then the application runs the
synchronization process at scheduled intervals. If it's disabled, then the records aren't automatically synced between
Microsoft 365 and your sales application.

Define the Sales Records to be Synced with Microsoft 365 Outlook
You can select predefined saved searches from the side panel or create your own saved search in the sales application.
When you select a saved search, the corresponding records matching the saved search are synchronized with Microsoft
365 when the next synchronization runs.

These are the predefined saved searches options for contacts and activities such as meetings and tasks.

Note:  The fields exposed on these predefined saved searches can't be removed even if they're saved with a different
name. If needed, you can modify their criteria.

Saved Search What Gets Searched

All Contacts
 

All contacts in your sales application
 

My Business Contacts
 

All contacts belonging to all the accounts you own
 

My Contacts
 

All contacts, of the type account, that you're an owner of
 

My Favorite Contacts
 

All your favorite contacts
 

My Open Activities
 

All meetings that are open and you're a resource for in your sales application
 

Synchronize Contacts
You can synchronize contacts between Outlook and your sales application. When the add-in syncs new contacts from
Outlook, it uses the company name of the contact to find the Sales account for that contact. If the sync process finds
a matching account, the contacts is created in the sales application and is associated with that account. Contacts from
the sales application can also be synchronized into Outlook. Changes that are made to synchronized contacts, whether
they're made in Outlook or in the sales application, are synchronized to the other.

Contact Sync Settings

Use this region to set the parameters for syncing contacts. You can select the list of contacts that are synced.
Additionally, you can select the conflict resolution rule.

Resolution Option Description

Cloud version wins
 

The contacts in your sales application overwrite the contacts in your Microsoft 365 account
 

Outlook version wins The contacts in your Microsoft 365 account overwrite the contacts in your sales application
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Resolution Option Description

  

You decide
 

You select the way you want to resolve the conflict if there's a conflict
 

Activities Sync Settings
Use this region to set the parameters for syncing meetings and tasks. You can select the list of meetings and tasks that
are synced. Additionally, you can select the conflict resolution rule.

Resolution Option Description

Cloud version wins
 

The meetings and tasks in your sales application overwrite the meetings and tasks in your Microsoft
365 account
 

Outlook version wins
 

The meetings and tasks in your Microsoft 365 account overwrite the meetings and tasks in your sales
application
 

You decide
 

You select the way you want to resolve the conflict if there's a conflict
 

Summary of Sync Errors
Here you can see the sync summary and list of errors when a sync fails.

The summary is segregated into three regions:

• Last sync: This region displays information of the latest sync.

• Outlook: This region displays the number of meetings, tasks, and contacts synced to your Outlook account.

• CX Sales: This region displays the meetings, tasks, and contacts synced to your sales application account.

Note:  The synced records can either be new records added to your account or existing records updated with new
information.

The error region displays the meetings, tasks and contacts that weren't synced, along with the nature of the error. From
here you can go to the individual records and fix the errors. You also have the option to display only the resolvable
errors. You can't update those records whose errors you can't resolve.

Fix Resolvable Sync Errors
When contacts, meetings, and tasks from Microsoft 365 are synced to the sales application, you may get errors due to
invalid or missing information in them. Most of the errors due to deficient information are resolvable just by correcting
or updating that information.
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Here's how you can fix such errors:

1. Go to Synchronization.

Note:  The Resolve Errors button only appears on the Synchronization page if the errors are resolvable.

2. Click Resolve Errors. In the Errors list page, you can see the resolvable errors with an edit icon.
3. Click the edit icon to go to the respective Contacts, meetings, or Tasks page that has the errors.
4. Fix the errors and click Save. After you save, the Microsoft 365 add-in directly saves the records to the sales

application and takes you back to the Errors list page to resolve pending errors.

Auto-Sync of Appointments  
If your administrator has enabled the auto-sync feature, your appointments are synced between Microsoft 365 and the
sales application automatically.

The one-time or recurring appointments that you have created and sent to a CX Sales contact are auto-synced. The
Auto-sync of appointments works for both bi-directional and one-way sync patterns.

If your administrator has enabled syncing private appointments, the private appointments that you created and sent to
at least one CX Sales contact are auto-synced too.

Note:  The appointments that don't have any CX sales contact are not auto-synced. Also, the appointments where
you're an invitee aren't auto-synced.

Related Topics
• Autosync Appointments

Update Details in External Appointments  
You can update details such as your availability to the meeting and reminder in the external appointments synced to the
sales application from Outlook.

Though you can update most of the fields in the external appointments, a few fields still remain read-only. The table
here shows what you can change and what you can’t.

Fields You Can Update Read-Only Fields

• Account

• Opportunity

• Lead

• Show Time as indicates your
availability for the meeting.

• Set Reminder

• Externally Owned setting

• Private

• Subject

• Location

• Time zone
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Fields You Can Update Read-Only Fields

• Add Attachments

• Add Objectives

• Add Notes

• Start date and time

• End date and time

• All Day setting

• All the fields on the Recurrence window

• Owner

• Resources

• Contacts

• Primary Contact

• Description

What You Can Do on an External Appointment
You can do these actions on an external appointment:

• Create a follow-up appointment

• Create a follow-up task

• Create a call report

• Delete appointment

FAQs for Microsoft 365  

Frequently Asked Questions (FAQs) for Microsoft 365  
This section contains some frequently asked questions (FAQs) for Microsoft 365. Scroll or search to find answers to
common questions.

Why am I frequently prompted to sign in the add-in?  

You will be prompted to sign in only if your sign-in token validity has expired. Let’s see what this means.

After your first sign-in, the add-in captures and stores the sign-in token and ensures that the token is valid for the next
48 hours. Whenever you open the add-in within 48 hours, your sign-in token’s validity is automatically extended for the
next 48 hours. This way, as long as your next session on the add-in is within 48 hours, the add-in won’t prompt you to
sign in.

But, in situations such as you had a long weekend or you went on a vacation, you might be opening the add-in only
after 48 hours from your last sign-in time. By that time, your token validity expires. In such situations, the add-in
prompts you to sign in again.
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How do I troubleshoot the error, "There is an issue in
communicating with Microsoft Services"?  
This error occurs when your Chrome browser doesn't allow third-party cookies, in normal mode or in incognito mode.
To resolve this issue, go to your browser settings, enable all cookies, and connect with the add-in.

Why did my Outlook contact fail to sync with the sales application?
 
When syncing an Outlook contact with the sales application, the address of the contact is copied from Outlook to the
respective address fields in the sales application.

During this sync, if any of the mandatory address fields don't get corresponding data from Outlook, the sync fails. You
can fix these type of sync failures from the add-in. See the related topics for more information.

Related Topics
• Sync Records Between the Sales Application and Microsoft 365 Outlook

Can I open sales records in the web application from the Microsoft
365 add-in?  
Yes. From the add-in, you can open sales application records of contacts, appointments, tasks, call reports, and custom
objects. To do so, open the menu (the ellipsis icon ...) from their detail pages and use the Open in CX Sales option.

The corresponding record shown in the add-in will open in your default browser.

What happens when I share an email with my sales application?  
The shared email is associated as a task with the relevant account, opportunity, or lead. Related known contacts or
resources are added to the task in your sales application.

How can I share an email with my sales application?  
Use the Share Item feature to share your email with the sales application. Here are the steps to do so:

1. Select an email you want to share.
2. Click Share Item under the Records tab of the add-in.
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3. Select the appropriate accounts, contacts, and sales leads.
4. Click Share.

The application shares your email with the selected parties. Notice that Microsoft 365 has categorized your email as
Shared with Oracle. All information in the email is saved as an activity of the type email. Go to the Activities tab and
select this activity to see the details. The shared email's content is copied as plain text into the Description field. You can
find the original format of the email as an attachment in the Attachments section. You can download the email body
from the Attachments section.

You can similarly share appointments that you compose in Microsoft 365.

How can I send a call report as an email?  
Open a call report in its detail view. Within the menu (the ellipsis icon ...) use the option Send as Email.

Outlook opens a draft email that has a link to the call report, some default content, a reference to the meeting, and
attendees of the meeting. The To field shows email IDs of contacts and assignees of the call report. You can change the
content, add more people as recipients, or copy people to the email. Send out the email when ready.

Can I share my Microsoft 365 email attachments with my sales
application?  
Yes, you can. Click Share email in the Related Records tab. From the list of contacts, accounts, and attachments
associated with the email, select the attachments you want to share, and click Save. Attachments must not exceed 25
MB.

What's the allowed attachment file type and size for sharing
emails?  
This topic shows the attachment size limit for sharing emails and for uploading files from objects such as Account and
Opportunity.

• Images: JPEG, GIF, PICT, PNG, TIFF: 2 MB

• Microsoft files: PPT, DOC, EXCEL: 10MB

• Video: QT, MP4, .XMS: 10 MB

• Audio: M4A, MPEG3, AAC, .WAV: 2 MB

For uploading files from objects such as Account and Opportunity:

• Upload a file: 10 MB

• Upload contact or avatar image: 2MB

Note:  If you have a locally-installed Outlook application and the Edge browser on Windows computers, you can't use
Microsoft 365 add-in to download the attachments that have been uploaded to the sales records. Alternatively, you
can download them from the sales application.
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Why doesn't the category of my email show the sales application
after I share it?  
The category is added to your email only after Outlook updates the inbox. To categorize instantly, click Send/Receive on
the Microsoft 365 ribbon. Click Update Folder and select the email.

Can I share a meeting that is still in the compose mode in Desktop
Outlook?  
Yes, but ensure that you send the meeting invite and run the sync job to share the meeting.

Here’s how you share a meeting:

1. Create a meeting in Outlook calendar and add invitees.
2. Open the add-in when you’re scheduling the meeting.
3. Click Share and Save.
4. Send the meeting to the invitees.
5. Run the Microsoft Instant Sync job.

Another way of sharing is to categorize the meeting as Shared with Oracle.

1. Create a meeting in Outlook calendar and add invitees.
2. Select the email you want to share with the sales application (callout 1).
3. Under Tags (callout 2), expand Categorize (callout 3), and click Shared with Oracle (callout 4). The sync engine

shares your meetings with the sales application in the next run of the Microsoft 365 standard sync process.

What happens if I create or update records in the side panel?  
When you create contacts or tasks using the side panel, the records are automatically synced with the sales application,
and the application creates the corresponding records both in the Microsoft 365 add-in and in the sales application.

This action isn't dependent on the sync settings. When you or another user updates a contact in the side panel, the
application automatically updates it in Microsoft 365 as well. Similar is the case when you update tasks. But, when
another user, not the owner, updates a task, then the sync engine deletes the linked task in Microsoft 365.
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Note that when you delete any of these records, the corresponding records aren't automatically deleted in the sales
application. The sync engine deletes the records when the next sync process runs.

Why can't I open the sales application records from the Microsoft
365 side panel?  
You can't open the records because the profile option FND_CLASSIC_INTERFACE is enabled. Disable this profile option
to view your sales application records from the Microsoft 365 side panel.

Why aren't my sales application user preferences visible in the
Microsoft 365 side panel?  
Any change that you make to user preferences in your sales application is reflected in the side panel only after you sign
out of the add-in, restart Outlook, and sign in again.

Why are the saved searches for the appointments read-only?  
Your administrator could have turned on one-way sync on appointments, which means, your meetings are synced from
Outlook to the sales application but not the other way around.

With one-way sync on:

• Changes to the meetings in sales application don't reflect in Outlook.

• Meetings that exist only in the sales application aren't synced to Outlook.

• You can't use saved searches for appointments.

• Because changes don't cascade from the sales application to Outlook, your invitees can't receive any
notifications on any updates you make to the meetings saved in your sales application.

• The errors you resolved in the Appointment records, from the Resolve Sync Error page, reflect in the sales
application only. Generally, the sales application won't update or create any appointments in Outlook.

Why didn't the invitees within my organization get notification
when I updated a meeting I created?  
While creating a meeting, ensure that you select the category as 'MS allows invitee record update'. So that, whenever
you update the meeting after it's shared with the sales application, your invitees will receive notifications about the
update.
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Will my internal and external invitees be notified when I update a
meeting shared with my sales application?  
Yes. If you have shared your appointment with the sales application, your internal and external invitees will receive
notification when you make updates.

Can I share a meeting I received from an external contact with the
sales application?  
Yes. If you're a resource in the sales application and an active user of the Microsoft 365 add-in, the appointment created
by an external contact showing up in your Outlook is shared with the sales application.

If the external contact updates the meeting, the updates are also shared automatically with the sales application.

Why can't I find the option I am looking for, even though I am
using Adaptive Search?  
Remember that Adaptive Search works based on the configurations your administrator decided for you. Here are the
possible reasons why you can't find an option:

1. If your administrator didn't mark a field as searchable, Adaptive Search doesn't look for the values of that field.
Let's see an example. Assume your administrator didn't configure the Job Title as a searchable field in the
Primary Contact object. When you search for a primary contact by their job title, you can't find that contact.

2. You can't search by the fields that aren't supported by Adaptive Search. For example, you can't search a Primary
Contact based on favorites, because, the Favorite check box can't be enabled for the Adaptive Search.

In the search results page, I can't see the attributes that were there
earlier. What should I do to see them again?  
Contact your administrator to enable Adaptive Search on those attributes, so that you can see them again in the search
results.
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Why do some records in the smart list not seem to match my
search criteria?  
The Microsoft 365 add-in generates a smart list by searching against multiple attributes of a record, not just the name. If
any of the attributes within the records contain your search criteria, they also show up in the smart list.

On the face of it, it may appear to you that the record that doesn't contain your search text also showed up on the list.
But, that's not true. To see the matched text in the records, hover over the information icon on the right side of the
records in the smart list. An information box appears showing the matched text in bold. You get an idea of the attribute
that caused the record to appear on the smart list.

Microsoft Teams  

Microsoft Teams  
Converting an opportunity into a sale requires teamwork. Add members to your opportunity and business plan teams
and create a Microsoft Team with them.

Communicate and collaborate with your team members in the Microsoft Team and take your deal to closure.

See these topics to learn more about creating an opportunity and business plan teams and collaborating on Microsoft
Teams:

• Opportunity Teams

◦ Add Team Members to an Opportunity

◦ How can I collaborate on opportunities using Microsoft Teams?

◦ What happens to the Microsoft team I created, when an opportunity closes?

◦ Re-create a Team for an Opportunity Team in Microsoft Teams

• Business Plan Teams

◦ Collaborate on Business Plans Using Microsoft Teams

◦ Re-create a Team for a Business Plan Team in Microsoft Teams

With Sales assistant within Microsoft Team, your team members can see opportunity, account, or contact details. They
can create notes, call reports, tasks, and appointments and do lot more.

See these topics to learn about all the capabilities of sales assistant when using Microsoft Teams:

• Overview of Sales Assistant Features

• Microsoft Teams Specific Features
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24  CX Sales Mobile

Overview of CX Sales Mobile  
The Oracle CX Sales Mobile app helps you to manage your day effectively and develop customer relationships using
your phone or tablet.
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• Manage Sales Activities:

◦ Action driven home page, with a sales briefing to track your pipeline and stay on top of daily activities..

◦ Optimized task based flows for key sales functions: Accounts, contacts, leads, opportunities, activities,
assets, service requests, partners, and custom objects.

◦ View, create and edit tasks, appointments and call reports.

◦ Use saved searches that are shared across CX Sales Mobile and Workspace lists, for consistency across
applications.

◦ View your recently accessed records in the app when using the global search, or when sharing notes from
an external app.

◦ Add contacts and leads to CX Sales Mobile from the mobile device's address book.

◦ Create contacts and leads by using a photo of a business card.

◦ Scan an asset's bar code to search for an asset and automatically enter the asset serial number.

◦ Share notes, photos, videos, documents, or files from the mobile device to CX Sales accounts,
opportunities or other records.

◦ Plan your sales activities around your current location by viewing your nearby contacts, accounts,
opportunities, and leads plotted on an interactive map. You can also plan future appointments in a city or
near an address with an easy location search.

◦ View your quotes in the app and stay updated on the quote status. View and send quote proposal
documents to customers, or share them with your team for feedback.

◦ View reports and analytics with modern visualizations optimized for mobile displays, such as bar graphs,
funnels, bubble charts, and more. Role-based layouts allow sales administrators to provide unique
experiences to sales representatives, managers, and others.

• Manage Partner Relationship Management Activities:

◦ Partners can effectively manage and improve channel sales on the go.

◦ Channel Managers can track the overall channel sales and also manage partner, partner contacts, and
related information easily.

• Oracle Sales Assistant Chatbot:

◦ Use Oracle Sales Assistant to help you perform your daily sales-related tasks. Using your phone, you
can type or use your voice to ask questions and sales assistant retrieves the information, or acts on your
requests.

◦ Sales Assistant reduces manual data entry, and makes it easier to view and update sales records using
voice commands or typing.

• Boost Productivity on the Go::

◦ Modern and intuitive experience, designed to boost productivity with fast and seamless interactions.

◦ At-a-glance record view for quick grasp of summary, key and related information.

◦ Access actions relevant to your task for fast and easy record updates..

• Use the Powerful Search Capabilities:

◦ Fast and simple search across all objects in one place.

◦ Use multi-keyword search across multiple fields for faster and easier access to desired information.

◦ Search more easily with recent searches and type ahead results displaying results as soon as you type.
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◦ Filter results by object types.

• Sign In Quickly and Easily:

◦ Scan QR Code to sign in easily using your Single Sign On, or basic authentication.

◦ Use face or fingerprint recognition to securely sign in to the app.

• Use Your Phone or Tablet:

◦ Use either your phone or tablet to access the app. Using a tablet changes the display to 2x portrait mode.

• Use Offline:

◦ View and edit Oracle CX Sales data in areas with no network connection.

◦ Sync automatically when a connection is re-established.

Get Started with CX Sales Mobile  
The Oracle CX Sales Mobile app helps you manage your day effectively and develop customer relationships using
your phone or tablet. An action-driven home page helps you prepare for meetings with the clients, stay on top of key
activities for your accounts, and track your pipeline anytime or anywhere.

Install and Sign In to the App
First of all, you need to install the app and sign in. Here's how:

1. Open the App Store, or Google Play, and search for Oracle CX Sales Mobile application, and then tap Install.
2. Open the app and accept the legal terms.
3. If you have a QR code, tap the QR Code button and scan the QR code using your mobile device's camera. Then

go to step 5.
4. If you don't have a QR code, tap either Single Sign On (if you have SSO access), or tap Basic Authentication.

Enter the host name your administrator has given you and then tap Next.

Note:  If you have problems entering the host name, make sure that the auto-correct isn't changing the
values you're entering.

5. Enter either your SSO details, or your CX Sales user name and password. Tap Next.

Once you have signed in, you will be given the option of setting up fingerprint recognition, or face recognition, to sign in
to the app in the future. If you would like to enable this at another time, tap the menu icon on the bottom left-hand side
of the app and then tap Settings.

Navigate Around the App
Use the home page to manage your pipeline and tasks. To show the list of sales objects, such as Opportunities,
Accounts, and Contacts, tap the menu icon on the bottom left-hand side of the app. Then tap the feature to retrieve a
list of items - for example, tap Opportunities to get a list of your open opportunities. To view the item details, tap any
item in the list view. In the list view, tap the more icon on an item to access frequent actions, such as adding a note.
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When you're viewing a sales object's details, not only can you view and edit the details - such as updating the account
address, or opportunity win probability - you can also quickly access other actions for the sales object, such as logging a
call or creating a task, by just tapping the more icon in the details page.

You can also use Oracle Sales Assistant to help you perform your daily sales-related tasks. Sales Assistant is a chatbot
that you can send questions or commands to and it retrieves the information, or acts on your requests. Tap the chat
icon on the bottom right hand side of the app and in the chat screen just type your request, or use the microphone to
say your request.

Add Contacts
You can sync individual contacts from your mobile device's address book to the app by tapping the plus icon in the
Contacts list page and then tapping From Address Book.

You can also add contacts by using a photo of a business card. Just take a photo of a business card using your mobile
device's camera, or use an existing photo, and a new contact is created in the app using the information on the business
card. Here are the exact steps::

1. Tap the plus icon in the Contacts list page.
2. Tap From Business Card.
3. Tap either From Photo Gallery to use an existing photo, or tap Take Photo to take a photo of the card using

your mobile device.
4. Check and, if required, edit the contact details, and then tap Save.

Note:  Here are some points to note about the business card feature:

• Only business cards in English are supported at this time.

• Only US address formats are supported at this time.

• The business card needs to contain an email address. The domain name (@example.com) is used to search
for an existing account. If a single account is found, then the account details are populated automatically in
the new record. If more than one is account found, then the account field is left empty, and you will need to
select an account.

• The app has a list of job titles that are used to match the job title on the business card. If a match can't be
made, then you can add it to the record, and the job title is added to the job title list so that it can be used in
the future. Also, if you edit a job title then this is added to the job title list as a new job title, so that you can
use it again.

• For best results, you should use a photo of the actual business card. Don't use a photo which is a picture of a
business card on a monitor, for example, as the image quality won't be good enough.

• Ensure that there is a good color contrast between the business card background and the text on the card, as
this enables a better scan.

Personalize Your Home and Reports Pages  
You can show, hide, and reorder the cards that appear in your home page and your reports page, enabling you to
personalize the pages so that they work best for you.

Here's how you personalize your home and reports pages:
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Personalize Your Home Page
1. Scroll to the bottom of the home page and tap Personalize.
2. Tap Hide this card to hide a card in your home page.
3. Reorder the cards by using the arrow buttons on the card.
4. When you're happy with your personalization, tap Done.

Personalize Your Reports
1. In the Reports page, tap the more button (three horizontal dots), and then tap Personalize.
2. Hide and reorder the cards by following the same steps for personalizing your home page.
3. When you're happy with your personalization, tap Done.

Reset the Home and Reports Pages
To return to how the home page and reports pages were originally configured, follow these steps:

1. In the home page, scroll to the bottom of the home page and tap Personalize. In the Reports page, tap the
more button (three horizontal dots), and then tap Personalize.

2. Scroll to the bottom of the pages and tap Reset to Default.
3. Then tap Reset to confirm.

Offline Usage  

Can I use CX Sales Mobile when I am not connected to Wi-Fi and I
haven't got a cell phone signal?  
Yes, you can view, create, and edit records in the app even when you're offline. When you lose your network connection,
a message is displayed to indicate that you're working offline.

At the top on the page, a banner displays how many updates will be synchronized when you're back online and also how
long it's been since you last synchronized your data.

When the network connection is restored, the application automatically synchronizes the updates you have made on
your mobile device to Oracle CX Sales. Alternatively, you can manually sync the records by tapping the offline banner at
the top of the page and then tapping the more icon in the Pending Sync page.

What data can I see in the offline mode?  
All of the data that you view in the application when you're online will be available when you're offline. Also, all of the
sales objects that your administrator has specified for offline use are available in the offline mode.

The data you created, edited, or deleted when you were offline is synchronized with the CX Sales web app when CX
Sales Mobile detects a network connection. Alternatively, you can sync the records manually by tapping the offline
banner at the top of the page and then tapping the more icon in the Pending Sync page.
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How can I synchronize my offline data?  
Your data synchronizes automatically with the CX Sales web app when your mobile device detects a network connection
and goes online.

Alternatively, you can manually sync the records by tapping the offline banner at the top of the page and then tapping
the more icon in the Pending Sync page.

What happens if there's an issue when your offline updates
synchronize with the CX Sales web app?  
You can find a list of records that have synchronization issues by tapping the synchronization banner at the top of the
app.

Once the issues have been resolved, you can sync the records manually by tapping the more icon and then the Retry
Sync For All  button.

Note:  If Oracle CX Sales Mobile detects a data conflict between CX Sales Mobile and the CX Sales web application,
then the updates you have made in CX Sales Mobile override the updates made in the Oracle CX Sales web app.

FAQs for CX Sales Mobile  

Frequently Asked Questions (FAQs) for CX Sales Mobile  
This section contains some frequently asked questions (FAQs) for CX Sales Mobile. Scroll or search to find answers to
common questions.

Which mobile devices are supported?  
To find out which mobile devices and operating systems are supported by CX Sales Mobile, see the System
Requirements for Oracle Applications Cloud page at https://www.oracle.com/system-requirements/.

What's the default language?  
CX Sales Mobile uses the language set on your device as the default language.
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What note apps can I use with CX Sales Mobile?  
As well as the note app that's provided with your mobile device, you can use other notes apps - such as Google Keep or
OneNote - to create and share notes.

Can I scan a business card to create a contact or lead?  
Yes, you can add contacts and leads by scanning a business card using your mobile device's camera, or by using an
existing photo of a business card. The app creates a new contact or lead using the information on the business card.
Here are the steps:

1. Tap the plus icon in the Contacts or Leads list page.
2. Tap From Business Card.
3. Tap either From Photo Gallery to use an existing photo, or tap Take Photo to take a photo of the card using

your mobile device.
4. Check the newly created contact or lead details and, if required, edit the details. Then tap Save.

Note:  Here are some points to note about the business card feature:

• Only business cards in English are supported at this time.

• Only US address formats are supported at this time.

• The business card needs to contain an email address. The domain name (@example.com) is used to search
for an existing account. If a single account is found, then the account details are populated automatically in
the new record. If more than one is account found, then the account field is left empty, and you will need to
select an account.

• The app has a list of job titles that are used to match the job title on the business card. If a match can't be
made, then you can add it to the record, and the job title is added to the job title list so that it can be used in
the future. Also, if you edit a job title then this is added to the job title list as a new job title, so that you can
use it again.

• For best results, you should use a photo of the actual business card. Don't use a photo which is a picture of a
business card on a monitor, for example, as the image quality won't be good enough.

• Ensure that there is a good color contrast between the business card background and the text on the card, as
this enables a better scan.

• Make sure that there's only one contact on the business card. You can't scan a card that contains more than
one contact, as the app can only create one contact for each business card.

Can I scan a barcode to view an asset or create an asset record?  
Yes, click Assets in the navigator, click the barcode icon, and take a photo of the barcode. The asset record is displayed
and you can create an asset record containing the asset details.
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How can I log a call report?  
Open the main menu and tap Calls to Log. Tap the activity you want to log, enter the information, and tap Save.

Alternatively, when you view your list of opportunities, accounts, tasks, and so on, just tap the more icon (three
horizontal dots) on a record, and then tap Create Call Report.

Lastly, you can also create a call report from a sales object's detail page (such as an opportunity, lead, or task detail
page). Open the detail page, scroll down to the bottom of the page, and in the Add section, tap Call Reports.

When you create or edit a call report, you can record many aspects of the activity, including logging the objectives that
you have achieved, and adding resources and attachments.

How can I view my call reports?  
Open the main menu and tap Call Reports.

You can also see a call report that's related to an opportunity, lead, task, and so on, by opening the details page and
scrolling to the Call Report section.

Why has the note I created become a PDF attachment?  
Some note apps, for example the OneNote app, create a note as a PDF file. CX Sales Mobile recognizes the PDF as an
attachment, rather than a note, and adds the file to the record as an attachment.

What type of files can I attach to a record?  
You can attach photos, videos, audio recordings, Word documents, PowerPoint presentations, Excel files, plain text files,
and PDFs.

You can attach one video to a record, and up to three other file types.

How can I use Sales Assistant to help me with my sales-related
activities?  
You can use Sales Assistant to help you perform your daily sales-related tasks via your phone.
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Type or use your voice to ask questions and sales assistant retrieves the information, or acts on your requests. Sales
Assistant reduces manual data entry, and makes it easier to view and update sales records using voice commands or
typing.

See the Sales Assistant chapter in the Using Sales guide for more information about how you can use Sales Assistant.

Related Topics
• Overview of Sales Assistant

• Features of Sales Assistant

• CX Sales Mobile Specific Features

When does a message appear to confirm that you have created a
record?  
A confirmation message appears when you have successfully created a new record, your lead conversion is in-progress,
and your lead conversion is complete. These messages remain briefly before closing automatically. You also have the
option to close the message.

The confirmation message appears for the following sales objects:

• Leads

• Opportunities

• Accounts

• Contacts

• Tasks

• Appointments

• Call reports

• Assets

• Service requests

• Custom objects

When a new record is created, the confirmation message contains a Review button which opens the new record if you
tap it.

Note:  This doesn't apply to lead conversion in-progress or complete messages.

If you're offline when you create a new record, or convert a lead to an opportunity, the confirmation message appears
when you're back online.
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25  Sales Assistant

Overview of Sales Assistant  
Sales Assistant is a chatbot that you can use to access sales information and perform sales activities. You enter
questions or commands, and the Sales Assistant retrieves the information or acts on your requests. The Sales Assistant
reduces manual data entry, and makes it easier to view and update sales records through text in Microsoft Teams and
through either text or voice in CX Sales Mobile.

Things to note:

• Supported Channels: Microsoft Teams, CX Sales Mobile

• Supported Language: English

• Supported Objects: Accounts, Appointment, Contacts, Opportunities, Service Requests, Tasks, Sales Leads,
and Custom objects

Administrators can enable or disable different objects for each channel.

• Security:  When using Oracle Sales Assistant in Microsoft Teams, you're prompted to sign in to CX Sales via
a sign-in button the assistant sends to you when you first converse with it. After you sign in, the assistant
continues the conversation with you.

To use Oracle Sales Assistant in CX Sales Mobile, you can use the chatbot right away after you sign in to Oracle
CX Sales Mobile.

For any channels, the same functional privilege you have in CX Sales applies when entering into conversations
with the Sales Assistant.

Where to Get Help with Sales Assistant Setup
If you need help with enabling Oracle Sales Assistant, send a message to the Sales Assistant forum on Oracle Cloud
Customer Connect. Here's the URL:

https://cloudcustomerconnect.oracle.com/resources/dee2ff3bf7/summary

Related Topics
• Overview of Sales Assistant Setup

• Set Up Oracle Sales Assistant for Microsoft Teams

• Set Up Oracle Sales Assistant for CX Sales Mobile

Features of Sales Assistant  
The sales assistant skill helps you to view and update sales records through text or voice commands. You can either
type or use the speech-to-text feature on your mobile device to communicate with the sales assistant.
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Features of Sales Assistant for Supported Channels
Here are the main Sales Assistant features for all supported channels:

Feature Description Sample Phrases to Use

Context
 

The sales assistant recalls the context of records within a conversation
between you and the sales assistant. For example, you're viewing the
details of an appointment and you then navigate to view the associated
opportunity's details. The sales assistant remembers the appointment
that you viewed previously, so that if you request more details about the
appointment, the sales assistant recalls the details.
 
Maybe you want to view the account associated with the appointment?
Once again, the sales assistant knows the account you want without
having to prompt you based on the context of records within the
previous conversation.
 

Tip:
You must specify the object in context that you're asking about in the
phrase.
 

• Show account for this
appointment

• Get the tasks for this account

• What are the appointments for
this opportunity?

• Show detail for this contact

Suggest Most Recently Accessed
Records
 

If you ask Oracle Sales Assistant for a record without providing context,
 the assistant suggests some records, if available, from the ones most
recently accessed by you. This lets you to easily view and act on the
record you are searching for.
 

• Get account

• Get leads

Search for a Record
 

There are a couple of ways you can search for a record (of any object
that's enabled for your specific channel) with the sales assistant:
 

• By Workspace's keyword search - Based on the phrase you send to
search for a record, the sales assistant will extract the keyword and
do a search against the object using workspace's keyword search.
For example, "View Oracle account".

The assistant will first try to search against the records that are
most relevant to you. However, if you can't find the record you
want within this set, then you can expand and see matches from
within your full set of accessible records for the specific object
type.

Note:  Formula fields aren't searchable because they can't be
configured in Adaptive Search and can't be indexed.

• By one or more fields that are enabled by Adaptive Search - (in
addition, the fields must be enabled in the Oracle Sales Assistant
skill.) For more than one field, use the "and" operator between
the fields. For example, "show me the opportunities with win
probability greater than 90 and closing next month".

The following search operators are supported:
 

• And

• Greater than

• Greater than

• Get account <search value>

• Get details for account <search
value>

• Get opportunities in the
qualification stage
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Feature Description Sample Phrases to Use

• Greater than and equal to

• Equal to / in

• Less than

• Less than and equal to

• Between

Tip:
If you don't send a value to search on, such as "get opportunity", the
assistant will prompt you for which record you're looking for. If you
were already conversing with the assistant regarding a specific record
of that type, then the assistant will respond with the details of the
specific record.
 

Tip:
Always include the object name (or its synonym) in the utterance you
send to the assistant.
 

Saved Search Lists from
Workspace
 

Ask for saved search lists from Workspace.
 

Tip:
To display a specific list, specify its name as close as possible to the
name of the saved search.
 

My Lists are lists with "Show Lists" filter set to true. They allow you to
view the most relevant results based on object activity and context.

Tip:
If there is more than 1 list with "Show List" filter set to true, the
assistant will return all lists for you to choose from.
 

In addition, you can also view a list of similar saved searches that match
your search criteria. Click Show all saved searches to display all of your
saved searches for the object you are looking for.
 

• Show all accounts

• Get my open opportunities

• View my lists of contacts

• Show all saved searches

Child or Related Records
 

You can view child or related records (of any object that's enabled for
your specific channel), such as notes. For example, you want to view the
notes on an account and the assistant will find the account and show
you the notes associated to the account, if there are any.
 

Tip:
You must specify the parent object that you're asking about in the
phrase.
 

• Show me the notes for the
oracle account <search value>

Request Specific Field Values for
Records

You can directly ask for values of fields on a record and quickly get the
information. When you ask questions or send commands, the sales
assistant can provide a specific standard or custom field value for a
record.
 

• What is the win probability for
this opportunity?

• Get the industry for the Vision
account.
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Feature Description Sample Phrases to Use

Use Sales Briefing
 

Obtain a snapshot of your day.
 

Tip:
By default, open pipeline is the list of open opportunities that are
in the current and next fiscal quarter closed period. However, the
pipeline period can be modified by your administrator.
 

• Hey, how's my day today?

• How's my day today?

• Sales briefing

Appointments
 

The sales assistant supports additional features for appointments:
 

• Next appointment: You can check for details of your next
appointment in your calendar, if any. For example, you can request
for a briefing of your next appointment to prepare for it before
going to the appointment.

• Current appointment: You can check for details of your
appointment that's currently in progress, if any. For example,
during an appointment, you can request a briefing to receive a
quick re-cap of the objectives of your current appointment.

• Follow up: You can follow up on an appointment that ended
by creating a follow-up call report, creating a follow-up task,
or scheduling a follow-up appointment. Send a keyword to
search for an appointment, such as "follow up on the demo
presentation" or simply send "follow up". If you don't specify
which appointment you want to followup on, the assistant will
show you the most recent appointments (appointments which
occurred and ended in the past 30 days), and you can select one
to continue. If the appointment you want isn't showing in the list
of recent appointments, simply send keyword(s) to search for the
appointment you're interested in.

Tip:
When scheduling a follow up appointment, the sales assistant creates
the appointment on the date and time based on your time zone
configured in CX Sales.
 

Things to consider:
 

• You can directly create a follow-up call report outcome, schedule
the next appointment, or add a follow-up task for an appointment
by using phrases such as "create follow-up call report," "schedule
next appointment," or "create follow-up task".

• In-progress appointments aren't returned as a recent appointment
to follow-up on.

• Some fields, such as the Subject field, defaults from the original
appointment you're following up on for:

◦ Follow-up call report

◦ Follow-up task

◦ Follow-up appointment

• Next meeting

• Current appointment

• Show me a briefing of my next
appointment

• Follow up

• Create follow-up call report

• Schedule follow-up
appointment

• Add a follow up task

Tasks
 

The sales assistant supports additional features for tasks:
 

• Get tasks due today

• View tasks due December 2021
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• Get tasks due on a certain day: You can ask for tasks that are due
on a certain day or month.

• Overdue tasks: You can get your tasks that are overdue.

• Create tasks: You can create a standalone task conversationally or
as a follow-up of an appointment.

For more information, see Create Records in the Microsoft Teams
Specific Features and CX Sales Mobile Specific Features topics.

• Show tasks due this week

• Show tasks due on March 19

• Get my overdue tasks

• Overview Tasks

• Create Task

Notes
 

For any object that has notes as a child object, you can ask the assistant
to add a note. The assistant prompts you for the note details to add to
the record you want.
 

• Add a note to this opportunity

• Add note to <keyword> search
account

Synonyms
 

The sales assistant understands the synonyms for objects and fields
that are defined by your administrators. Synonyms allow the sales
assistant to understand your company's jargon. For example, instead of
sending "show the opportunity", you can send "show the opty" to the
assistant. It will still understand you're asking to see an opportunity.
 

• Opportunity - oppty, opty, deal

• Account - acct, company

• Contact - person

• Task - to-do, todo

• Appointment - meeting, appt

Sample synonyms for fields:
 

• EffectiveDate (for Opportunity)
- closing, close date

• State (for Account) - province

Filtering a List of Records
 

When you ask the sales assistant a question, for example, to find
opportunities in the open pipeline, it responds with a list of records.
From the list, you can select a record to drill in to, view, and act on the
record. To quickly get to the record of interest, you can perform searches
to filter any list by sending a keyword or by specifying a field and value
to filter on.
 

Tip:
Filtering the list is always based on the original list - not the filtered
list. You can send a keyword based on the fields showing on the list
card or based on what's enabled for your company's keyword search
for the object.
 

Tip:
You can filter any saved search list either by a keyword or by
specifying a field and value to filter on. However, when asking for a
record and if the assistant shows a list of matches, you can only filter
this type of list by keyword.
 

Not applicable
 

Cancel a conversation with
multiple steps
 

You can cancel a conversation at any stage during a multistep
conversation flow. For example, if you want to create a task, sales
assistant prompts you with several questions. At any point during this
process, you can enter a command or phrase such as "restart" to exit the
flow. This saves you time and means you don't have to follow through
with a conversation you no longer want to pursue.
 

• Restart

• Reset
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Feature Description Sample Phrases to Use

Provide Tips During a
Conversation
 

Sometimes Oracle Sales Assistant provides tips about recommended
next steps at the end of a conversation.
 
This feature improves the user experience of the Oracle Sales Assistant
as it helps you learn how to use the Sales Assistant by providing
examples of what you can say at certain parts of the conversations. Each
tip is shown once a day and is displayed up to 5 times to a user. You can
click "Got it" to stop the tip from showing again.
 

Not applicable
 

Provide Help During a
Conversation
 

Users can also request help when viewing a list or summary card. The
assistant responds with a help message matching the context of the list
or summary card.
 

• Help

 

Microsoft Teams Specific Features  
You request information by entering questions or sending commands and sales assistant retrieves the information or
acts on your requests. You can greet the assistant or ask for help.

Here are some sample phrases you can use:

• Hi

• Hello

• Hey

• Get started

• Start

• What can you do for me?

• What can you do?

• What can I do?

Things to note:

• In Microsoft Teams, the sales assistant may be part of a digital assistant with other Oracle supported skill from
Oracle Cloud applications, so that you can interact with one assistant for its various services.

• Oracle Digital Assistant handles the initial greeting as well as any requests for help. If there are multiple skills
(including the sales assistant) added to your digital assistant, the digital assistant returns suggestions for what
you can do with each of the skills.

Features
Here are the Sales Assistant features specific to Microsoft Teams users.

Feature Description

Actions
 

There may be special actions which administrators can enable to allow you to act on a specific
record. These actions are displayed as a button on the summary card. For example, if enabled on the
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Feature Description

opportunity, account and contact summary cards, the "Add a note" button lets you add a note to the
record.
 

Create Records
 

Records with values such as Notes, Call Reports, Tasks, and Appointments can be created
conversationally. The assistant prompts for information to create the record. When all the questions
defined are asked, a confirmation message prompts you to confirm the creation of the record with the
input provided.
 
For fields that aren't mandatory, you can choose to skip the field and not provide an input value. For
fields that are mandatory with a default, you can choose to accept the default value or provide an
input.
 

List of Records
 

For lists that have more than 5 records, you can use the Next and Previous buttons for easy navigation.
 
See "Filtering a List of Records" in the main Sales Assistant features table to quickly find a record
without navigating through the list.
 
To see more details for a record, you can click anywhere on the row of the record in the list. To select
the record for further conversations, you can either click the index number button or send the index
number, such as "3".
 

Deep Links
 

Deep links are links that let Microsoft Teams users drill directly down into a record, such as an
opportunity record and are available only for certain intents.
 
For Microsoft Teams Mobile app users, the deep link also goes to the CX Sales mobile app. However, if
you switch from using the mobile app to the web or desktop app, then the deep links initially sent with
the mobile app record card are maintained for that specific record. Any other cards you receive with
deep links when conversing on the desktop client are sent to the CX Sales web app.
 

Attachments
 

For any object (of any object that's enabled for your specific channel) that has attachment as a child
object, you can ask the assistant to attach a file to the records.
 
Things to consider:
 

• The Sales Assistant in Microsoft Teams configuration must support uploading and downloading
files.

• Files shared with Sales Assistant through Microsoft Teams are uploaded to Microsoft Teams and
saved to the record in CX Sales as either a file or as a URL attachment.

• You can only upload one file at a time to CX Sales and 20 MB is the maximum file size.

• For Microsoft Teams on iOS or Android, you can choose from your files on your device to attach
to a record via the sales assistant. The sales assistant currently doesn't support attaching photos
from gallery to your CX Sales records.

Note:
Depending on your device, you can save the photos in gallery to your files on your device.
 

Sample phrase you can use:
 

• Attach a file

• Add file

• Upload a document

• Attach a doc to this account
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Related Topics

CX Sales Mobile Specific Features  
You can use the Sales Assistant by tapping the chat icon on the bottom right hand side of the CX Sales Mobile app.

In the chat screen, you can type and send your request to the Sales Assistant using the chat box at the bottom of the
page, or tap the microphone icon to say your request.

Features
Here are the Sales Assistant features specific to CX Sales Mobile users.

Feature Description

Using Voice
 

In the chat screen, you can either type or ask the assistant something. To type, tap on the white chat
box at the bottom of the screen. To use voice to speak to the assistant, tap on the green microphone
icon.
 

List of Records
 

For lists that have more than 3 records, you can use the 'View All' button. Tap the button to see the full
list of records.
 
See "Filtering a List of Records" in the main Sales Assistant features table to quickly find a record
without navigating through the list.
 
To see more details for a record, you can tap the white section of the item. To select the record for
further conversations, you can tap the purple portion of the item.
 

Attachments
 

For objects that are enabled for your specific channel and have an attachment as a child object, you
can ask the assistant to attach the file to the object's records. It will launch the attachment form for you
to share notes, photos, videos, documents, or files from your mobile device to CX Sales records.
 
Sample phrases that you can use:
 

• Attach a file

• Add file

• Upload a document

• Attach a doc to this account

Create records
 

Notes, Call Reports, Tasks, and Appointments can be created conversationally. The assistant prompts
for information to create the record. When all the defined questions are asked, a confirmation message
prompts you to confirm the creation of the record with the input information provided.
 
At any time when the assistant is asking for information, there is an option to switch to a form to
complete the creation by tapping Switch to Form. Any questions answered in the conversation prior to
switching to the form are populated in the form. Tapping Save brings you back to the conversation.
 
For fields that aren't mandatory, you can choose to skip the field and not provide an input value. For
fields that are mandatory with a default, you can choose to accept the default value, or provide an
input.
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For objects that aren't supported for conversational create, asking the assistant to create the record will
launch the record creation page.
 

Update records
 

Asking the assistant to update the record will launch the update page for the record.
 
Sample phrases that you can use:
 

• Update opportunity

• Update the Supremo account
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26  LinkedIn Sales Naviagtor

Overview of LinkedIn Sales Navigator  
LinkedIn Sales Navigator helps sales teams acquire new business, expand existing customer relationships, and
maximize sales productivity. Use the LinkedIn Sales Navigator to:

• Get introduced to buyers through your company's network with TeamLink.

• Spot new buyers that appear at your target accounts with saved search.

• Get immediate alerts when a lead engages with your marketing campaigns.

• Proactively track champions through real-time alerts including role changes.

• Find distributed buyers at the account with lead search.

• Connect with warm outreach with a personalized InMail.

To learn more about LinkedIn Sales Navigator, visit sales.linkedin.com.

Related Topics
• Enable LinkedIn Sales Navigator for Accounts, Contacts, and Leads

• Supported Platforms for the LinkedIn and Sales Integration

• Remove Mashup Content for LinkedIn Sales Navigator for Accounts

Use the LinkedIn Sales Navigator  
View the LinkedIn profile details of an account, contact or lead.

Watch video
 

You can access the information in the LinkedIn Sales Navigator region from these pages:

• Edit Account: Profile page for an account

• Edit Contact: Profile page for a contact

• Edit Lead: Summary page for a lead

Use your LinkedIn credentials to sign in to LinkedIn Sales Navigator.

Here are the tasks you can do with the LinkedIn Sales Navigator:

Task Description

View Profile View the complete LinkedIn profile details of an account, contact, or lead.

377

https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20062946
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20080661
https://www.oracle.com/pls/topic/lookup?ctx=fa23a&id=s20080660
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:24501
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:24501


Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 26
LinkedIn Sales Naviagtor

Task Description

  

Connect
 

Request to connect on LinkedIn by sending an invite.
 

Send Message or Send InMail
 

Send messages to first-level connections. Alternatively, use an InMail to connect with contacts or leads
at other levels.
 

Icebreakers
 

Explore common interests and conversation starters with the selected account, contact, or lead.
 

Get Introduced
 

Request an introduction through a mutual connection.
 

Match Profile
 

Associate an accurate profile when LinkedIn suggests multiple profiles that match with an account,
 contact or lead. Once associated, you can see the matched LinkedIn profile in your account, contact, or
lead records.
 

Not this person
 

Use this option if LinkedIn displays profiles that don't belong to the selected account, contact, or lead.
 

Before you can use LinkedIn Sales Navigator, your administrator must enable it and you must have Team or Enterprise
licenses.

Related Topics
• Enable LinkedIn Sales Navigator for Accounts, Contacts, and Leads

• Remove Mashup Content for LinkedIn Sales Navigator for Accounts

Associate LinkedIn Records with Accounts, Contacts and
Leads  
You can use LinkedIn Sales Navigator to build and nurture sales relationships that increase sales performance. Use
LinkedIn Sales Navigator to associate LinkedIn records with accounts, contacts, and leads.

The association helps to connect with the relevant people for contacts and leads or companies for accounts. To receive
information about a new contact or lead, search in LinkedIn with a few basic details such as name or job title. With
LinkedIn Sales Navigator, you get a detailed overview of your contact or lead. Your administrator has to enable the
LinkedIn Sales Navigator for you on the contact and lead pages. The steps given here use contacts as an example. Use
similar steps to associate a lead or an account with a LinkedIn record.

Here's how to associate a contact with a LinkedIn record.

1. On your Sales application home page, click Sales  > Contacts.
2. Click Create Contact.
3. Enter the first name, last name, and job title.
4. Click Save and Close.
5. Click to open the newly created contact and expand the LinkedIn region of the Contact detail page.
6. Click  LinkedIn Sales Navigator.
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Note:  LinkedIn suggests potential matching profiles for Contacts and Leads and suggests matching
companies for Accounts.

7. Select the relevant person that you want to associate with.
8. Click Match.

You receive a notification saying that the contact is matched to the contact.
9. Click Save in Sales Navigator to save the association.
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27  Service Requests

Overview of Service Request Management  
Service request management functionality lets you manage and deliver a streamlined service in response to service
requests. Delivering consistent answers to customer questions helps ensure that service requests are resolved
efficiently and effectively.

Service request management lets you:

• Create service requests

• Enter summary information into service requests

• Add products and product groups to service requests

• Organize service requests into queues

• Compose and send messages from service requests

• Add contacts to service requests

• Add team members to service requests

• Automatically or manually assign service requests to other users

• Create activities for service requests

• Share service request information

• Associate and view items in the knowledge base

• Integrate with the partners application to capture and resolve issues reported by your partner accounts

See the Using Fusion Service guide for more information about sales user tasks for service requests.

Overview of Service Request User Tasks  
You can create and manage service requests once your sales administrator enables the service request offering. To
create a service request (SR), select the Service Requests menu from the Navigator page, and on the Service Requests
list page, click Create Service Request.

Here are some of the high-level user tasks that you can perform for service request management:

• Capture service requests

You can capture new service requests through user data entry, APIs, or file import.

• Organize and assign service requests

You can organize and assign service requests to queues either manually or using the Assignment Manager
feature. You can also assign service requests to team members through the Assign To field in the service
requests UI.

381



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 27
Service Requests

• Manage the lifecycle of a service request

A service request typically moves through the statuses: New, Waiting, In Progress, Resolved, and Closed. You
can modify the statuses per your requirements if you have sufficient privileges.

See the Using Fusion Service guide for more information about sales user tasks for service requests.

See the Implementing Fusion Service guide for more information about service requests setup tasks.
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28  Sales Lightbox

Overview of Sales Lightbox  
With the Sales Lightbox content library, you can store, access, and share files, such as slide decks, web-based content,
and .pdfs. The following is a high-level summary of the content library features:

• Upload and access stored content: Upload content from your computer to the library for later access and
sharing. Supported file types include .pptx, .html (in the form of microsite .zip files), and .pdf. The image file
types .jpg and .png are supported as separate file types as well.

• Find content: Browse and search for library content. Search includes file name, owner, and keywords.

• Share content: Share content with other users, with sales accounts, and with sales opportunities. Joint
ownership also is supported.

• Create new presentations on the fly: For .pptx files only, assemble new slide decks using slides from the library.

• Add to cart: For .pptx files only, add slides to your cart.

The topic, Available Lightbox Actions for Different Content Types, has full details of the available actions for each file
type.

Library Views
When you open the library, you see these views:

• My Content: Displays all content that you own. This includes content that you have uploaded and all the
content that was shared with you by other users. Documents can be shared with or without joint ownership.

• Shared Content: Displays all content that you own, and all the content that's shared with you by other users.

If you're an administrator, you also see the All Content view: This view displays all content uploaded by all users,
including all content that belongs to the administrator. For more administrator information, see the Implementing Sales
guide.

For more information about user tasks in the content library, see the online help and the Using Sales guide.

Related Topics
• Available Actions for Different Content Types

• Open Content

• Download Content

• About Uploading Content

• Search for Content
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Available Actions for Different Content Types  
In the Sales Lightbox content library, different file types carry different available actions. For example, slides
presentations can be added to the cart, but microsite and .pdf files can't.

Here's a list of actions that you can perform with different Lightbox file types.

Action PowerPoints PDFs Microsites Images

Upload
 

Yes
 

Yes
 

Yes
 

Yes
 

Download
 

Yes
 

Yes
 

Yes
 

Yes
 

Update
 

Yes
 

Yes
 

Yes
 

Yes
 

Open
 

Yes
 

Yes
 

Yes
 

Yes
 

New Pages
 

Yes
 

Yes
 

No
 

No
 

Share
 

Yes
 

Yes
 

Yes
 

Yes
 

Add to cart
 

Yes
 

Yes
 

No
 

No
 

Delete
 

Yes
 

Yes
 

Yes
 

Yes
 

Search
 

Yes
 

Yes
 

Yes
 

Yes
 

View properties
 

Yes
 

Yes
 

Yes
 

Yes
 

Here's a list of actions with different Lightbox file types and the information that you must consider while performing
them.

Action Information

Upload
 

• Slides must be .pptx files.

• Microsites must be .zip files. See the topics, Using Microsites in the Lightbox Content Library and
Creating and Uploading a Microsite .Zip File: Procedure: Procedure, for more information.

• Image files must be .jpg or .png format.

Share
 

Sharing is possible with other users, accounts, and opportunities, including joint ownership.
 

Delete The file owner can delete files that she owns. Administrators can delete any content.
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Action Information

  

Search
 

• Slides: Can use file name, owner, or keyword in the document.

• PDFs: Can use file name, owner, or keyword in the document.

• Microsites: Can use file name or owner. If keyword search is enabled within the microsite, can
search by keyword. If keyword search isn't enabled, then the main .html file is scrubbed of HTML
tags and stored as searchable content.

• Image files: Can use file name and owner.

View properties
 

• Slides: Can view file name, owner, number of slides, date and time uploaded, current version
number, number of downloads, number of views, number of shares.

• PDFs: Can view file name, owner, date and time uploaded, views, number of downloads, number
of shares.

• Microsites: Can view file name, owner, number of pages, date and time uploaded, current version
number, number of downloads, number of views, number of shares.

• Image files: Can view file name, owner, number of slides, date and time uploaded, current version
number, number of downloads, number of views, number of shares.

About Bursting and Assembling Content
The terms burst and assemble have specific definitions in the context of the Lightbox content library.

• Burst: Users burst content when they open a file in Lightbox. The act of "bursting" refers to the application
displaying the individual pages of a file as it's opened. During this process, after splitting a file into individual
pages, the application analyzes the pages, saves them, and creates records for them in the database.

• Assemble: Users assemble content when they save individual pages to a cart and download them. Assembling
means content with pages from one or more different files (of the same content type) is saved to the cart,
potentially rearranged, and then downloaded. During assembly, in the background, the application compiles
the files into a single file set.

For more information about using the content library, see the online help and the Using Sales guide.

Create Content  

Overview of Creating Content  
To be able to upload presentations to the Sales Lightbox content library, you first create them and then save them to
your hard drive.

Lightbox supports these file types:

• Microsoft PowerPoint: The content library supports the Open XML file format (.pptx 2007). If you install the
Microsoft Office Compatibility Pack, and save a presentation in the Open XML format (.pptx 2007), then those
presentations are fully compatible with Sales Lightbox.

• PDF: You can upload .pdf files and share them with other users. However, you can't open .pdf files in Lightbox
or add them to the cart.
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• Microsites: These are collections of html and supporting files, saved in a .zip compressed file type. For more
information about this content type, see the topics, Using Microsites in the Lightbox Content Library and
Creating and Uploading a Microsite .Zip File: Procedure.

• Image files: The image file types .jpg and .png are supported for upload and sharing as distinct pieces of
content.

See the related topics for more information.

Related Topics
• Use Microsites in the Lightbox Content Library

• Available Actions for Different Content Types

Use Microsites in the Lightbox Content Library  
You can use the Sales Lightbox content library to store and share microsite content. The content library supports
multiple-page and single-page microsite content. You construct your microsite content in .zip file format. The .zip file
contains the required .html and supporting files, such as images and cascading style sheets.

For a procedure about creating and uploading the microsite files, see Create and Upload a Microsite .Zip File.

About the .Zip File
You create the microsite file structure on your hard drive and then you use a .zip compression utility to compress the
files for upload. Only .zip compression format is allowed. The microsite's main landing page can have its own domain
name or subdomain name. Your .zip file structure determines whether Lightbox considers the microsite a single-page
microsite or a multiple-page microsite.

• Single-page microsite: The .zip file contains no embedded .zip files and contains one .html (or .htm) file in the
directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files,
or JavaScript (.js) files in a separate folder.

• Multiple-page microsite: The .zip file contains embedded .zip files that contain one .html (or .htm) file in the
directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files,
or JavaScript (.js) files in a separate folder.

This topic contains examples of the supported folder construction for microsite .zip files.

The following rules apply to the .html files:

• For a single-page microsite, the .zip file must contain only one .html (or .htm) file at the top location in the
folder. For multiple-page microsites, the embedded .zip files serve as independent microsite pages. That is,
each embedded .zip file must contain all of the elements that a single-page microsite contains, including
the .html file.

• The .html file must be named identically to the .zip file. For example, visionservers.zip must contain a file
named visionservers.html (or .htm) at the top location in the folder.

• If a properly-named, full-sized thumbnail image is provided in the .zip file, the application uses it as the
thumbnail. See the rules on image files following this text for more information.

The following rules apply to the image files:

• Supported image file types are .png and .jpg.
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• To designate a thumbnail image in the microsite, include the image file at the same location as the .html file.
and append -full to the file name. For example, in the visionservers.zip file, include an image file named
visionservers-full.jpg.

• If no image is designated as the thumbnail, then Lightbox displays its default thumbnail image.

You can enable keyword search for microsites by including a text file with the keywords. See the section on enabling
keyword search for microsites later in this topic.

Name and Structure Microsite Files
For microsites to be accepted for upload into the content library, you must follow some rules for naming and
structuring the files. Each page must contain a folder of the same name, and that folder must contain an .html file
of the same name. Thus, visionservers.zip must contain a folder, visionservers. In that folder there must be a file,
visionservers.html. It can contain any number of other files and folders, but it must at least contain that file.

For a single-page microsite, you supply the .zip file that contains an .html file named the same as the .zip file. Optionally,
you also supply a thumbnail image, a text file for keyword search, and supporting files, such as a cascading style sheet
and JavaScript files.

The following figure shows an example of a well-constructed single-page microsite folder structure called
visionservers.

For multiple-page microsites, you construct the .zip file as multiple .zip files within a parent .zip file.

The following figure shows an example of a well-constructed multiple-page microsite folder structure called
visionservers.
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Enable Keyword Search for Microsites
You can add the ability for users to search for microsite files by keywords. Add a text file with the keywords to the
microsite .zip file and name the file appropriately. If keyword search isn't enabled, then the main .html file is scrubbed of
HTML tags and stored as searchable content. Use the following guidance when creating the text file:

• Use a text editor application, such as Microsoft Notepad, to create the text file.

• Name the text file with the same name as the .zip and .html files and append it with -Searchdata (note the file
name is case-sensitive). For example, name it visionservers-Searchdata.txt.

• Include the text (.txt) file in the same location as its corresponding .html file.

• Enter the keywords with only spaces between them.

• Don't use punctuation marks, such as commas or periods, in the text file.

Related Topics
• Create and Upload a Microsite .Zip File
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Create and Upload a Microsite .Zip File  
After you have created your files and file structure for the microsite, you then must create a .zip file containing the
folders and files in the correct structure.

Here are the high-level steps to create and upload microsite .zip files to the content library. For more details about how
to structure the folders for the .zip file, see the topic, Use Microsites in the Lightbox Content Library.

1. Create and store the .html and supporting files in a location on your computer. When creating the folder
structure, you can use the examples in the topic, Using Microsites in the Lightbox Content Library.

2. Use a file compression application to add the files to a .zip file.
3. Sign in to the applications and navigate to Sales > Lightbox.

The Lightbox page appears, showing content that's available to you.
4. In the My Content view, click Upload.

The Upload Content dialog window appears.
5. Browse for the .zip file on your computer.
6. Click Open.
7. Click Upload in the Upload Content dialog window.

A confirmation message lets you know of a successful upload.

Related Topics
• Use Microsites in the Lightbox Content Library

Upload Content  

Use the Cart  
The cart lets you assemble content and download it. You can view the details of the content while it's in the cart.

Select the content and remove it using the drop-down button on the content, or clear the cart and remove all of the
content.

You can only add one type of content at a time to the cart. If you try to add different types of content to the cart, you
receive an error stating that the content type is different. For example, if you have uploaded a .pptx presentation and
then try to add a PDF file, an error message appears. Clear out the cart and then add your other item type. To add
content to a cart:

1. Click Sales > Lightbox.
The Lightbox overview page appears.

2. Click the plus symbol on the content on the Lightbox overview page to add the content to the cart.
3. Click Cart to view the content.

The Lightbox: Cart page appears.
4. Click the drop-down button on the content to remove or move the content.
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5. Click Clear Cart to remove all the content from the cart.

About Uploading Content  
In the Sales Lightbox content library, you can upload content that you want to view later or share with other users.

For a procedure detailing how to upload content, see the topic, Uploading Lightbox Content: Procedure.

When you upload content, the application performs in the following way:

• If the content uploads successfully, then a thumbnail image appears on the My Content view after you refresh
your view. After an initial upload, a placeholder thumbnail appears and postupload processing continues. You
can continue to work during this time.

• An error message appears if uploaded file isn't a supported file type.

• After the initial file upload, postupload processing extracts thumbnails, performs a virus check on the uploaded
file, and so on. A confirmation message appears if the content has successfully uploaded. When the upload is
complete, refresh your view to see the content thumbnail image and to access the content.

• If postupload processing fails, and if a preferred notification method has been configured for you, then you
receive a message explaining that an error occurred. If this error occurs, contact your administrator. Any
content that fails the postupload process is removed from the My Content view.

• If you sign out during an upload, then postupload processing continues.

Note:  The maximum file size of a content that can be uploaded is 100 MB.

Related Topics
• Upload Content

• About Updating Content

• Update Content

Upload Content  
In the Sales Lightbox content library, you can upload content that you want to share with other users. You also can share
content with a potential sales opportunity or with an account.

Here's how you can upload new content.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. In the My Content view, click Upload.

The Upload Content dialog window appears.
3. Click Browse. Browse for and select the content you want to upload from a location on your computer.
4. Click Open or double-click the file.
5. Click Upload in the Upload Content dialog window.
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6. A confirmation message lets you know of a successful upload.
7. After the upload is complete, refresh your view to see the new thumbnail images for the content, and to access

the content.

Related Topics
• About Uploading Content

• About Updating Content

• Update Content

Update Content  

About Updating Content  
In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you
might have already shared content with other users, but you want to replace the original content with a version
containing newer data.

For a procedure detailing how to update an existing content, see the topic, Update Content

When you update content, the application performs in this ways:

• During post-upload processing, the placeholder thumbnail images change, but the file name remains the same
for the newer content. You can continue to work during this time.

• If you're updating content while another user wants to use the content, for example, to add the content to the
cart or to share the content, the other user can do so safely, and the current version of the content is used.

• When you're updating content, any search results for that content display the previous version of the content.

• If you attempt to update content while another user is already updating or deleting the content as a joint owner,
then you will receive a message that an update is in progress, and to try again later.

• While the update is in progress, the content properties panel is available and a dynamic circle image is overlaid
on the thumbnail, providing visual feedback that a new upload is processing.

• While the update is in progress, other users can open the previous version of the content.

• If you decide to update content with content that has a different name than the original content, then the name
of the original content is kept, and only the content slides are updated.

After you update content, the application performs in the following way:

• If the content is successfully updated, then the content displays as the first document in the list.

• If the content fails to update, then the existing version remains in place and you receive an e-mail notification
confirming that the update failed.

• The cover thumbnail image for the new content is determined by the previously selected cover thumbnail
image. For example, if slide number 5 was the previous cover thumbnail, then slide number 5 is also selected
for the new content. If the slides are re-ordered, then a different cover thumbnail is displayed.

• If the number of slides in content is reduced, then the thumbnail for the first slide is the cover thumbnail. For
example, if slide number 20 was selected as the cover thumbnail for the previous content, but the new content
only contains 10 slides, then the thumbnail for the first slide is the cover thumbnail for the content.
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• When the content is fully updated, the Version and Uploaded properties are updated accordingly.

• The contents remain shared and the ownership remains shared with other users.

• Each time you update a specific content, the content is listed at the start of the content list in the My Content
view.

Related Topics
• Update Content

• About Setting a Slide as a Cover Thumbnail

Update Content  
In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you
might have already shared content with other users, but you want to replace the original content with a version
containing newer data.

Here's how you can update content.

1. Navigate to Sales > Lightbox.
The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. In the My Content view, locate the content you want to replace and update.
3. From the Actions menu, click Update.

The Upload new version of Content dialog window appears.
4. Click Browse. Browse for and select the updated content from a location on your computer.
5. Click Open or double-click the file.
6. Click Upload.

A confirmation message lets you know of a successful upload.
7. After the update is complete, refresh your view to see the new thumbnail images for the content, and to access

the content.

Related Topics
• About Updating Content

Search for Content  

Overview of Searching for Content  
You can search for content by file name, owner, or keyword, in the sales Lightbox content library. The search finds
content that you own or that's shared with you by other users. As soon as a file is uploaded and processed, it's available
in the search results.

To know how to search Lightbox content, see Search for Content.
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When searching, remember:

• Searches aren't case-sensitive. For example, searching for America returns the same results as searching for
aMERICA.

• The search returns partial word matches. For example, if you search for mas, the application finds files
containing the words Masquerade, Masculine, Mask, and so on.

• You can use the percent sign (%) as a wildcard at the beginning of a string. For example, if you perform a search
for %ore, the application returns all content containing core, sore, and so on.

• You can search for file names that contain special and accented characters such as ampersands.

• The order of keywords within the search string is irrelevant. All keywords must match, to match the search
string text in file names and content. The Boolean AND operator is implicit. That's you don't enter the Boolean
AND operator in your search string. The application automatically inserts it between each keyword (or between
keywords and phrases) in the search string.

• From the search results, you can perform the allowed activities with the content. See the topic, Available
Lightbox Actions for Different Content Types, for more information about the allowed actions.

Related Topics
• Search for Content

Search for Content  
You can search for content by file name, owner, or keyword, in the sales Lightbox content library. The search finds
content that you own or that's shared with you by other users.

For more information about the Lightbox search actions and tips, see Overview of Searching for Content.

Here's how to search for content containing a specific word or text.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content available to you.
2. In My Content or Shared Content views, click the magnifying glass icon.
3. Enter the text that you want to find in the search field, and press Enter or click the search icon.
4. Use the Actions menu to download the content or add it to your cart (if applicable). To open the content (if

allowed), click the content name.
See the topic, Available Lightbox Actions for Different Content Types, for more information about the allowed actions.

Search results remain available until you perform a new search in your current session.

Related Topics
• Overview of Searching for Content
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Download and Open Content  

Download Content  
Using the Sales Lightbox content library, you can download content that's shared with you. You also can download .pptx
slides that you added to your cart.

You can download content from these locations in Sales Lightbox:

• The Shared Content view

• The My Content view

• The cart

Note:  Only .pptx slides can be added to the cart; therefore, this is the only content type you can download from the
cart.

Here's how you can download content from the Lightbox page. To filter the view of the content, you use the Shared
Content and My Content view filters.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that's available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. In the My Content or Shared Content views, click the Actions menu on a content item and select Download.
3. Do one of these actions:

◦ In the open file window, click Save to save the content to your computer's local drive.

◦ In the open file window, click Open  to open the content and then save the content to your computer's
local drive.

Download Slides from the Cart
This procedure applies only to .pptx slides. Other content types can't be added to or downloaded from the cart. Use this
procedure to assemble all slides in your cart into a single slide deck and download them to your computer's local drive.

Note:  Slides must first be added to the cart in order for you to be able to download them from the cart. See the topic,
Overview of Managing Your Cart, for more information.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that's available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. Click Cart to open the cart.
3. Click the Download button.
4. Do one of these actions:

◦ In the open file window, click Save to save the content to your computer's local drive.
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◦ In the open file window, click Open to open the content in Microsoft PowerPoint and then save the
content to your computer's local drive.

After you save the content, the download property for each slide is updated. The slides remain in the cart until you
remove them.

Related Topics
• Overview of Managing Your Cart

• Overview of Sales Lightbox

Open Content  
In the Sales Lightbox content library, you can open your own content and content that has been shared with you.

Opening content lets you:

• View the thumbnail images of PowerPoint slides (if available) in a dialog box.

• View thumbnail images of multiple-page microsites (if images have been provided) in a dialog box.

• Set a particular slide as the content's cover thumbnail image (for slide presentations and microsites).

• Add individual slides from slide presentations to your cart.

• View content properties, such as the number of times the content was downloaded or shared.

Note:  Note that you can't open .pdf files from the library. When you click on the link for a .pdf file, you see thumbnails
of each page.

Here's how you can open content.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, find the content you want to open.

You can also locate content by performing a search. Files are listed in the chronological order in which they
were uploaded.

3. To open content, do one of the following:

◦ Click the Actions menu and select Open.

◦ Click the file name link under each thumbnail.

◦ From search results, click the content name.

Related Topics
• Search for Content

• About Setting a Slide as a Cover Thumbnail
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Overview of Managing Your Cart  
You can use the cart in the Sales Lightbox content library to add and assemble Microsoft PowerPoint (.pptx) slides that
are available to you. Other content types, including .pdfs, microsites, and image files, can't be added to the cart.

The following are the tasks for the Lightbox cart:

• Adding a presentation to the cart

• Adding a slide to the cart

• Removing slides from the cart

• Emptying the cart

• Downloading slides from the cart

• Arranging the slide order in the cart

Tip:  The current number of slides you have in your cart is always indicated on the Cart button. And the number of
slides in a presentation is shown next to the Add to Cart action.

Add All Slides in a Presentation to the Cart
To add all the slides of a presentation to the cart, do the following:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. In the My Content or Shared Content views, locate the presentation you want to add to the cart.
3. Do one of the following:

◦ Click the plus sign (+) icon located at the top center of the thumbnail to add the presentation to the cart.

◦ Click the Actions menu and select Add to Cart.

A confirmation message notifies you of a successful addition to the cart.

Add a Single Slide to the Cart
To add a single slide to the cart, do the following:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. In the My Content or Shared Content views, open the presentation that contains the slide you want to add to
the cart. Open the presentation by clicking the Actions icon and then clicking Open.

3. To add a single slide of the presentation to the cart, do one of the following:

◦ Click the plus sign (+) icon located at the top center of the slide that you want to add to the cart.

◦ Click the Actions menu and select Add to Cart.
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A confirmation message notifies you of a successful addition to the cart.
4. Click Done to return to the My Content or Shared Content views.

Note:  If a slide in your cart has its corresponding presentation deleted, then the slide remains in the cart, but the slide
properties are unavailable.

Remove Slides from the Cart
To remove a slide from the cart, do the following:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. Click Cart and find the slide you want to remove.
3. Do one of the following:

◦ Click the minus sign (-) icon located at the top center of the slide that you want to remove from the cart.

◦ Click the Actions menu and select Remove.

4. Click Yes on the confirmation message.
5. Click Done to return to the My Content or Shared Content views.

Empty the Cart
To empty the cart:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. Click Cart to view your cart.
3. Click Clear Cart.

Download from the Cart
To download all slides from the cart into a single presentation and save them to your computer's local drive, do the
following:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. Click Cart to open the cart.
3. Click Download.
4. Do one of the following:

◦ In the open file window, click Save to save the presentation to your computer's local drive.

◦ In the open file window, click Open to open the presentation in Microsoft PowerPoint and then save the
presentation to your computer's local drive.

After you save the presentation, the application updates the properties information for the slide. The slides
remain in the cart until you remove them.
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5. Click Done to return to the My Content or Shared Content views.

Arrange the Slide Order in the Cart
To change the order in which slides appear in the cart, do the following:

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail
image. The image has icons on it that allow access to actions and information.

2. Click Cart to open the cart.
3. In the cart, find the slide you want to move.
4. Do one of the following:

◦ Move the slides to where you want them.

◦ Click the Actions menu and select Move Left or Move Right.

◦ Click the left or right arrow located at the top center of the thumbnail.

5. Click Done to return to the My Content or Shared Content views.

Related Topics
• Download Content

• Open Content

• Overview of Searching for Content

Share Content  

Overview of Sharing Content  
In the Sales Lightbox content library, you can share content with:

• Opportunities

• Accounts

• Users

You can also select a user to be the joint owner of a content item along with you.

Share Content with Opportunities and Accounts
You can share your content with accounts and opportunities. When you share content with an opportunity or an
account, you're essentially attaching a copy of the content to the opportunity or account you select. Note the following:

• You can only share content with an account or an opportunity if you have access to Sales accounts or
opportunities applications.

• If you make any changes to the content after you share it with an opportunity, the shared document isn't
affected.
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Share Content with Other Users
You can share content with another user without granting joint ownership. The following table indicates which actions
the other user can perform after the content is shared. All content that's shared without joint ownership is available in
the user's Shared Content view.

Actions User Permission?

View content
 

Yes
 

Download content
 

Yes
 

Share content without joint ownership
 

Yes
 

Update content
 

No
 

Share content with joint ownership
 

No
 

Delete content
 

No
 

Share Content with a User as the Joint Owner
If you own a content item, you can share it with a user and grant joint ownership to that user. The following table
indicates which actions the other user can perform when the content is shared with joint ownership. All content that's
shared with joint ownership is available in the user's My Content view.

Actions User Permission?

View content
 

Yes
 

Download content
 

Yes
 

Update content
 

Yes
 

Share content with ownership
 

Yes
 

Share content without ownership
 

Yes
 

Delete content
 

Yes
 

For procedures details sharing activities, see the additional topics on sharing content.
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Related Topics
• Share Content with an Account

• Share Content with an Opportunity

• Share Content with a User

• Share Content as Joint Owner

Share Content with an Opportunity  
In the Sales Lightbox content library, you can attach a copy of a content to an opportunity. If you make any changes to
the content after you share it with an opportunity, the shared document isn't affected.

You can only share content with an opportunity if you have permission to access the opportunities application.

Here's how to share content with an opportunity.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with

Opportunity.

The search and select page for opportunities appears.
3. Search for and select the opportunity.
4. Click OK.

A confirmation message lets you know that the content was successfully shared.

Related Topics
• Overview of Sharing Content

• Share Content with a User

• Share Content as Joint Owner

• Share Content with an Account

Share Content with a User  
In the Sales Lightbox content library, you can share your content with others using sales applications. After you share
content with another user, the content appears in the user's Shared Content view.

If you make any changes to the content after you share it with a user, these changes are visible to all users with whom
the document has been shared. You can only share content with a user who has access to Sales Lightbox, and if the
content owner has granted you joint ownership.

Here's how to share content with a user.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with User.
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The search and select page for users appears.
3. Search for and select the user.
4. Click OK.

A confirmation message lets you know the content was successfully shared.

Related Topics
• Overview of Sharing Content

• Share Content with an Opportunity

• Share Content as Joint Owner

• Share Content with an Account

Share Content as Joint Owner  
In the Sales Lightbox content library, you can share your content with other sales application users and make them joint
owners of the content.

If you make any changes to the content after you share it with a user, these changes are visible to all owners with whom
the document has been shared. When you share a document with a user with joint ownership, that user is allowed to
update and delete that document. You can only share a content with a user as joint owner if the user has access to Sales
Lightbox, and if the content owner has also granted you joint ownership.

Here's how to share content with a user as joint owner.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with User as

Joint Owner.

The search and select page for users appears.
3. Search for and select the user.
4. Click OK.

A confirmation message lets you know the content was successfully shared.

Related Topics
• Overview of Sharing Content

• Share Content with an Opportunity

• Share Content with a User

• Share Content with an Account

Share Content with an Account  
In the Sales Lightbox content library, you can attach a copy of a content item to an account. If you make any changes to
the content after you share it with an account, the shared document isn't affected.
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You can only share content with an account if you have permission to access the sales accounts application. Here's how
to share content with an account.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with

Customer.

The search and select page for accounts opens.
3. Search for and select the account.
4. Click OK.

A confirmation message lets you know that the content was successfully shared.

Related Topics
• Overview of Sharing Content

• Share Content with a User

• Share Content as Joint Owner

• Share Content with an Opportunity

Content with Thumbnail Images  

About Setting a Slide as a Cover Thumbnail  
When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide
presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

For details on how to set a cover thumbnail image, see the topic, Set a Slide as a Cover Thumbnail.

Before you set a slide as a cover thumbnail image, consider the following:

• If you don't set a cover thumbnail, then a default cover thumbnail is assigned. The default cover thumbnail is
either the last slide used as a cover thumbnail or the first slide in the presentation.

• If you explicitly set a cover thumbnail for a presentation once, then the cover thumbnail remains the same
unless you explicitly change it again.

• If you're the owner of the document and set the cover thumbnail, then the cover you set becomes the cover
thumbnail for you and for all other users with whom this document is shared, who haven't explicitly set their
own cover thumbnail.

• If you own a document jointly with other users, and you and a second user have changed the cover thumbnail
from the default cover, then all other document owners who haven't set a new cover will see the most recently
set thumbnail as the new cover.

Related Topics
• Set a Slide as a Cover Thumbnail

402



Oracle Fusion Cloud Sales Automation
Using Sales

Chapter 28
Sales Lightbox

Set a Slide as a Cover Thumbnail  
When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide
presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

Here's how you can set a slide that you want to display as the cover thumbnail image for a presentation.

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing presentations that are available to you.
2. In the My Content view, open the presentation.
3. Click the star icon on the target slide to set the slide as the cover thumbnail.

When a slide is set as the cover thumbnail, the star icon on it changes to a filled gray star.

Related Topics
• About Setting a Slide as a Cover Thumbnail

Delete Content  

Overview of Deleting Content  
In the Sales Lightbox content library, you can delete content that you own. When you delete content, it's no longer
available to you or to others.

For a procedure detailing how to delete content, see the topic, Delete Content

If, before deleting a content item, you shared the content item with other users who are currently working with the
content you deleted, one of the following scenarios might occur:

• If you're browsing through content library that includes deleted content, the deleted content isn't available
when the page is refreshed.

• If you're browsing through content that has been deleted since you started browsing, when you scroll to the
next set of content, a warning message indicates that the content has been deleted. You're then returned to the
view prior to opening the content, for example, the Shared Content view.

• If you're browsing through a content that has been deleted since you started browsing, and if you click Show
Content Properties or another menu option, then a warning message indicates that the content has been
deleted. You're then returned to the view that was active prior to opening the file, for example, the Shared
Content view.

• In the case of slide decks, if you have already added slides from a deleted content to the cart, the thumbnail
images of the slides remain visible and available for you to view and to download from the cart until they're
manually removed from the cart, or until the cart is cleared. However, the slide properties are unavailable for
the deleted slides.

• If you try to directly download a deleted content from the Actions menu or from one of the views, a warning
message indicates that the content has been deleted and the content isn't downloaded.
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• If a deleted content item is displayed in search results and you attempt to select or open that content, then a
warning message indicates that the content has been deleted. You can't interact further with the search result
item.

Note:  If you're a sales administrator or a setup user, you can delete any content from the All Content view. This view
is available only to sales administrators and setup users.

Related Topics
• Delete Content

Delete Content  
In the Sales Lightbox content library, you can delete content that you own. When you delete content, it's no longer
available to you or to others.

Here's how you can delete content

1. Navigate to Sales > Lightbox.

The Lightbox page appears, showing contents that are available to you.
2. In the My Content view, locate the content you want to delete.
3. Click the Actions menu and select Delete from the menu.
4. Click Yes to confirm the deletion.

Related Topics
• Overview of Deleting Content
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29  In-Context Audit

Overview of In-Context Audit  
The in-context Audit feature lets you view the change history on a record, such as an opportunity, while you're viewing
the record. You can view the history for the object without checking the fundamental audit reports separately.

You can view who made the changes, what were the changes, and when the changes were made in the change history
subtab.

This feature helps to:

• Reduce time to resolve an issue

• Understand the audit history

• Improve compliance

• Track the change history of a particular object record.

Use the Change History Subtab  
Use this topic to understand how you can use the Change History subtab to view who made changes to a record and
when they made the changes.

Note:  Every business object has a separate privilege for viewing the Change History subtab. The subtab is visible only
if your administrator has given the necessary privileges to you or to your role.

View History
Click the Change History subtab on the object's details page, as shown in callout 1. By default, you can see the records of
the last 30 days for that record. You can view all the changes in one transaction per object grouped together, as shown
in callout 2.
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Search Fields in the Change History Subtab
Use the fields within Search in the Change History page and define your search.

Field Name Description

Date
 

Specify the audit history date range.
 

User
 

Filter the records based on a particular user.
 

Action
 

Filter the records based on the action done, for example: Add, Update, Delete.
 

Modified Object
 

Specify whether you want to see the records for the parent object, related or child objects or both.
 

Name
 

Specify the name of the object that you want to search.
 

Field
 

Select one or more fields on the object and filter the records to see the changes made only for those
fields.
 

Old Value/New Values
 

Search with the old or new value of a field.
 

For example, you search only the header opportunity object and within that, you want to view only the changes on Win
Probability. Then do these actions as shown in the image.

• Select Opportunity in Modified Object, as shown in callout 1.

• Select Win Probability in Field as shown in callout 2.

• Search. The filtered records display, as shown in callout 3.
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